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This chapter provides an overview of MEDUSA4.
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Introduction to MEDUSA4
What is MEDUSA4?

MEDUSA4 is a system of linked computer programs that perform a wide range of functions for 
computer aided design and computer aided manufacture (CAD/CAM). The system includes a 
powerful drafting system for creating and manipulating all types of drawings. These drawings 
can be readily interpreted by other programs running within MEDUSA4.

Fields of application for MEDUSA4 are amongst others mechanical engineering, 2D/3D layout  
plant design, factory layout and electrical engineering.

Using 2D Drawings in Other MEDUSA4 Programs

Once a MEDUSA4 sheet is produced using the MEDUSA4 drafting system, it can be modified 
and interpreted by other MEDUSA4 applications. 

The MEDUSA4 drafting system is therefore an integral part of all other MEDUSA4 applications.
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MEDUSA4 2D Functionality

MEDUSA4 2D offers a comprehensive set of tools and functionality for professional drafting and 
the creation of detailed drawings. A large number of line and geometry creation tools, along with 
advanced 2D features and design object functionality, serve to create intelligent components 
which are easy to use, move and edit. Users can add text to their drawings with a range of for-
matting options, and create URLs that point to external Websites or to relevant project related 
files, such as PDF documents. MEDUSA4 is a professional drafting system with extensive layer 
management capabilities. A user friendly dialog allows users to quickly organize and add prop-
erties to different layers.

MEDUSA4 offers a large selection of industry standard dimensioning tools. Quickly dimension 
your drawings through intelligent dimension placement and extensive dimensioning options. 
Various configuration options allow users to accurately position and format dimensions accord-
ing to individual requirements. You can choose from pre-set DIN, ISO, ANSI, BSI or JIS stan-
dard dimensions, or modify standards to create and save your own styles.

MEDUSA4 lets you dynamically load 2D symbols, or quickly and easily create new ones. There 
is a user friendly dialog for loading 2D symbols in MEDUSA4, DXF, or DWG format, allowing 
you to use any of your existing symbols in MEDUSA4.
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Main Features of MEDUSA4

Some of the main features that distinguish MEDUSA4 from other 2D CAD systems are:

• The use of multi-segment lines rather than single segment lines 

• The permanent grouping of elements (for example, for building up assemblies), in 
addition to temporary association of elements through selection sets and groups

• The graphical user interface is designed to:
• Enhance the user’s work flow, for example a popup menu for the active tool reduces 

the number of hand and head movements
• Increase the user’s productivity by making existing functionality more accessible 

and organizing the functionality on the screen on the basis of frequency of use
• Allow the user to recover from mistakes by offering the facility to cancel, undo, and 

redo (for certain MEDUSA4 functions).

• A Dashboard, which informs the user of the properties of geometry as it is created and 
modified

• A tree viewer, which keeps the user aware of the logical structure of the sheet and so 
maximizes the potential of permanent groups

• The ability to customize MEDUSA4, for example, the ability to:
• Define styles for elements
• Rearrange the contents of the ribbons 
• Assign new styles to tools

• The ability for the System Administrator to control how MEDUSA4 will run on site, 
including the ability to specify the type and appearance of the sheets, and the dimen-
sioning standards in use.
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Introduction to MEDUSA4 Elements

A MEDUSA4 sheet consists of different elements, known as element classes. 
These are:

• Lines composed of one or more line segments 

• Text elements

• Prims (predefined graphical shapes)

• Groups (elements which are associated with each other and are manipulated as a sin-
gle entity)

Element Properties

Each element class has a number of properties. These properties, known as attributes, are 
dependent on the element class.

As you create or modify an element, MEDUSA4 displays the most significant attributes on the 
Dashboard. You can display a full set of the different attributes in the Element Properties dia-
log. For example, line properties are displayed in the Line Properties dialog as shown below.

Figure 1 Example of an Element Properties Dialog

Users can easily change the properties of each element, either for the instance on the sheet, or 
for the use of the tool, or for the MEDUSA4 session.
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Multi-segment Lines in MEDUSA4

In MEDUSA4, a line consists of a series of points joined by line segments. A point is created at 
each vertex in the line. Moving one of the points, or adding or deleting points to the line affects 
the geometry of the whole line:

Figure 2 Adding a Point to a Line:

A multi-segment line can be an open line with two ends:

Figure 3 An Open Multi-segment Line

Or a closed line:

Figure 4 A Closed Multi-segment Line

A multi-segment line can be manipulated as a single entity.
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Advantages of Using Multi-segment Lines

You can develop a shape by modifying one line and its segments rather than several indepen-
dent lines. Modifications to one part of a multi-segment line automatically affect the other line 
segments. This example shows the result of successively deleting points in a multi-segment 
line:

Figure 5 Deleting Points in a Multi Segment Line

When you edit a line at segment level, you can, for example:

• Convert two line segments into an arc and vice versa

• Move a segment through a specified angle and vary its length

• Add and remove fillets and chamfers

You can manipulate complex shapes that are drawn as a single line as a single element. The 
outline of the design shown in Figure 6, “Shapes” is produced by drawing one half of the com-
ponent and then duplicating and mirroring it:

Figure 6 Shapes
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STARTING MEDUSA4
To start MEDUSA4, you have several possibilities:

Start via Desktop

Click on the MEDUSA4 Icon on your Desktop .

Launch MEDUSA4 from the Program Group

Click on the Start button  of the start desktop, then:

• open the MEDUSA4 program group on the start menu and click on  (Windows 7) 
or

• click on  in the APP overview (Windows 8)

Use Start-Batch-File

Run <MEDUSA4 installation path>\master_project\startmedusa.bat, e.g. by clicking twice on the file 
in the Windows explorer.

or

1. Open a terminal window (DOS box). 
2. Type the start command with its complete path, for example:
<MEDUSA4 installation path>\master_project\startmedusa.bat

3. After pressing Return MEDUSA4 is started.
Enter the command for starting MEDUSA4 in advanced mode:
<MEDUSA4 installation path>\master_project\startmedusa.bat -advanced

Use the Login-File and MEDUSA4 command

1. Open a terminal window (DOS box). 
2. Type the login command with its complete path, for example:

d:\medusa4\master_project\login.bat
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3. After pressing Return type one of the following commands:
• medusa4 -advanced starts MEDUSA4 in advanced mode. In this mode the bore 

hole tables tools are available, for example.
4. After pressing Return MEDUSA4 is started.
24 © CAD Schroer GmbH



MEDUSA4 Drafting
HELP
This chapter explains how and where you can get help in MEDUSA4.

• MEDUSA4 Documentation ...................................................... 26

• DVD and Installation Directory................................................. 27

• Help Menu................................................................................ 27

• Help Options ............................................................................ 28

• Tooltips..................................................................................... 28

• Message Line........................................................................... 28

• Context-sensitive Help ............................................................. 29

• Help Button in Dialogs ............................................................. 29
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MEDUSA4 Documentation

The MEDUSA4 product is delivered with a complete documentation. The documentation con-
sists of several separate PDF files.

The documentation is available directly on the DVD in the directory <DVD ROM>/doc and after 
installation in the directory <MEDUSA4 installation directory>\meddoc\doc.

In order to view and print PDF files a PDF viewer or a web browser with a suitable PDF Plugin 
has to be installed on your computer. The MEDUSA4 product comes with its own CSG PDF 
Viewer as help viewer. You find the CSG PDF Installer in the root directory of the MEDUSA4 6.2 
DVD. The READER variable in the login.bat must be set properly:

READER=csgpdf
or
READER=C:\Program Files (x86)\csgPdfViewer\CSG-PDF-Viewer.exe

The Reader variable is automatically set during the MEDUSA4 installation, depending on 
which option is choosen in the installation wizard. Default seting is CSG PDF Viewer. See also the 
“Administration“ Guide, “Installation“

Additional options to view the MEDUSA4 Help (Documentation) are Acrobat Reader® and Web 
browser with appropriate plugin.

Please note: If you have Adobe Acrobat Pro on your computer, set acrobat.exe instead of 
acrord32.exe (for the Acrobat Reader) when you are asked to make the set-
tings for the documentation during the MEDUSA4 installation.

Example:
Adobe Acrobat:
C:\Program Files (x86)\Adobe\Acrobat 11.0\Acrobat\Acrobat.exe

Adobe Reader:
C:\Program Files (x86)\Adobe\Reader 11.0\Reader\AcroRd32.exe

Please note: After an update of Acrobat Reader it might happen that the name of the .exe file 
or the location has changed. Since the path to Acrobat Reader can be specified 
during the MEDUSA4 installation, it is no longer correct in case of an update. If 
you then want to display the documentation, an error message is displayed.

In this case, you must edit the Reader Variable in the login.bat by modifying the 
name or the path accordingly.
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DVD and Installation Directory

1. Switch to the MEDUSA4 installation directory:
<DVD ROM>/doc/<language>
or
<MEDUSA4 installation directory>\meddoc\doc\<language>
where <language> is either english, german or french

2. Click on file mainmenu.pdf.
An overview of all available documents is displayed.

3. Click on the title of the book which you want to display. 

Help Menu

In the top right corner of the user interface MEDUSA4 provides a question mark button.

When you click on the button the Help menu is displayed:

Figure 7 Help Pulldown Menu

MEDUSA4 Documentation

opens a window which provides an overview of all available documents.
When you select an entry a PDF file is displayed in a separate window and you can 
either view or print it.

On Help

displays the chapter ”Help” (this chapter) in the „Drafting“ Guide.
On Keys

displays the chapter ”Accelerators and Mapkeys” in the „Drafting“ Guide
On Version

displays brief information on the version of MEDUSA4 that you are currently running.

Click the Left mouse button (LMB) on the desired item to display the relevant help and close the 
menu.
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Help Options

In addition to displaying the complete documentation you have several other possibilities to get 
help on specific issues while working with MEDUSA4. These are:

• Tooltips

• Message Line

• Context-sensitive Help (F1)

• Help button in dialogs

You can obtain help on:

• nearly any part of the MEDUSA4 menus or window

• using a dialog

• using the active tool

• the contents of the current tool group

Tooltips

1. Move the cursor over a tool, a button or an option.
The tool is highlighted and a tooltip is displayed. It gives a short information on the tool, 
the button or an option.

2. Move the cursor over different tools.
The tooltip changes according to the highlighted tool.

Message Line

The message line at the left hand side of the status area gives information on the use of the cur-
rent tool.

1. Select a tool.
The icon of the active tool is displayed in the status area far left.

2. Move the cursor into the graphic area.
The message line displays a short instruction of the next step which you have to per-
form.
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Context-sensitive Help

In order to get detailed help on a specific tool, a menu option or a dialog you can use the F1-
Help.

1. Move the cursor over a tool, button or menu option and press the F1 key on your key-
board.

2. The defined browser is initiated and loads the corresponding page of the documenta-
tion.

Help Button in Dialogs

Any dialog provides a Help button at the bottom right side. In order to get help to the dialog, click 
the LMB on the Help button.
MEDUSA4 starts the PDF-Viewer and displays the relevant page of the documentation.

Figure 8 Help Button in Dialog
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WORK ENVIRONMENT
This chapter gives an overview of the main components of the MEDUSA4 user interface and 
introduces users to the basic function of the components.

You will also learn about the special use of mouse and keyboard in MEDUSA4.

This documentation was created with the MEDUSA4 standard product installation. If you notice 
minor differences from your UI, it might be that you have installed a different product variant or 
your administrator has already made customizations.

• User Interface - Overview ........................................................ 32
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• Graphics Area .......................................................................... 44

• In Graphics Probe Bar ............................................................. 46
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• Dialogs ..................................................................................... 52
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• Tools......................................................................................... 57

• File Selectors ........................................................................... 59
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User Interface - Overview

Following figure shows the MEDUSA4 User Interface that is displayed after starting the pro-
gram.

The main components of the User Interface are:

• ”Ribbon” (1)

• ”Dashboard” (2)

• ”Status Area” (3)

• ”Graphics Area” (4)

• ”In Graphics Probe Bar” (5)

• ”In Graphics Tool Bar” (6)

Figure 9 User Interface - Main Components

Ribbon (1)

Dashboard (2)
In Graphics Tool Bar (6)

Graphics Area (4)

In Graphics Probe Bar (5)

Status Area (3)
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Ribbon

The Ribbon contains different tabs between which you can toggle. Number and label of the tabs 
depends on which MEDUSA4 products you are using.

Both the File and Home tab are available in all MEDUSA4 product variants. In addition, there may 
be other tabs.

Please note: You can switch between tabs by clicking on the desired tab or by moving the 
mouse wheel forward or backward, while the cursor is positioned on any tab.

Tabs

File

The File tab provides mainly general functions, i.e. functions that do not directly have to do with 
drawing or designing. The File tab allows to access the so-called backstage area.

It is used to create new sheets, to save them, to open existing files and to manage sheets in 
working sets. You switch into administrator mode, you can make program and printer settings, 
activate licenses and make settings for data exchange with other applications (interfaces).
You also find the plot and print command.

Home

The Home tab contains a standard set of the most common tools.

Additional Tabs

All other tabs provide in addition to the common tools of a function more complex tools.

If you have additional MEDUSA4 products installed (e.g. P&ID) you find the relevant tools on a 
separate tab (e.g. the P&ID tab).

Tool Groups

All tabs, except the File tab, contain Tool Groups, which provide tools of similar functions. You 
recognize a tool group by its specific label.

It may be possible that you have to scroll the ribbon in order to make all available tool groups of 
the Home tab visible. In this case, proceed as follows:
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a. Click the LMB on a tool group label, keep the LMB pressed and move the mouse to 
the right or left.
or

b. Click repeatedly the LMB on one of the arrows which are located on the bars at the 
right or left hand side of the ribbon.

Figure 10 Moving the Ribbon by using the Arrow

Each tool group is identified by a label.

You can:

• hide the bar with the tool group labels by clicking once on the arrow in the upper right 
corner of the ribbon.

• hide the tools by clicking twice on the arrow.

• display the complete ribbon again by clicking a third time on the arrow.

Figure 11 Button for Hiding or Displaying Tool Groups

LMB
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The Dashboard is located on the left hand side of the graphical area.

It displays either properties of the current sheet or properties of currently created or edited ele-
ments. The Dashboard allows you, for example, to change properties or select specific tools 
available for the current element type.

The Dashboard provides several areas arranged one upon the other, which are identified by a 
title bar. You can display or hide each area with a click on the relevant title bar.

Figure 12 Dashboard, Example of an Area Title

The display of the Dashboard depends on the context. Basically there are three states:
a. no tool is active and no element is selected
b. a tool is active and/or an element on the sheet is selected
c. a tool is active and/or an element is currently in creation or edit mode 

The dashboard can be customized. (For details see “Customizing the User Environment” on 
page 767.)

No tool is active and no element selected

The Sheet Dashboard is displayed. It consists of three areas:

The Sheet Header Editor with the data of the current sheet, the Grid area and the Sheet Proper-
ties such as Scale, Units and Size. (For details, see “Dashboard”,  “Sheet Dashboard” on 
page 63)

A tool is active and/or an element is selected

A specific Dashboard is displayed. It depends on the class of the element which can be cre-
ated with the current tool or of the selected element. The Dashboard title now contains the 
name of the element class, e.g. Line Dashboard.

The Dashboard displays the General Properties of the element.

Each element class has its own particular set of basic properties. For example the basic proper-
ties of lines are Style, Color, Layer, Type, Thickness, whereas prims have the properties Style, 
Color, Layer, Type, Magnification, Rotation.
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Some of the area title bars in the Dashboard provide a button on the left hand side, which can 
be used to open a Properties Dialog.

Figure 13 Dashboard, Title Bar, Button to Open a Properties Dialog

There you can edit additional properties of an element.

In addition the Dashboard provides tools that can be used in the context of the element.

For example, if you have activated a create line tool or an existing line is selected the Dash-
board provides line edit tools. But, these tools are only available when an element is in create or 
edit mode.

For tasks that require input, such as creating text, an input field is given at the top of the Dash-
board.

Please note: The input field can be displayed as separate window as described in “Dashboard”,  
“Input Area” on page 82 and chapter ”Text - Home Tab”, note page 36.

Tool is Active and/or an Element is in Creation or Edit Mode

The display of the Dashboard is as described previously but the tools which are provided in con-
text with the current tool are available now.
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The Status Area at the bottom of the UI (see Figure 9, page 32) provides some useful informa-
tion and buttons. These are mainly information to the current tool and sheet and instructions to 
the step required next.

You can open a message window, which displays any steps and error messages, you have 
access to Structure, Style tree and Symbols.

In the following the functions are listed from left to right.

Current Tool and Message Line

Figure 14 Status Area - Active Tool and Message Line

At the left hand side of the status area the icon of the current tool is displayed.

When you move the cursor into the graphics area an instruction appears next to the icon and 
gives a short information about the next step you have to do.

Message Window

Via the Toggle visibility of message area button  you can open a message window, where each 
operation of the MEDUSA4 session is logged and error messages are displayed.

Figure 15 Example of Message Window

Clicking the button  again closes the window.
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Coordinates, Scale, Grid Properties, User Attributes

Figure 16 Status Area - Center

The x- and y-coordinates indicate the position of the cursor in the graphics area.

The text field shows the current level, where elements are selected, for example. Usually you 
are on sheet level if no element is selected. (For details see “Groups & Sheet Structure”,  “Mem-
bers and Owners” on page 181)

Right of the text field the permanent (at the top, here 1:1) and the temporary sheet scale (in 
brackets, here 1:1) are displayed. (For details on sheet scale see “Dashboard”,  “Sheet Scale” 
on page 70.)

Via the button  you open the Grids Properties dialog. (For details see “Grids” on page 197)

Via the button  you open the User Attributes dialog. This button is only available when an ele-
ment is selected in the graphics area. (For details to user attributes see “User Attributes” on 
page 133)

E-Mail with MEDUSA4 Sheet as Attachment

The status area provides a button  which opens the E-Mail dialog. All currently opened sheets 
are listed in the dialog. You can select one or more sheets to be attached to an e-mail by set-
ting, respectively removing, check marks.

Figure 17 E-Mail Dialog
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When you click on the Ok button your default e-mail program opens with a new e-mail which 
contains the selected files as attachment.

Please note: To ensure that your e-mail program will open, it must be explicitly defined as 
default program.
This is done, for example, for Microsoft Outlook under Windows, via:
Start > Control Panel > Default Programs > Set your default programs >

Microsoft Outlook > Set this program as default

Cloud Integration

MEDUSA4 Cloud Integration (CSG-Cloud) allows you to save MEDUSA4 files on a Cloud 
Server and open these files from the Cloud-Service. Currently, Microsoft OneDrive, Google 
Drive and Dropbox are supported.
The CSG-Cloud is part of the Catalog, Tree and Browser Area which is displayed by default at 
the right side of the graphics area (see the following section ”Structure Tree, Styles and Sym-
bols”).

The second button  from the right of the status area opens the Cloud-Browser.
Alternatively you can open the Catalog, Tree and Browser Area by clicking on the rightmost but-
ton  and switch to the Cloud tab.

Figure 18 Cloud Tab in the Catalog, Tree and Browser Area
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The functions of the buttons are:

How you can use the Cloud-Services is described in the following.

1. Choose your Cloud-Service in the Pulldown menu.

Figure 19 Pulldown Menu Cloud-Service

2. Click on the Refresh button , to open the cloud login dialog.

Table 1    Cloud Tab - Functions of the Buttons

Button Function

Logout
logout from your Cloud account

Search
searches for a file in the chosen Cloud

Refresh
opens the login dialog of the selected Cloud Service, where you can login, and loads 
the directories from the chosen Cloud

Open
opens the chosen file

Save
saves the chosen sheet in the current folder.
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Figure 20 Login Cloud-Service - Example, Google Account

3. Login with your e-mail and password and close the dialog.
The directory tree is displayed.
Activate the Show shared option if you want to display also directories other users share 
with you.

4. Select a directory to display the files, which are stored in this directory, in the lower part 
of the Cloud tab.
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Figure 21 Display of Directories Stored on the Cloud Server

5. To load a sheet in MEDUSA4 click twice on an entry or use the Load button  at the 
top of the Cloud tab.

Structure Tree, Styles and Symbols

A click on the button  at the far right opens the Catalog, Tree and Browser Area which pro-
vides the Structure, Style, Symbol and Cloud tabs. Depending on the products which you have 
installed, additional tabs may be available.

Once the Catalog, Tree and Browser Area is opened the display of the button changes .
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Figure 22 Structure, Style and Symbol Tabs

The Structure tab displays the Structure Tree. It presents the hierarchical structure of the ele-
ments on the sheet. (For working with the Structure Tree, see “Groups & Sheet Structure”,  “The 
Structure Tree” on page 183)

The Style tab displays the Style Tree. It lists all styles which are available in MEDUSA4 sorted 
by element classes. (For details on styles, see “Styles” on page 165)

The Symbol tab provides the Symbol Manager. (For details on symbols, see “Symbols - Home 
Tab”,  “Named Symbols” on page 596, et seqq.)

The Cloud tab allows you to open sheets stored on a Cloud Server. (For details to Cloud Integra-
tion, see “Cloud Integration” on page 39)
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The graphics area is where you create MEDUSA4 drawings (see “User Interface - Overview” on 
page 32). By default an empty sheet with frame and sheet header is provided when you open 
the program.

Popup Menus

Once you move the pointer into the graphics area and press the right mouse button (RMB), a 
popup menu becomes available. The menu gives you quick access to those functions most 
used when working with the active tool. The popup menu changes according to the active tool 
type.

If no tool is active, the General Popup Menu is displayed. The menu options are available once 
an element is selected on the sheet. If you have activated a tool, e.g. a create line tool, the right 
popup menu is displayed.

Figure 23 General Popup Menu and Popup Menu while Creating/Editing a Line

If no tool is active and you move the cursor into the graphics area and press the Shift+RMB 
keys a Selection Tools Popup Menu is displayed.

General Popup Menu
Popup Menu while
Editing a Line
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Figure 24 Selection Tools Popup Menu

Please note: The same selection tools are also available on the In Graphics Tool Bar. 
(For details, see  “In Graphics Tool Bar”,  “Selection” on page 91)
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On the left side of the Graphics area next to the Dashboard there is a transparent toolbar. Once 
you move the cursor over it, it will be completely visible. The bar provides buttons for several 
Probe Modi to define the position which is to be selected on the sheet, e.g. a position centered 
on a line, on the center of a circle or on an intersection of grid lines.

Figure 25 In Graphics Probe Bar 

Click the LMB on the required tool of the In Graphics Probe Bar in order to activate it. After 
probing into the graphics area the default probe specifier at the top of the In Graphics Probe Bar 
is active again automatically.

(For details on probe specifiers, see “In Graphics Probe Bar” on page 111.)
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In Graphics Tool Bar 

The In Graphics Tool Bar is located centered at the top of the graphics area. First it appears 
transparent. Once you move the cursor over the In Graphics Tool Bar it becomes non-transpar-
ent.

The In Graphics Tool Bar provides a range of often used functions as shown in the following fig-
ure. 

Figure 26 In Graphics Tool Bar

(For details on the functions, see “In Graphics Tool Bar” on page 87)
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The following abbreviations are used in this documentation:

• left mouse button > LMB

• middle mouse button > MMB

• right mouse button > RMB

Please note: The above abbreviations are based on the use of the default right-handed mouse 
configuration.

Functions of the three Mouse Buttons

The three mouse buttons have the usual functionality.

Left Mouse Button

When you click the LMB, you can:

• choose a tool

• select a menu entry

• select an option

• select an element

If selecting, choosing a tool or option is mentioned in the documentation it always means 
clicking the LMB on it.

When you press the Ctrl key + LMB and move the mouse up or down, you can zoom out or 
in.

Middle Mouse Button

When you click the MMB or the mouse wheel, you can:

• add elements to a selection

• create chain dimensions.

Please note: Alternatively you can use the Shift+LMB keys.

Right Mouse Button

When you click the RMB, you can:
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for most functions, open a popup menu available providing further functionality for the 
current tool.

If opening a popup menu is mentioned in the documentation, it means clicking the RMB.

Please note: Your mouse buttons may be mapped differently than usual. If this is the case, or 
you want to change the mapping, then contact your System Administrator.

Using Mouse Buttons

You can either click, double click or hold down a mouse button. 

• Click means to push down and then instantly release the mouse button. 

• Double click means to click the mouse button twice in close succession. 

• Hold down means to press the mouse button and keep it pressed while performing 
another action, e.g. moving the mouse. Then release the mouse button.

Using the Mouse Wheel

If you have a wheel mouse, you can use the wheel as follows:

• You can zoom into and out of the sheet:
The mouse wheel zoom allows the user to zoom in precisely on the point directly under 
the cursor. Pushing the wheel up zooms out, pushing down zooms in.

• You can scroll inside lists, without opening the list:
Move the cursor, for example, into the Style field on the Dashboard, hold down the 
Crtl key while turning the mouse wheel.

• You can toggle between the ribbon tabs:
The cursor has to be positioned on any tab.

Dragging

Dragging means to hold down a mouse button and move the cursor to another position. You 
use dragging to:

• Move dialogs around a sheet.

• Select elements on your sheet, doing the following steps:
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a. Position the pointer at a corner of the area you want to select.
b. Click and hold down the LMB.
c. Drag the pointer to the diagonally opposite corner.
As you drag a temporary selection box appears and you can see what elements will be 
selected. The selected elements are highlighted.

Please note: If you select elements by clicking the LMB and drag the cursor, then all previously 
selected elements are deselected. However, if you press the MMB, previously 
selected elements remain selected and other elements are also selected.

(For more information on selecting MEDUSA4 elements, see  “Selection Methods”,  “Overview 
of Selection Methods” on page 128)
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Shift-Key

The Shift-key is used in MEDUSA4 to enhance functions, for example by adding or subtract-
ing to a selection.

Ctrl-Key

The Ctrl-key is used in MEDUSA4 for independent functionality like dynamically pan and 
zoom.

If the Ctrl-key can be used for a tool, it is mentioned in the appropriate explanation.

Examples:

• Some tools, e.g. tools for creating a closed geometry, call up input fields attached to 
the cursor when they are activated.
When you press and hold the Ctrl-key you can move the cursor into the input field, 
enter a value and apply the input by clicking on the check mark.

• The combination of Ctrl-key + LMB is used to perform the drag and drop function 
inside the structure tree (see “Groups & Sheet Structure”,  “Using the Mouse” on 
page 187).

Esc-Key

The use of the Esc-key has different effects depending on the context in which it is used.

• If the mouse cursor is on the graphics area, Esc deselects all elements as defined in 
the Accelerator Key dialog (see  “Options”,  “Accelerators and Mapkeys” on page 291).

• The Esc-key quits an active tool.

• For a popup menu Esc dismisses the popup menu.

• For a dialog Esc closes the dialog according to the cancel operation.

Other Keys

The Accelerator and Mapkey dialog allows you to define frequently used tools to be called by certain 
keys (e.g. F12), shortcuts (e.g. ctrl+s) or a certain character combination (e.g. at). Details 
are described in “Options”,  “Accelerators and Mapkeys” on page 291.
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A dialog is a floating window which allows you

• to enter information appropriate to the current function
or

• which displays a series of options or buttons appropriate to the current function.

The Grid Properties dialog is displayed, when you click on the button  of the Grids Dashboard title 
bar.

Figure 27 Grid Properties Dialog

You can move dialogs freely on the desktop by clicking on the title bar, keeping the LMB 
pressed and moving the mouse until the desired position is reached, then release.

Common Buttons

Dialogs have buttons for applying the changes you made inside the dialog, canceling the 
changes or opening the help. This section explains the buttons which are often used. In the 
other parts of the manuals you find no explanations for these buttons anymore.
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The following buttons can be found often in dialogs:

Figure 28 Often Used Buttons

OK

applies the changes you made inside the dialog and closes the dialog window.
Apply

applies the changes you made inside the dialog but the dialog window remains open.
Cancel

closes the dialog window without applying the settings of the dialog.
Help

opens the documentation at the relevant topic. If there is no link for the current item the 
chapter is displayed.
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A number of tools in MEDUSA4 display input fields which require numeric input.
You can directly type in the desired number in the fields or enter a formula. MEDUSA4 automat-
ically calculates the value and inserts it in the input field.

Input Fields at the Cursor

1. For example, choose the Creates boxes tool  and click on the graphics area to probe 
the first point of the rectangle.
The Width and Height fields defining the size of the rectangle are attached to the cursor.

2. Click the Ctrl key.
The input fields are now fixed on the sheet, i.e. the input fields are no longer attached 
to the cursor and keep the position even if the mouse is moved.

3. Then click the equal key (=)to get in the mode that allows you to enter a formula.
The input field expands indicating that you are in the desired mode.

4. Type in the desired formula with the relevant values, e.g. 12+33, and press the ENTER 
key.
The result of the arithmetic operation (45), is automatically inserted into the input field.

Figure 29  Input by using a Formula  -  Example

Input of Formula Display of Result

Input Fields attached to the Cursor

1. CTRL

Formula Mode

ENTER

2. =(equalkey)
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Other Numeric Input Fields

Input fields which require numeric input also occur on dialogs or on the Dashboard, for exam-
ple, in the Protractor dialog (see “The Protractor” on page 383) or on the Shape - Box Dashboard (see 
“Shapes” on page 349).

You also can enter values using a formula in this fields.

1. Place the cursor in the relevant field and press the equal key (=) to put the input field in 
formula mode.
The input field expands.

2. Type in the formula and press ENTER.
The resulting value is entered in the input field.

Figure 30 Example of Numeric Input Fields in a Dialog

Figure 31 Example of Numeric Input Fields on the Shape - Box Dashboard

equal key
(=)
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Basically many different arithmetic operations are possible. Some examples for arithmetic oper-
ations are listed in the following table.

Please note: Multiplication and division operators have precedence over the addition and sub-
traction operators.
By default decimals require point entry rather than comma, example 2.3.

Table 2    Examples for Arithmetic Operations

The four basic arithmetic 
operations:
addition, subtraction,
multiplication, division

x+x, x-y, x*y, x/y

square root sqrt(x)

sinus sin(x)

cosine cos(x)

tangent tan(x)

pi pi*x
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The Creation Tools are available in the Ribbon, which is located by default in the upper area of 
the user interface. Tools for editing are available in the Dashboard depending on the context. 
(see “User Interface - Overview” on page 32)

Here you get information on tools in the ribbon, these are in part also valid for tools which are 
not located in the ribbon.

Tool Groups

The tools in the ribbon are arranged in groups of tools with a similar function. The label below a 
tool group gives information on the basic function.

The figure below shows the example of the Line tool group on the Home tab.

Figure 32 Home Tab, Lines Tool Group

Tool Sets

A small triangle next to or below a tool button indicates a set of tools. When you click on the 
triangle a pulldown menu opens, that provides style variation of this tool.

Figure 33 Tool Set
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If a tool is not activated the button is displayed with a light gray background color. When you 
move the cursor over a tool, the button is highlighted blue. At the same time a tooltip is dis-
played that gives an indication of the function of the tool.

When you carry on moving the cursor, the tooltip disappears and the tool is no longer high-
lighted.

Activate Tool

To activate a tool means you select a tool in order to work with it.

Move the cursor over the tool button and click the LMB. Now the tool button remains high-
lighted, even if you move the cursor away. The tool is enabled now and you can start working 
with it.

On the left hand side of the status area (see page 37) the icon of the current tool is displayed. 
When you move the cursor into the graphics area you can see right next to the icon an instruc-
tion of what you have to do next.

Please note: Tools which are grayed out can not be selected. Thus, for example, line edit tools 
can be selected only if a line element is selected.

Exit Tools

Some of the tools are automatically disabled after executing an operation, but most of the tools 
remain active after use and must be terminated actively.

To quit a tool:

• select a different tool or

• open a RMB popup (see page 44) and click on the Exit Tool option .

Please note: In order to display a popup menu the cursor must be placed in the graphics area.
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MEDUSA4 uses the file browser dialog of the operating system.

By choosing the relevant display option you get small previews (thumbnails) of the files.

Figure 34 Opening Pulldown Menus with Filter Options

Figure 35 Example of Display Option „Big Symbols“ under Windows
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This section describes the Dashboard and how to use it:

• Dashboard - Introduction ......................................................... 62

• Sheet Dashboard ..................................................................... 63

• Title Bar.................................................................................... 64

• Sheet Header Editor ................................................................ 64

• Grids ........................................................................................ 67

• Sheet Properties ...................................................................... 69

• Element Specific Dashboard.................................................... 75

• Display Properties.................................................................... 84

• Modify Properties ..................................................................... 85

• Creating New Elements ........................................................... 86
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Dashboard - Introduction

By default the Dashboard takes a large area of the left hand side of the user interface below 
the ribbon. (see “User Interface - Overview” on page 32). It contains information as well to the 
properties of the current sheet as to the MEDUSA4 geometry element that you are creating or 
modifying. You can use the Dashboard to view or edit properties of the sheet or of the elements.

If no element is selected on the sheet and no tool is activated MEDUSA4 displays the Sheet 
Dashboard.

The Dashboard can be undocked as separate window and be moved to any position of the 
User Interface.

In order to undock and re-dock the Dashboard:

1. Either click twice on the Dashboard title bar or
keep the LMB pressed on the title bar and move the window by using the mouse.

2. Release the LMB at the desired position.
3. Click twice on the title bar to dock the Dashboard at the position of origin again.
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Make sure that following prerequisites for displaying the sheet dashboard are fulfilled:

• No tool is active.
If necessary quit the tool by using Exit Tool option from the RMB popup menu.

• No element is selected on the sheet.
If anything is selected, deselect all by using the Deselect All option from the RMB popup 
menu.

If the prerequisites are met, you are on sheet level which is the highest level in the drawing 
structure. (See also ”Groups & Sheet Structure”, “The Structure Tree” on page 183).

The Dashboard displays the properties of the current sheet and contains the following compo-
nents respectively areas.

• Title Bar (see “Title Bar” on page 64)

• Sheet Header Editor (see “Sheet Header Editor” on page 64)

• Grids area (see “Grids” on page 67)

• Sheet Properties area (see “Sheet Properties” on page 69)

The areas can be identified by its title bar. Each area can be hidden by a click on the title bar.
A second click displays the area again. In the example below only the Sheet Header Editor area is 
displayed.

Figure 36 Sheet Dashboard 
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Title Bar

The title bar of the Dashboard labeled Sheet Dashboard indicates that you are on sheet level and 
that neither any element is selected nor any tool is active.

Sheet Header Editor

The title block text of a drawing contains a lot of information. Manually processing this informa-
tion is not only very laborious but it can also generate errors. The Sheet Header Editor dialog 
enables fast, efficient and interactive processing of the data.

The special advantage of the Sheet Header Editor is its open configuration. This allows as many text 
field types as desired, all processed with the same tool. 

Another benefit is, that the content of the title block text can be summarized to logical groups via 
the configuration (see the Administration Guide, chapter Administration, Setting up the Sheet 
Header Editor). Possible groups would be, for example: standard entries (name of the drawing, 
number of the drawing, scale, material....) or the area of the revision index. Consequently, the 
processing of long lists of title block text information can be structured concisely.

The operation and appearance of the Sheet Header can be configured according to the require-
ments of your company via a configuration file. Detailed information about the configuration of 
the Sheet Header Editor are given in the Administration Guide.

The following description of the Sheet Header Editor dialog is an example only because the open 
configuration allows many more possibilities of text definitions.

Figure 37 Sheet Dashboard - Sheet Header Editor containing Data Example 

All input fields marked with an asterisk (*) are mandatory fields, if your drawings are to be man-
aged in document management systems, respectively PDM/PLM system.
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The transfer of the data into the sheet by using the Apply button is only possible if all mandatory 
input fields have a content, otherwise an error message is displayed.

You can enter additional input by choosing Additional or PDM from the pulldown list.

Figure 38 Sheet Header Editor - Pulldown List

Figure 39 Sheet Header Editor - Additional Input 1

Figure 40 Sheet Header Editor - Additional Input 2

Please note: PDM means Product Data Management.
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When you click the Apply button the data are automatically taken into the sheet header of the 
sheet.

You can zoom into the sheet header on your sheet by using the button . If you click the but-
ton for a second time the complete sheet is displayed again.

When you save the sheet, by default Drawing No., Sheet No. and Issue No. are proposed as file 
name. (see also ”Sheet Properties”, “Sheet Filename” on page 69)
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Grids 

MEDUSA4 provides several possibilities to support the creation of drawings including grids. 
(For details on grids, see ”Grids”, “Grids” on page 197)

Via Sheet Dashboard you can activate and deactivate a grid, which is stored in a sheet and you 
can control its display. You also have the possibility to define a new origin of the grid and reset it 
to default.

Figure 41 Sheet Dashboard - Grids Area

The parameters in the Grids area have the following functions:
Active 

controls the activity of the grid,
If the check mark is set the grid is active, if no check mark is set the grid is deactivated.

Draw

controls the display of the grid
If the check mark is set the grid is visible, if no check mark is set the grid is hidden.

The following options control the appearance of the grid. The effect of the options is only visible 
if you have activated Draw.
Full, Border

If you activate Full the grid is displayed on the whole sheet. If you activate Border the 
grid is only displayed at the border of the sheet.

Points / Lines

If Lines is activated the current grid is displayed as lines. If Points is activated only the 
grid points are displayed.

The parameters in the Origin area have the following functions:
Set

Usually the origin of a grid is set when you create the grid in the Grid Properties dialog. 
When you click the Set button and probe a point in the graphics area the origin of the 
current grid shifts to the position of the probed point. The coordinates of the point are 
displayed in the X- and Y-input fields.

Reset

If you click on the Reset button the origin is reset back to the coordinates 0,0 of the 
sheet.
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Clicking on the button  in the Grids title bar opens the Grid Properties dialog. It displays the prop-
erties of the current grid. You can change certain properties of the grid and define new grids. 
(For details on grids and the Grid Properties dialog, see “Grids” on page 197)
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Sheet Properties 

In the Sheet Properties area of the Dashboard the properties of the current sheet are displayed and 
most of them can be modified.

Figure 42 Sheet Dashboard - Sheet Properties

You can change the following properties:

• Sheet Scale, see “Sheet Scale” on page 70

• Sheet Units (temporary), see “Units” on page 71

• Sheet Size and Maximum Sheet Size, see “Sheet Size” on page 73

• Layers, see “Layers” on page 74

Sheet Filename

The Filename field displays the full path name of the current sheet. The name displayed depends 
upon whether you have saved the sheet.

• If you have saved your sheet the saved name and path name are displayed.

• If the current sheet is a new sheet and if it has not been saved the default filename is 
displayed.
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The default name is <DrgNo. Issue No. Sheet No.she>, but this may alter if your System Adminis-
trator has defined standard sheets for use at your site.

Please note: You cannot change the sheet filename in this field. You save the sheet using the 
Save As... item from the File tab. 

Sheet Scale 

The default scale of a sheet is 1:1, i.e., any dimensions that you specify are the actual dimen-
sions used when the element is plotted on paper. To avoid the problem, for example, of having 
to scale up something small like an integrated circuit, you can change the default sheet scale for 
the entire sheet. This enables you to enter actual object dimensions while, for example, creating 
a quarter scale drawing.

Figure 43 Sheet Dashboard - Sheet Properties: Scale

Permanent Sheet Scale

In the Sheet field you define the Permanent Scale for the sheet. This scale is saved with the 
sheet. For example, if you want the dimensions you enter to be scaled down by a factor of two 
(that is, all values you enter are divided by two before being drawn on the sheet), you should 
enter 1:2.

If you want to draw an object larger than actual size then you must enter a factor greater than 
one. For example, if you want all the dimensions you enter to be multiplied by a factor of two, 
enter 1:0.5, or 2:1.

Temporary Sheet Scale

In the Temporary field you define the Temporary Scale for the sheet. This scale is not saved with 
the sheet. The temporary factor is used either until you:

• change the temporary sheet scale or reset it to the permanent scale by clicking the 
Reset button.

• save the sheet and choose a new one.

If you save the sheet and then continue to work on it the temporary scale remains the same for 
that sheet. Enter the temporary scale in the same way as the permanent sheet scale.
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Resetting the Default Sheet Scale

To reset the scale to the default value, click on the Reset button.

Display of Sheet Scale in Status Area

Both the permanent and the temporary sheet scale are also displayed in the status area. The 
upper value indicates the permanent the lower value in brackets the temporary sheet scale.

Figure 44 Status Area displaying the Sheet Scale

(See also ”Work Environment”, “Message Window” on page 37)

Please note: The sheet scale refers to the sheet units (see the following section ”Units”).

Units

There are permanent and temporary sheet units. Temporary units can be modified but perma-
nent units cannot be changed.

Figure 45 Dashboard - Sheet Properties: Units

Permanent Sheet Units

These units (mm or inches) are set when you create the sheet and cannot be changed later. 
These units are used to store measurements internally. The field is disabled.

Temporary Linear Units

You can define a local unit to use while dimensioning, in the Protractor dialog (see ”Lines - Dash-
board”, “The Protractor” on page 383) or entering coordinates in the X- and Y-input fields.

To set a local unit choose a linear unit from the Linear pulldown list. Click the Apply button to 
update the Width and Height fields below Size.
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Figure 46 Sheet Properties Units - Temporary Linear

Please note: When entering coordinates, type fractions of inches in decimal format, for exam-
ple, type half an inch as 0.5.

Angular Units

The Temporary Angular pulldown list by default comprises the following units:

Figure 47 Sheet Properties - Temporary Angular

• Degrees (default angular unit)

• Minutes

• Seconds

• Radians (1 radian angular unit is approximately 57.296 degrees)

• Gradians (100 grad = 90 degrees)

Please note: To specify a negative angle, type a minus sign before the number.
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Sheet Size 

Figure 48 Sheet Properties - Size

You can modify the size of the sheet by typing the required values into the Width and Height fields.

Changing the sheet size changes the area that is plotted. It does not change the size of the bor-
der or title block. The dimensions of the new sheet are measured from the sheet origin in the 
lower left corner.

Maximum Sheet Size

You may need to define points outside the normal sheet area. For example, when you:

• Create large radius arcs you may need to define reference points that lie outside the 
normal graphics area.

• Store text (as reminders to yourself)

• Rotate a large object some of the points may be moved outside the normal sheet area 
during the rotation.

You can perform such operations by using a border area around the normal sheet area. You use 
the Maximum fields to define the width of this border area.
This area is not printed if you use the Full sheet plotting option. Printing (plotting) is explained in 
”File Tab”, “Printing a Sheet” on page 242 (”File Tab”, “Plotting a Sheet” on page 239).

Setting the Maximum Sheet Size

Enter the maximum width and height of the sheet for setting the maximum sheet size and define 
a border size by typing in the required dimensions in the Maximum Width and Maximum Height fields.

Figure 49 Sheet Properties - Size Maximum

For example, if you want a border that is 10 units wider than the sheet, enter values that are 10 
units more than those you defined for the sheet size. You cannot place points outside of this 
area.

Please note: By default the maximum size is:
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Maximum width = sheet width + 2(width+height)
Maximum height = sheet height + 2(width+height)

Layers

Figure 50 Sheet Properties - Layers

The View or change the layer properties button  opens the Layer Management Dialog where you can 
change the layer properties. (For details on the Layer Management Dialog, see ”Layers”, “Layer Man-
agement” on page 148)

The Layer Naming Convention field indicates that layer names on your sheet conform to the default 
names set up in your project (in the layers.map file).
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Element Specific Dashboard

Either an element on your sheet is selected or a tool is activated. In both cases a specific Dash-
board is displayed. The Dashboard depends on the class of the element which you have 
selected or which you can create with the current tool.

You can use the Dashboard for a number of different purposes, for example, for:

• displaying property values for selected elements (see “Display Properties” on page 84)

• setting property values for selected elements (see “Modify Properties” on page 85)

• setting property values for the element you are creating (see “Creating New Elements” 
on page 86 and ”Creation Tool Group”, “Creation Tool Group” on page 305)

Element Classes

Each element class has its own specific set of basic properties. For example lines have style, 
type, layer, color, thickness and a set of line segments, whereas prims have style, layer, color, 
thickness, type, magnification, rotation and picture. 

There is a Dashboard associated with each class. When you select an element, a collection of 
elements or when you start creating an element MEDUSA4 displays the relevant Dashboard.

Some examples follow:

Figure 51 Line Dashboard
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Figure 52 Tex Dashboard

Figure 53 Dimension - Linear Dashboard
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The Dashboard of any element class consists at least of the following components respectively 
areas:

• Title bar (see ”Dashboard Title Bar”)

• General Properties (see ”General Properties”)

• Tools (see “Tools” on page 78)

The Dimension Dashboard (Angular, Radial, Linear, Radius) provides additionally:
Components (see “Components” on page 81)

The Text Dashboard provides additionally:

• Input Area (see “Input Area” on page 82)

• Components (see “Components” on page 81)

Each area is labeled by a title bar and can be displayed or hidden by clicking on the bar.

Dashboard Title Bar

The title bar at the top of the Dashboard displays the class of the element which you are cur-
rently creating or editing, e.g. Line Dashboard, Text Dashboard, Crosshatch Dashboard.

General Properties

In the General Properties area the basic properties of an element of the specific class are displayed, 
e.g the element class Lines these are:

• Style

• Layer

• Type

• Thickness

• Color

You can open the properties dialog of the current element using the button in the title bar. It dis-
plays the basic and additional properties.

Figure 54 Button to open the Properties Dialog
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Tools

The Tools area provides tools and functionalities which can be used in context of the currently 
activated tool.

Please note: To activate the line tools, you have to probe on the sheet or an existing line has to 
be in edit mode.

Figure 55 Example of the Tool Area of the Lines Dashboard

Shortcuts

Each Tools area contains a Shortcuts area. Here you can place tools which are used to create ele-
ments with specific properties.
However this area is visible only when at least one shortcut is created.
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Adding a Shortcut

To add a tool to the Shortcuts do the following:

1. Select, e.g. a line with specific properties on your sheet.
2. Press the RMB to display the popup menu.
3. Choose the Shortcut from Selection option at the bottom of the menu.

Figure 56 RMB Popup Menu

The Shortcuts area is displayed in the Dashboard and a tool button is added.
Now you can use this tool to create a line with the same properties as the selected line.

Changing Shortcut Icon

It is possible to change the icon of the tool:

1. Click the RMB on the tool to display the popup menu and choose the Change Icon entry.

Figure 57 Popup Menu > Change Icon of Shortcut Tool

The Icon Chooser is displayed in the catalog, tree and browser area on the right hand 
side.
You now can choose an icon from any existing directory or add a new directory with 
other icons (format PNG and GIF).

2. Click the LMB on the desired icon.
The original shortcut icon is replaced by the selected one immediately.

The following figure shows the icon chooser. A directory with icons has already been added for 
this example. The Preview area shows the icons which are available in the currently selected 
directory.
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Figure 58 Icon Chooser Tab in the Catalog, Tree and Browser Area

Deleting a Shortcut

In order to remove a tool from the Shortcuts area, click the RMB on the tool button and choose 
the Delete Shortcut entry in the popup menu.

Figure 59 Popup Menu > Delete Shortcut

The shortcut is removed from the Shortcuts area immediately.

You can also add shortcuts using the Style Tree which is explained in ”Styles”, “Popup Menu” on 
page 176.
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Components

There are elements in MEDUSA4 which consist of several sub-elements which are grouped. 
These groups are e.g. Shapes (closed geometries created by using special tools), balloon texts 
and dimensions. In some cases sub-elements of the groups need to be changed. This can be 
done in the Components area of the Dashboard.

The Components area is displayed only if a selected element consists of a number of sub-ele-
ments, i.e. components.

Example: A dimension consists of Dimension Line, Leaders and Text.

Figure 60 Example of the Components Area of the Dimension - Linear Dashboard

You can select the individual components and change their properties directly in the Dashboard. 
In order to do so open the pulldown menu and choose the requested component (e.g. Text).

Figure 61 Components Pulldown Menu of the Dimension - Linear Dashboard

Below the input field the relevant properties of the component are displayed.
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Figure 62 Component Properties - Example Dimension Text

To be able to edit single properties you first must unlock the properties fields by clicking on the 
lock next to the component field. The symbol of the lock changes and the properties can be 
edited.

Figure 63 Component Properties - Edit Mode

For Text these properties are:
Special characters, Height, color, the text itself can be edited, the text format

Input Area

If a text tool is activated the Input Area is displayed at the top of the Text Dashboard.
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Figure 64 Text Dashboard - Input Area

You can enter the desired text in the input field and you can change the text properties.

If you click once on the button  on the left hand side of the Input Area title bar, the input area is 
provided as separate window which can be moved to any position of your screen.

Figure 65 Separate Input Window

To click the button  again replaces the window on the Dashboard.

(For details on text, see “Text - Home Tab” on page 499.)
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Display Properties

The Dashboard display depends on the selection of elements.

Single Element Selection

If a single element is selected MEDUSA4 displays the class of the current element and the 
appropriate Dashboard, as described before (Examples Line Dashboard, Text Dashboard, Crosshatch 
Dashboard).

Multiple Element Selection

If two or more elements are selected there are two possible ways that MEDUSA4 displays the 
Dashboard:

• If all selected elements are of the same class, MEDUSA4 displays the appropriate 
Dashboard for this class and scans the properties of all the elements.
• If all elements share the same value for a particular property, then that value will be 

displayed in the associated field on the Dashboard.
• If different values of a property are found, then the associated Dashboard field is 

empty.
• If this Dashboard field contains a pulldown menu, as for example Style and Thick-

ness, the pulldown menu provides an empty option.

• If the selected elements are not of the same class, MEDUSA4 filters out the set of 
general properties (see “General Properties” on page 77) that all the elements share 
and displays the associated fields. 
• If the current selection consists, e.g., of a line and a text the Dashboard displays 

only the Style, Layer and Color fields, either with values if they are common to both 
elements or empty if not.

• If no common properties are found the Sheet Dashboard is displayed.
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Modify Properties

If you enter or modify a value in a Dashboard field it is immediately applied to all selected ele-
ments except it is a value, which has to be confirmed to use it. For example, tolerance values 
for dimensions are confirmed either by pressing the Return or Tab key on your keyboard.

If a dialog is opened in which you modify the properties you have to confirm with OK or Apply. 
Only then the values are applied to the current element.
E.g. if you select a different color, first you have to confirm the setting in the color select dialog.

If you select several elements of a different class which have common properties, but the values 
of these properties are different, then the relevant fields in the Dashboard are displayed empty. 
(See above “Multiple Element Selection” on page 84)

If you click on the arrow to the right of an empty input field and a pull-down menu opens you can 
select a value from the list which is assigned to the selected elements.

Example:

You select a text and a line on your sheet. Both elements belong to a different class. The Dash-
board displays the Style and Layer fields because these are common properties for both ele-
ments.
Since the values of Style and Layer are different the input fields remain empty.

Figure 66 Example: Dashboard Display for Elements of Different Classes

If you click on the arrow to the right of the Style input field, nothing happens, i.e. you cannot 
choose a common value.

But if you click on the arrow to the right of the Layer input field a pulldown menu is displayed and 
you can assign the same layer to both elements by choosing a layer from the list.
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Creating New Elements

With the Dashboard you can either create elements with new properties or you can create ele-
ments using properties of existing elements.

The tools for creating elements are located on the ribbon leftmost of the Home tab > tool group 
Creation. How to create elements is described in ”Creation Tool Group”, “Creation Tool Group” on 
page 305.
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This chapter introduces MEDUSA4 users to the In Graphics Tool Bar.

• Overview of Functions ............................................................. 88

• Selection .................................................................................. 91

• Undo and Redo........................................................................ 96

• Window Views.......................................................................... 98

• Measure ................................................................................. 103
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Overview of Functions  

The In Graphics Tool Bar is located at the top of the graphics area and appears initially trans-
parent. Once you move the cursor over the In Graphics Tool Bar it becomes completely visible. 
(See also “Default Settings”, ”Switches” on page 264)

The bar provides a range of often used functions.

Figure 67 In Graphics Tool Bar

A small triangle at the bottom right corner of a button indicates a popup menu. It is displayed 
when you move the cursor over the button and click the RMB.

(See also “Work Environment”, ”User Interface - Overview” on page 32 and “In Graphics Tool 
Bar” on page 47)

The In Graphics Tool Bar provides following functions:

Table 3    Functions of the In Graphics Tool Bar

Button Function

Selection
Selects element of any type
When you click the RMB on the button a popup menu is displayed. 
You can change the selection tool to refine the choice of elements that can be 
selected, e.g. you can only select lines or text on a sheet.
(See “Selection” on page 91)

Save
Saves the current sheet under its existing identity.
The button is only available if the sheet has been saved before under a defined name 
in a specified directory.

Save as
Opens a browser window there you select the directory where you want to save the 
file and enter a file name.
You can save a new created sheet under a defined file name or a copy of the current 
sheet under a new file name

Undo
cancels the last action.
You can also undo several actions.
When you click the RMB on the button a popup with the Undo option is displayed. A 
click on the option opens the Undo dialog where all executed actions are listed. You 
can select how many actions you want to undo.
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Redo
Restores an undone action.
The Redo button is activated after undoing the first time.
When you click the RMB on the button a popup menu with the Redo option is dis-
played.
A click on the option opens the Redo dialog where all undone actions are listed. You 
can select how many actions you want to redo

One level up
You can navigate one level up in the sheet structure.
(For details, see “Groups & Sheet Structure” on page 179, et seqq.)

Go to Sheet level
You can navigate to sheet level in the sheet structure
(For details, see “Groups & Sheet Structure”, ”Interacting with the Structure Tree” on 
page 187)

Refresh Graphics
Redraws the graphics area

Window into an area of a sheet
You can enlarge an area on the sheet by dragging a selection rectangle i.e. you zoom 
into the sheet 

Zoom out
Displays a larger area of the sheet and therefore minimizes the displayed elements 
by factor 2, i.e. you zoom out of the sheet

Stores and Restores windows by name
You can define views (windows) on your sheet, which you can store under a specific 
name and call them up later.
The triangle at the bottom right of the button indicates a RMB popup menu, but this is 
only available if named windows already exist.
(See “Window Views” on page 98)

Zoom on selected geometry
Enlarges the area around currently selected drawing elements.
If you select this tool when a group is active MEDUSA4 zooms into the area display-
ing all elements of the group in the window.

View the full area of the current sheet
If you have zoomed in to an area on the sheet, e.g. to work on a detail, you can easily 
display the complete sheet by using this button.

Table 3    Functions of the In Graphics Tool Bar

Button Function
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Please note: Alternatively you can:
pan dynamically by using the key combination Ctrl + RMB
zoom dynamically by using the key combination Ctrl + LMB or rotate the mouse 
wheel forward or backward

More complex functions which are listed in the table are explained in detail in the following sec-
tions. A separate chapter is provided for the structure tree navigation.

Dynamic pan and zoom
Panning means:
Click the LMB, keep it pressed and move the mouse. The sheet moves according to 
the mouse movement. (See also the Note below)
Zooming means:
Click the LMB, move the cursor into the graphics area, click the MMB and keep it 
pressed and move the mouse forward and backward to enlarge (zoom in) and mini-
mize (zoom out). (See also the Note below)

Dynamical auxiliary lines, tangential
Creates dynamical construction lines
Using the RMB you open a popup menu which provides a range of dynamical con-
struction lines. (For details see “Construction Lines - Home Tab”, ”Dynamic Construc-
tion Lines” on page 483)

Measuring functions
Displays the Measuring dialog. This offers several possibilities to measure elements in 
on your sheet.
(See “Measure” on page 103)

Table 3    Functions of the In Graphics Tool Bar

Button Function
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Selection 

The In Graphics Tool Bar provides a range of selection tools at the far left.

Figure 68 Select Elements of any Type Button

The default selection tool is the common selection tool. You can select a single element by 
clicking on it or you can select multiple elements by dragging a selection box around them.

You can change the selection tool to refine the choice of elements that can be selected.

Click the RMB on the Select elements of any type button. A popup menu opens and provides the 
available selection tools.

Figure 69 Selection Tools Pulldown Menu

When you choose one of the tools from the popup menu the common selection tool in the In 
Graphics Tool Bar is replaced with the currently selected tool.

Please note: The same selection tools are available on the Shift+RMB popup menu in the 
graphics area. (see “Work Environment”, ”Graphics Area” on page 44)
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The tools in the popup menu have the following functions:
Table 4    Functions of the Selection Tools

Tool Function

The All tool selects elements of any type, i.e. there is no limitation on the selection. 
This is the default setting (see above).

The Selects lines tool limits the selection to lines only. 

The Select text elements tool limits the selection to text elements.

The Select dimensions tool limits the selection to dimensions.

The Selects named groups tool limits the selection to elements that belong to groups. 
The group and all its elements are selected.
(For details, see “The Structure Tree” on page 183)

The Selects elements or named groups at sheet level tool limits the selection to lines, text 
and prims (not contained in groups) and groups at sheet level.
(For details, see “The Structure Tree” on page 183)

The Select sheet-level named groups tool limits the selection to elements that belong to 
sheet level groups. The group and all its elements are selected. 
(For details, see “Introduction to Groups” on page 180.)

The Selects prims tool limits the selection to prims.

The Select Stipple tool limits the selection to stipple elements.

The Crosshatches tool limits the selection to crosshatch elements.

The Select Crosshatching tool limits the selection to crosshatch elements.

The Select elements by area tool selects elements in a defined area. When you click on 
the tool the Area dialog is displayed.
(For details, see “Selecting Elements by Area” on page 93)
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Selecting Elements by Area

MEDUSA4 provides advanced definitions used for selecting elements inside a certain area of 
the drawing.

For area selection choose the Area tool  from the RMB selection popup menu in the In Graph-
ics Tool Bar. The Area dialog opens:

Figure 70 Dialog for Selection by Area

Please note: The button to open the dialog is also available in the Ribbon > tab Misc > tool group 
Selection (see “Functions of Tools on the Selection Pulldown Menu” on page 755).
© CAD Schroer GmbH                             93



MEDUSA4 Drafting
In Graphics Tool Bar
The dialog contains the following buttons:

The following parameters are provided:

Enclosed

Fully 

selects elements which are enclosed completely by the defined area. 
Consider that a geometry is recognized as Enclosed if all its points are inside the selec-
tion area.

Partially

selects elements which are enclosed completely and partially by the defined area. The 
following example shows this. The rectangle is recognized as completely Enclosed by 
the group line.

Table 5    By Area Dialog - Functions of the Buttons

Button Function

Select
applies the definitions for area selection and inside the drawing the selected ele-
ments are highlighted.

Add
applies the definitions for area selection and adds the selected elements previously 
selected elements.

Toggle
selects all elements which meet the defined parameters and which are currently not 
selected, and deselects all currently selected elements which meet the defined 
parameters. Elements which are already selected but do not match the area defini-
tions remain selected.

Remove
applies the definitions for area selection and removes the newly selected elements 
from the previously selected elements.

Common
This option considers the last selection for selecting new elements. For example, if 
you already selected elements, they are displayed highlighted. If you now define as 
selection criteria Group lines, Common selects all those elements which are inside 
the first selection AND which are selectable by the Group lines. Common behaves 
like a mathematical AND operation.

Undo 
is used for canceling the last selection
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Figure 71 Example: Select Elements by Area

Boundary line 

provides the options for defining the boundary of an area.
• Group defines that the area is enclosed by a group line.
• Selected defines that the area is enclosed by the selected line. This option is disabled 

if there is no or more than one line selected in the sheet. After choosing Select the 
selected line is deselected.

• Other defines that the area is enclosed by a certain line type, which can be chosen 
from the pulldown list available by the arrow on the right of the edit field.

Level 

provides the options for defining the level of selected elements.
• Any defines that all elements on any group level which match the area definitions are 

selected.
• Sheet selects only elements which are on sheet level.

Close, Help 

Buttons work as usual
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Undo and Redo

The Undo function enables you to cancel a number of actions at the same time.
This action can be reversed completely or partially by using the Redo function.

Undo

1. Click the RMB on the Undo button  in the In Graphics Tool Bar.
The popup with the Undo option appears.

Figure 72 Undo Popup

2. Click on Undo.
The Undo: Select actions to undo dialog is displayed.

Figure 73 Select actions to Undo Dialog

The dialog displays the history of your actions. The work step that has been performed 
at last is positioned at the top of the list.
You are prompted to select a row in the list of actions to undo.

3. Select for example the third line.
This and all following actions are highlighted in the list.

4. Click OK.
The dialog is closed and all actions up to this point are undone.
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When you call the dialog again you can see that the first three lines are no longer dis-
played in the list, i.e.,if you select one action in the list it always results in undoing any 
following action. 

Redo

1. Click the RMB on the Redo button  in the In Graphics Tool Bar.
The popup with the Redo option appears.

Figure 74 Undo Popup

2. Click on Redo.
The Redo: Select actions to redo dialog appears.

Figure 75 Redo Dialog with List of Canceled Actions

The actions which has been canceled are listed in the field.
You can now proceed as described for undoing.

3. Select a line in the list and click OK.
All work steps up to this point and the selected action are activated again.
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Window Views 

It is often useful to define several views of a sheet in order to work on different areas of the 
geometry. Therefore, you can define views, known as window views within a drawing, and 
store them. You can call up these window views later. You can either store window views for the 
duration of the current MEDUSA4 session or you can save them with the sheet and use them 
again in a following MEDUSA4 session.

For creating a window view in a drawing for the first time you use the Stores and Restores windows by 

name button in the In Graphics Tool Bar.

Figure 76 In Graphics Tool Bar - Button to Create Window View for the First Time

Once you have stored a window view the appearance of the button changes.

Figure 77 In Graphics Tool Bar - Saves and Restores Windows by Name Button

I.e., if the Stores and Restores windows by name button in the In Graphics Tool Bar looks like this one 
 you know that the sheet already contains window views which can be restored.

Save Window

1. Zoom into the area that you wish to save with the Windows into an area of the sheet  or 
Zoom on selected geometry  function.

2. Click on the Stores and Restores windows by name button .
The Window Views dialog appears:

Figure 78 Window Views Dialog
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Now you can save a window either for the duration of this session only or in the sheet for follow-
ing sessions.

Save for Current Session

1. Type a name into the Session entry box.
2. Click the Save button .

The window view name appears in the Window Name (Session) pulldown list.

Figure 79 Window Views Dialog - Window Name (Session) Pulldown List

Save in Sheet

1. Type a name into the Sheet entry box.
2. Click the Save button .

Now the window view name appears in the Sheet pulldown list.

Please note: You can store a window view under a new name only. If you try to save a new win-
dow with an existing name you are prompted for choosing another name.

3. Close the dialog and display the full view of the sheet by using the button  in the In 
Graphics Tool Bar.

The button on the In Graphics Tool Bar  has changed and looks like this now . This indi-
cates that named windows views already exist in the current sheet.
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Restore Window

There are two possible ways to display a saved window view:

Restore by Using the Dialog

1. Click on the Stores and Restores windows by name button  in the In Graphics Tool Bar to 
open the Window Views dialog.

2. Select the name of the window you want to display either in the Window Name (Session) or 
Window Name (Sheet) pulldown list.

3. Click on the Restores the selected window button in the dialog.

Figure 80 Window Views Dialog - Restoring Saved Window

The graphics area displays the stored window view.

Restore by Using the Popup Menu

1. Click the RMB on the Stores and Restores windows by name button  in the In Graphics Tool 
Bar.
A popup menu appears which lists all saved window views.

Figure 81 In Graphics Tool Bar - Restoring Window Using Popup Menu 

2. Select the requested window.

Please note: If you open a sheet which has saved window views with the same name as the 
session window views then the window view saved with the sheet is opened.
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Delete Window View

1. Open the Window Views dialog.
2. Select the name of the window view which you want to delete from one of the lists and 

click the Delete button.

Figure 82 Window Views Dialog - Delete Button

The window view disappears from the list.

Refresh

Figure 83 Window Views Dialog - Refresh Button

The Refresh button redraws the graphics, for example, to display no longer the position frames 
after using Show Position.

Show Position

Figure 84 Window Views Dialog - Show Position Button

The Show Position button displays the locations of all window views that are saved with the sheet. 
When you press this button, red rectangles are automatically drawn on the sheet defining the 
extent of each window view. The window view names are displayed in the lower, left corner of 
each rectangle. Perhaps you need to display the whole sheet in order to see this information.
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Figure 85 Store and Restore: Show Position
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Measure 

Figure 86 Measuring Functions Button

The measuring function is used to measure lengths, distances and angles without having to cre-
ate dimensions.

Select the Measure tool  from the In Graphics Tool Bar to display the Measuring dialog:

Figure 87 Measuring Dialog

The tools in this dialog can be used to measure:

• line segments, circles and circular arcs,

• the distance between two points or the distance of the last two created points, and

• certain angles, either over three points or between two line segments.

Once you are finished measuring either select Exit tool from the RMB popup menu to exit the tool 
and leave the dialog open for later use, or press the Cancel button to close the dialog.

Please note: If you start a tool, e.g. a line creating tool, before you exit an activated measure 
tool, the measure tool is automatically deactivated. The Measuring dialog remains 
and you can restart the measure tool by using the button on the left side of the 
dialog tab page.

Please note: Each time the status area displays the active measuring tool and indicates the 
steps which you have to do.
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Precision of measurements

You can define the precision of the measuring:

1. Click the Properties button at the bottom of the Measuring dialog to display the Measuring 
Properties dialog.

2. Define the precision of the measure tool by entering the number of decimal places in 
the input field.

Figure 88 Measuring Properties Dialog

Measuring Line Segment

Figure 89 Measure Dialog: Line Segments

To measure a line segment, select the Line segments button  from the top of the dialog, then 
select the line segment you wish to measure. MEDUSA4 recognizes whether you have selected 
a line, circle or circular arc. The dialog is adjusted accordingly. 

Information about the selected line appears in the dialog. There is information about the start 
and end point as well as line length and position. If you selected a circle or circular arcs, data for 
the position of the center, diameter, radius, circumference and apex angle are also shown.
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Measuring the Distance Between Two Points

Figure 90 Measuring Dialog: Distance Between Two Points

To measure the distance between two points, select the Distance between two points button  from 
the top of the dialog, then select two points on the drawing. The dialog displays information 
about the distance, position, and so on, of the points. You can continue to select further points, 
the measuring continues until you stop this function. 
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Measuring the Distance Between the Current Point and the Last Point

Figure 91 Measuring Dialog: Distance Between Last and Current Point

To measure a line segment, select the Distance between current and last points button  from the top 
of the dialog and leave the dialog open while you create your drawing.

The dialog updates automatically as you probe new points, displaying the distance between the 
current point and the point probed at last.

Measuring Angles

You can measure an angle over three points or between two line segments. The specification of 
the angle is decimal.

Measuring an Angle Over Three Points

Figure 92 Measuring Dialog: Angle Over Three Points
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To measure an angle over three points, select the Measure between three points button  from the 
top of the dialog, then select three points. The second point must be at the apex of the angle. 
The value of the angle appears in the dialog.

Measuring an Angle Between Two Line Segments

Figure 93 Measuring Dialog: Angle Between Two Lines

To measure an angle between two line segments, select the Measure between 2 straight line segments 

button  from the top of the dialog, then select the two line segments. The value of the angle 
appears in the dialog.

Measuring an Edited Line

Figure 94 Measuring Dialog: Query Line

To get the properties of a line that you are editing, select the Query the properties of the line that you are 

editing button  from the top of the dialog.

The dialog updates automatically and it shows information on the currently edited line segment.
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Measuring 2D Properties of a Geometry

Please note: Consider that calculations can be done only for closed geometry consisting of 
polygons. If your element selection contains geometry consisting of single lines, 
no measuring is done.

Figure 95 Measuring Dialog: 2D Properties of Geometry

To measure the 2D properties of a selected geometry:

1. Select the 2D properties of a selected geometry tab  from the top of the dialog.
2. Select the elements building the geometry.
3. If you switch on the option Show axes of inertia and center of gravity, they are displayed in the 

graphics area according to the selection of elements.
4. Click left on the button  on the left of the tab.

The properties are listed inside the dialog. The following figure shows a part of an 
exemplary result.
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Figure 96 Measuring Dialog: 2D Properties of Geometry Output

Additionally to the output the button for saving the properties  is enabled. When you 
click on the button a browser window opens where you can enter a file name into the 
File Name input field at the bottom of the dialog. Below the File Name field the File Type with 
extension sxp is preset. Choose the directory where you want to save the file and click 
on Save.
The file containing the properties of the closed geometry can be viewed in an editor as 
shown below.
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Figure 97 Measuring Dialog: 2D Properties of Geometry Output in File
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This chapter describes how to use probe specifier tools from the In Graphics Probe Bar to cre-
ate new points or locate existing points.

• Using Probe Specifiers........................................................... 112

• Auto Probe ............................................................................. 115

• Free Probe ............................................................................. 116

• Grid Probe.............................................................................. 116

• Intersection Probe.................................................................. 116

• Near Probe............................................................................. 117

• Entering Points using Cartesian Coordinates ........................ 117

• Segment Probe ...................................................................... 119

• Perpendicular Probe .............................................................. 120

• Center Probe.......................................................................... 121

• Mid Segment Probe ............................................................... 122

• Tangent Probe........................................................................ 122

• Last Probe.............................................................................. 123

• Offset from Last Probe........................................................... 124

• Datum of Selected Element Probe Specifiers ........................ 125
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Using Probe Specifiers

The probe specifier enable you to position points on the sheet at specific locations, for example 
at the intersection of two line segments. They do this by instructing MEDUSA4 to search for a 
specific type of geometry.

The In Graphics Probe Bar with the probe specifiers is located right of the Dashboard and on 
the left hand side of the graphics area (see Figure 9, “User Interface - Main Components” on 
page 32). The In Graphics Probe Bar initially appears transparent. Once you move the cursor 
over the bar, it becomes fully visible. (See also “Default Settings”, ”Switches” on page 264)

Figure 98 In Graphics Probe Bar  - Overview of Probe Specifiers

Please note: If MEDUSA4 cannot create a point using the chosen probe specifier, it creates a 
Free probe instead (see “Free Probe” on page 116).

- Auto Probe

- Free Probe

- Grid Probe

- Intersection Probe

- Near Probe

- Point using Cartesian Coordinates

- Segment Probe

- Perpendicular Probe

- Center Probe

- Mid Segment Probe

- Tangent Probe

- Last Probe

- Offset from Last Probe

- Datum Probe

- Offset from Datum Probe
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Choosing a Probe Specifier

When starting MEDUSA4 usually the probe specifier Auto probe is used by default. For choosing 
another probe specifier:

1. Click the LMB on the required probe specifier.
The selected probe specifier becomes active.

2. Move the cursor into the graphics area to use the probe specifier.

Please note: After probing into the graphics area the default probe specifier is active again.

Setting the Default Probe Specifier

The Auto probe specifier  (described in “Auto Probe” on page 115) is set as default when you 
start up MEDUSA4. To change the default:

1. Move the cursor above the In Graphics Probe Bar and click the RMB.
The following popup is displayed:

Figure 99 Popup Probe Specifier - Auto:Near

The popup provides the following entries:
Auto Near
exchanges the entries Intersection and Near for automatic probing (see “Auto Probe” 
on page 115). If chosen it turns to Auto: Default.

Figure 100 Popup of the In Graphics Probe Bar - Auto: Default On

Set as Default
sets the selected probe specifier as default for the rest of the session.

2. Click the LMB on the probe specifier which you want to set as default.
The button appears highlighted.

3. Choose the Set as Default item from the popup menu while the pointer is still positioned 
over the probe specifier.
The chosen probe specifier becomes the new default and remains highlighted.
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Hit Radius

When you use any of the probe specifiers, except for Free probe and Auto probe, you have to posi-
tion the cursor within a specified radius of the required geometry in order that MEDUSA4 finds 
that geometry. This radius is known as the hit radius.

By default, the hit radius is 2 mm but you can change this as described in “Querying and 
Changing the Current Hit Radius” on page 114.

If the cursor is not within the specified radius when a probe is selected, a Free probe is created.

Querying and Changing the Current Hit Radius

1. To find out the current hit radius, open the File tab on the ribbon and choose Defaults.
The Defaults dialog is displayed

2. Choose the Radii / Arc Fac option.

Figure 101 Defaults Dialog > Radii / Arc Fac

3. Change the current hit radius by typing in a new value in the Hit Radius field and confirm 
the setting with Apply.

The Radii / Arc Fac tab provides following entries:

Search Radii area
Hit Radius 

specifies the radius which is required in order that MEDUSA4 finds a geometry. Hit 

Radius is not valid for Free and Auto probe specifiers. Default: 2.0
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Maximum Radius 
specifies the maximum radius of a point using Near, Intersection, Perpendicular, Segment or 
Tangent probe specifiers. Default: 50.0

Coincidence Radius 
specifies that separate points are considered for coincidence unless they are sepa-
rated by a distance greater than the coincidence radius. Default: 0.00

Auto Probe Radii area
Near Point Radius

specifies the radius for finding the nearest point using an Auto probe specifier. Default: 
2.5

Intersection Radius 
specifies the radius for finding an intersection point using an Auto probe specifier. 
Default: 2.5

Segment Radius 
radius for finding a segment point using an Auto probe specifier. Default: 2.5

Please note: The values have to be specified as screen units (and not sheet units).

Auto Probe 

The Auto probe specifier  creates a point by automatically selecting one of the six probes. 
When you choose the Auto probe specifier MEDUSA4 searches to see which type of probe can 
be used, dependent on which type of geometry is closest to the cursor. 

The order in which the probe is attempted is:

• Intersection

• Perpendicular

• Tangent

• Near

• Segment

• Free

If none of the first five listed probe types can be used then a Free probe is selected. 

The Auto probe specifier usually supplies the probe specifier you need. However, you should note 
that it is most likely to produce the wrong result when the cursor is in an area of dense lines. 
You can ensure that the correct type of probe is used by zooming into the area. (Zooming is 
described in page 98, page 89)

When you start up MEDUSA4, the Auto probe specifier is set as the default. Therefore, you do not 
have to choose the Auto probe specifier. You can position the cursor where you want the point to 
be placed and click left.
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Free Probe 

The Free probe specifier  allows you to create a point at any location on the sheet independent 
of any previously created point.

A Free probe specifier creates a point at the current cursor position unless the grid is active. When 
the grid is active MEDUSA4 creates a point at the closest grid intersection. The coordinates of 
the point are then taken as the coordinates of the grid line intersection. 

For further information on creating free points at grid intersections see chapter ”Grids”, “Intro-
duction to Grids” on page 198.

Grid Probe 

The Grid probe specifier  lets you create a point that snaps to the nearest grid intersection 
even if the grid is inactive. 

For information on active and inactive grids see chapter ”Dashboard”, “Grids” on page 67 und in 
chapter ”Grids”, “Activating and Deactivating a Grid” on page 210.

Intersection Probe 

The Intersection probe specifier  allows you to create a point at the intersection of two existing 
line segments.

This example shows how to create a line through points where two overlapping boxes intersect.

1. Select the Intersection probe specifier .
2. Position the cursor near the intersection where you want to have the first point of the 

line and click the LMB

Figure 102 Using the Intersection Probe Specifier: 1

A point is created at the intersection nearest to the probed position.
3. Select the Intersection probe specifier  again.
4. Move the Cursor to the opposite corner and click the LMB.
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Figure 103 Using the Intersection Probe Specifier: 2 

A point is created at the second position that you probe and a line is drawn between 
the two intersections.

Near Probe 

The Near probe specifier  allows you to create a new point at the nearest existing point.

This means that a Near probe specifier allows you to position a point at exactly the same coordi-
nates as a point in an existing line or at the datum point of a text element or prim.

Entering Points using Cartesian Coordinates

When you create and edit MEDUSA4 elements you usually use cursor probes on the sheet, but 
you can also directly enter coordinates.

MEDUSA4 stores points in terms of their coordinates on the sheet, that is, the distance along 
the X-axis and the distance along the Y-axis of the point from the sheet origin.

By default, the sheet origin is located at the bottom left corner of the sheet and is given the coor-
dinates (0; 0) (X=0; Y=0). Figure 104 shows an example of a point created using the Cartesian 
Coordinates.

Figure 104 Cartesian Coordinates

1. Click on the Enter X/Y Coordinates button  on the In Graphics Probe Bar
Input fields are displayed at the top left of the sheet.

New point

Sheet origin (0, 0)
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Figure 105 Coordinates Input Fields

1. Enter X and Y coordinates for defining a position on the sheet.
You can use the tab key to jump from one field to the next.

2. Press the Return key or choose the check mark to confirm your entries.
The new point is drawn.
When you display the input fields again the last entered values are given.

Please note: If you close the X/Y coordinates input fields by clicking the X button the drawing 
function finishes.

By default the sheet origin is at the bottom left hand corner of the sheet (0, 0) but it is different 
if the current grid specifies a different origin. (For details of changing and resetting the origin, 
see chapter ”Grids”, “Modifying Grid Properties” on page 206)
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Segment Probe 

The Segment probe specifier  allows you to create a point on an existing line so that the new 
point lies as close to the cursor as possible.

1. Choose the Segment probe specifier.
2. Position the cursor close to the line and click the LMB.

A point is created on the line as shown below.

Figure 106 Using the Segment Probe Specifier

point selected
on the sheet

point created
on segment
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Perpendicular Probe 

The Perpendicular probe specifier  allows you to create a perpendicular line between the current 
point and the line nearest the cursor.

The following example shows you how to use the Perpendicular probe specifier:

1. Using an appropriate probe specifier, create a point where you want the perpendicular 
line to start. In this example use an Auto or Segment probe specifier:

Figure 107 Using the Perpendicular Probe Specifier: 1

2. Choose the Perpendicular probe specifier.
3. Move the cursor close to the position where you want the perpendicular line to end and 

click the LMB.

Figure 108 Using the Perpendicular Probe Specifier: 2

A line is created perpendicular to the line that you probe in step 3.

If you are creating the first point in a line or if you place a text or prim element and you use the 
Perpendicular probe specifier then MEDUSA4 uses the last point you probed on the sheet instead of 
the current point.
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Center Probe 

The Center probe specifier  locates the center point of the nearest curved line segment.

For circles or arcs, the probe locates the defined center point. For other types of arcs a center 
point is inferred as the intersection of the two perpendiculars from the tangents at the ends of 
the arc, see Figure 109. If the perpendiculars do not intersect inside the arc no position is 
located. In this case the Free probe specifier is taken and a message is given inside the message 
area.

The following example shows you how to use a Center probe specifier:

1. Choose the Center probe specifier.
2. Position the cursor close to the arc or circle for which you want to find the center point.
3. Click the left LMB.

The probed point is the center of the circle or arc.

Figure 109 Using the Center Probe Specifier for a Fillet

X

X

probed point

created
center point of arc
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Mid Segment Probe 

The Mid Segment probe specifier  locates the middle of the straight or curved line segment near-
est to the position that you probe.

The following example shows how to use a Mid Segment probe specifier:

1. Choose the Mid Segment probe specifier.
2. Position the cursor close to the line and then click left:

Figure 110 Using the Mid-segment Probe Specifier

A point is created in the middle of the line segment.

Tangent Probe 

The Tangent probe specifier  allows you to create a point on the nearest arc or circle such that 
the line segment joining the new point is tangential to the arc or circle. 

The following example shows you how to use a Tangent probe specifier:

1. Using the appropriate probe specifier, create the point where you want the tangential 
line to start. In the illustration shown below use the Free probe.

Figure 111 Using the Tangent Probe Specifier: 1

X
probed point

created
mid segment point

Existing circle

Current point
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2. Select the Tangent probe specifier .
3. Move the cursor close to the circle, then click left. 

Figure 112 Using the Tangent Probe Specifier: 2

A new line is drawn between the original current point and the circle which is a tangent 
at the circle.

Figure 113 Using the Tangent Probe Specifier: 3 

If you create the first point in a line or if you place a text or prim element and if you use a Tangent 

probe specifier, then MEDUSA4 uses the last point you probed on the sheet instead of the cur-
rent point.

Last Probe

The Last probe specifier  locates the most recent current point. This enables you to create a 
number of lines that pass through the same point without having to define that point for each 
line.

The following procedure demonstrates how to use the Last probe specifier to create a construction 
line through the most recent current point.

1. Create a line. End it by choosing New Line from the popup menu.
The current point marker is no longer displayed indicating that there is no current point.

2. Select the Horizontal Construction Lines tool .
3. Select the Last probe specifier .

MEDUSA4 creates the construction line using the most recent current point as the 
datum.

Probe here

Current point

Tangent line
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Offset from Last Probe 

The Offset from last probe specifier  locates the most recent current point and you can define an 
offset for probing from this point. This enables you to create a number of lines that pass the 
same point with a certain spacing without having to define that point for each line. If you define 
zero for the offset in x- and y-direction the specifier works the same way as the Last probe speci-
fier.

Please note: This probe specifier is only enabled, if you already selected one element.

The following procedure demonstrates how to use the Offset from Last probe specifier to create a 
construction line 10 units away from the most recent current point.

1. Create a line. End it by choosing New Line from the popup menu.
The current point marker is no longer displayed indicating that there is no current point.

2. Select the Creates horizontal construction lines tool .
3. Select the Offset from last probe specifier .

The Last X and Last Y input fields are displayed top left of the graphics area.

Figure 114 Offset Input Fields for Offset from last Point

4. Type in the offsets for x- and y-coordinates. Use 10 for both values and press Return.
MEDUSA4 creates the construction line using an offset of 10 units in x- and y-direction 
from the most recent current point as the datum. The following figure shows an appro-
priate result.

Figure 115 Example for Offset from Last Probe

resulting horizontal construction line

automatically created point marking the offset

most recent current point used for the offset
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Datum of Selected Element Probe Specifiers

The Datum probe specifiers allow you to create a point directly at the datum point of a selected 
element or close to it at a certain offset.

Please note: These probe specifiers are only enabled, if you already selected one element.

Datum Point Definition

For line elements, the datum point is the first point in the current line.

For text elements and prims, the datum point is the single point that is used to position that ele-
ment on the sheet.

For groups, the datum point is the datum point of the first line, text, or prim element that it con-
tains.

Datum Probe Specifier

The Datum probe specifier  allows you to use the datum point of the selected element, for 
example to place a point in a line. To do this:

1. Select an element on the sheet, whose datum point is to be used for the starting point 
of the new element

2. Select a tool, for example a create line tool.
3. Choose the Datum probe specifier.

The first point of the new element is created at the datum point of the selected ele-
ment. The selected line is deselected and the new line becomes selected.

Offset from Datum Probe Specifier

The Offset from datum probe specifier  allows you to place a point at a certain offset from the 
datum point of the selected element. To do this:

1. Select an element on the sheet, whose datum point is to be used for the starting point 
of the new element.

2. Choose a tool, for example a create line tool.
3. Choose the Offset from datum probe specifier .
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The Datum X and Datum Y input fields are displayed top left of the graphics area.

Figure 116 Input Fields for Offset from Datum of Selected Element

4. Type in the offsets for x- and y-coordinates. Use 10 for both values and press Return.
MEDUSA4 creates the first point of a new line using the defined offset of 10 units in x- 
and y-direction from the datum point of the selected line. The selected line is dese-
lected and the new line becomes selected.The following figure shows an appropriate 
result.

Figure 117 Example for Offset from Datum

resulting new point

current cursor position with
attached rubber band
after pressing Return and
moving the cursor

this line was selected
before applying the offset values

datum point
of the line
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This chapter provides information about basic methods how to select one or more elements 
which you can copy, delete, save as a symbol or transform. In addition you get hints where you 
can find detailed information to various selection methods.

• Overview of Selection Methods ............................................. 128

•  Selecting with the Mouse ...................................................... 129

• Cancel Selection .................................................................... 131

• Toggling a Selection and Extend Selection............................ 131
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Overview of Selection Methods

There are a number of different methods to select elements: 

• You can select elements using the mouse and cursor (see “Selecting with the Mouse” 
on page 129).

• You can use the selection tools which are available via button far left on the In Graph-
ics Tool Bar. All tools are provided on the pulldown menu. (see “In Graphics Tool Bar”, 
”Selection” on page 91)
The same tools are provided on the general popup menu in the graphics area, when 
you click the Shift+RMB keys on the keyboard.

• You can use the Power Selection Dialog.
The dialog is displayed:
a. when you choose the Power Selection option on the common RMB popup menu

or
b. on the ribbon > Misc tab > Selection tool group > Power Selection button.

Detailed information are given in “Power Selection Tool” on page 757.

• You can use the selection tools which are available in the ribbon on the Misc tab > tool 
group Selection > pulldown menu. (For details, see “Selection - Misc Tab”, ”Power 
Selection Tool” on page 757)

• You can select elements by attributes by using the Select Elements by Attributes dialog. The 
dialog is called up on the Misc tab > tool group Selection. Detailed information are given 
in “Selecting Elements by Attributes” on page 764.

• You can select elements using boundary groups. Details are described in “Transforma-
tion”, ”Boundary Groups” on page 332)

• You can select elements using groups and the tree structure. (See “Groups & Sheet 
Structure”, ”Interacting with the Structure Tree” on page 187)

Once you have selected elements, you can:

• Copy or cut the selection set and paste it somewhere else on the sheet

• Delete the selection set

• Save the selection set as a symbol (see “Symbols - Home Tab” on page 593)

• Transform them using the transform tools, described in “Transformation”, ”Überblick” 
on page 330.

• Change any properties that the elements in the selection set may share in common, 
see “Dashboard”, ”Modify Properties” on page 85.

• Edit the selection if you selected a single element.

In the following you are made familiar with the selection using the mouse. Any other, partly very 
complex selection methods, are described in separate chapter which are mentioned above. 
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Selecting with the Mouse

You can select single elements, select elements by drawing a selection box (dragging) and you 
can revert the selection status of elements.

Clicking on Elements

You can select an element by positioning the cursor over the element and clicking the LMB. 
When the element is selected it is highlighted in a different color, usually red (default setting).

If you are trying to select an element that is close to another element you may not select the ele-
ment you want. If you click the LMB again, without moving the cursor, MEDUSA4 selects the 
next element near the cursor.

Dragging Selection Rectangle

Selection by dragging lets you select one or more elements in an area of the sheet.

Elements are selected if they have one or more points in the drag selection area:

• Lines are selected by any of the points defining the line. 
If the selection rectangle extends over a part of a line but does not cover any points of 
that line then the line is not selected.

• Text are selected by the datum of the text element. 
If the selection rectangle extends over a part of the text but does not include the datum 
point then the text is not selected.

• Prims are selected by the datum of the prim. 
If the selection rectangle extends over a part of the prim but does not include the 
datum point then the prim is not selected.

To select by dragging:

1. Press and hold the LMB at one corner of the area.
2. Keep the LMB pressed and move the cursor to the opposite corner of the desired area 

MEDUSA4 draws an expanding box to show the area.
3. When the cursor is at the opposite corner of the area, release the LMB.

Any elements with points inside the selection area are selected and any selected ele-
ments become deselected unless you specify otherwise.

The following examples show how different selection areas can select different elements.
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In the first example all elements are selected because they are completely enclosed in the 
selection area:

Figure 118 Drag Selection, Example1

In the second example only some elements are selected because some elements have points 
inside the selection area and some have not. The points defining the lines and the datums of 
the text elements are shown as crosses:

Figure 119 Drag Selection: Example2
130 © CAD Schroer GmbH



MEDUSA4 Drafting
Cancel Selection
Cancel Selection

Using the Deselect All option from the RMB general popup menu you can cancel all selections on 
your sheet.

The option Deselect All is also available on the Misc tab of the Selection pulldown menu. (See “Func-
tions of Tools on the Selection Pulldown Menu” on page 755)

Toggling a Selection and Extend Selection

You can toggle and/or extend a existing selection.

Toggling Selection 

Toggling selected elements means that if an element is already selected then it is deselected 
and vice versa.

You can toggle a selection by holding down the Shift key and click the LMB on one element 
or dragging over several elements.

Example

The shows how elements are selected respectively deselected when using two drag selections. 
The second drag selection includes pressing the Shift key.

Figure 120 Changing Selection Set: Example 1

A Toggle Selection tool is also available on the Misc tab in the pulldown menu of the Selection tool 
group. (See “Changing Selection Sets” on page 765)
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Extend Selection

Extend a selection means that there are already selected elements on your sheet and you add 
further elements to the existing selection.

You extend a selection by moving your cursor over an element which is to be added to the exist-
ing selection and then clicking the MMB.
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In this chapter you will learn how user attributes are used and how you can assign user attri-
butes to elements, how you can edit and query them and how you can assign them to other ele-
ments.

• User Attributes Dialog ............................................................ 134

• User Attributes Button............................................................ 137

• Add User Attribute.................................................................. 138

• Edit User Attributes ................................................................ 140
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User Attributes Dialog

To get the possibility to select special elements or groups within a sheet you have to assign attri-
butes to these elements/groups named User Attributes.

Click on the Query and edit user attributes button  in the status area to open the User Attributes dialog. 
(to status area see also “Work Environment”, ”User Interface - Overview” on page 32)

Please note: The button is only available if an element is selected!

Figure 121 User Attributes Dialog
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In the following the functions of the dialog buttons are explained:

Selecting Elements

a. If you select an element to which no user attribute has been assigned so far, the dia-
log displays only the Element Type of the selected element (i.e. line). Name and Value 
fields are blank as shown in Figure 122.

Figure 122 User Attributes Dialog - Display having Selected an Element without Attribute

b. If you select one single element to which a user attribute has been assigned 
already, the attribute values of this element are shown in the dialog box. If you select 
another single element, the dialog is updated on the fly.

Table 6    Buttons of the User Attributes Dialog

Adds a new, empty row to the dialog

Deletes the currently selected row from the dialog

Deletes all data rows from the dialog and reads the attribute data from the 
current element (e.g. a line) again into the dialog

Changes the current element to his parent. If the element is on sheet level, 
this switch will be deactivated. It is not possible to reach the sheet level ele-
ment

Stores the data of the selected dialog box lines into a cache, e.g for a later 
copy to other elements

Reads the cached data and merges them into the current dialog data

Writes the dialog data to the current set of elements (one ore more element(s) 
and closes the dialog

Same as OK, but does not close the dialog

Closes the dialog without any changes
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Figure 123 User Attributes Dialog - Display having Selected an Element with Attribute

c. If you select more than one element, the dialog is cleared.
No attribute values are shown because of the different set of attributes each ele-
ment can have.
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User Attributes Button

Depending on the current element selection there are different states of the Query and edit user attri-

butes button:

• If the selected element can get user attributes but still don‘t have any, then the button 
appears blue .

• If the selected element can‘t get user attributes, then the button appears gray .

• If the selected element already has user attributes assigned, then the button appears 
red .

• If the selected element does not have any user attributes but belong to a group which 
have user attributes, then the button looks like this .
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Add User Attribute

To Assign a First Attribute

1. Type a name into the Name input field.
You can insert up to 6 alphabetic or numeric characters.
Characters must begin with a letter.

2. Choose a Data Type from the pulldown menu (Figure 121). The attributes dialog sup-
ports the data types integer, real and string.

3. Enter a value into the Value input field.
The input option is determined by the data type you chose before.

4. Click OK to assign the attribute to the selected element and quit the dialog.
5. Click Apply to assign the attribute to the selected element and let the dialog opened for 

further actions.

Please note: There are some rules to be considered when filling out the input fields.
If you enter values incorrectly an error message is displayed with an indication of 
what is wrong.

To Add Additional Attributes to a Single Element

1. Select a single element.
Its attribute values are shown in the dialog.

2. Press the button .
A new empty line is added to the dialog.

3. Type the name of the attribute in the column field Name and the attribute value in the 
column field Value.

4. Press either the OK or Apply button.
The attribute is assigned to the element.
Now, at any time you select the element and choose the Query User Attribute button, the 
User Attributes dialog will display any attribute assigned to this element.
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To Add Additional Attributes to a Set of Elements

1. Select more than one element.
The dialog is cleared.

2. Press the Add a user attribute to dialog button .
A new empty line is added to the dialog.

3. Type the name of the attribute in the column field Name and the attribute value in the 
column field Value.

4. Press either the OK or Apply button.
The attribute is written to the set of elements.
That means, that the data are merged to possible existing attributes of each of the 
selected elements.
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Edit User Attributes

To Change a User Attribute

1. Select the requested entry in the table. 
2. Modify the name or value in the input fields.
3. Click Apply to accept the modifications.

The table displays the changed user attribute.

To Delete a User Attribute

1. Select a single element.
If some attributes exist, they are displayed in the User Attributes dialog.

2. Select the row with the attribute that you want to delete by clicking in the numbered 
column at the start of the row or select a simple cell of the row.

3. Press the Delete a user attribute from the dialog button .
The row is removed from the dialog.

4. Click either the OK or the Apply button to accept the erasure.

Reset the Dialog

If you made changes within the dialog without applying these and you press the Reset button , 
the dialog is cleared and the attributes of the current single element are read again.

Change to the Parent Element

The button Show the attribute(s) on the parent element  switches from the current single to its parent 
element and updates the dialog for showing the attributes of the parent element.

If there are no attributes, the dialog remains empty.

If the current element is on sheet level, the button is deactivated. That means, it is not possible 
to go to the sheet element (M10).
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Copy Attributes to a Cache

1. Select a single element.
Its attribute values are shown in the dialog, if some exist.

2. Select the attributes you want to copy. 
a. Therefore you can select the complete row by clicking on the numbered column at 

the start of the row or select one cell of the row. 
b. To select more than one line, use Shift+LMB to select a block of rows or 
Ctrl+LMB to select different single rows. 

3. Press the Copies dialog data to temporary space button .
The selected attributes are copied to the cache.

Paste Attributes to Element(s)

Cached attribute data can be copied to one single element or to a set of elements.

1. Select one single element.
Its attributes are shown in the dialog, if some exist. 

2. Press the Merge/add attributes from temporary space to dialog button .
The cached data is merged to the dialog data. Existing attributes are overwritten, 
missing ones are added.
If you select more than one element, you can only merge the cached data to the ele-
ments; that means, that the existing element attributes are not replaced by the dialog 
content. Existing attributes are overwritten, missing ones are added.

3. Press the button OK or Apply to write the date to the element(s).
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This chapter describes how to use and customize layers and layer sets.

• Introduction ............................................................................ 144

• Default Layer.......................................................................... 145

• Layer Management ................................................................ 148

• Layer Properties..................................................................... 150

• Layer Datum .......................................................................... 152

• Layer Change ........................................................................ 153

• Layer Set Management.......................................................... 155

• Customize Layers .................................................................. 159

• Customize Layer Sets............................................................ 162
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Introduction 

The geometry on a MEDUSA4 sheet can be visualized as a stack of transparent films contain-
ing geometric elements. These films, called layers, are used to group the geometric elements 
so that they can be operated together. Each layer is used to distinguish between parts of a 
sheet that have different functions.

Your company policy could, for example, specify that one layer should contain the sheet outline, 
another the sheet tiles, a third all the text, and so on. In this way layers provide another way of 
grouping elements with similar functions.

For example, you might want to create a plan view drawing of a building where all the geometry 
for each floor of the building is put on a distinct layer. This would then allow you to hide the 
geometry of some floors by making those layers invisible.

Figure 124 Layers

In an industrial drawing sheet you might wish to assign all the electrical wiring elements to one 
layer and the plumbing elements to another.

An element can only belong to one layer. Layers do not describe spatial relationships between 
elements on different layers. All elements exist at the same depth as there is no third dimension 
in MEDUSA4.

When printing you can choose which layers to print. For this read “File Tab“, “Printing a Sheet” 
on page 242.

A layer set is a collection of individual layers which can be treated as a single layer for edit-
ing purposes. For example, in the building sheet example above you could create a layer set 
consisting of the layers of the first five floors. You can then easily select and operate on all the 
elements of these layers.

A single layer can belong to one or more layer sets.

Layer third floor

Layer second floor

Layer first floor
144 © CAD Schroer GmbH



MEDUSA4 Drafting
Default Layer
Default Layer 

When you create an element, it is automatically assigned to a default layer according to its 
style, class (line, text, prim, and so on) or function (sheet outline, dimensioning, crosshatching, 
and so on). The layer of the currently selected elements is displayed in the Dashboard as 
shown below.

Figure 125 Dashboard for a line with Default Layer

While creating or editing an element you can change its layer. MEDUSA4 provides following 
possibilities:

• directly inside the Dashboard

• in the Line Properties dialog on the Line Properties tab

• in the Layer Management dialog on the Layer Properties tab

To open the Lines Properties dialog use the button  on the Dashboard title bar.

To open the Layer Management dialog use the button  on the Dashboard right hand side of the 
Layer input field. The dialog is explained in “Layer Management” on page 148 and “Layer Set 
Management” on page 155.
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Changing the Layer in the Dashboard

Inside the Dashboard you can choose any layer from the pulldown list available with the triangle 
on the right hand side of the Layer text field.

Figure 126 Dashboard for a line with opened layer list 

If you change the layer for a style and if this layer differs from the default layer, this is indicated 
by an asterisk appended to the Style label as shown in the following figure:

Figure 127 Dashboard - Display when the layer was changed

Changing the Layer in the Properties Dialog

1. Select, create or edit an element.
2. Open the Properties Dialog

a. via the button  on the General Properties title bar of the Dashboard
or

b. via the Properties option of the RMB popup menu
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3. Open the Layer pulldown menu via arrow to display a list of all named layers.

Figure 128 Properties Dialog for a Line with opened Layer List 

4. Select a new layer name in the pulldown list.
The Layer field displays the name of the selected layer.

Figure 129 Properties dialog for a line, layer changed

   

5. Apply the setting for Layer with the Apply or the OK button.
OK closes the dialog, with Apply the dialog remains open.
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Layer Management

The layer management in MEDUSA4 allows you to change different properties of layers tempo-
rarily for the current MEDUSA4 session. For changing layer properties choose

• on the ribbon > tab File > Options > Layer Management

or

• if you are just creating or editing an element, use the button  on the Dashboard next 
to the Layer input field, General Properties area.

In both cases the Layer Management Dialog appears, providing the Layer Properties and the Layer 

Management tab. The settings on the Layer Set Management tab are only available in Admin mode. 

Figure 130 Layer Manager: Tab Layer Properties

The Layer Properties tab is described in “Layer Properties” on page 150, the Layer Set Management tab 
is described in “Layer Set Management” on page 155.
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Show Options and Common Buttons

The show options and the common buttons at the bottom of the dialog are available on both 
tabs and are explained in the following:
Show Named Layers, Show Used Layers, Show All Layers

Options in order to display either all named layers, all layers used in the current sheet 
(default) or all layers available in MEDUSA4 from 0 to 1023 in the list.

Layer Datum
When an element is created, it is automatically allocated to a default layer. The number 
of this layer refers to the so-called Layer Datum which is set to 0 by default. Using this 
option you can change the layer datum by choosing a name from the list or entering a 
number (see “Layer Datum” on page 152).

Layer Datum ON/OFF

switches the layer datum on or off.
Change Layer

Opens a window where you can make settings in order to change the layer of the 
selected elements. (see “Layer Change” on page 153.)

OK, Apply

uses the current settings.
In case of OK the dialog is closed.
When you click on Apply the dialog remains opened and the button is disabled until you 
change something in the dialog again.

Reset

sets the layer settings back to the values of the sheet.
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The entries on the Layer Properties tab have the following meaning:
Layer Sets

The text field displays the currently selected layer set.
It is empty by default, indicating that no layer set is selected.
A pulldown list is available when you click on the arrow next to the Layer Sets input field. 
If you select a layer set from the list the relevant properties of the set are displayed.
Details on layer sets are described in “Layer Set Management” on page 155.

Below the layer set field the layer list is displayed. Which layers are displayed depend on the 
show options that are activated at the bottom of the dialog (see page 149). Each line contains 
one layer with number, layer name and the properties of the layer.

Figure 131 Layer Manager: Layer Properties Tab, List of Layers 

0, 2, 5, 6 ... 

The left column shows the layer number (this example: 0, 2, 22, 28). This is an identifier 
for internal use by the system. In MEDUSA4 1024 layers exist having the numbers 0 to 
1023. The number of layers cannot be increased.
If you click on a layer number, the relevant elements are highlighted in the drawing; 
but, they are not selected and already selected elements remain selected.

Layer Name

column gives the name of the layer. 
On 

switches the visibility (Vis) and selectivity (Hit) on (default) or off at the same time.
Vis 

switches on or off the layer visibility. If this property is switched on (default), the ele-
ments on the layer are displayed. If it is off, the elements on the layer are invisible.

Hit 
switches on (default) or off the layer selectivity (hit ability). If this property is switched 
on (default), the elements on the layer can be selected. If it is off, selection is not pos-
sible.
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Protection

switches the layer protection to Modify, Full or Unprotected.
• If Unprotected is activated, elements on the layer can be created, modified and 

deleted.
• If Full is activated, the system prevents elements being created, modified or deleted 

on the layer.
• Modify is the same as Full for elements which are on the sheet. If you load or save 

symbols with elements which are on this layer, these elements are not loaded or 
saved.

Color 
switches on or off the layer color (Layer Color). The color button can be switched on only 
if a valid layer color (Layer Color) is defined. If this property is switched on (default), the 
elements on the layer are drawn with the specified color. If Col is off, the color of the 
style is used.

Layer Color 
This is the color used for drawing elements on the layer when the color switch Color is 
on. By default no color is defined. How to select a color or define a new one is 
explained in ”Grids”, “Color” on page 203.

Change Layer Properties

Please note: Layer properties can be changed temporary only. In the next MEDUSA4 session 
the default settings are used again.

Except the layer number all properties can be changed. You have the following possibilities:

• Change for all layers:
If you click on the column header in case of On, Vis, Hit and Color all check boxes in the 
list change to on (with check mark) or off (empty). 
In the case of Protection, the entries change to Full, Modify or Unprotected.

• Change a single layer:
• If you click on a check box, the property is switched on or off.
• For the Protection property you can click on the arrow to the right of the entry field to 

select a value from a pulldown list.
• For the Layer Color property you can open the Select Color dialog by a double click with 

the LMB on the color field. In this dialog you can select a color for the current layer.

Changes are used on the sheet, once you have confirmed your settings by clicking either the 
Apply or OK button.
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Each new created element is allocated to a default layer (see “Default Layer” on page 145). For 
example, construction lines are created on layer number 27, Construction Lines. That is, 
they are created on the 27th layer after the datum layer which by default is set on 0.

You can change the layer datum. To change the layer datum can be useful, e.g. if you set differ-
ence layers for each technical discipline.

Example:

You keep the layer datum for discipline 1 on 0, according to the default setting, for discipline 2 
you change the layer datum to 50, for discipline 3 to 100.
The center lines for discipline 1 are on layer 7, according to the default, for discipline 2 on layer 
57 and for discipline 3 on 107.

The switches for the layer datum settings are located at the bottom of the Layer Properties tab in 
the Layer Management dialog.

Figure 132 Layer Management Dialog, Layer Properties Tab, Switches Layer Datum

To define a new layer datum:

1. Choose a layer datum from the pulldown list.
2. Select Layer Datum On.
3. Press OK.

Please note: If you choose the Layer Datum Off option all elements are allocated to their default 
layers.
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When an element is created, it is allocated to a default layer as described in “Default Layer” on 
page 145. The layer name is displayed in the General Properties area of the Dashboard. If several 
elements are selected, a layer is only displayed, if it is the same for all elements.

The Change Layer dialog is called up via button at the bottom of the Layer Properties.

Figure 133 Layer Management Dialog, Layer Properties Tab, Button Change Layer

Figure 134 Change Layer Dialog

The dialog is used to change the layer or layers of the selected elements.

You can put all layers on one layer, or assign to each layer a new one by changing the layer 
number incrementally. In both cases the procedure is similar:

1. Select the elements for which you want to change the layer.
2. Click the Change Layer button to open the Change Layer dialog.
3. Choose one of the options Absolute or Incremental.

• Absolute means that all layers of the selected elements will be placed on one new 
layer. You can open a pulldown menu which displays all available named layers.

Figure 135 Change Layer Dialog, Pulldown Menu of Layer Names 
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Having selected a layer the pulldown menu closes and the name of the layer is dis-
played in the Absolute text field.

• Incremental means that the layer number of each single layer of the selected elements 
will be changed by the Incremental value.
Having chosen Incremental, the text field right of the option is activated and displays 0. 
Now you can enter any value, the result always will be between 0 and 1023 to be a 
valid layer number.
For example, if a selected element is on layer 6, entering the value 3 will change the 
layer number to 9. If you enter -9, the element will be on layer 1021 after executing 
the layer change.

Please note: When you changed the layer incrementally and the new layer is not a named 
layer, it is named automatically (e.g. to Layer_1021) and displayed in the list of 
named layers.

4. Confirm the inputs for the layer change and run the function by clicking Apply or OK.
When using Apply the dialog remains opened and you can repeat the same action for 
further elements. When using OK the dialog will be closed additionally.
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For the layer set management you have to be in the Administrator mode. If you are not in 
Administrator mode the Layer Set Management tab is disabled.

To log in as Administrator switch to the File tab > Options > Administrator (see ”Options”, “Adminis-
trator” on page 285, Administrator).

On the Layer Set Management tab you can create, edit or delete layer sets.

Figure 136 Layer Manager: Tab Layer Set Management (Admin Only)

The entries on the tab are explained from top to bottom:
Layer Sets

The text field displays the currently chosen layer set. It is empty by default, indicating 
that no layer set is chosen. If you select a layer set from the pulldown list the Layer Set 

Attributes of the chosen set are displayed. How to add, edit and delete a layer set is 
described in “Customize Layer Sets” on page 162.
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Save

creates or updates the current layer set in the internal list of layer sets.
Layer sets are stored in the current MEDUSA4 project, e.g. 
master_project\user\<username>\layerset.xml, not until you close the Layer Management 

Dialog either with OK, Cancel or X in the top right corner of the dialog.

Please note: If you re-create the user project, the layer set file will be deleted. Therefore we rec-
ommend to copy this file in the user product directory, e.g. custom\m2d\src\layer-
set.xml, and then reconfigure your MEDUSA4 project. Details on this can be found 
in the Customization Guide, chapter Running MEDCONFIG, section Adding a 
User-Product Directory.

Delete

deletes the current layer set.

Below these entries the All Layers list and the Actual Layers list are provided.

Figure 137 Layer Management Dialog: Tab Layer Set Management, Layer Lists

• The list of All Layers displays the name of the layers. Which layers are listed depends on 
the settings of the show options in the Layers area, by default all named layers are 
listed.

Inverts selection of all available layers

Selects all available layers

Adds selected layers to layer set

Removes selected layers from layer set

Selects all layers in layer set

Inverts selection in layer set

Deselects all layers in layer set

Deselects all available layers
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• The list of Actual Layers displays layers which belong to the current layer set.

• Between the two lists a number of buttons is located which are used for selecting and 
deselecting layers either in the left or right list, and for take over layers from one list to 
the other.

Below the two lists you find the section Layers on the left hand side and Layer Set Attributes 
on the right.

Please note: All entries in the Layer Set Attributes area are only enabled when the current layer set 
is first saved.

Figure 138 Layer Set Management Dialog: Tab Layer Set Management, Options

The Layers area:
Text field (below the list of all layers on the left)

The field is disabled by default. If you click double on a layer number inside the list 
above, the field becomes enabled and the name is displayed in it. Now you can delete 
or change the layer name. Details are described in “Customize Layer Sets” on 
page 162.

Show Named Layers, Show Used Layers, Show All Layers

Options for displaying either all named layers, all layers used in the current sheet or all 
layers available in MEDUSA4 (which are the layers numbered from 0 to 1023) in the 
left list.

In the area Layer Set Attributes are the same properties as explained already for the tab Layer 

Properties (see “Layer Properties” on page 150). The difference is that the properties are valid for 
a layer set, meaning several layers, and not only for one layer. 
On, Off

switches on or off the visibility and selectivity at the same time.
Visible, Invisible

switches on or off the visibility for the selected layer set.
Hitable, Unhitable

switches on or off the selectivity for the selected layer set.
Protected Modify, Protected Full, Unprotected 

• Protected Modify behaves like full protection except that if you load or save symbols 
with elements which are on layers of the layer set, these elements are not loaded or 
saved.
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• Protected Full prevents elements on layers of the layer set from being created, deleted 
or modified.

• Unprotected allows you to create, change or delete elements on layers of the layer set.
Color ON, Color OFF

switches on or off the color chosen by the color selection button. 
 Color selection button

This is the color used for drawing elements on the layers of the layer set when the 
color switch Color is on. By default no color is defined.

Figure 139 Select Color Dialog

The buttons at the bottom of the Layer Set Management (Admin only) tab are the same as those for 
the tab “Layer Properties” on page 150.
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Customize Layers

MEDUSA4 allows to rename layers and delete layer names.

Please note: In MEDUSA4 you always have 1024 layers numbered from 0 to 1023, so you can-
not add new layers which have a higher number.

To customize layers you must be in Administrator mode. For logging in as Administrator, 
switch to the File tab > Options > Administrator (see ”Options”, “Administrator” on page 285).

Rename a Layer

Do the following for renaming a layer:

1. Open the Layer Management dialog by choosing File > Options > Layer Management or click on 
the button  in the Dashboard (see also “Default Layer” on page 145)

2. Choose the Layer Set Management (Admin only) tab.
3. Click the LMB double either on a layer number or the layer name.

The text field below the list becomes enabled and the layer name is displayed.
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Figure 140 Example: Rename Layer Name

4. Click in the text field.
5. Type a new name or change the displayed name.

The button Delete layer name  becomes inactive and the button OK to set layer name  is 
activated.

6. Click on the button OK to set layer name .
The layer name is changed and the list is updated to the new name.
The text field and both buttons on the right from it are disabled. 
If the currently displayed layer set contains the changed layer, the name is also 
updated in the list of layers defined in the layer set.

LMB
2X
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Delete a Layer Name

Do the following steps for deleting a layer name:

1. Open the Layer Management dialog
a. via File tab > Options > Layer Management

or

b. via button  in the Dashboard, in case you are just creating or editing an element 
(see also page 145)

2. Switch to the Layer Management tab of the dialog.
3. Click the LMB twice either on a layer number or the layer name.

The text field below the list becomes enabled and the layer name is displayed. Addi-
tionally the button  for deleting the layer name is activated.

4. Click on the button Delete layer name .
The relevant name in the list
a. changes to Layer_<No> (No is the current layer number) to mark it as undefined if 

one of the show options is active, either Show Used Layers or the Show All Layers, or
b.  is removed from the list if the show option Show Named Layers is chosen.
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Customize Layer Sets

To customize layer sets you must be in Administrator mode. For logging in as Administrator, 
switch onto the File tab on the ribbon > Options > Administrator (see ”Options”, “Administrator” on 
page 285) 

You can define your own layer sets by using Layer Management dialog.

Define Layer Sets in the Layer Management Dialog

1. Open the Layer Management dialog
a. via File tab > Options > Layer Management or

b. via button  in the Dashboard, in case you are just creating or editing an element 
(see also page 145)

2. Choose the Layer Set Management tab of the dialog.

Add Layer Set

1. Click the LMB in the text field Layer Sets.
2. Type a new name for the layer set into the entry box.
3. Click the Save button.

 The new layer set is created. Now the new layer set is available in the pulldown list 
which can be opened using the arrow right of the text field.

Figure 141 Layer Management Dialog > Layer Set Management Tab > New Layer Set

Add Layers to Layer Set

1. Select a layer set from the pulldown list. 
The list on the right Actual Layers displays the layers which are defined in the current set.

2. Click the LMB on layers in the left list All Layers which are to be added to the layer set.
If a layer is highlighted, it is selected and ready to transfer it to the Actual Layers list on 
the right.
If you click on an already highlighted layer, it is deselected.

3. Click left on the button Add layer to set .
The selected layers are transferred to the right list.

4. Click the Save button for storing the changes on the layer set.
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Remove Layers from Layer Set

1. Select a layer set in the pulldown list.
The list on the right Actual Layers displays the layers which are defined in the current set.

2. Click the LMB on layers which are to be removed from the layer set in the Actual Layers 

list.
If a layer is highlighted it is selected and ready for removing from the list.
If you click on an already highlighted layer, it is deselected.

3. Click the LMB on the button Remove layer from set .
The selected layers are removed from the right list.

4. Click the Save button to apply the changes on the layer set.

Delete Layer Set

1. Select the layer set which is to be deleted in the pulldown list.
The name is displayed in the text field.

2. Click the Delete button.

Figure 142 Layer Management Dialog > Layer Set Management > Delete Layer Set
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This chapter gives an introduction to the subject “Styles“ and explains the importance of styles 
in MEDUSA4.

• Introduction to Styles.............................................................. 166

• Changing Styles and Style Properties.................................... 170

• Style Definitions and their Effect on an Element .................... 173

• Style Tree............................................................................... 175
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Introduction to Styles

A style is a set of several properties, which are grouped under a particular name.
For example, construction lines are thin dashed lines and they are created on their own particu-
lar construction line layer. These properties are stored in a style named Construction.

All elements of a MEDUSA4 sheet have an associated style. The style for an element is dis-
played:

• in the General Properties area of the specific Dashboard
and

• in the specific properties dialog which is opened either via button  in the title bar of 
the General Properties or from the RMB popup menu.

Figure 143 Example Line Dashboard - Style

Figure 144 Example Line Properties Dialog

A style might be used to record what the element on the sheet is supposed to represent. For 
example, if the sheet is an electrical schematic drawing, then you might want to use line styles 
with the names Low Voltage and High Voltage.
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Style Properties

Each style has a set of properties associated with it, so that different styles can have a distinc-
tive graphical appearance. For example, the Low Voltage style could be defined to produce thin 
green lines while the High Voltage style could be defined to produce medium red lines. 

MEDUSA4 comes with a set of generic pre-defined styles for the different types of elements. 
For example, for lines there are, amongst others, the following styles:

• center line

• solid thin

For text there are for example:

• plain large

• circle

Pre-defined Tool Buttons

MEDUSA4 comes pre-configured with a set of tools for creating elements with varying proper-
ties. Each of these tool buttons is associated with a particular style. When a tool is called, it first 
sets the Dashboard to the associated style and then allows you to start creating your new ele-
ment on the sheet. You can achieve an equivalent result by:

1. Select the appropriate type of creation tool
on the ribbon > Home tab > Creation tool group.

2. Choose the desired style from the Dashboard > General Properties area > Style pulldown 
list.

(For details to the creation tools, see “Creation Tool Group” on page 305...)

Special Styles

Default Style

Every class of element has a default style associated with it. This is the style that is displayed 
initially by the Dashboard when MEDUSA4 is started first. Properties whose input field appears 
gray cannot be changed. Your System Administrator can modify this style if desired. However, 
MEDUSA4 will not permit you to delete this style.
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The Free style, provided in the Style pulldown list, has all fields unlocked and so it gives you max-
imum flexibility for modification. Elements imported from old MEDUSA4 versions or external 
applications often have this style because the attributes of these elements are unlikely to 
exactly match any of the MEDUSA4 built-in styles. This style is built into MEDUSA4 and there-
fore it cannot be modified or deleted.

Why use Styles?

You can define all of your elements as free style, for example, and then set properties of each 
element individually as you require. But as a result the powerful functions offered by MEDUSA4 
would not be utilized. There are several reasons why it is recommended to use styles in MEDU-
SA4:

• Capturing Design Intent
Associating the correct style with an element is a way of incorporating design intent in 
your drawing. For example, if a line has a style High Voltage it provides more information 
to the end-user of the drawing than the style name Free.

• Improving Consistency and Maintaining Drawing Standards
Industry or Company standards may require that certain elements on a drawing should 
be drawn in a certain manner. You can achieve this if you create a style for that ele-
ment. Similarly if there are different conventions within different subsections of your 
company you can also support this by asking your System Administrator to produce 
appropriate styles in order to distribute them to these subsections.

• Ability to Switch Drawing Representation
If you need to switch the representation of certain elements on your drawing, you can 
achieve this by redefining the appropriate style definition. Any elements that are subse-
quently created with this style will have the new set of attributes.

Style Files

When MEDUSA4 starts up, it reads in all styles defined in the standard products, as well as any 
that your administrator may have defined and packaged in a user-project, as well as any styles 
that you have defined for your personal use, either in this session of MEDUSA4, or any previous 
ones.

MEDUSA4 finds style definitions in several places.:

• Firstly the products come supplied with pre-defined styles which are stored in a direc-
tory <product>/m2d/styles. 
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• Secondly, MEDUSA4 will also use any styles which have been defined in user-defined 
products in the area <user-product>/m2d/styles. 

• Finally, if you define some new styles (or modify some of the existing definitions), then 
they are stored in the project as individual XML files in <userproj>/user/<name>/styles.

Note that for speed purposes, MEDUSA4 creates a single, merged XML style file which rep-
resents all the styles defined in all the standard products together with any defined in user-
defined products.This file is stored in your project area as <userproj>/m2d/bin/styles.xml.

If any style files in the standard products or your user products are altered then this merged 
style file will be regenerated. MEDUSA4 will do this automatically when it is next started, or 
alternatively, you can regenerate it explicitly by using the styles command in MEDconfig.

If you are the Administrator, then you may want to define or modify some styles and make these 
new definitions available to all your MEDUSA4 users in your office or company. MEDUSA4 pro-
vides a special tool which streamlines this process (for details see ”Style Tree”, “Merge User 
Styles” on page 177). 
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Changing Styles and Style Properties

You can modify the visual appearance of an existing element by:

• changing the style of an element with the effect of changing all the properties of the 
element to match those of the style or by

• modifying the properties of the element and keep the style

Changing the Element Style

Changing the element style is explained in the following with the help of the text style plain small:

1. Create some text on the sheet using the plain small style and make sure it is selected.
The style in the Dashboard reflects the style of the selected element.

2. Choose a different style from the pulldown list in the Dashboard.

Figure 145 Style - Pulldown List

If the list does not provide the style you want to use, choose the entry More.

The Style Tree window opens at the right hand side of the user interface. The Style Tree 
displays all available styles sorted by element classes.
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Figure 146 Section of the Style Tree

3. To apply the style to the selected element:
• double click on the desired style or
• click on the desired style in the list, open the RMB popup menu and choose Apply.
Now the selected element has the new style.
The Dashboard displays the new style and all properties associated with it.

For details to the Style Tree, see “Style Tree” on page 175.

Changing Element Properties 

Your System Administrator can define whether users can alter style properties. You can only 
change a property which is either not used in the current style or which is set as unlocked for 
editing. Depending on how the styles are set, some property attributes are locked and others 
are unlocked. This is explained in more detail in section “Style Definitions and their Effect on an 
Element” on page 173.
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The following example shows you how to change an unlocked property attribute for a selected 
line while the style is retained:

1. Select a line on the sheet.
The style is displayed in the Dashboard, e.g.solid thin.
Two properties are unlocked and can be changed, Color and Layer.

2. Change the color by clicking on the color button next to the Style input field and choose 
a different color on the Select Color dialog.

3. De-select the line to make the changed color of the line visible.
The Dashboard still displays the style solid thin although the color has been 
changed. An asterisk (*) was appended to the Style label in the Dashboard to indicate 
that the current style differs from the standard style.

4. To draw further lines with the same style and the just changed style property choose 
the Creates lines of specified type and properties  tool in the Creation tool group on the Home 
tab.
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Style Definitions and their Effect on an Element

The properties of an element can be divided into the following groups related to a style:

• The property is not used in the style

• The property has a value in the style but it is left unlocked.

• The property has a value in the style and it is locked.

The following sections describe how the properties of an element are affected when its style is 
changed.

Unused Properties

All properties which are not used in the new style remain unchanged. 

In this example we assume that the System Administrator has created the style thick only that 
only contain thickness values. Thus when changing the style between the predefined line styles 
solid thick and thick only the dashboard changes from:

Figure 147 Dashboard - Properties Style „solid thin“

to:

Figure 148 Dashboard - Properties new Style „thick only“

The unused fields (that is, Layer, Color, Type) remain at their former values and the values become 
active indicating that they can be modified.
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Your MEDUSA4 Administrator may want to set a policy for certain styles to prevent the previous 
case occurring. MEDUSA4 supports this by allowing the System Administrator to define certain 
properties in the style to be locked to a particular value. 

As in the previous example for the solid thin line the element properties are set to this locked 
value and in addition the associated fields in the dashboard and Properties dialog are disabled 
(greyed-out).
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Style Tree

Each style available in MEDUSA4 is listed in the Style tree.

You have the following options to display the style tree:

• Choose the More entry from the Styles pulldown list in the Dashboard.

Figure 149 Style Pulldown Menu - More Option

• Click on the Opens catalog, tree and browser area button  in the status area far right and 
choose the Style tab.

(See also ”Work Environment”, “Structure Tree, Styles and Symbols” on page 42)

Figure 150 Style Tree

The Style Tree is structured by the classes of elements. Each class contains the group My 

Favourites and Standard and if available Decor styles (e.g. element class Lines).
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The entry My Favourites contains the styles which are provided inside the Style pulldown list of the 
Dashboard and the property dialogs so you have direct access to them via the pulldown menus.

The following sections explain how to use the Style Tree window.

Popup Menu

The Style tree provides a popup menu for adjusting the tree and the style pulldown list of the 
Dashboard to your needs.

Move the cursor over an entry on the style tree and click on the RMB to open the following 
popup menu:

Figure 151 Style Tree Popup Menu

The options have the following functions:
Add Style to Favourites

adds the selected style to My Favourites of the style tree (see “Add Styles to My Favour-
ites” on page 177). The style is also listed on the Style pulldown menu of both the Dash-
board and the properties dialog.

Add to Shortcuts

adds a tool to the Shortcuts of the Dashboard which can be used to create an element 
with class and style according as selected in the style tree. (See also ”Dashboard”, 
“Shortcuts” on page 78)

Remove Style from Favourites

removes a selected style from the My Favourites list on the style tree (see “Remove 
Styles from My Favourites” on page 177).

Use Style

applies the style on the selected elements. After applying the style to the selected ele-
ments use the Redraw tool on the quick menu to see the result.
If you selected elements of different types like lines and texts Use Style is not active.

Save Style Tree

saves the style tree into the current user project directory:
<user project>\user\<name>\styletree.xml
<Installation path\master_project\user\<name>\styletree.xml
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combines style files from the user project and user product directories (for details see 
“Merge User Styles” on page 177).

Add Styles to My Favourites

There are two different ways to add a style to My Favourites:

1. Select the desired style inside the tree.
2. Open the RMB popup menu and choose the Add Style to Favourites entry.

or

1. Move the cursor on the desired style.
2. Keep the Ctrl key + LMB pressed on the entry.
3. Move the cursor on My Favourites and release both keys.

Remove Styles from My Favourites

For removing a style from My Favourites: 

1. Select the style inside My Favourites.
2. Choose Remove Style from Favourites from the popup menu.

The selected style is removed immediately from the favorites.

Merge User Styles

Please note: The option Merge User Styles is only available if you have Administrator rights.

If you are the Administrator, then you may want to define or modify some styles and make these 
new definitions available to all your MEDUSA4 users in your office or company. The option 
Merge User Styles of the style tree popup menu allows you to merge several style files into a single 
file in a new product directory. 
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The following steps show you how to merge style files:

1. Define any new styles, or modify existing ones, using the Style Dialog (as explained in 
section “Changing Styles and Style Properties” on page 170).
MEDUSA4 stores all these new definitions as separate XML files in your personal area 
in <userproj>/user/<name>/styles. At this point, if another user used MEDUSA4 from the 
same project, they would not see your new style definitions.

When you are happy with these new definitions and if you want to provide them to your co-
workers, you can create a new user-product to store them. You do this as follows:

2. Open the Style Tree.
3. Select a node in the Style Tree (details on nodes are given in ”Groups & Sheet Struc-

ture”, “Nodes” on page 185).
4. Choose Merge User Styles from the popup menu.

A dialog appears entitled Merge user style files:

Figure 152 Merge User Styles Dialog

5. Specify the name of your user Product directory.
This is simply a directory name, (which may be empty if you have not previously cre-
ated a user-product). Consider that the directory has to exist.

6. Click OK.
MEDUSA4 creates a styles file in the following area:
<Product directory>/m2d/styles/styles.xml
This single file will contain all the new style definitions and modifications that you cre-
ated in step 1.
In addition it also moves the definitions that were in your personal area (<userproj>/
user/<name>/styles) into the new area (<Product directory>/m2d/styles). These files are 
not used now, so you can delete them once you are happy that your new styles work 
as required.

7. You now need to add this new product into your project and reconfigure the project.
After reconfiguring the project your new styles will be available for anyone with the next 
start of MEDUSA4 from that project. If you have other MEDUSA4 projects which also 
want to share these same style definitions, then you just need to add your new product 
into the product list and reconfigure it.
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This chapter deals with the structure of MEDUSA4 drawings and explains the meaning and 
function of groups within the sheet structure.

• Introduction to Groups ........................................................... 180

• The Structure Tree ................................................................. 183

• Interacting with the Structure Tree ......................................... 187

• Reparent Elements ................................................................ 190

• Using the Structure Tree Navigation ...................................... 192

• Using the Structure Tree Toolbar ........................................... 193
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Introduction to Groups

Groups are a powerful feature of MEDUSA4 used to collect geometry together so that it can be 
manipulated as a single entity. Adding structure to your drawing in this manner makes it easier 
to edit it later on. You can structure the drawing logically by assigning user specific names to the 
groups.

Examples of groups are: 

• a hole with its center lines and dimension lines

• all lines and text that make up a single view of a component.

You can create a new group and then add geometry to it or form a group from existing ele-
ments. Geometry may be added to groups and edited or deleted from the group.

To make the structure within a sheet visible MEDUSA4 provides a Structure Tree which can be 
used to display and manipulate groups. (see also ”Work Environment”, “Structure Tree, Styles 
and Symbols” on page 42)

What are Groups?

Groups are permanent collections of elements. They are useful if you want to manipulate a 
number of associated elements on a sheet as a single entity. 

For example, suppose you are designing an electrical circuit that contains a large number of 
identical resistors each represented as shown in Figure 153.

Figure 153 A Resistor

The resistor consists of:

• a prim (the resistor symbol)

• some associated text

To create the resistor, you first open the group, then you create or select the elements making 
up the resistor and finally you close the group. By creating all these elements as a group you 
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can manipulate the elements as a single entity if the circuit needs to be changed. If you move 
the resistor all the elements inside the group are moved with it. If you delete the group all the 
elements making up the resistor are deleted.

(For details on creating groups see “Creating Groups” on page 613.

Members and Owners

Elements which make up a group are called Members. The group is called the Owner of the 
elements.

Figure 154 shows a part of the Structure Tree which illustrates the structure.

The sheet-level group Sheet is the owner of the Group Frame and therefore this group is a 
member of the owning group Sheet. The groups Revision Block, Title Block and 
drive shaft are members of the owner Sheet too.

Figure 154 Example of Group Structure
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A group may also be a member of another group as shown in the figure below.

Figure 155 Example of two Groups being Members of another Group

Please note: The group level depth is limited to 32. If you try to save the sheet and the limit is 
exceeded, a warning appears. Then you first have to correct the group structure 
before you can save the sheet.
(See also “Creating a Nested Group” on page 616)

Details on using the structure tree are provided in the following sections.
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The Structure Tree

In order to display the structure of a sheet MEDUSA4 provides the Structure Tree.
The Structure Tree is part of the Catalog, Tree and Browser Area which is displayed by default 
at the right hand side of the user interface. This area provides several tabs. Which tabs are 
available depends on the installed MEDUSA4 products.

To view the structure of a sheet we use the Structure tab.

Displaying and Hiding the Structure Tree

To display the Structure tree:

1. Click the LMB on the Displays Catalog, Tree and Browser Area button  which is located in 
the status area on the bottom right.

2. Switch to the Structure tab. (see Figure 156)
The structure tree reflects the hierarchical structure of the current sheet.

Figure 156 Structure Tree

When you click on the button  again the structure tree disappears.

(See also ”Work Environment”, “Structure Tree, Styles and Symbols” on page 42)
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Dock and Undock the Structure Tree

The structure tree can be displayed either docked to the MEDUSA4 graphical user interface or 
undocked as separate window. If the structure tree is undocked, it can be placed anywhere on 
the screen. By default, the structure tree is docked.

Undocking

In order to undock the structure tree you have several possibilities:
a. Click once on the icon in the right corner of the structure tree title bar.
b. Click twice on the title bar.

Figure 157 Structure Tree, docked and undocked

c. Click the LMB once on the title bar of the structure tree and keep it pressed.
Move the mouse with the window attached to the cursor to the desired position on 
the desktop and release the LMB.

You can re-size and place the dialog at any time to any position. 

Please note: During a MEDUSA4 session the changed size and position will be stored internally 
in order to keep it when docking and undocking again.

Docking

In order to dock the structure tree again click the LMB double on the title bar of the structure 
tree window. The structure tree is automatically docked on the user interface at its origin loca-
tion again.

2X LMB

1X LMB
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Nodes

MEDUSA4 uses the concept of the current node. If you create a new element it is created as a 
child of the current node. The current node is determined as follows: 

• If there is no current selection the current node is at sheet level. Therefore all new ele-
ments are created on this level.

• If there is a single element selected the current node is the group which owns this ele-
ment. Therefore all new elements are created in that group.

• If the selection is multiple the current node is taken to be the nearest common owner of 
all the selected elements.

If you select an element on the sheet, the corresponding nodes in the structure tree are 
selected and highlighted. If you select a node in the structure tree the corresponding element on 
the sheet is selected and highlighted. The structure tree indicates the current nodes by high-
lighting the corresponding node name.

In the figure below the current node is the shaft group.

Figure 158 Example of a current Node
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There are different kinds of nodes in the structure tree:

Figure 159 Examples of different Nodes

(1) Sheet Node This is the node which contains all other nodes.
It is labeled Sheet.

(2) Group Node This is a group of summary nodes.
 An example is the node named Level 2 Group (drive shaft).

(3) Summary Node This is a collection of nodes of the same class.
Examples for this are the nodes named 6 Lines, 4 Texts or 12 Lines.

(4) Leaf Node This is a single element such as the nodes named Solid

1

3

4

4

4

3

3

2

2

186 © CAD Schroer GmbH



MEDUSA4 Drafting
Interacting with the Structure Tree
Interacting with the Structure Tree

MEDUSA4 provides a variety of ways for you to interact with the structure tree. You can:

• ”Using the Mouse”

• ”Using the Popup Menu”

• ”Using the Structure Tree Navigation”

• ”Using the Structure Tree Toolbar”

Using the Mouse 

You can use the triangle to the left of the node names to expand and collapse group nodes and 
summary nodes.

Figure 160 Expanding Groups 

• If you select a leaf node MEDUSA4 selects the corresponding element(s) on the sheet. 

• If you select a summary node MEDUSA4 will select all the elements of that class in the 
current group. 

• If you select a group node MEDUSA4 will select the group on the sheet.

• If you select the sheet node no elements are selected. Selecting the sheet node is the 
same as using the Deselect All function.
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• Finally the structure tree supports drag and drop.
You can reparent an element or group by selecting the corresponding node on the tree, 
pressing and holding down the Ctrl-key+LMB and dragging the element or group into 
another node on the tree.

Please note: There is a time limit of a few seconds for opening each tree node - after that the 
tree expansion stops and the node is painted red . 

Using the Popup Menu

Move the mouse cursor on the structure tree and click the RMB to access the structure tree 
popup menu. The popup menu functions are described below:

Figure 161 Structure Tree Popup Menu

New Group

creates a new group as a child of the current node, i.e., the group is created as a 
nested group within the current group. The highest level at which you can create a 
group is the sheet level. Therefore you have to select the Sheet entry in the structure 
tree.
Selecting an item displays the Group Dashboard at the left hand side of the user 
interface where you can define the name of the new group.

Cut, Paste

used to cut and paste an entry of the structure tree.
You can paste cut elements also on another sheet.

Refresh

updates the display of the tree.
Properties

displays the properties dialog for the currently selected elements.
If a group name is selected in the structure tree the Group properties dialog opens:
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Figure 162 Named Group Properties Dialog

The Named Group Properties dialog displays the Style, Layer, Type and Name of the selected 
group.
In the Name field you can define a name for a new group or change the name of an 
existing group.
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Reparent Elements

You can move elements from sheet level or from a group into any other group, by reparenting 
these elements. You have two possibilities:

• Reparent inside the graphics area

• Reparent inside the structure tree

Reparent inside the Graphics Area

To reparent elements inside the graphics area do the following steps (in this case we assume 
that you want to move elements into a new group):

1. Open the structure tree e.g. via Displays Catalog, Tree and Browser Area button  in the 
status area.

2. Create a new group by using the New Group option in the structure tree popup menu. 
(see “Using the Popup Menu” on page 188) and draw a line in this new group.
The new group is displayed inside the structure tree with the new line.
The new line is only needed for defining the group in which you want to move elements 
later on.

3. Inside the graphics area select the elements which are to be reparented.
Inside the structure tree the selected elements respectively its group names are dis-
played highlighted.

4. Click the RMB to open the popup menu and choose Reparent.
The previously selected elements are displayed as deselected now.

5. Inside the graphics area select the line of the new group (see step 2) for defining the 
group to which you want to move the elements selected in step 3.

6. Click the RMB to open the popup menu and choose Apply.
The elements selected in step 3 are moved to the new group. You can see this inside 
the structure tree because the reparented elements are displayed highlighted. 

7. Now you can delete the line drawn in step 2.
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Reparent inside the Structure Tree

To reparent elements inside the structure tree do the following steps:

1. Open the structure tree e.g. via Displays Catalog, Tree and Browser Area button  in the 
status area.

2. Select an element inside the structure tree by clicking on the relevant entry.
To select multiple adjacent elements use the Shift key.

3.  Press the Ctrl+LMB above the selection and keep both pressed.
4. Move the mouse cursor over the group name in which you want to move the elements 

and release the mouse button.
The elements are moved to the chosen group and the structure tree is updated.
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Using the Structure Tree Navigation

The In Graphics Tool Bar of MEDUSA4 provides two tools to navigate through the structure 
tree. With these tools you can navigate through the different hierarchical levels of the sheet. 
(see ”In Graphics Tool Bar”, “Overview of Functions” on page 88)

Figure 163 Button for Hierarchical Navigation

Table 7    Buttons for Structure Tree Navigation in the In Graphics Tool Bar

Button Function

One Level Up
You can navigate one level up in Sheet Hierarchy.

Go To Sheet Level
You can navigate to sheet level in Sheet Hierarchy.
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Using the Structure Tree Toolbar

Below the structure tree title bar a toolbar is located, which can be used to cut elements from 
the structure tree, to paste elements and to display the structure tree by defined options.

Figure 164 Structure Tree Toolbar

Cut

Use the Cut button  to remove the currently selected elements from the sheet. (see also 
“Using the Popup Menu” on page 188)

The tree stores the cut elements in a paste buffer. You can paste them at another position in the 
sheet structure.

Please note: If you cut one element and then cut another element only the last element is avail-
able to paste. 

Paste

Using the Paste tool  you insert elements stored in the buffer at the selected place into the 
structure tree.

Please note: The button is only available if elements are cut and with it provided in the buffer. 
If you already pasted the cut geometry the button is disabled again.

The cut and paste tools in the toolbar of the structure tree only work on the same 
sheet. If you cut an element by using the tool , switch to another sheet and try 
to paste the element, the Paste button is disabled. When you switch back to the 
original sheet, the Paste button is disabled too. But, you can use the Paste option 
from the RMB popup to paste the cut element either on the original or another 
sheet. (See “Using the Popup Menu” on page 188).

Change Structure Tree Display

In the toolbar you find the following tools for changing the display of the tree:

• Use the Show only selected elements in tree button  to reduce the display of the tree to the 
selected elements only.
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• Use the Recreate, rebuild and reselect the whole tree button  to display all elements on the 
sheet in the structure tree again. Elements selected on the sheet are also highlighted 
in the structure tree.
Alternatively, use the Refresh option on the RMB popup menu as described in “Using the 
Popup Menu” on page 188.

Structure Tree View-Options

You can set different options for the structure tree. The button Shows structure tree options dialog  
opens the following dialog:

Figure 165 Structure Tree Options Dialog

The area Special Group Visibility provides several options to temporarily hide special drawing ele-
ments like dimensions and crosshatches. This has the advantage of clearing the structure tree if 
necessary. By default all options are on.

Deactivate the Show „Crosshatch“ Groups to hide „Crosshatch“ Groups in the structure tree by clicking on 
the check mark and confirm with OK.

Figure 166 Structure Tree: Display of the special Group for Crosshatch On and Off 
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The structure tree does not display any crosshatch element. If you choose Refresh form the RMB 
popup menu of the structure tree, all crosshatch elements are displayed again.

Please note: Consider that the visibility of special groups can be set for the structure tree only. 
The visibility of the appropriate elements in the graphics area is not affected by the 
settings in the dialog.

The Options Switch at the bottom of the dialog is on by default and makes sure that the structure 
tree will be updated automatically after an undo or redo action, if it is open.

Figure 167  Structure Tree Options Dialog - Options Switch

If you save the defaults at the end of a MEDUSA4 session, changes in the Structure Tree Options 
dialog will be saved too.
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This chapter gives you information to the function and importance of grids
and how to use it in MEDUSA4.

• Introduction to Grids............................................................... 198

• Grid Properties....................................................................... 199

• Modifying Grid Properties ...................................................... 206

• Creating a Grid....................................................................... 208

• Choosing the Current Grid ..................................................... 209

• Defining a Standard Grid........................................................ 209

• Activating and Deactivating a Grid......................................... 210

• Drawing and Hiding a Grid..................................................... 212

• Deleting a Grid ....................................................................... 213
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Introduction to Grids

MEDUSA4 provides several possibilities to support the creation of drawings including grids.

Grids are sheet overlay data consisting of grid points connected by lines. Grid points help you 
to create and position elements on a drawing, e.g. to align geometric and text elements), but 
grid lines are present purely as a visual aid. You cannot use grid lines to position elements on 
a drawing.

In the following sections among others you will learn about grid properties, how to change them, 
how to define several grids and how to activate, deactivate, make visible and invisible grids.

Please note: If you use a Free probe specifier when a grid is active, every free point that you cre-
ate is placed at the nearest grid point to the cursor. This action is called Snapping.
(For details to Probe Specifiers, see “In Graphics Probe Bar” on page 111)
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Grid Properties 

The properties of grids are displayed, defined and changed in the Grid Properties dialog.

You can open the dialog either via the button in the status area or by using the button in the 
Dashboard

Opening Dialog via Status Area

Figure 168 Status Area - Button to Open Grid Properties Dialog

In the status area you have access to the button at any time.

Opening Dialog via Dashboard

Figure 169 Sheet Dashboard - Grids Title Bar with Button

The button to open the dialog is available only on the Sheet Dashboard, i.e. you have to be on sheet 
level. The button is located on the title bar of the Grids area.

Please note: Using the button  in the In Graphics Tool Bar is an easy way to navigate to the 
sheet level.
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Figure 170 Grid Properties Dialog

Each grid has the following properties:
Grid name 

A name (maximum six alphanumeric characters) that uniquely identifies a grid. The 
default grid of a sheet is named draft.

Line style 

specifies the style of the grid lines. You can define Color, Type and Thickness of the line 
(for details see “Specifying Grid Line Style” on page 203).

Grid origin

The coordinates X and Y indicate the grid origin which is the starting point for the grid. 
Usually it is 0, 0 which is the bottom left hand corner of the sheet. By default, the grid 
origin is at the same position as the sheet origin.

Cartesian

gives the settings for a Cartesian grid. If this option is selected (indicated by the check 
mark inside the option field) parameters for the Polar option are not accessible. The fol-
lowing settings can be made:
X spacing, Y spacing

defines the spacing between the grid lines in horizontal (X) and vertical (Y) 
direction.

Rotate grid

provides the option Isometric grid and the edit fields for rotation angles at the 
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X axis and the Y axis. If Isometric grid is chosen all other settings are disabled 
(including the settings for Shear grid) and the grid is set to the isometric defaults 
(which is 30 degree rotation at the x axis and 60 degree rotation at the y axis, 
both counterclockwise).

Shear grid

provides the options X axis and Y axis for shearing either the grid lines in x- or y- 
direction according to the given Angle.

Polar

gives the settings for a polar grid. If this option is selected (indicated by the check mark 
inside the option field) parameters for the Cartesian option are not accessible. The fol-
lowing settings can be made for a polar grid:
Radial increment

defines the distance between the circular grid lines to each other and to the 
origin of the grid.
gives the increment in radial direction seen from the origin. For example, a 
value of 5.00 gives grid circles, which are drawn with a spacing of 5, 10, 15, 
and so on units around the grid origin.

Origin rotation

gives the angle by which the grid is rotated around the origin.
Angle

is the increment angle per segment. If you change this value the Number of 

segments is changed too.
Number of segments

defines the number of segments inside a circle. If you change this value the 
Angle is changed too.

Representation

defines whether the grid is displayed with lines or with points.
Points Only the cross-over points of the grid lines are displayed.
Lines The complete grid lines are displayed.

Extent

defines whether the grid is displayed as full sheet or on the border only.
Full The grid is displayed on the whole sheet.
Border The grid is displayed at the border only.

Please note: The settings for Representation and Extent can also be made in the Sheet Dashboard. (See 
”Dashboard”, “Grids” on page 67)

Interval 

An integer value which defines what grid lines are drawn on the sheet. For instance, if 
the X interval is 4, then only every 4th grid line is shown.

Sub-grid increment

The input fields are only active for grids displayed with dots. If you enter values here a 
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sub-grid will be created also displayed with dots. The values depend on the current val-
ues for Interval and have to be an exact divisor of the Interval field. For instance, if the 
Interval field is 4, then the sub-grid Interval can be 1, 2 or 4. A pulldown menu (see 
Figure 171) shows the valid values.

Figure 171 The Sub-Grid Increment Pulldown Menu

Buttons

OK, Apply 

uses the current settings for the current grid. OK closes the dialog additionally.
Delete

is only activated if more than one grid is defined (see also “Deleting a Grid” on 
page 213).

Default Settings

sets back the settings on the values of the last saved defaults.
These values must not correspond to the values of the default grid draft of a new 
MEDUSA4 sheet!

Set Defaults

defines the current grid settings as defaults (see also “Defining a Standard Grid” on 
page 209).
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The grid line style is defined by Color, Type and Thickness.
Default settings are black color, dotted line Type and the thinnest line Thickness.

Figure 172 Grid Properties Dialog - Line style

Color

The button below Color  opens the Select color dialog, where you can choose the desired 
grid line color in the Current Colors area. Plot Colors are the colors which will be printed/plotted. 
These cannot be selected and are only given for showing how the displayed colors will be 
printed/plotted.

Figure 173 Select Color Dialog

OK applies the selected color.
Cancel closes the dialog without applying the color.
Once a color was changed you can Reset it to its original settings.
Edit and Add provide the following dialog:
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Figure 174 Define Color Dialog

The color can be specified in different ways:
Hue and Luminescence/Saturation 

Any LMB click on a color in these areas changes either the Hue or the color Luminescence/

Saturation. The sliders and color values in the Current Color area change accordingly as 
well as the display of the color New and the html code.

Current Color 
provides sliders and text fields for specifying hue, luminescence and saturation on top 
and for red, green and blue color values at the bottom.
html

The text field below html allows you to specify an HTML color code.
New, Old 

is only available if the dialog is opened via Edit button. The field displays the 
New color against the Old one.

OK

applies the settings for the Current Color.
Cancel

closes the dialog without applying the settings.
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Type

To define the line Type open the pulldown menu by clicking on the arrow right of the Type field. 
Choose the desired type from the list.

Figure 175 The Type Pulldown Menu

Thickness

To define the Thickness of the line open the pulldown menu via arrow right of the Thickness field. 
Choose the desired thickness from the list.

Figure 176 The Thickness Pulldown Menu
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Modifying Grid Properties

You can change any properties of an existing grid in the Grid Properties dialog.

1. Open the Grid Properties dialog via button  in the status area or the button in the Dash-
board.

2. Click on the arrow close to the Grid name input field to call up the list of available grids 
(see Figure 179, “The Grid Name List” on page 208).

3. Select the grid you want to modify.
The dialog displays the properties of the chosen grid.

4. Change the properties of the grid as required.
5. Click OK to apply the changes and exit the Grid Properties dialog.

Changing Origin of the Grid

MEDUSA4 provides an easy way to change the origin of a grid. The options to set and reset the 
grid origin are located in the Sheet Dashboard.
(see also ”Dashboard”, “Grids” on page 67)

Figure 177 Dashboard - Grid Origin Setting Options

Aligning a Grid With an Element

You can move the origin of the current grid so that it is aligned with an element. This is shown 
below where the grid origin is set to the bottom left corner of the element.
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Figure 178 Set Grid Origin to Element Corner

6. Navigate to sheet level via button  in the In Graphics Tool Bar.
7. Click on the Set button  in the Dashboard > Grids area > Origin.
8. Probe the point on the element that you want to align it to.

Resetting the Grid Origin

To reset the origin of the current grid to (0,0) click on the Reset button  in 
the Dashboard > Grids area > Origin.

X
X

Element not aligned with grid Grid origin moved
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You can create up to ten grids for each sheet. The grids are saved when the sheet is saved.

To create a grid:

1. Open the Grid Properties dialog via button  in the status area or the button in the Dash-
board. (See “Grid Properties” on page 199)

2. Enter a new name for the grid in the Grid name field.
The new grid name can have up to six alphanumeric characters and the first character 
must be a letter. Spaces and special characters are not allowed.

Please note: When you open a new sheet the Grid name field already contains the entry draft 
because every MEDUSA4 sheet has a default grid with this name. If you do not 
change this default grid name and apply the grid settings, you modify the default 
grid but you do not create a new grid. The grid “draft” is lost.

3. Define grid properties as required.
4. Click Apply to accept the changes.

The Grid Properties dialog remains opened and you can continue making settings.
5. Click OK.

The changes are applied and the Grid Properties dialog disappears.

Since you can create up to 10 grids for each sheet, you can repeat these steps up to ten times. 
At each time the last entered grid name is displayed in the input field. It is added to a list, which 
can be displayed by using the arrow as shown below.

Figure 179 The Grid Name List
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Choosing the Current Grid

In MEDUSA4 it is possible to define several grids for one sheet. But, at one time you can only 
activate or display one of them. This grid is called the current grid.

For choosing the current grid:

1. Open the Grid Properties dialog via button  in the status area or the button in the Dash-
board. (See “Grid Properties” on page 199)

2. Display the list of defined grids via the arrow right of the Grid name input field as shown in 
Figure 179.

3. Select the grid you want to be the current grid from the list.
The dialog displays the properties of the grid.

4. In order to make this grid the current one, click the OK button.
It can now be displayed and activated as described on the following pages.

Defining a Standard Grid

You can define any current grid as standard grid, both for the current session and following ses-
sions.

1. Select the desired grid in the Grid Properties dialog as described in section ”Choosing the 
Current Grid”.

2. Click on Set defaults.
3. Apply the setting with OK.

The selected grid becomes the standard grid for all sheets opened during the current 
session.
The Grid properties dialog is closed.

4. In order to see this effect first open another or a new sheet and then the Grid properties 
dialog.

5. Press the Set Defaults button.
The grid defined as default is displayed, assumed that the Show current grid option in the 
menu Grids is activated.
(see “Activating and Deactivating a Grid via Popup Menu in Status Area” on page 210)

If you wish to keep this default setting for subsequent sessions, you have to save the 
changes of the defaults when quitting MEDUSA4.
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You can activate and deactivate the current grid at any time. If a grid is active probing a point 
snaps to the nearest grid point. Therefore grid activation and deactivation contains switching on 
and off grid snapping.

There are two different ways to activate or deactivate a grid:

• using the Grids area of the Sheet Dashboard. (See ”Dashboard”, “Grids” on page 67)
or

• via RMB popup menu of the grids button in the status area. (See ”Grids”, “Grid Proper-
ties” on page 199, Figure 168)

Activating and Deactivating a Grid using the Dashboard

You turn on the current grid by clicking in the Active option box in the Grids area of the Dashboard. 
Now a check mark indicates that the grid is active.

Figure 180 Activate Grid in the Dashboard

When a grid is active, all points that you create using the Free probe specifier are adjusted to the 
nearest grid point to the position of the cursor. To create free points between the grid lines you 
must deactivate the grid.

To deactivate the grid click again into the Active option box. The check mark is removed. An 
empty box indicates that the grid is not active.

Activating and Deactivating a Grid via Popup Menu in Status Area

In the status area click the RMB on the button which displays the Grid Properties dialog.

Figure 181 Status Area - Button to Open Grid Properties Dialog

A popup menu is displayed.
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The display of the symbol to the left of the De/Activate Grid entry depends on the settings in the 
grid properties. 

Figure 182 Popup Menu for Cartesian and Polar Grid

Clicking on Activate Grid turns on the grid and the entry changes into Deactivate Grid.

Figure 183 Popup Menu with Options for Activating and Deactivating the Grid

When you click on the Deactivate Grid entry the grid is switched off.
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Although you can create up to ten grids for each sheet, you can only display one grid on your 
current sheet at a time.

There are two different ways to display and hide a grid:

• using the Grids area of the Sheet Dashboard. (See ”Dashboard”, “Grids” on page 67)
or

• via RMB popup menu of the grids button in the status area. (See ”Grids”, “Grid Proper-
ties” on page 199, Figure 168)

Drawing and Hiding the Current Grid by using the Dashboard

You display the current grid by setting a check mark in the Draw option box in the Grids area of 
the Sheet Dashboard. The check mark indicates that the grid is displayed.

Figure 184 Activate Draw Grid Option in the Dashboard

You hide the current grid by clicking in the Draw option box again with the effect of removing the 
check mark. An empty box indicates that the grid is not displayed.

Drawing and Hiding the Current Grid via Popup Menu in Status Area

In the status area click the RMB on the button which displays the Grid Properties dialog.

Figure 185 Status Area - Button to Open Grid Properties Dialog

A popup menu is displayed.

When you click on Show Current Grid the grid is displayed on the sheet and the entry changes into 
Hide Current Grid.
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Figure 186 Popup Menu with the Draw and Hide Options of the Grid

If you click on Hide Current Grid the grid is no longer displayed.

Deleting a Grid

To delete a grid:

1. Open the Grid Properties dialog via button  in the status area or the button in the Dash-
board. (See “Grid Properties” on page 199)

2. Open the Grid name pulldown-list as described before.
3. Select the grid you want to delete from the list of available grids.
4. Press the Delete button at the bottom of the dialog.

The selected grid is deleted. Another grid from the list is made current.
5. Click OK to apply the change and dismiss the Grid Properties dialog.

Please note: You cannot delete the last grid on the sheet.
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This chapter explains the functions which are available on the File tab of the ribbon.

• The File Menu........................................................................ 216
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• Saving Sheets........................................................................ 227
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• Printing a Sheet ..................................................................... 242

• Default Settings - Overview ................................................... 254

• Options - Overview ................................................................ 255

• Quitting MEDUSA4 ................................................................ 258
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The File Menu 

The File tab of the ribbon provides access to the backstage area and contains the following 
options.

Figure 187 File Tab

The options at the top of the tab deal with the basic handling of sheets including:

Create a new blank template sheet, open an existing sheet file, save and close sheets. Below 
that are commands to access plot and print functions.

The Default Settings and Options commands allow users to modify the configuration of the MEDU-
SA4 Drafting application.

Last but not least you can quit the program using the Quit option at the bottom of the menu.
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Creating a Sheet

You can create standard sized sheets and custom format sheets.

The File tab > New > Available Templates provides buttons as thumbnails of standard formatted 
sheets and a question mark for customized sheet sizes.

Figure 188 File Tab > New > Available Templates

To create a new sheet click on the relevant button.
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The sizes of standard formats comply with the default settings in Table 8.

The sizes of the standard sheets may differ from those shown above. They may be specific to 
your installation. Therefore you should confirm with your System Administrator the sizes of the 
sheets supported at your installation.

Creating the Sheet

In order to create a standard format sheet click on the thumbnail of the desired format.

MEDUSA4 switches to the Home tab and displays a sheet of the selected format.

The sheet contains sheet frame and header. The Dashboard displays the sheet properties in 
the Sheet Properties area. You can change the size of the sheet, as described in ”Dashboard”, 
”Sheet Properties”, “Sheet Size” on page 73.

Table 8    Standard Sheet Sizes

Standard Sheet
Metric (mm)
Width          Height

Imperial (inches)
Width           Height

E/A0 1189.00 841.00 44.0  33.5

D/A1 841.00 594.00 34.0  22.0

C/A2 594.00 420.00 22.0  17.0

B/A3 420.00 297.00 17.0  11.0

A/A4 (horizontal) 297.00 210.00 11.0  8.5

AV/A4V (vertical) 210.00 297.00 8.5  11.0
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Special Format Sheet

To create a special format sheet:

1. Choose New on the File tab and click on the question mark button.
MEDUSA4 switches to the Home tab and opens the Special Sheets dialog.

Figure 189 Special Sheets Dialog

The dialog provides the following parameters:
Size

provides the standard sheet sizes and a Custom entry (Figure 189).
If you choose one of the standard sheet sizes, you can define the Scale, Units and the 
Type different from the default settings available with the standard sheets.
If you choose Custom you have to enter Width and Height of the sheet additionally to the 
specification of Scale, Units and Type. Enter width and hight in current sheet units.

Width, Height

define the size of a Custom sheet. These entry fields are disabled if a standard format is 
selected.

Scale

defines the permanent scale of the sheet. Details are described in ”Dashboard”, “Sheet 
Scale” on page 70.

Units

defines the sheet units either to Metric (mm) or Imperial (inch). (See also ”Dashboard”, 
“Units” on page 71)
The units are defined by the Administrator and can only be changed if more than one 
type of units is available.

Type

defines the type of the drafting. Details are described in “Sheet Type” on page 220.

2. Select either one of the standard sizes or Custom from the Size pulldown menu.
3. Define the parameter as required.
4. Click OK for creating the new sheet
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If you choose a Custom sized sheet a completely blank sheet is created (without frame 
or header details).
If you chose one of the standard sized sheets a new sheet is created with the settings 
you made and contains Frame and header.

5. If you created a Custom sheet annotate the sheet as described in ”Annotating a Special 
Format Sheet”.

Sheet Type

The sheet type varies depending on the MEDUSA4 application you are working in, or on the 
requirements of your company. The Type option button in the Special Sheets dialog lists the avail-
able sheet types for your project. For example, you would set the Type option button to 2D if you 
are working in MEDUSA4 Drafting.

The range of sheet types is defined by your System Administrator.

Please note: You cannot change the sheet type after you have created the sheet.

Annotating a Special Format Sheet

If you have a custom sheet there is no title block containing the name of the sheet for unique 
identification. Therefore it is essential to annotate the sheet with the sheet name so that it can 
be easily identified when you display it on the workstation screen or when you plot it. 

To annotate a sheet:

1. Select a tool to create text .
The Text Dashboard is displayed.

2. In the General Properties area of the Text Dashboard choose:
the Free option from the Style pulldown menu and
the Drawing Number option from the Type pulldown menu

3. In the Input Area at the top of the Text Dashboard:

Type the drawing name into the text entry box
4. Move your cursor until the text is in the position you require, and click the LMB.
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Any opened sheet contains a sheet tab at the bottom of the sheet edge.
This tab displays feedback on:

• Write protection (see also “Write Protection Display” on page 223)

• File name

• File modification

• Button to close the sheet

The figures below show tabs of different sheet conditions.

Figure 190 Tab of a new Sheet in Standard Format- Drawing Number in Title Block not yet changed 

Figure 191 Sheet Tab of a new Sheet in Special Format- Drawing not yet named 

Figure 192 Sheet Tab of an Edited but not yet Saved Sheet - Asterisk indicates Modifications

An asterisk is displayed on the sheet tab if you have drawn something on your sheet but not yet 
saved the sheet.

Figure 193 Sheet Tab of a Saved Sheet - Tab displays the File Name
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If you want to open an existing sheet, you can select it from any directory via file manager.

1. Choose Open on the File tab.
The file browser of the operating system is displayed.

Figure 194 Windows “Open Sheet” Dialog

2. Choose the requested directory.

At the bottom right of the dialog you can open a pulldown menu to select from a list of different 
file formats.

Figure 195 File Format Pulldown List

The dialog provides several options to display the list of files, including thumbnails which pro-
vide a preview of the sheets. (see the button at the top right of the dialog, Figure 194)
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Figure 196 File Browser  -  Display Option “Medium Icons“

3. To open a sheet either click once on the desired file and then on Open

or click twice directly on the desired file.

Write Protection Display

When you have opened a MEDUSA4 drawing, the tab below the graphics area displays the file-
name and at the left hand side of it the symbol of a lock. The lock informs you whether a file is 
write protected or not.

Figure 197 Display of File Attribute - Write Protected
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Closing a Sheet

You can close a sheet:

• via File tab > Close

• via button on the sheet tab

Closing via File Tab

Via File tab you can close any currently loaded sheet.

1. Choose the Close option on the File tab.
File name and path of all currently opened sheets are listed below Close Currently Opened 

Documents.

Figure 198 Pulldown Menu Close

2. Click on the file to be closed.
• If you have changed the file and not yet saved, you are asked if you want to save or 

discard the modifications without saving it. After responding the sheet is closed.
• If the file already has been saved, the sheet is closed immediately and MEDUSA4 

toggles to the Home tab.
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Closing via Sheet Tab

Via sheet tab you can close the current sheet only.
You recognize the current sheet by the tab displayed in the foreground and by the red button for 
closing the file.

Figure 199 Closing File via Sheet Tab

Click on the Close Tab button.

• If you have changed the file and not yet saved - indicated by the asterisk close to the 
file name - you are asked if you want to save or discard the modifications without sav-
ing it. After responding the sheet is closed.

• If the file already has been saved, the sheet is closed immediately.
© CAD Schroer GmbH                             225



MEDUSA4 Drafting
File Tab
Recent Sheets

Additional to the Open menu option (see “Opening a File” on page 222), the Recent option is pro-
vided on the File tab. When you click on this option the Sheet History Stack is displayed. It is a 
list of previous opened files.
In this form MEDUSA4 provides quick access to files in a manner consistent with other 
Microsoft Windows applications.

1. Choose File tab > Recent.
2. Click on a file name.

The file is loaded.

Figure 200 File Tab - Recent Option

The number of files displayed in the list of Recent Sheets can be configured with a maximum of 8 
files being displayed. Further information on the configuration of the list of recently used docu-
ments is given in ”Default Settings”, “Sheet” on page 267.
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Saving Sheets

The File pulldown menu offers different save options which are shown below.

Figure 201 Save Options on the File Tab

Please note: Both the Save and Save As tool are also available in the In Graphics Tool Bar, where 
you can easily use them (see also ”In Graphics Tool Bar”, “Overview of Functions” 
on page 88).

Save

The Save option is only available if you have loaded an existing sheet which has been saved 
before under a defined name in a specified directory.

Click on Save to store modifications in the drawing while retaining the existing file name.

Save As

You can use the Save As option to:

• save a new created sheet under a defined file name in a specified directory

• save a copy of the current sheet under a new file name in a specified directory

Click on Save As for saving a sheet to a new file.

The Save As dialog is displayed.
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Figure 202 The Save As Dialog

The head of the dialog displays name and path of the current directory.

On left hand side of the dialog the directory structure is displayed. Here you select the directory 
where you wish to save your sheet.

The field at the right hand side of the dialog displays the names of the files which are stored in 
the currently selected directory.

By default the file name complies with the setting of the DrgNo. in the sheet header, but you can 
overwrite it.

Please note: Your System Administrator can modify the default file name as displayed in the 
Filename input field. Further information is given in the 
MEDUSA4 Administration Guide.

By default the File Type field provides the type with extension .she.
The pulldown menu displays a list of other possible file types.
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Figure 203 The File Type Pulldown Menu

To save the current sheet:

1. Select the directory where you wish to save your sheet.
2. Accept the suggested File Name or overwrite it.
3. Select the File Type as which you want to save your sheet.

For example, choose AutoCAD DXF (*.dxf) for exporting the current sheet with AutoCAD 
exchange format.

4. Click on Save.

The current sheet is stored in the chosen directory under the defined file name.The 
dialog disappears.

Save All

Using the Save All option saves all opened and modified files under the current name. When you 
choose this option a request appears which you have to confirm.

Figure 204 Save All - Request
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If you have the optional MEDRaster module installed, then you can save MEDUSA4 sheets as 
image files. Several formats are available.
To save a sheet as monochrome image (black and white), choose the last option from the pull-
down menu, image type Image TIFF Black/White (see Figure 203, “The File Type Pulldown Menu” 
on page 229).
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Working Sets

For useful sheet administration MEDUSA4 provides the possibility to group a number of sheets 
in a so-called Working Set. You define a Working Set by storing selected sheets under a com-
mon name in a .wsd file (working set definition).

This section describes how to group the sheets in a .wsd file and how to deal with .wsd files.

Sheet Working Sets Dialog

Choose the Working Sets option on the File tab to open the Sheet Working Sets dialog.

Figure 205 Sheet Working Sets Dialog

This dialog allows you to:

• Create, open, copy and delete WSD files

• Load and close the sheets defined in the WSD file

• Define a new multi-sheet working set containing the currently loaded sheets

• Refresh the list of available sheets

• Reset the list of selected sheets to that one stored in the WSD file

• Manage the properties associated with WSD files

• Add sheet files to and remove sheet files from a WSD file
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If you move the cursor over the lists of the Sheet Working Sets dialog and click the RMB the follow-
ing popup menu is available:

Figure 206 Sheet List Popup Menu

Select All, Deselect All

selects or deselects all entries of a list.
Sort

is used for sorting the list entries alphabetical. This option is used after adding and 
removing sheets from a WSD file.

Creating a WSD File

When you open the Sheet Working Sets dialog at first both the list of available sheets and the list of 
selected sheets are empty.

1. Click the Defines a new multi-sheet working set button .
The Available Sheets list displays all available sheets of the current working directory.
The Selected Sheets list still remains empty.

Please note: The current working directory is the directory from which you start MEDUSA4. 
Usually it is preset during installation by the Administrator, but during a MEDUSA4 
session you can change to any directory. 
Select the desired directory via File tab > Options > Change Directory.

Please note: If already a working set has been loaded, any sheets associated with that working 
set will be closed automatically. This occurs, if the Loaded Sheet option is set to 
Clear in the Working Set Properties dialog (for details to this dialog see “Modifying 
Loading Behavior” on page 238).
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2. Select the files that you wish to be part of the new Working Set in the Available Sheets list.
3. Click on the button Add available sheet to set button  to move it into the Selected Sheets list.

Figure 207 Adding Files to Selected Sheets List

4. Click the Saves the current multi-sheet set button  on the Sheet Working Sets dialog. 
A file selector dialog appears.

5. Select the directory where you wish to store the WSD file and insert a file name.
6. Click on Save.

The current working set is saved immediately. The Saves the current multi-sheet set button 
 becomes disabled until you change something in the WSD file.

Creating a WSD File from currently loaded sheets

MEDUSA4 provides a button which allows you to create a WSD file very fast from currently 
loaded sheets.

1. Click the Defines a new multi-sheet working set containing the currently loaded sheets button  on 
the Sheet Working Sets dialog.
The Selected Sheets field of the dialog displays the file names of all currently loaded 
sheets.
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Figure 208 List of all Currently Loaded Sheets in the Sheets Working Sets Dialog

2. Click the Saves the current multi-sheet set button  on the Sheet Working Sets dialog.
A file selector dialog appears.

3. Select the directory where you wish to store the WSD file and insert a file name.
4. Click on Save.
5. The current working set is saved immediately. The Saves the current multi-sheet set button 

 becomes disabled until you change something in the WSD file.

Creating a Copy of the Current WSD File

1. Click the Saves current multi-sheet set under a new identity button  on the Sheet Working Sets.
The selector dialog Save As A New Working Set appears.

2. Choose the folder for the WSD file and enter a name in the File Name field.
3. Click OK.

Provided the file does not already exist, a new working set is created and the sheet set 
is updated. If the set already exists an error is reported in the output message area and 
the File Selector dialog remains on the screen to allow you to try again.

Loading a WSD File

1. Click on the Opens a multi-sheet set button  on the Sheet Working Sets dialog.
The Open Working Set dialog opens.
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2. Choose the directory and .wsd file which should be loaded.
3. The sheet lists are updated according to the definitions in the loaded WSD file. 

The Available Sheets list displays all sheet files of the selected directory which are not 
defined in the current working set. The Selected Sheets list displays all sheet files which 
are defined in the current working set. Both lists together show all sheet files inside the 
selected directory.

Please note: If the WSD file references any sheets that cannot be found a Warning Notification 
will be displayed.

Figure 209 Warning when files were not found in the loaded Working Set

Deleting a WSD File

1. If it is not currently open, open the WSD file via the Sheet Working Sets dialog.
2. Click the Deletes current multi-sheet set button  on the dialog.

The current WSD file is deleted from the hard disk. Its settings remain until you create 
a new or load another WSD file.

Adding Sheets to a WSD File

To add sheets to a WSD file:

1. Select the sheet files from the Available Sheets list on the Sheet Working Sets dialog.
2. Click the Add option  to move the files to the Selected Sheets list. 

Please note: Sheets are automatically added to a WSD file once it is active. See “Once the 
Working Set is Active” on page 236.
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To remove unwanted sheets from the WSD file:

1. Select the sheet files from the Selected Sheets list on the Sheet Working Sets dialog.
2. Click the Remove option  to move the files to the Available Sheets list.

The selected sheet files are removed from the WSD file.

Loading Sheets of a WSD File

Click on the Loads the complete Working Set button .
The files listed in the Selected Sheets panel are loaded into the current MEDUSA4 session.

You can alter the behavior of the load process. This is explained in “Modifying Loading Behav-
ior” on page 238. For example, you can modify what MEDUSA4 does with currently loaded 
sheets.

If you saved a WSD file and quit MEDUSA4 (see also “Quitting MEDUSA4” on page 258), in the 
next session you are asked for reloading the sheets of the WSD file by the following dialog:

Figure 210 Reload WSD File

• If you choose OK, all sheets of the appropriate WSD file are loaded.

• Cancel aborts loading.

• If you choose the option Don’t ask unless I open another working set and click the OK button, the 
WSD file is loaded automatically when starting the next session until you load another 
WSD file or no WSD file and save the defaults with that setting.

Once the Working Set is Active

Once a working set is loaded in MEDUSA4
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• any sheets that are subsequently opened or created are automatically added into the 
working set.

• sheets which are closed are automatically removed from the working set.

At the end of a session the working set is checked for modifications. If there are unsaved 
changes, the following dialog is displayed, allowing you to save or discard any changes to the 
working set definition.

Figure 211 Save or Discard Working Set Dialog

A similar dialog is displayed when a new working set is created or opened and you have made 
changes to the existing working set.

Refresh and Reset Sheet Lists

Click Refresh the available sheet list  to display a refreshed Available Sheets list. Sheet files that are 
referenced in the WSD file are excluded. 

Click Reset the multi-sheet set  to reset the Selected Sheets list to the saved WSD file and display a 
refreshed Available Sheets list. This button is only available if you moved sheets between the lists 
as explained in ”Adding Sheets to a WSD File” and “Removing Sheets from a WSD File” on 
page 236.

Closing Sheets of a WSD File

Clicking the Closes all files of the current multi-sheet set button  on the Sheet Working Sets dialog closes 
the files listed in the Selected Sheets panel.
© CAD Schroer GmbH                             237



MEDUSA4 Drafting
File Tab
Modifying Loading Behavior

You can customize the way in which the sheets are loaded using the Working Set Properties dialog. 
To display this dialog, click the Manage the properties associated with working sets button  on the Sheet 

Working Sets dialog.

Figure 212 Working Set Properties Dialog

Loaded Sheets

pulldown menu to define whether to retain or close any sheet files which are already 
loaded.
Retain

keeps the sheet files already loaded.
Clear

closes the sheet files already loaded.
When you load a WSD file you will be prompted to save or discard any unsaved 
changes.

Known Sheets

pulldown menu to either use the sheet files already loaded in MEDUSA4 or to reload 
them.
Auto Switch

uses the sheet files already loaded.
Always Load

reloads the sheet files.
When you load a WSD file, you will be prompted to save or discard any unsaved 
changes.
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Plotting a Sheet

To display the Plot Sheet dialog, select the Plot... option from the File menu.

Figure 213 Plot Dialog

The parameters of the Plot Sheet dialog are:
Admin plot project 

defines the plot queues and plotter driver programs to be used by the plotting system 
administrator.
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Available queues

Displays all available directories where MEDUSA4 sheets and plot definition files are 
stored until they are processed by a plotter driver program. Each directory is called 
queue.

Plot templates

Allows you to define whether you wish to use the full sheet or the current view in the 
MEDUSA4 drawing window as the template for the plot.

Drawing code

Gives the number of the drawing code used for plotting. Up to ten Drawing codes are 
defined in the code.dat. Refer to your System Administrator for more information. By 
default the value is 1.

No of copies

Allows you to define how many copies will be plotted.
Priority

Sets the priority of running the plot process on your computer It can be a value from 1 
(highest priority) to 5 (lowest priority).

Plotter Format

Is relevant only for particular plotters and may not be relevant at your site. Refer to 
your System Administrator for more information.

Title

A title box may be included at the bottom of the plotted sheet. Text in this entry box 
determines what will appear in the first line of the plot information title box if it is plotted. 
You can click in this area and edit this text if required.

Drafting project

This is an user project, which defines the appearance of drawing elements. The Drafting 

project can be the Admin plot project at the same time.
Layers

This pulldown list allows you to select which layer or specific set of layers (for example 
All layers) you would like to plot.

Plot window

These entry boxes define the coordinates defining precisely which area of the sheet is 
plotted. The numbers change automatically to reflect the coordinates of whichever Plot 

Template you select (that is, Sheet or Window). You may alter these coordinates if required.
Plot scale

This option is only active when Enable Autoscale choice box is not selected. Use this entry 
box to define a specific scale.

Curve Factor, Max Angle, Min. Angle

Arcs are drawn using a number of straight lines known as chords. The more chords 
that are used to draw the arc, the smoother the curve appears. The way in which arcs 
appear on your screen is not necessarily the way that they appear on the plotted sheet. 
The options Curve Factor, Max Angle, Min. Angle work together to define the arc factor for the 
plotted sheet. 
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The operation of these entry boxes is the same as the operation of the entry boxes 
which are used to define the way in which arcs appear on your computer screen.

Plot raster backdrop

If this option is on, a raster image included in the sheet is plotted with the sheet. Addi-
tionally you can define whether a referenced raster is updated before plotting, and 
whether the raster is also copied  into the plot queue.

Visibility Settings of Design Objects

this option sets the visibility of hidden, profile and load point lines on or off for plotting.
Query Plot Queue

opens the following dialog:

Figure 214 Plot Queue Dialog

The list of Available queues is shown. 
You can sort it either by priority or plot number. 
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Choose the Print option on the File tab.

The Print dialog is displayed.

Figure 215 Print Dialog

The parameters of the Print dialog are:
Filename

becomes active if you want to print to a file. In order to do this choose the File option 
from the Print output  to pulldown list. You have to enter name and complete path of the 
plot file. The File Selector button opens the dialog. You can choose a file in any directory. 
Filename and path are passed to the Filename input field.
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Please note: The predefined super printers qtplotpdf_bw (black and White) and 
qtplotpdf_color (colored) print into a PDF file. When you select one of these 
printers, you must choose File for the Print output to field. Enter the directory in 
which the file is to be stored and a Filename. Add the extension .pdf to the filename.

Directory

Select the target directory of the output-file, when the Print output to option is set on File. 
Details are described in “Directory” on page 245.

Available printers

displays a list of all the printers configured in your system.
Print output to

Allows you to define the destination for printing which is either the printer or a file. If 
you choose File then the entry Filename becomes active for specifying a file name.

Print templates

Allows you to define whether you wish to use the full sheet or the current view in the 
MEDUSA4 drawing window as the template for the print.

Drawing code

Gives the number of the drawing code used for printing. Up to ten Drawing codes are 
defined in the code.dat. Refer to your System Administrator for more information. By 
default the value is 1.

No of copies

Allows you to define how many copies will be printed.
Printer Format

complies with the FORMAT command and is used to pass format names. Format 
names are assigned with additional predefined format-specific commands 
(DEFFORMAT commands), for example “Rotating only if A3“ or “Special paper tray, if 
A4“, or similar.

Paper Width, Paper Height

gives the width and height of the paper on which the sheet is printed.
Area options

Select the area to be printed (see “Area options” on page 246).
Title

Depending upon settings in the Advanced Options dialog, (see “Advanced Options” on 
page 250) a title box may be included at the bottom of the printed sheet. Text in this 
entry box determines what will appear in the first line of the print information title box if 
it is printed. You can click in this area and edit this text if required.

Layer settings

Enter the layer numbers which are to be printed. For further information see “Layer set-
tings” on page 247).

Print window

These entry boxes define the coordinates defining precisely which area of the sheet is 
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printed. The numbers change automatically to reflect the coordinates of whichever Print 

templates you select (that is, Sheet or Window). You may alter these coordinates if required.
Print scale

This option is only active when Enable Autoscale choice box is deselected. The default 
setting for Print scale is 3. Your Administrator can define another default value by setting 
the relevant keyword and the desired value in the defaults.dat (for detailed information 
on this subject, please, refer to the Customization Guide, Printing Defaults). Use this 
entry box to define a specific scale.

Curve Factor, Max Angle, Min. Angle

Arcs are drawn using a number of straight lines known as chords. The more chords 
that are used to draw the arc, the smoother the curve appears. The way in which arcs 
appear on your screen is not necessarily the way that they appear on the printed 
sheet. The options Curve Factor, Max Angle, Min. Angle work together to define the arc factor 
for the printed sheet. 
The operation of these entry boxes is the same as the operation of the entry boxes 
which are used to define the way in which arcs appear on your computer screen.

Print backdrop

If this option is on, a raster image included in the sheet is printed with the sheet. Addi-
tionally you can define whether a referenced raster is updated before printing, and 
whether the raster is also copied into the plot queue.

Enable Autoscale

When this choice box is selected, MEDUSA4 will automatically scale the defined area 
to fit on the sheet. The graphics will not become distorted. To define a specific scale, 
ensure this choice box is not selected and use the Print scale option.

WARNING: Normally, if auto scaling is disabled and the requested print is too large for the 
selected printer, nothing is printed.

Enable Autorotate

When this option is selected, MEDUSA4 automatically rotates the defined area to suit 
the sheet orientation, if necessary. For example, if you send a landscape shaped sheet 
on a printer which has a portrait orientation paper feed, then the sheet will be rotated. A 
portrait orientated sheet will not be rotated. If the Rotate Print choice box is selected it 
becomes deselected if you select this choice box again.

Please note: To ensure that the area to be printed is scaled to the fullest extent for the paper 
size, ensure that both the Enable Auto scale and Enable Auto rotate choice boxes are 
selected. 

Rotate Print

When this choice box is selected, MEDUSA4 always rotates the area to be printed 
through 90 degrees, for example to print a landscape shaped area on a printer which 
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has a portrait orientation paper feed. If the Enable Auto rotate choice box is selected it 
becomes deselected if you select this choice box.

Enable Optimization

Option relevant only for pen plotter
according to the OPT command in the description file, prevents that the pens are 
changed to often and optimizes the path of the pens.

Show Preview

displays a preview window of the sheet or part of sheet which is to be printed. For 
details see “Print Preview” on page 249.

Advanced Options

Opens a dialog allowing you to set further print settings. Details are described in 
“Advanced Options” on page 250.

Directory

This input field Directory /Filename works in conjunction with the Filename field and is also only 
active, when the Print output to option is set on File. It provides the possibility to choose a pre-
defined target directory or file from a pulldown list. The selected one is entered into the Filename 
input field of the File Selector dialog. The user now can add or change the filename by clicking 
twice on the desired file.

Please note: In order to display the pulldown list the Administrator has to define the relevant 
keywords in the defaults.dat (for detailed information on this subject, please, refer 
to the Customization Guide, Printing Defaults).

Figure 216 Directory Pulldown Menu of the Print Dialog
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Area options

These options are not normally used for general printing operations and should not require 
alteration.

Figure 217 Selection of plotting area

Explicit

Format definition is taken from the currently displayed window (values of the Paper Width 
and Paper Height fields).
Allows you to define an explicit paper size. If this is not supported on the selected 
printer at your installation the graphics will be sized and located based on the given 
sizes but then they could be trimmed to the available paper size. Which parts of an 
oversized drawing are trimmed or whether an undersized drawing is placed on the 
paper, depends on the type of printer that you use.

Hard

Plot size according to the inquired hardware limits of the plotter at run time (and the 
plotter driver settings with WINPLOT respectively). Complies with the AREA HARD 
command in the description file.

Soft

Sets the size of the graphics area by using the soft clip limits obtained from the plotter 
itself. This can be set through the plotter control panel. If this information is not avail-
able, the area defaults to A4 portrait.

Auto

Takes the information on the paper size out of the sheet; complies with AREA AUTO in 
the description file.
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Layer settings

The section Layers is used to define which layers should be printed.

Figure 218 Input area, layers to be printed

Layers

Enter the layer numbers which are to be printed. Multiple values are separated by a 
comma (,), e.g. 0-10,12,15-20.

 Configuration of layers to print

Opens the Layers to Print dialog, in which you can select layers from a table (see “Layers 
to print” on page 247).

 Reset the configurated layers to the layers from default

Resets the input to the values defined in the file defaults.dat. For further information see 
the Customization Guide chapter User Interface, section DEFAULTS.DAT.

 Show a preview of the current sheet with the configured layer settings

All elements with the defined layers as enter in the input field Layers will be visible, the 
others will be invisible.

 Shows the current sheet with the standard layer setting

Resets the visibility of the elements.

Layers to print

The Layers to print dialog is used to select the desired layers which then will be entered in the 
input field Layers of the Print... Dialog.
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Figure 219 Dialog, to select layers

The left column shows the layer numbers. The appropriate layer names are printed in the col-
umn Layer Name. The choice boxes in the On column indicate the layers which are to be printed. 
The options are described below.
On

Activates or deactivates all choice boxes at the same time.
Print... dialog

Only the layers defined in the input field Layers of the Print... dialog are available for 
selection.

Used layers

Only the layers are available for selection, which are used on the sheet.
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All layers

All layers are available for selection.
OK

Transfers the selected layer into the Layers input field of the Print. dialog and closes the 
dialog.

Cancel

Dismiss the selection and close the dialog.
Preview

All elements with the defined layers will be visible, the remaining will be invisible.
Review Reset

Resets the visibility of the elements.

Print Preview

MEDUSA4 provides a “preview before printing” option. The option has to be enabled in the Print 
dialog.

Figure 220 Print Dialog - Show Preview Option 

1. Activate Show Preview.
2. Click OK.

The Print window appears.
3. Click on Print.

The Print Preview dialog opens displaying the current sheet.
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Figure 221 Print Preview Dialog

The dialog provides several options for displaying the sheet preview.

The Page Setup button  opens a dialog where you can make print settings.

The button  starts printing.

Please note: Plot preview only works when using the qtplot driver and a real printer.

Advanced Options

You can define advanced printing options, for example for text printing or defining a print title 
block, using the Advanced Printing Options dialog. To display this dialog, click the Advanced Options but-
ton on the Print dialog.
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Figure 222 Advance Printing Options Dialog

Select the required options and define any optional user text on this dialog and click OK to return 
to the Print dialog. The fields on this dialog are described below.

Layout Options

These radio buttons define various sheet layout options.
Boundary Brackets

If On angular markers are drawn on the printed sheet, outside of the sheet borders to 
define the corners of the sheet boundary area

Margin

If On a blank margin is kept around the edge of the sheet. Once set to On use the Values 
button to display a dialog which allows you to specify the margin extents as X and Y 
coordinates. 
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Option only relevant for pen plotter
Complies with the SCR ON/OFF command (Scrubbing) in the description file. It is the 
area on the plot paper, which is used for the fact, that the pens can draw undisturbed, 
so that the ink begins to flow in the right moment; i.e. if the first correct line is pro-
duced. 

Title Block

If On a title block is drawn at the bottom of the print, outside of the graphics area. Text 
for the title block may be defined in the Title entry box on the Printer dialog and the 
Optional User Text area of the Advanced Printing Options dialog.

Format Options

These radio buttons define various format options

Please note: Text may have a proportional spacing or shear attribute set but this spacing or 
shear setting may not be displayed on the screen. 

Proportional Spacing

If the On radio button is selected text with proportional spacing attributes is printed with 
proportional spacing, even if the proportional spacing is not shown on the screen.

Text Shear

If the On radio button is selected text with shear attributes is printed sheared, even if 
the shear is not shown on the screen.

Thickness Simulation

Complies with the THKSIM ON/OFF switch
If required, it uses a pen repeatedly in order to create a line which surpasses the line 
width of the thickest pen. If OFF is active, the physical pen is used to create this line.
Particularly with color plotters the number of defined pens will be very large, possibly 
too large. Using THKSIM ON, one thin per color is sufficient.

Please note: A disadvantage is that the plot file becomes needlessly large.

Visibility Options

Using the On or Off radio buttons you can select whether Hidden lines, Profile Lines or Loadpoints 
should be visible or not in the print.

Optional User Text

These text entry areas allow you to specify optional lines of text which may be included in the 
title block of the printout below the graphics area.
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Please note: The title block is not printed unless the Title Block option is set to On in the dialog.

Each User Text entry box defines a line of text which can appear in the title block.

1. Enter text into the text entry areas as required.
2. If you want all user text to be shown on the printed sheet ensure that none of the Disable 

choice boxes is selected.
3. To disable one or more lines of user text so that they are not shown on the printed 

sheet, select the appropriate Disable choice box(es).

Perform Printing

1. To display the Print Dialog choose the Print option from the File menu.
2. Select a printer name from the Available Printers list.
3. Select an option from the Print output to pulldown list to define whether you want to print 

directly to the printer or to a file.
4. If you selected Print output to file type a name for the file in the Filename text entry box. If 

required click the File Selector... button and use the browser to define a file name and 
location in which to store the file.

Please note: The Filename text entry box and the File Selector... button remain grayed out until you 
select the Printer option from the Print output to pulldown list.

5. Set the other options on the dialog as required.
6. Click OK to print either to the printer or to a file, as specified.
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Choose File tab > Default Settings option to open the Default Settings dialog.

Figure 223 Default Settings Dialog

The dialog provides on different tab pages the possibility to make General, Element and Dimen-
sion, settings and settings for Search Radii for element selection and Arc Factor for the display 
of arcs and circles. If you click on one of the entries on the left hand side of the dialog, the rele-
vant tab page is displayed.

For details on all settings, please, refer to chapter “Default Settings” on page 261.
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Options - Overview

Via File > Options you have access to many specifications, settings and adjustments of your appli-
cation. The following figure shows the available options. Depending on the MEDUSA4 products 
you have installed on your computer this list may differ from the list on your screen.

Options which are displayed gray are disabled.
In order to activate it you have to be logged in as Administrator.

Figure 224 File Tab > Options

The following options are available:
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Administrator

You can log in as Administrator and leave the Administrator mode.
You can change the Administrator Password if you are in Administrator Mode.
You can change the graphics background color by selecting the desired color from a 
palette.
You can compile the defaults definition files for Fits, fits_metric.dat and fits_imperial.dat 
to a binary file. In this files the Administrator defines fits according to the standards of 
your company.
Details to the Administrator options are described in ”Options”, “Administrator” on page 
285.

Layer Management

opens the Layer-Management dialog. It is used to set Layer Properties and define Layer 
Sets. In order to define Layer Sets you must be in Administrator Mode.
Details to Layers are described in  “Layer” on page 149.

Accelerators & Map keys

opens the Accelerator & Map key Editor.

The entry enables you to set accelerator keys (shortcuts) and map keys for MEDUSA4 
functions and tools.
Details to Accelerator & Map keys are described in ”Options”, “Accelerators and Map-
keys” on page 291

Change Directory

changes the current directory. The chosen directory will be used, e.g. when loading a 
sheet or a symbol and for that a file browser, is displayed.
Details on the current directory are described in ”Options”, “Change Directory” on page 
296.

Licenses

displays a list licenses which are currently in use and provides switches to activate 
licenses which are necessary for the use of certain MEDUSA4 products.
Details on the current directory are described in ”Options”, “Licenses” on page 297.

Auto Sheet Save

opens the Auto Save Dialog, where settings for the automatic saving of sheets are made
Details on the current directory are described in ”Options”, “Auto Sheet Save” on page 
298.

Reset Customization

Resets any changes of the user interface to the original default settings. This option is 
not available for FX version of MEDUSA4
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Print

The Print setting options are only available if you are logged in as Administrator. 
Plotter Configuration

opens the Plotter Configuration dialog. The dialog is used to add or delete plotter, to 
change the properties and configure a plotter.

Interfaces

The Interfaces entry provides several options for the DXF/DWG configuration.
Configuration

You can make settings for im- and export of DXF/DWG files, the AutoCAD exchange 
and standard format. 
If you are in Administrator mode you can edit files, which control the mapping between 
MEDUSA4 and AutoCAD, in a table.
You can switch between different configuration paths for text- and line-mapping.

Details on Interface options are described in the CAD Convert User Guide.
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Quitting MEDUSA4

To exit MEDUSA4:

• choose the Quit option  on the File tab
or
click on the Quit button  in the program title bar

If you have created a sheet which has not been saved till now the Save or Discard Sheet dialog 
opens.

Figure 225 The Save or Discard Dialog 1

a. Click on Save As calls up the Save As dialog. You can store the sheet in a requested 
directory (see “Saving Sheets” on page 227). After saving the dialog disappears and 
the MEDUSA4 session is terminated.

b. Click on Discard rejects changes and closes the MEDUSA4 session.
c. Click on Cancel ignores quitting. The sheet is still loaded and you can continue your 

session.

If you have modified a sheet which has already been saved in a directory the Save or Discard Sheet 
dialog opens.
The displayed message contains a hint of the path and file which has been modified.

Figure 226 The Save or Discard Dialog 2

The Save as, Discard and Cancel buttons work as described above.
Click Save to store the sheet and the changes under its existing identity.
The dialog closes and the session is terminated.
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If you have made any changes of the defaults during the session MEDUSA4 displays the Save or 

Discard Defaults dialog with the according message.

Figure 227 The Save or Discard Defaults Dialog 

a. Click on Save stores the changes of the defaults, closes the dialog and quits the 
MEDUSA4 session.

b. Click on Discard ignores the changes and quits the session.
c. Click on Cancel ignores quitting and you can continue the session.
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DEFAULT SETTINGS
Using the Default Settings option on the File tab MEDUSA4 provides many ways to make global 
settings for your application.

This chapter gives detailed information on Default Settings.

• Default Settings Dialog .......................................................... 262

• General .................................................................................. 264

• Drawing Elements.................................................................. 269

• Dimension .............................................................................. 272

• Radii and Arc Factor .............................................................. 277

• Parametric.............................................................................. 280

• Design Objects....................................................................... 280

• 2D Products ........................................................................... 281

• 3D Products ........................................................................... 282
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Default Settings Dialog

Choose the Default Settings entry on the File tab.

Figure 228 File Tab > Default Settings

The Default Settings dialog is displayed.

Figure 229 Default Settings Dialog

On the left hand side of the dialog several options are available. Clicking on an entry changes 
the display of the dialog and provides setting options according to the selected tab.

Grayed entries are first deactivated. These tabs are available only after activating the relevant 
licenses via File > Options > Licenses.
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Common Buttons

At the bottom left the Default Settings dialog contains the following buttons, which are the same for 
all options.

Figure 230 Default Settings Dialog > Common Buttons

OK

applies the settings and the dialog closes.
Cancel

closes the dialog without applying changed settings.
Reset

sets the values back to the settings when you started the session.

Please note: Any changes in the dialog are only applied after you have confirmed them with OK!

Changed settings are only available in the current MEDUSA4 session.
If you want to retain the settings also for subsequent sessions you have to save 
the modified defaults when quitting MEDUSA4.
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General

Default Settings

The settings control the storage process when closing the program.

Figure 231 Dialog Default Settings: General, Default Settings

Save on Exit
Always
Changed default settings are always saved. An inquiry dialog will be not displayed, 
when leaving the program.
Never
Changed default settings are never saved. An inquiry dialog will be not displayed, 
when leaving the program.
Prompt
A query occurs whether changed default settings should be saved or not.

Switches

The settings control a number of global user options.

Figure 232 Dialog Default Settings: General, Default Settings

Display Rubber Band

A dynamic line is displayed between current point and cursor during line creation and 
line edit operations.

Enable Transportation Lines

enables transportation lines (for details see “Construction Lines - Lines Tab”, ”Trans-
ported Construction Lines” on page 692).
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Enable Error Bell

Whenever an error occurs an acoustic signal indicates that an error information is 
shown in the output message area. If a message is displayed in its own dialog, no 
sound can be heard.

Save Window Position

If this option is on, MEDUSA4 saves the coordinates of the current main window as 
default. Then, with the next start of MEDUSA4 the main window appears in the same 
size and on the same position.

Show Console

displays the console/command prompt window which is hidden by default.
Define Vertices with Left Button

allows drawing points of a line using the left LMB. If this option is off you can place 
points of elements only with the middle mouse button.

Clip Zoomed Window

If the option is on and if you zoom into the sheet using the Windows into the area of a sheet 

tool , only elements inside the selection frame are displayed. The borders of the 
selection frame are displayed as dotted lines (you can see a maximum of two of them). 
If the option is off, also elements are displayed, which are not part of the selection 
frame but fit into the zoomed view.

Copy to Clipboard

If the option is on (default), elements which are copied by using the Copies the selected 

Elements tool on the Home tab > tool group Clipboard are copied as well into the internal 
buffer of MEDUSA4 as in the buffer of the operating system. As a result the elements 
are also available in other applications.

Display of Line Thickness

By default this option is activated. This has the effect that all lines are displayed 
according their defined thickness.
If the option is not activated, all lines are displayed thinly; this also concerns text lines 
and lines of prims.

Opaque in-sheet buttons

controls the appearance of the In Graphics Tool and Probe Bar (see “In Graphics Tool 
Bar” on page 87 and “In Graphics Probe Bar” on page 111).
If checked, the In Graphics Tool and Probe Bar are permanently opaque. If unchecked, 
the In Graphics Tool and Probe Bar are opaque when the mouse is over a bar, but 
becomes translucent when the mouse moves outside the bar area.

Message Area

In this area you can make global settings for messages displayed inside the output message 
area (for details see “Work Environment”, ”Message Window” on page 37).
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Figure 233 Dialog Default Settings: General, Message Area

Message Types to Display

specifies the type of messages to be displayed. You can choose between Errors, Errors 

and Warnings, or All messages.
If you activate the All option, also logging messages are displayed which occur after 
probing elements or updating the layer display.

Please note: The output message area is not visible unless you click the Toggle visibility of error 

message area tool  in the status area, see page 37.

Dashboard

Figure 234 Dialog Default Settings: General, Dashboard

Dashboard Selection Limits

defines the limits of element selection for the display in the Dashboard.
Some Dashboard actions depend on the number of selected elements. If the number 
of selected elements exceeds the limit, the Sheet Dashboard is displayed. The following 
table shows the default and maximum values for limits:

You can define the limits either in the Defaults dialog (File > Default settings > General) or in 
the defaults.dat file of the product. Details to settings in the defaults.dat are described in 
the Administration Guide, Dashboard - Element Selection Limits. 

Please note: The higher the values are, the longer MEDUSA4 needs for checking.
If you exceed the maximum value, a message dialog is displayed and the value is 
reset to its maximum.

Element Default Value Maximum Value

General 5000 1000000

Properties 2000 10000 

Texts 500 100000
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Drawing Code

This area specifies the display of a particular element type.

Figure 235 Dialog Default Settings: General, Drawing Code

Select Drawing Code

The pulldown list provides 10 codes, code1 to code10.
You find the code definitions in the file code.dat.
Choose the desired code from the list. Then the currently used code is displayed in the 
field.

Apply to all open Sheets

By default the option is deactivated. In this case the chosen drawing code is only 
applied to the current sheet and all sheets, which will be opened subsequently in the 
current session.

When running MEDUSA4 for the first time the code setting depends on the settings of the 
Dimension Text switch (see “Text” on page 275). If Normal (default setting) is activated, the currently 
displayed code is Code 1. If Bold is activated, the currently displayed code is Code 4.

In order to be able to set another code as default, you have to define a value for the keyword 
code_default which is written as comment within the defaults.dat file by default.

1. Delete the comment characters (--) in front of the keyword.
2. Enter the value of the desired code.

Having changed the defaults.dat file requires to re-configure your project which is 
described in the Administration Guide. 
Details on drawing codes are described in the Customization Guide.

Sheet

Figure 236 Dialog Default Settings: General, Sheet
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No. of recently used sheets

The value defines the number of files displayed on the Recent Sheets list. The pulldown 
list provides entries from 1 to 8 (see also “File Tab”, ”Recent Sheets” on page 226).
The setting will take effect only after a reboot of MEDUSA4.
On the File tab > Recent > Recent Sheets you find a list of the last opened drawings.

Sheet Loading/Saving

Load References

loads the geometry of a sheet reference.
This setting is only available in the M4 Professional product. (see tab Refsys)
Save References

keeps a porthole reference inside a sheet but the appropriate geometry is not loaded. 
This setting is only available in the M4 Professional product.
Add Preview on Sheet Save

adds preview automatically to any sheet when saved.
Sheet Units

Metric

sets the sheet units to the metric system (mm). This measuring system is used when-
ever you open a new sheet.
Imperial

sets the sheet units to the imperial system (inch). This measuring system is used 
whenever you open a new sheet.
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Drawing Elements

Layer

Figure 237 Dialog Default Settings: Drawing Elements, Layer

Display in Layer Manager

Named Layers

All named layers are displayed in the Layer Manager dialog.
Used Layers

All used layers of the current sheet are displayed in the Layer Manager dialog.
All Layers

All layers available in MEDUSA4 (i.e. layers from 0 to 1023) are displayed in the Layer 

Manager dialog.
Prefer Color by Layer

The layer color has priority over the element color.
I.e. any elements which are created on a layer assigned to a specific color will be dis-
played in this color irrespective of their element color. 

Construction Lines

Figure 238 Dialog Default Settings: Drawing Elements, Construction Lines

Construction Line Extent

Window

Construction lines are drawn until the border of the currently visible graphics area.
Sheet

Construction lines are limited by the sheet size.
Maximum Size

Construction lines are drawn till the maximum size of the graphics area, which can be 
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defined in the Sheet Dashboard > Sheet Properties > Size.  (see “Dashboard”, ”Sheet Size” on 
page 73)

Dynamic Construction Lines

Search Radius

indicates the size of an area around the cursor in which MEDUSA4 uses to search for 
and detect geometry.
Angular Increment Width

indicates the angle offset with which the dynamic construction lines are constructed 
from a fixed point.
In order to fix points press the Ctrl-key of your keyboard.

Text

Figure 239 Dialog Default Settings: Drawing Elements, Text

Default Font

provides a pulldown list of all available fonts. The chosen Default Font is used for texts 
which are created indirectly like in dimensions or feature control frames. For text styles 
this setting is not applied because text styles have a font given in the style definition.

Minimum Text Legibility (pixels)

defines the minimum number of pixels where text is displayed on the sheet legibly.
If the height of the text (in pixel) is smaller than the given value, text is displayed as 
rectangle.
Text attached to the cursor is always readable. If you increase the minimum value of 
the legibly text, smaller text is displayed as rectangle. This reduces the number of lines 
to be drawn. As a result the time for refreshing a drawing containing a lot of text ele-
ments is reduced.

Text Display

Decortext

If this setting is on, text is displayed with its defined font.
If this setting is off, text is always displayed with the Quick Text font, no matter what font 
is set in the properties of the text.
Legible Text

If this setting is on and the text is large enough, the text is drawn as defined.
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If this setting is off, MEDUSA4 always draws a box instead of text.
With Shear

allows text shear attributes to be defined and display text with shear appropriately.
Scale Text Height (during Paste or Symbol Load)

controls the scaling of text height when pasting elements which contain text or when 
loading symbols.
For example, if you copy a rectangle containing dimensions and a text into a drawing 
with a different scale, text and dimension text are scaled according to the following 
options:
All texts

All texts are scaled.
None

No texts are scaled.
Not Dimension Texts

All texts except dimension texts are scaled.

Symbol

Figure 240 Dialog Default Settings: Drawing Elements, Symbol

Symbol Load/Unload

Sheet Level

If this option is set symbols are loaded or saved (unloaded) always on sheet level. The 
level on which the symbol currently is, or which was saved with the symbol is ignored.
Current Level

If this option is set, symbols are loaded or saved (unloaded) always on the level they 
are currently on, or which was saved with the symbol.

Hide Symbol Browser after loading a symbol

If this option is active (default setting) the symbol browser disappears after loading a 
symbol.

Add Preview on Symbol Unload

adds preview automatically to any symbol file when unloaded/saved. For large sym-
bols it is recommended because the preview will be faster.

Select Symbol after Exit Tool

After setting this option, the last symbol placed on the sheet using the Load named symbol 
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tool becomes selected and highlighted after leaving the Load named symbol tool. If the 
option is deactivated, no symbol is selected after leaving the Load named symbol tool.

Dimension

In MEDUSA4 it is possible to pre-define the dimension style and the dimension norm as stan-
dard. Details on dimensioning are described in chapter “Dimensioning - Home Tab”, ”Dimen-
sioning - Home Tab” on page 413.

Standard

Figure 241 Dialog Default Settings: Dimension, Standard

Following dimension standards are available:
ISO, DIN, ANSI, BSI and JIS.

If you choose any standard all dimension options in the properties dialog are set accordingly to 
the relevant standard.

If you change the settings you must be aware that these settings perhaps no longer comply with 
the selected standard.

Arrows

Figure 242 Dialog Default Settings: Dimension, Arrows
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Line Dimension

shows the definitions for arrows on dimension lines for the selected Standard. 
If you click the LMB on one of the symbols, the Point Functions dialog is displayed. If you 
choose another symbol in this dialog, it replaces the symbol shown in the Default Settings 
dialog (see also ”Dimensioning - Home Tab”, ”Linear Dimension Properties”, ”Text and 
Arrows” on page 432).

Angular/Arc Dimension

shows the definitions for arrows on dimension lines of angles and arcs. 
The symbols are changed in the same way as described for Line Dimension.

Symbol of Start Point (Coord Dimension)

defines the symbol of the starting point when using coordinate dimensioning. 
The symbol is changed in the same way as described for Line Dimension.

Radial Dimension

defines whether radial dimensions are drawn with or without the line marking the 
radius.

Please note: The ISO standard also allows you to draw flipped out diameter dimensions with or 
without a witness line exhibiting the diameter.

Gap

The settings control the distances and gaps of witness/leader and dimension lines.

Figure 243 Dialog Default Settings: Dimension, Gap

Dimension Line Gap

defines the distance between witness/leader and dimension line, respectively the 
excess length of the witness/leader line beyond the dimension line.
If you click the LMB on one of the symbols, the Point Functions dialog is displayed. If you 
choose another symbol in this dialog, it replaces the symbol shown in the Default Settings 
dialog (see also ”Dimensioning - Home Tab”, ”Linear Dimension Properties”, ”Text and 
Arrows” on page 432).
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Leader/Witness Line Gap 

defines the distance between witness line and probe point.
The symbol is changed in the same way as described for Dimension Line Gap.

Gaps in overlapping Leader/Witness Lines

defines the size of the gap, if witness lines are overlapping.
The symbol is changed in the same way as described for Dimension Line Gap.

Gap Mode

Horizontal

defines that the gaps in overlapping witness lines are inserted in horizontal lines only.
Vertical

defines that the gaps in overlapping witness lines are inserted in vertical lines only.
Natural

defines that the gaps in overlapping witness lines are inserted wherever it fits.

Prefix/Suffix

This area defines the settings for Prefix and Suffix of text for the relevant dimension.
If you click the LMB on the button  next to an entry box the Special Characters dialog opens.

Figure 244 Dialog Default Settings: Dimension, Prefix/Suffix

Radial Prefix/Suffix

defines prefix and suffix of text for the dimension of radii.
Diametric Prefix/Suffix

defines prefix and suffix of text for the dimension of diameters.
Thread Prefix/Suffix

defines prefix and suffix of text for the dimension of threads.
Chamfer Prefix/Suffix

defines prefix and suffix of text for the dimension of chamfers.
274 © CAD Schroer GmbH



MEDUSA4 Drafting
Dimension
Text

Figure 245 Dialog Default Settings: Dimension, Text

Dimension Text

Normal

displays dimension text with normal font weight (default setting).
Bold

displays dimension text with font weight bold for printing or plotting.
If this option is set, boldness of plotted dimensions can be set to a certain value by 
defining environment variables inside the login.bat (for details see the Administration 
Guide, chapter Setting up Boldness for Plotting Dimensions).

DIN Tolerance Text Height

Normal

sets the text height for the tolerance according to the text height of the dimension.
Small

sets the text height for the tolerance smaller than the text height of the dimension.

Settings

Figure 246 Dialog Default Settings: Dimension, Settings

Saved Damaged Dimensions

Prompt

If the option is set, you are asked how to handle damaged dimensions every time you 
try to change a dimension (for details see “Dimensioning - Home Tab”, ”Possible Mes-
sages while Changing Dimensions” on page 448).
Never

Damaged dimensions are never saved but are always reverted to their original struc-
ture if possible.
Always

Damaged dimensions are always saved.
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Reset Tool Properties

Automatic Reset 
If this option is activated each time one of the dimensioning tools is activated, tempo-
rary dimensioning attributes (text height for instance) are reset in accordance with the 
default values in the same way they are when using the button Reset of the dimension 
properties dialog.
Keep User Settings 
If this option is selected, temporary dimensioning attributes (text height for example) 
are left as they were from the last use of a dimension creation tool.

Escape

The setting is only available in Administration mode and it is a placeholder for the dis-
play of the formats.  
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Radii and Arc Factor

Search Radii

Figure 247 Dialog Default Settings: Radii and Arc Factor, Search Radii

Hit Radius

specifies the radius which is required in order that MEDUSA4 finds a geometry. Hit 

Radius is not valid for Free and Auto probe specifiers. Default: 2.0
Maximum Radius

specifies the maximum radius of a point using Near, Intersection, Perpendicular, Segment or 
Tangent probe specifiers. Default: 50.0

Coincidence Radius

specifies that separate points are considered for coincidence unless they are sepa-
rated by a distance greater than the Coincidence Radius. Default: 0.00

Auto Probe Radii

Figure 248 Dialog Default Settings: Radii and Arc Factor, Auto Probe Radii

Near Point Radius

is the radius for finding the nearest point using an Auto probe specifier. Default: 2.5
Intersection Radius 

specifies the radius for finding an intersection point using an Auto probe specifier. 
Default: 2.5

Segment Radius

is the radius for finding a segment point using an Auto probe specifier. Default: 2.5
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Please note: The values used in the radii sections have to be specified as screen units (not 
sheet units).

Arc Factor   

Arcs are drawn using a number of straight lines known as chords. The more chords that are 
used to draw the arc, the smoother the curve will appear. The arc factor controls the angles 
between these chords and therefore affects the number of chords which are used to display 
each arc on the MEDUSA4 sheet on your screen. If you set the arc factor to display curves less 
smoothly, this decreases the number of lines which MEDUSA4 needs to draw. Therefore, this 
decreases the time to redraw sheets containing complex geometry.

Please note: Setting the arc factor for displaying the sheet on the screen does not affect the arc 
factor that is used when you print/plot a MEDUSA4 sheet. For information on how 
to set the arc factor in printing see “File Tab”, ”Printing a Sheet” on page 242.

The initial values for the arc factor are set to:

• Curve factor: 0.0125

• Maximum angle: 15.0

• Minimum angle: 3.00

The values submitted are limited to 0.0125 through 100000.0 for the curve factor, and 0.5 
through 60 degrees for the angles. In addition the minimum angle is silently forced to be less 
than or equal to the maximum angle. 

To find out the current arc factor or change it choose the Radii / Arc Factor tab from the Defaults dia-
log.

Figure 249 Defaults Dialog: Radii and Arc Factor, Arc Factor

Curve Factor

If the curve factor is changed or an arc is magnified, the number of chords used to 
describe the curve changes sequentially, for example, 3 to 4 to 5. 
Large arcs (those greater than 90 degrees) are always processed in sections. There-
fore, an arc between 90 and 180 degrees changes in the sequence 2, 4, 6, 8 and so on 
and a complete circle changes in the sequence 4, 8, 12, 16 and so on (see values A 
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and B Figure 250). (see “Note on How the Arc Factor is Calculated” on page 280 for 
more information)

Maximum Angle

If the arc factor increases (or the size of the arc decreases) the number of chords 
decreases until the minimum number of chords is reached. This minimum number is 
controlled by specifying a maximum angle for the chords in the Maximum Angle field. 
The maximum angle is 30 degrees when you start up MEDUSA4. The largest value 
allowed is 60 degrees (see angle C Figure 250).

Minimum Angle

If the arc factor decreases (or the size of the arc increases) the number of chords 
increases until the maximum number of chords is reached. This maximum number is 
controlled by specifying a minimum angle for the chords in the Minimum Angle field.
The minimum angle is 5 degrees when you start up MEDUSA4, however. The smallest 
value allowed is 0.5 degrees (see angle D Figure 250).

Figure 250 Display of the Arc Factor Options

Please note: If you changed the arc factor choose Redraw  from the In Graphics Tool Bar to 
see the result.
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Note on How the Arc Factor is Calculated

This information is included for the benefit of those users who need to understand how 
MEDUSA4 calculates the arc factor.

The number of segments is controlled by the use of a curve factor value which is in turn deter-
mined by the arc factor value that you specify. As each arc is considered, the curve factor is 
compared against a value derived from the following calculation:

curve factor = (chord_height)**4 / (chord_length)**2

chord_height
is the height of the arc above the chord at the midpoint of the arc (see Figure 250, B).

chord_length
is the length of a chord drawn between the two end points of the arc (see Figure 250, 
A).

If the value is exceeded the arc is halved and the calculation and comparison repeated.

This calculation and comparison is performed using sheet units and is not related in any way to 
the screen size of the element. As a result, when you zoom in or if you use small curves, the 
display of arcs becomes more ragged and you need to reduce the curve factor to maintain a 
smooth curve. The curve factor value is derived from the arc factor value using the following for-
mula:

curve_factor = 10**((2.0*LOGe(ARCFAC))/LOGe(2.0)) / (sheet_conv)**2 

Parametric

The Parametric tab is only available after activating the Parametric license via File > Options > 

Licenses.

For details on Parametric, please, refer to the Parametric User Guide.

Design Objects

For details on Design Objects, please, refer to the Design Objects User Guide.
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Reference System

MEDUSA4 provides three options which are used to control the type of text transformation for 
loaded references.

Figure 251 Dialog Default Settings: 2D Product, Reference System

When text on the source drawing of a reference is transformed, e.g. mirrored or rotated, you 
choose a specified type of transformation in the context menu (RMB) of the transformation tool. 
This type defines the appearance of the text after a transformation. If the text is part of a refer-
ence, you have to specify the same type of transformation within the Defaults dialog, in order to 
display the text accordingly after loading; only then, the transformation of text is executed also 
with the reference analogously to the source drawing.
Legible

The text remains legible after the transformation.
For example, a text is mirrored along an axis but it is not displayed mirror-inverted.

Fixed

The direction of a text is kept.
For example, an originally horizontally created text, which is transformed with the rota-
tion tool, remains always horizontally aligned.

Rigid

The text is handled in the same way as other elements, regardless of its legibility.
For example, a text, which is mirrored along an axis, is also displayed mirror-inverted.

For detailed information on text transformation please refer to “Transformation of Text Ele-
ments” on page 321. on references read “Reference Sheet Procedure” on page 715.

Raster Backdrop

The Raster Backtrop setting options are only available after activating the MEDCOL-RASTER license 
via File > Options > Licenses.

For details on Raster Images please refer to MEDRaster Guide.
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Figure 252 Dialog Default Settings: 2D Products, Raster Backdrop

3D Products

The 3D Products tab is only available after activating the 3D Design licenses via File > Options > 

Licenses.

For details on 3D Products please refer to the 3D Design Guide.
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MEDUSA4 provides many options for setting global parameters in your application by using 
Options on the File Tab.

This chapter introduces you to all options. But some of the options are more complex and 
require a detailed explanation. Therefore they are described in more detail in separate chapters. 
A note is provided in relevant sections.

• Options Overview................................................................... 284

• Administrator.......................................................................... 285

• Layer Management ................................................................ 289

• Accelerators and Mapkeys..................................................... 291

• Change Directory ................................................................... 296

• Licenses................................................................................. 297

• Auto Sheet Save .................................................................... 298

• Reset Customization.............................................................. 299

• Plotter Configuration .............................................................. 300

• Interfaces Configuration......................................................... 304
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Options Overview

If you choose Options on the File tab the following options are displayed:

Figure 253 File > Options - Overview

The options are explained in the following sections.
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Administrator

Particular settings can only be made by the Administrator. The Administrator has special rights, 
especially to ensure that specified company standards can not be changed by any user arbi-
trarily. To access the Administrator modus you have to log in by using a password.

Please note: The default Administrator password after installation is admin.
You can only change the password if you are logged in as Administrator.

Choose the File tab on the ribbon > Options > Administrator.

The following options are displayed:

Figure 254 File Tab > Options > Administrator
© CAD Schroer GmbH                             285



MEDUSA4 Drafting
Options
Log-In, Log-Out, Change Password

Figure 255 Administrator Log-In, Log-Out and Change Password

• In order to log in as Administrator insert the password and click on the button  to 
confirm.

• In order to leave the Administrator mode click on the button .

• In order to change the password first type in the new password in the upper text field 
then repeat the entry in the field below and confirm with .

Change Background Color

MEDUSA4 opens sheets by default with an light colored background. You can change the back-
ground color by using this option. You have to be logged in as Administrator to be able to use 
this option.

MEDUSA4 provides a range of colors, from which you can select the desired one.

Figure 256 File Tab > Options > Administrator > Change the Background Color

Click on the desired color and confirm your choice with .
The sheet appears directly in the chosen color.

When you quit the program you are asked if you want to save the settings as default.
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You have to be logged in as Administrator to be able to use this option.

Figure 257 Compiling the Standard Definition Files for Fits

Using this button the default definition files for fits, fits-metric.dat and fits_imperial.dat, are com-
piled to a binary file. Within these files the Administrator defines the fits according to the stan-
dards of the company. The binary file is used internally by MEDUSA4 when creating 
dimensions. If something changes, these files change and the binary file needs to be compiled 
again for the usage within MEDUSA4.

You can edit them with a usual text editor.

First click on the button  to compile the files and then click on  in the status area to display 
the messages in the message area.

Figure 258 Messages in the Message Area after Compiling the Standard Definition Files

For dimensioning MEDUSA4 reverts to the binary file (e.g. fits.bin). In the Dimension Properties 
dialogs you have to activate Limit/fit by setting a check mark in the choice box. With this you are 
able to choose the needed fit for your dimension.

Figure 259 Figure 149 Limit/Fit Choice Box in Dimension Properties Dialog

If you click on the Look up table button the Limits and Fits dialog opens. It provides the list of defined 
fits from the definition files (.dat). Choosing an entry the according identification code is added to 
the dimension.
For detailed information about dimensioning see chapter “Dimensioning - Home Tab” on 
page 413.
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You can store the settings of your MEDUSA4 session in a text file. The relevant option is only 
available if the Administrator mode is activated.

Figure 260 File > Options > Administrator > Saving the Definition of Environment in a File

Choose File tab > Options > Administrator > Saving Environment Definition in Text File.

A file browser opens showing the predefined File Type *.txt of a text format file.

1. Select a directory and enter a name for the file in the File Name field.
2. Click on Save.

The environment settings and environment variables of your MEDUSA4 session are stored in 
the defined text file.
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Choose the File tab on the ribbon > Options > Layer Management.

The Layer Management dialog opens. It provides two tabs, the Layer Properties tab and the Layer Set 

Management tab. The Layer Set Management tab is only enabled if you are in Administrator mode.

Figure 261 Layer-Management Dialog, Layer Properties Tab

On the Layer Properties tab you can define particular properties of single layers and set the layer 
datum.
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Figure 262 Layer Management Dialog, Layer Set Management Tab

On the Layer Set Management tab you can define layer sets and layer set properties.

Due to the complexity of Layers this topic is covered in a separate chapter (see “Layers” on 
page 143).

(For details on Layer Properties see “Layers”, ”Layer Properties” on page 150, for details on 
Layer Set Management see “Options”, ”Layer Management” on page 289)
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Accelerators and Mapkeys

MEDUSA4 provides the possibility to set up accelerator and mapkeys for nearly every function 
and tool you can access.

Accelerator Keys

In MEDUSA4 you easily can assign frequently used functions and tools to shortcuts that you 
know from other applications, e.g. Ctrl+C or Ctrl+V.

Choose on the ribbon > File > Options > Accelerators and Mapkeys to display the following dialog.

Figure 263 Accel Mapkey Editor Dialog > Accelerator Tab
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The dialog provides the Accel tab and the Mapkey tab. By default the Accel tab is displayed. The 
dialog contains a window which displays a table with three columns, showing Accel, Function and 
Icon.

As you scroll through the list, you find many accelerator keys which are already assigned to 
MEDUSA4 functions by default. 

For changing an accelerator key assignment do the following steps:

1. Click the LMB on the line inside the list whose key is to get another function assigned.
Below the list the accelerator key, the assigned function and its icon is displayed.

2. Click the LMB on the Choose a button to map button.

Figure 264  Accelerator & Mapkey Editor Dialog > Accelerator Tab > Choosing a Button

The field displaying the function text is cleared.
3. Choose a function/tool, e.g., by clicking on a tool button in the ribbon.

Figure 265 Accelerator & Mapkey Editor Dialog > Accelerator Tab > Choosing a different Tool

The description of the chosen function or tool is displayed inside the field which was 
cleared in the last step. Also the icon changes to the new function.

4. Click the LMB on the Assign button top right of the dialog.

Figure 266 Accelerator & Mapkey Editor Dialog > Accelerator Tab > Assign

The assignment is changed and the new function text and icon is displayed inside the 
list of available accelerator keys.
However it can be, that the function you choose is already assigned to a shortcut.
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In this case the following request is displayed.

Figure 267 Request Window

If you still want to assign the function to the chosen accelerator key, confirm with Yes.
5. Apply your settings by clicking OK or Apply.

The changed accelerator key assignment can be used now.

For changing the accelerator key, do the following:

1. Click the LMB on the line inside the list whose key is to be changed.
Below the list the accelerator key, the assigned function and its icon is displayed.

2. Click the LMB into the Accelerator field.
3. Press another key combination on your keyboard, e.g. Shift+k.

If the key combination is new, the field is updated according to the pressed keys and it 
displays, for example, Shift+K. Each string belonging to the combination starts with 
an uppercase letter. The function text remains unchanged
If the key combination already exists, the appropriate function text is given for it and 
the existing key combination is displayed in small letters. You have to restart changing 
the accelerator key. Go back to step 1.

4. Click the LMB on the Assign button.
The assignment is changed.

5. Apply your settings by clicking OK or Apply.
The changed accelerator key can be used now.

For removing an accelerator key, do the following:

1. Click the LMB on the line inside the list whose key is to be removed.
Below the list the accelerator key, the assigned function and its icon is displayed.

2. Click the LMB on the button Remove top right of the dialog.
The assignment is removed from the list of accelerator keys.

3. Apply your settings by clicking OK or Apply.
The removed accelerator key cannot be used anymore.

For adding an assignment of an accelerator key to a function or tool do the following steps:

1. Click the LMB into the Accelerator field below the list.
2. Press a key combination on your keyboard, which is not defined till now, e.g. shift+q.

The field below the list is updated according to the pressed keys and displays, e.g., 
Shift+Q. The function text remains unchanged.
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3. Click the LMB on the Choose a button to map button .
The field displaying the function text is cleared.

4. Choose a function/tool, e.g., by clicking the LMB on a tool button in the ribbon.
The description of the chosen function or tool is displayed inside the field which was 
cleared in the last step. Also the icon changes to the new function.
However it can be, that the function you choose is already assigned to a shortcut. In 
this case the accelerator field below the list changes and displays the already existing 
shortcut definition.
If you still want to assign the function to the chosen accelerator key, you have to 
remove the assignment first and then add a new assignment (see below).

5. Click the LMB on the Assign button.
The assignment is added and the new definition is displayed inside the list of available 
accelerator keys.

6. Apply your settings by clicking OK or Apply.
The added accelerator key can be used now.

For using an accelerator key, do the following:

1. Move the mouse cursor into the graphics area.
Ensure that the graphics area is active, by clicking either on the title bar of the main 
window or - in case a dialog window is still active - pressing the Alt+s keys on the 
keyboard.

2. Press a key combination on your keyboard, e.g. shift+q.
The assigned function is executed according to the key definition.

Mapkeys

Mapkeys are another way of building shortcuts for frequently used functions and tools. Against 
accelerator keys, a mapkey consists of letters only.

1. Choose File tab > Options > Accelerators and Mapkeys.

The Accelerator & Mapkey dialog is displayed.
2. Choose the Mapkey tab
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Figure 268 Accelerator & Mapkey Editor Dialog - Mapkey Tab

As you scroll through the list, you find some mapkeys which are already assigned to functions 
by default.

You can:

• change assigned functions

• change key combinations

• remove mapkeys

• add new key assignments.

The procedures for editing, removing, changing and adding mapkey definitions are similar to 
those for “Accelerator Keys” on page 291.

When the cursor is over the graphics area and you press the Alt+s keys and then a letter key 
on your keyboard, MEDUSA4 automatically detects this as the beginning of a mapkey. 
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Usually the current directory is the directory from which you start MEDUSA4. The chosen direc-
tory will be used in the file browser, e.g. when loading a sheet or a symbol.

But you can change the current directory.

1. Choose File tab > Options > Change Directory to open a file browser.
2. Select any directory.

The directory name is displayed in the Directory field.
3. Click on Choose Directory.

The selected directory is your current directory now.

The current working directory is automatically listed under Favorites of the Windows Explorer. 
When you change the directory, the directory is also updated under Favorites.

Figure 269 Automatic Display of the Current Directory in the Explorer Favorites
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In order to be able to use particular MEDUSA4 products you have to activate the relevant 
license first. Which licenses are displayed depends on the products you have installed.

Choose File tab > Options > Licenses.

Figure 270 File Tab > Options > Licenses

The text box displays the Licenses which are already activated and additional information to the license.

To activate a license click on the relevant button (icon) at the left hand side. When you quit the 
session, the license has to be activated again when you start MEDUSA4 for a new session.

If you want a license to be activated with the next MEDUSA4 session, set a checkmark in the 
box right of the button text and save the modified defaults when you quit the program.

The activated license is displayed in the list above and the tools which require a particular 
license, e.g. Parametric, are enabled on the ribbon tab.
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Auto save saves the current drawing under a chosen path in a file named 
autosave_<no>_<username>.sas and can be loaded as a sheet in MEDUSA4.

You can define both the directory with the path where a file is to be saved automatically and the 
interval in which it is saved automatically. 

1. Choose File tab > Options > Auto Sheet Save.
The Auto Save Dialog is displayed.

Figure 271 Auto Save Dialog

2. Enter the number of seconds in the Save Every field to define the time interval in which 
the file is to be saved automatically.

3. Select the Location on your hard disk where your sheet is to be saved.
The pulldown list provides the following options:

current
saves the sheet in the current directory
home
saves the sheet in your home directory
user
saves the sheet in the directory that you define in the Path Selection field.
The Path Selection field is only enabled if user is selected in the Location field.

4. Click on OK to apply the settings on the current sheet or click on Cancel to ignore the 
settings and close the dialog.
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Reset Customization 

Using this option you can reset any customization which you made in the user interface, e.g. 
Ribbon or Dashboard to the original default settings.

1. Choose File tab > Options > Reset Customization.

Figure 272 Options > Reset Customization

2. Confirm the resetting by clicking on the check mark.
3. Restart MEDUSA4 to get the default settings.
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This option is only available if the Administrator mode is activated.

Choose File tab > Options > Plotter Configuration.

The Plotter Configuration dialog is displayed.

Figure 273 File Tab > Options > Plotter Configuration Dialog

The dialog allows you to add and configure printers or plotters to use for printing MEDUSA4 
drawings.

The Plotters field lists all plotters that are installed in your MEDUSA4 project. The plotters/printers 
may be connected to different printer drivers or may be connected to the same printer driver but 
with different configurations.
Add...

opens the dialog for adding a printer (for details see “Adding a Printer” on page 301).
Properties...

opens the dialog for editing the properties of a selected printer (for details see “Proper-
ties” on page 302).

Delete

deletes a printer by selecting the printer name from the Plotters list and then click the 
Delete button.

Edit Description

opens a text editor with the description file for the selected printer (for details see “Edit 
Description” on page 303).

Please note: Printing and plotting need a temporary directory for writing intermediate files, e.g. 
c:\temp. If there is no directory like this on your system, please create it.
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Adding a Printer

To install a new plotter or printer in your MEDUSA4 project:

1. Click the Add... button on the Plotter Configuration dialog.
The Add Plotter dialog appears.

Figure 274 Add Plotter Dialog

The dialog displays a list of available plotter drivers. There may be a number of differ-
ent drivers depending upon the printers available at your site. Refer to your System 
Administrator for information about each printer driver.

2. Type a name for the printer in the Name entry box.
3. Select the printer driver that you wish to use.

For each driver different configuration files can exist (e.g. for the driver qtplot amongst 
others there are configuration files for creating black/white or colored PDF files).

4. Select a Description file.
5. Select the Logging choice box(es) if you wish to create a log file showing details of all 

your printing jobs.
• Logging... enters general details about each print job into the log file. For example, the 

time and date at which the file was printed, the number of copies and the length of 
time it took to print.

• Full Logging... enters more detailed information about each print job into the log file. 
This option is grayed out until you select the Logging choice box.

Please note: The name of the log file is automatically defined to be Name with extension .log.

6. Click OK.
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The new printer is added to the Plotter list in the Plotter Configuration dialog. An information 
dialog appears, giving you information about the plotter you have created and location 
of the plotter configuration file. An example of this is shown in Figure 275.

Figure 275 Plotter Information Dialog

If there are no plot products in your product list, an error message is displayed.

Properties

To view the current properties of a plotter, or to turn logging on or off, select the printer name 
from the Plotter list in the Plotter Configuration dialog, and press the Properties... button. 
The Plotter Properties dialog appears, as shown in Figure 276. 

Figure 276 Plotter Properties Dialog

This dialog gives the name of the printer and the driver to which it is connected. 
Select or deselect the Logging and Full Logging choice boxes as required to turn log file creation on 
or off (see “Adding a Printer” on page 301).
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To configure an installed printer, you must first open the printer configuration file for editing. 
To do this, either:

• Select the plotter name from the Plotter list in the Plotter Configuration dialog, and press the 
Edit Description... button. The file opens in a new window.

• Use your standard system File Open options to open the relevant printer configuration 
file. The file has the name <plottername>.des.

Please note: You were informed of the name and location of this file when the printer was 
added. For example: <medusa4>\MASTER_PROJECT\superprint\macro\Plotter.des
You can use this file to configure the printer in a number of different ways. Printer 
configuration is generally defined by your System Administrator. 
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In MEDUSA4 you can set up several parameters for importing and exporting files in DXF/DWG 
AutoCAD exchange and standard format.

Choose File tab > Options > Interfaces > DXF/DWG Configuration.

The following options are available. 

Figure 277 File Tab > Options > Interfaces > DXF/DWG Configuration

For details on topic „Interfaces“, please, refer to the CAD Convert User Guide.

Button Function

opens the Options DXF/DWG Interfaces dialog
The dialog provides two tabs
MEDUSA4 R6 -> DXF/DWG and DXF/DWG -> MEDUSA4 R6.
On the first you can make settings for the import of AutoCAD files into
MEDUSA4 R6 the second one is used for the export of MEDUSA4 files into AutoCAD.

This option is only available in Admin mode!
opens the CADConvert Mapping Tables dialog. It provides the tabs for all configuration files 
that define the mapping of lines and texts when converting MEDUSA4 files into DXF/
DWG (AutoCAD format) and vice versa.

opens the CADConvert Configuration Path dialog
It displays a list of all sub directories which are located in the cc_custom directory of your 
user product and contain a cadconvert.cfg file.
You can select the desired file from the list.
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This chapter describes the tools of the Creation tool group which are available on the Home tab of 
the ribbon.

• Creation Tool Group - Overview............................................. 306

• Creating New Element with New Properties .......................... 310

• Creating New Element with Properties of an Existing............ 311
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Creation Tool Group - Overview

The Creation tool group is located on the ribbon, leftmost of the Home tab.

Figure 278 Home Tab > Creation Tool Group

The group provides tools which can be used for:

• creating a new element with new properties
or

• creating a new element with properties of an existing element

The figure above shows a tool for creating a line. According to this tool the Dashboard below 
the ribbon displays the Line Dashboard with the General Properties of lines. (See also ”Dash-
board”, “Display Properties” on page 84)

Figure 279 Line Dashboard - General Properties

A click on the triangle below the tool icon opens a pulldown menu which provides additional 
tools.

Figure 280 Home Tab> Tool Group Creation - Pulldown-Menu
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Once you click on a tool in the pulldown menu the icon of the selected tool appears on the rib-
bon. The relevant Dashboard is displayed showing the default General Properties of the element that 
can be created with this tool.

Figure 281 Example: Prim Creation Tool and Prim Dashboard

(See also ”Work Environment”, “Dashboard” on page 35 and ”Dashboard”, “Element Specific 
Dashboard” on page 75)
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The pulldown menu provides the following tools:

Table 9    Tools on the Creation Pulldown Menu and their Function

Tool Function

Line
Creates lines of specified type and properties
For details see ”Lines - Home Tab”, “Creating a Line” on page 341

Group
Creates a named group
For details see ”Creating Groups”, “Creating Groups” on page 615

Crosshatches
Crosshatches the selected areas
For details see ”Area Fills”, “Using the Crosshatch or Stipple Tools” on 
page 572

Angular
Default angular dimension format
For details see ”Dimensioning - Home Tab”, “Creating Angular Dimen-
sions” on page 441

Arc
Arc dimension
For details see ”Dimensioning - Home Tab”, “Creating Circle and Arc 
Dimensions” on page 437

Linear
Default linear dimension format
For details see ”Dimensioning - Home Tab”, “Creating Linear Dimen-
sions” on page 421

Radial
Dimensions the radius of a circle
For details see ”Dimensioning - Home Tab”, “Radial Dimension Proper-
ties” on page 439

Note
Creates note with horizontal orientation
For details see ”Dimensioning - Home Tab”, “Creating Notes” on page 
450
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Prim
Creates Prim of specified type and properties
For details see ”Predefined Graphical Shapes (Prims)”, “Adding Prims 
to a Sheet” on page 545

Stipple
Stipples the selected areas
For details see ”Area Fills”, “Using the Crosshatch or Stipple Tools” on 
page 572

Table
Creates a table
For details see ”Tables”, “Creating a Table” on page 557

Text
Creates text of specified type and properties
For details see ”Text - Home Tab”, “Creating Text” on page 502

Symbol
Selects symbol libraries
For details see “Symbols - Home Tab” on page 593 et seqq.

Table 9    Tools on the Creation Pulldown Menu and their Function

Tool Function
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You can create a new element with any combination of properties by first selecting a Create tool 
from the ribbon and then setting the properties in the Dashboard to the desired values.

For example, to create a line:

1. Select the Create Line tool on the ribbon > Home tab > Creation tool group.
2. Choose Free style from the Style pulldown list. 

Styles are explained in more detail in the following section. For now we choose a style 
which allows us to modify all fields.

3. Set the Thickness and Color properties. 
4. Create the line by probing on the sheet.

The line is created with the defined properties.
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Creating New Element with Properties of an Existing

You can create a new element with the same properties as an element that already exists on 
the sheet.

1. Select the element whose properties you want to clone.
The Dashboard changes to reflect the properties of the selected element.
The relevant tool for creating this element is displayed on the ribbon > Home tab > tool 
group Creation.

2. Click on the tool to activate it.
3. Create the new element.

The new element is created with the same properties as that one you originally 
selected.

Example

On your sheet there is line with particular properties which do not comply with any default line 
style. You want to create a line of exactly the same properties.

1. Select the line on the sheet.
The Creation tool group accordingly displays the Creates lines of specified type and properties 
tool.

2. Click on the tool to activate it.
3. Draw the new line.

The properties of the new line comply with the properties of the previously selected 
line.

Now you have the following options:

• create additional lines of the same properties by choosing the New Line option from the 
RMB popup menu

• quit the tool by choosing the Exit tool option on the RMB popup menu

• quit the tool by choosing a different tool
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This chapter describes the tools of the Clipboard tool group which are available on the Home tab of 
the ribbon.

• Functions - Overview ............................................................. 314

• Cut, Copy and Paste.............................................................. 315

• Area Cut and Area Copy........................................................ 318
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Functions - Overview

The Clipboard tool group on the Home tab contains the following buttons:

Figure 282 Home Tab > Clipboard Tool Group

The functions of the buttons are:

There are two different default settings for the Copy and Cut tools in the Clipboard tool group. You 
can activate or deactivate Copy to Clipboard.
Copy to Clipboard means that copied elements are also saved in the buffer of the operating system 
as graphics suitable for pasting into other applications. You can toggle between Copy to clipboard 
and Copy as explained in “Default Settings”, ”Switches” on page 264.

Table 10    Overview of Functions

Button Function

Copy
Copies the selected elements and stores them in a buffer
(For details see “Cut, Copy and Paste” on page 315)

Area Copy
Copies elements within a defined area and stores them into a buffer.
An area is defined by a closed line of any style
(For details see “Area Cut and Area Copy” on page 318)

Cut
Removes selected elements from the sheet and stores them into a buffer
(For details see “Cut, Copy and Paste” on page 315)

Area Cut
Cuts elements which are located within an defined area and stores them into a buffer. 
An area is defined by a closed line of any style.
(For details see “Area Cut and Area Copy” on page 318)

Paste
Places cut or copied elements which are stored in the buffer back onto the sheet
(For details see “Area Cut and Area Copy” on page 318)

Delete
Removes any selected element from the sheet
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Cut, Copy and Paste

The tools are used to cut or copy selected elements and paste them at a certain point on the 
sheet. While pasting you can manipulate the elements. 

Cut

1. Select one or more elements.
2. Choose the Cut tool .

The selected elements disappear from the drawing and are stored in the buffer for 
pasting the element(s).

The Cut functionality is also available with the popup menu inside the graphics area when the 
default selection tool is active. (see “Popup Menus” on page 44)
It works a little different: 

1. Select one or more elements.
2. Choose Cut from the popup menu.
3. Define a datum point for the selection by probing on the selected elements.

The selection disappears from the drawing and it is stored in the paste buffer for past-
ing the element(s). The defined datum point is the point at which the elements will be 
placed. Now they are ready for pasting anywhere on the sheet.

Copy to Clipboard/Copy

1. Select one or more elements.
2. Choose Copy to Clipboard/Copy tool .

The copied elements are stored in the paste buffer and you can paste them now.

Please note: If the menu entry is Copy to Clipboard instead of Copy, the elements stored in the paste 
buffer are also available for pasting them within other applications. (See also 
page 314)

The Copy functionality is also available with the popup menu inside the graphics area when the 
default selection tool is active. It works the same way as described for ”Cut”.
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Popup Menu While Pasting

You have copied or cut elements and with it stored in the buffer. Now you want to place the ele-
ments on the sheet again. During pasting you can manipulate the elements using the options 
from the popup menu.

Figure 283 Paste Popup Menu

Please note: Some options open an input field attached to the cursor. You can either enter val-
ues directly by using the keyboard and confirm with Enter-key or alternatively 
you can enter a value by keeping the Ctrl-key pressed which “freezes“ the input 
field and you can move the cursor into the field, typing a value and click on the 
check mark to apply the value.

Recreate structure

If you select elements which belong to a group by using 
the Selects elements of any type tool , copy and paste them via the RMB popup menu, 
these elements are added to the existing group.
If you click on the entry Recreate structure before you paste the selected elements and 
paste, the copied elements build their own group. That means, the existing structure is 
reproduced.

Rotate 90

rotates the attached elements by 90 degree counter clockwise around the datum point 
of the selection.

Rotate

opens an input field attached to the cursor. Now you can define the angle by which the 
selection is to be rotated.

Figure 284 Input Field - Angle of Rotation l
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Enter the value for the angle and press Return to apply the defined value on the selected ele-
ments.
Magnify

allows you to re-size the attached elements. When you choose this entry an input field 
opens, where you can specify the magnification factors in x- and y-direction.

Figure 285 Input Field - Magnification Factor

Positive factors larger than 1 increase the size.
factors larger than 0 and smaller than 1 decrease the size
Negative values and 0 cause an error message
After typing in the magnification factors press Return for applying the values.

Dyn. scaling off, Dyn. scaling on

Toggles dynamic scaling on or off. With dynamic scaling on, pasted elements are 
dynamically sized according to the current scale in the drawing. You can see the effect 
only if your sheet has different scale views defined. 
If you click on Dyn. scaling off dynamic scaling is switched off and the entry turns to 
Dyn. scaling on.

Undo

cancels the last action.
Exit Tool

quits the tool.

Perform Pasting

1. Select the Paste tool on the Home tab > tool group Clipboard and move the cursor into the 
graphics area.
The elements from the buffer are attached to the cursor.
If you want to manipulate the attached elements click on the RMB to open the popup 
menu.
(see above “Popup Menu While Pasting” on page 316)

2. Click the LMB to paste the attached elements.
Now you can:
a. choose Exit Tool from the popup menu to finish pasting or
b. click in the graphics area to paste the elements once more on the sheet

Paste is also available with the popup menu inside the graphics area when the default selection 
tool is active. It works the same way as described above for Paste from the Edit menu.
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On the Home tab > tool group Clipboard both the Area copy tool  and the Area cut  tool are avail-
able. They allow you either to cut or copy selected elements surrounded by a closed line and to 
select a datum point to position the cut or copied elements.

Please note: If there is at least one tangent point arc in the part of a line included in the selection 
area, all arcs in this line are changed to tangent point arcs. If a line does not, all 
arcs remain as circular arcs.
If you want all arcs to be circular arcs, set area_copy_convert_all_arcs to 
true in the file defaults.dat. To activate the change, re-configure your project as 
described in the Administration Guide.

1. Create a closed line of any style/type around the objects you want to cut or copy.
2. If it is not already selected, select the line.
3. Select either the Area copy or the Area cut  tool.

All elements inside the line become selected.
4. Choose the Apply option from the popup menu. 
5. Select a position as the datum point for the cut or copied elements.

The selected elements are cut or copied and they are stored to the buffer, ready for 
pasting.

6. Choose either the Paste tool on the Home tab > Clipboard or the paste option from the RMB 
popup menu.
The selected elements are attached to the cursor at the datum point.

7. Move your cursor until the elements are at the required location.
8. Click the LMB to paste the elements on the sheet.
9. Now you can:

a. choose Exit Tool from the popup menu to finish pasting or
b. click in the graphics area to paste the elements once more on the sheet
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Overview

Once you select elements you can transform them, for example, move, rotate or mirror. Trans-
formation tools are shown in Figure 286. Many of the tools allow you to transform the selected 
elements or to make a copy of them and transform the copied elements. 

The transformation tools also include the tools for creation and deletion of group lines because 
these lines are used for marking several elements which then can be transformed the same 
way. 

Figure 286 Transformation Tools in the Home tab

Pulldown menus containing toolsets
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Transformation of Text Elements

If you want to transform text elements as well as geometry, for some transformation tools (like 
rotation or mirroring) you can define, how texts will be handled. You can open the following 
popup menu by clicking the RMB on the transformation tools.

Figure 287 Popup Menu for Handling Texts during Transformations 

The options Legible, Fixed and Rigid control the display of a text after an appropriate transforma-
tion. The activated option appears disabled in the popup menu.
Legible The text remains legible after the transformation.

For example, a text is mirrored at an axis but it is not displayed mirror-inverted.
Fixed The direction of a text is kept.

For example, an originally horizontally created text, which is transformed with the rota-
tion tool, remains always horizontally aligned.

Rigid The text is handled in the same way as other elements, regardless of its legibility.
For example, a text, which is mirrored along an axis, is also displayed mirror-inverted.

Figure 288 Example for transforming text elements
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Move Elements

Selected elements can be moved on the sheet. In MEDUSA4 you have two possibilities to 
move elements:

• using the popup menu, available in the graphics area, see below

• using the toolset for moving elements, see “Moving with the Move Tools” on page 323

Moving with the Popup Menu in the Graphics Area

1. Select elements on the sheet.
2. Right click on the graphics area to open the general popup menu.

On top of the popup menu there is a move function for easy handling.

Figure 289 Popup Menu Option Move

3. Choose the option Move.
The selected elements are attached to the crosshair.
Now you have the possibility to choose another datum point or to exit the function 
inside a further popup menu.

Figure 290 Popup Menu during the Move

4. If you click Choose datum point, you have to define the datum point before moving either by 
entering values into the text fields or by clicking left into the graphics area.

Please note: You can change the default procedure of this function in the file defaults.dat by 
changing the entry gen_move_bydatum boolean false to true (then you 
have to re-compile the defaults, see Customization Guide, chapter Running 
MEDCONFIG). 

5. Place the selected elements by clicking left into the graphics area.
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Moving with the Move Tools

Figure 291 Move Toolset

From top to bottom the following tools are available:

• Move the selected elements 

• Duplicates and moves the selected elements 
copies the selection and then moves this copy.

• Duplicates and moves the selected elements with an optional repeat 
copies the selection and then moves this copy. This operation will be repeated auto-
matically as often as you have defined this (for this the additional input field Repeat is 
provided).

How to Move Elements

The procedure of moving is the same for all tools.

1. Select elements on the sheet.
2. Choose, for example, the Move the selected elements tool.

Please note: Having chosen the tool, consider the messages in the message area. Each step 
will be displayed there.

3. Move the selected elements.
For this you have the following possibilities:
• Using the mouse 

If you click left, the selection is attached to the mouse cursor. The next left click 
places the elements at the target position.

• Using the input fields By X and By Y 
In the edit fields By X and By Y type in the movement values in X and Y direction. If 
you confirm the values by pressing the button Return on your keyboard or clicking 
left on the check mark behind the edit fields, the selected elements will be moved.

• Using the coordinates input fields 
Details are described in chapter “In Graphics Probe Bar“, “Entering Points using 
Cartesian Coordinates” on page 117.
Define the start point of movement in the coordinates input fields and confirm the 
values by pressing the button Return on your keyboard or clicking left on the check 
mark behind the edit fields. Then open the coordinates input fields again to define 
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the target point. This target point is relative to the start point. If you confirm the val-
ues by pressing the button Return on your keyboard or clicking left on the check 
mark behind the edit fields, the selected elements will be moved. The result of 
movement will be entered in the fields By X and By Y and is available for the next 
movement.

Popup Menu of the Move Tools

The move tools provide a popup menu in which you can toggle between the tools. The current 
tool is displayed grayed out. The further options Undo and Exit Tool work as usual.

Figure 292 Popup Menu of the Move Tools
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Rotate Elements

Selected elements can be rotated on the sheet. As for moving elements you can copy elements 
one or more times before rotating them.

Figure 293 Rotate Toolset

From top to bottom the following tools are available:

• Rotates the selected elements 

• Duplicates and rotates the selected elements 
copies the selection and rotates this copy.

• Duplicates and rotates the selected elements with an optional repeat 
copies the selection and rotates this copy. This operation will be repeated automati-
cally as often as you have defined this (for this the additional input field Repeat is pro-
vided).

How to Rotate Elements

The procedure of rotating is for all tools the same. 

1. Select elements on the sheet.
2. Choose, for example, the Rotates the selected elements tool.

Please note: Having chosen the tool, consider the messages in the message area. Each step 
will be displayed there.

3. Choose the point of rotation on the sheet (in message line datum point is shown).
For this you have the following possibilities:
• Using the mouse

If you click left, the click point becomes the fulcrum.
• Using the coordinates input fields 

Details are described in chapter “In Graphics Probe Bar“, “Entering Points using 
Cartesian Coordinates” on page 117
If the exact coordinates of the fulcrum are known but this point cannot be defined by 
a mouse click clearly, enter the coordinates in the coordinates input fields and con-
firm with Return or the check mark.
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4. Define the angle of rotation.
For this you have the following possibilities:
• Using the mouse 

If you click left, the selection is attached to the mouse cursor. If you move the 
mouse, the selection is rotated about the fulcrum. The next left click places the ele-
ments at the target position.

• Using the input field Angle 
If the rotation angle is known exactly, enter it in the field Angle and confirm by press-
ing Return or the check mark. The selected elements will be rotated immediately.

• Using the coordinates input fields 
Details are described in chapter “In Graphics Probe Bar“, “Entering Points using 
Cartesian Coordinates” on page 117.
If the rotation angle is unknown, but can be defined by points on the sheet, use the 
coordinates input fields. 
First define the start point and confirm the values by Return or the check mark. 
After this open the coordinates input fields again to define the target point. If you 
confirm the values with Return or the check mark, the selected elements will be 
rotated by the angle which is defined by the virtual lines built between fulcrum and 
start point and fulcrum and target point.
The result of rotation will be entered in the field Angle and is available for the next 
rotation. An example is provided in ”Example - Rotation Angle unknown”.

Popup Menu

The rotation tools provide a popup menu in which you can toggle between the tools. The current 
tool is displayed grayed out. The further options Undo and Exit Tool work as usual.

Figure 294 Popup Menu of the Rotation Tools
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Example - Rotation Angle unknown

This example shows you how to rotate a selection without knowing the angle. This is the case 
for example, if you want orientate elements at a known point.

In the following figure you see a rectangle with an arrowhead, which is to be rotated in that way 
that it shows on the coordinate 260/310. The required rotation angle is unknown.

Figure 295 Example for Rotating, Input

1. Select the rectangle and the arrowhead.
2. Choose the Duplicates and rotates the selected elements tool.
3. Click left on the intersection point of the center lines, 150/225, for defining the fulcrum.

The input field for the fulcrum appears at the mouse cursor. Ignore this field because 
the angle of rotation is unknown.

4. Open the coordinates input fields using the tool on the In Graphics Probe Bar.
Details are described in chapter “In Graphics Probe Bar“, “Entering Points using Carte-
sian Coordinates” on page 117.

5. Enter the XY values for the start point in these the fields, 200/225.
6. Confirm your input either by pressing the Return key on your keyboard or clicking left 

on the check mark behind the input fields.
A horizontal line is defined running through the fulcrum and the start point which builds 
the basis for the rotation angle. If you move the mouse cursor in the graphics area, you 
see that the selected geometry is attached to it and rotates around the fulcrum as you 
move the mouse.
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Figure 296 Example for Rotating, before entering the target point

7. Open the coordinates input fields using the tool on the In Graphics Probe Bar again 
and enter the values for the target point, 260/310.

8. Confirm your input either by pressing the Return key or clicking left on the check mark 
behind the input fields.
As a result a line is defined running through the fulcrum and the target point. The angle 
of rotation is the one between this target line and the base line. The selected geometry 
is copied and rotated and points to the target point now. The tool remains active for the 
next rotation. The calculated rotation angle is displayed in the Angle field now and can 
be used for further rotations. 

Figure 297 Example for Rotating, Result
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Mirror Elements

Selected elements can be mirrored on the sheet either in horizontal, vertical or oblique direc-
tion. As for moving elements you can copy elements one or more times before mirroring them.

Figure 298 Mirror Toolsets

From top to bottom the following tools are available:

• Mirrors the selected elements vertically 

• Mirrors the selected elements horizontally 

• Mirrors the selected elements obliquely 

• Duplicates and mirrors the selected elements vertically 

• Duplicates and mirrors the selected elements horizontally 

• Duplicates and mirrors the selected elements obliquely 
The duplication tools copy the selection and then mirror this copy.

How to Mirror Elements

1. Select elements on the sheet.
2. Choose a tool for mirroring.

Please note: Having chosen the tool, consider the messages in the message area. Each step 
will be displayed there.

3. Execute mirroring.
For this you have two possibilities:
• Using the mouse

Click left in the graphics area to define the position of the axis of reflection at which 
the selection will be mirrored.

• Using the coordinates input fields 
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Details are described in chapter “In Graphics Probe Bar“, “Entering Points using 
Cartesian Coordinates” on page 117.
If mirroring is to be performed at a axis of reflection from which the exact coordi-
nates are known, enter the coordinates in the coordinates input fields and confirm 
with Return or the check mark.

In both cases mirroring is executed immediately.

Please note: The axis of reflection will be generated automatically and virtually for mirroring 
horizontal and vertical. So you can click any point on the sheet.
An existing line segment has to be probed for mirroring oblique because it 
defines the orientation of the axis of reflection.

Popup Menus

A separate popup menu is available for Mirroring and Duplicate and Mirroring, in which you 
can toggle between the tools. The current tool is displayed grayed out. The options Undo and Exit 

Tool work as usual.

Figure 299 Popup Menu of the Mirror Tools

The tools for Mirroring provide the following additional option:
Mirror Lock

controls whether dimension text is transformed during a mirror process.
If Mirror Lock is activated (default setting), the dimension text is mirrored.
If Mirror Lock is not activated, the dimension text is not mirrored. 
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Magnify Elements

Selected elements can be magnified on the sheet. As for moving elements you can copy ele-
ments one or more times before magnifying them. 

Figure 300 Magnify Toolset

From top to bottom you find the following tools:

• Magnify the selected elements 

• Duplicates and magnifies the selected elements 
copies the selection and then magnifies the copy.

• Duplicates and magnifies the selected elements with an optional repeat 
copies the selection and then magnifies the copy. This operation will be repeated auto-
matically as often as you have defined this (for this the additional input field Repeat is 
provided).

Please note: Magnifying can also be used for scaling down. You only need to insert factors 
between 0 and 1.

Magnifying elements has the same work flow as it is for movement. 

1. You select elements, 
2. choose the tool, 
3. define the datum point, 
4. specify the magnification factor, 
5. and define the number of repeats if required. 

For further information read “How to Move Elements” on page 323.

The magnify tools provide a popup menu which allows you to switch between the tools of the 
toolset. The current tool is displayed grayed out. The options Undo and Exit Tool work as usual.
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Boundary Groups

A boundary group is a collection of elements (lines, texts, groups, dimensions and prims) con-
tained within a group line. The group line is defined using a special group line style. You can 
manipulate a boundary group, for example, by moving, rotating, or copying. 

Tools

The following figure shows the tools which create and delete group lines and which transform 
boundary groups.

Figure 301 Tools for Boundary Groups

Comparison with Other Methods of Grouping

Boundary groups are intended to set up temporary collections of elements, unlike groups in the 
tree structure which are used to associate permanent collections of elements (for details see 
“Groups & Sheet Structure“, “Interacting with the Structure Tree” on page 187). You can define 
group lines whenever you require and delete them after you have used them.

Creating Group Lines

There are two ways of creating group lines:

• Freehand (point by point) using the Creates group lines tool 

• Using the Creates group line boxes tool 

Please note: When you draw a group line freehand, do not create any curved line segments. 
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Only group lines consisting of straight line segments are valid.

Drawing group lines is done in the same way as drawing any other line. Also here the usual 
popup menus are available (see “Lines - Home Tab“, “Popup Menu While Drawing a Line” on 
page 342 and “Popup Menu for Closed Geometry” on page 345). Some examples of group lines 
are shown in the following figure.

Figure 302 Group Box and Freehand Group Lines

Please note: It makes no difference whether the elements in the group are at sheet level or in 
a permanent group (see “Groups & Sheet Structure“, “The Structure Tree” on 
page 183, et seqq.).

When you enclose some of the points of an element with a group line, you create a 
point group. The other points defining the element are not affected by any operation that you 
carry out on a point group. The figure below shows that by the effect of moving a point group in 
order to shear the elements partially:

Figure 303 Moving a Point Group
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Deleting Group Lines

To delete all group lines, select the Deletes all group lines tool .

Transforming Boundary Groups

You can manipulate boundary groups using any of the tools shown in the Figure 301, “Tools for 
Boundary Groups” on page 332. For transforming points and elements within a group line:

1. Choose one of the tools for manipulating boundary groups.
All group lines and all elements which are crossed or inside the group lines become 
selected inside the graphics area a.

2. The further working steps depend on the tool.
Details can be found here:
• “Moving with the Move Tools“, “How to Move Elements” on page 323
• “How to Rotate Elements“, “How to Rotate Elements” on page 325
• “How to Mirror Elements“, “How to Mirror Elements” on page 329
• “Magnify Elements” on page 331
• “Transformation - Misc Tab“, “Shear Elements” on page 744

For all transformation tools a popup menu is available, which allows you to switch between the 
tools. The current tool is displayed grayed out. The options Undo and Exit Tool work as usual.

Figure 304 Popup Menu while Transforming Groups

The option Switch Dimension Update Off from the popup menu means that selected dimensions are 
updated to its new values after transformation. If you click left on this option, updating will be 
switched off and the display changes to Switch Dimension Update On. We recommend not to do that 
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because then dimensions can be wrong after transformation. The following figure shows an 
example, in which dimensions were updated.

Figure 305 Move a Point Group, Updated Dimensions 
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This chapter explains the basic concepts that you need to understand in order to effectively cre-
ate and edit lines. 

• Line Geometry ....................................................................... 338

• Create Line Tools ................................................................... 340

• Creating a Line....................................................................... 341

• Popup Menu While Drawing a Line........................................ 342

• Closed Geometry ................................................................... 344

• Line Properties....................................................................... 352

• Line Point Properties.............................................................. 358

• Point Functions ...................................................................... 360

• Edit Line Tools........................................................................ 365

• Editing a Line ......................................................................... 376

• Edit Line Popup Menu............................................................ 377
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Line Geometry

MEDUSA4 uses a series of points to define a line. The simplest line is defined by two 
points.The first point defines the beginning of the line and the second point defines the end of 
the line. A single line can contain up to 1000 points.

Many line operations in MEDUSA4 depend on:

• Which point is the current point

• The line direction (the direction the points within the line are numbered)

Current Point

While you are creating a line, the current point is always the most recent point that you create. 
The current point is shown as an arrow. Whenever you choose an edit line tool, the current point 
in the line will be the point nearest to the cursor when you select the line by double clicking. 

Any one of the other points in the line can however be made current, as described in ”Lines - 
Dashboard”, “Navigating a Line” on page 381. If you change the shape of a line, delete or move 
a point, this always affects the current point. New points are always added after the current 
point.

Figure 306 Current Point
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Line Direction

A line is a sequence of points, beginning with point 1. The sequence of the points defines the 
direction of the line. This is shown in Figure 307. The current point marker indicates the direc-
tion of the lines.

Figure 307 Line Direction

Knowing the direction of a line is important for adding a new point to the line as it affects the 
result that you achieve. Line direction and navigating a line is described in ”Lines - Dashboard”, 
“Navigating a Line” on page 381.
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Create Line Tools

The standard line tools are in the Home tab.

Figure 308 Standard Line Tools in the Home tab

SMART Drafting is a tool for easy drafting in MEDUSA4 and it allows to draw geometry in a con-
venient way. Details are explained in chapter “SMART Drafting” on page 397.

The usage of these tools and the possibilities of using supporting functions for drawing are 
described in this chapter.
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Creating a Line

The following procedure describes how to create a line in MEDUSA4: 

1. Choose one of the Create Line tools from the Home tab.

Figure 309 Create Thick Lines Tools

2. Move the mouse cursor to the location on the sheet where you want to create the first 
point in the line and click left.
The first point is created and a line is drawn dynamically as you move the mouse. This 
line looks like a rubber band.

3. Move the mouse cursor to the location on the sheet where you want to create the next 
point in the line and click left.
A point is created and a line is drawn between the first point and the new point.

4. Proceed the same way for all further points.
5. If you want to finish the line, you have several possibilities in the popup menu, e.g. Exit 

Tool from the popup menu. 
The current point marker is removed from the line, indicating that there is now no cur-
rent point and you cannot edit the line any longer. The drawn line remains selected.

While drawing you have the following possibilities:

• Each point can be placed exactly by entering its coordinates as described in chapter 
”In Graphics Probe Bar”, “Entering Points using Cartesian Coordinates” on page 117.

• The popup menu provides several functions for working on the current line. Details are 
described in the section “Popup Menu While Drawing a Line” on page 342.

• If required, you can change the point function of each point in the Line Point Properties dia-
log (see “Changing Point Functions” on page 361).
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While drawing a line the following popup menu is available by clicking the RMB.

Figure 310 Popup Menu While Drawing a Line

Please note: It depends on the stage of drawing which entries inside the popup menu can be 
chosen. For example, if the tool is active but no point is positioned only the Exit Tool 
is available and the other tools are deactivated.

The following entries are provided inside the popup menu:
New Line

finishes the currently drawn line and sets up the function for drawing the next line.
Close Line

connects the current point and the starting point of the line. The current line is still 
active and you can go on drawing this line. If you go on drawing after probing the next 
point of the line, the new segment is drawn and the whole line is closed again between 
the current point marker (given by the arrow tick) and the start point of the line.

Close and New Line

connects the current point and the starting point of the line. The line is finished and the 
function is set up for drawing the next line.

Move Point

is used for shifting the point defined by the current point marker to another position. If 
Move Point is chosen, you can probe the new point by clicking left inside the graphics 
area, or entering coordinates (for details see chapter ”In Graphics Probe Bar”, “Enter-
ing Points using Cartesian Coordinates” on page 117). You can also enter X and Y val-
ues in the input fields at the mouse cursor (By X, By Y) by which the point is to be 
moved.Delete Point

removes the current point. The current point marker is set to the previous point.
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Flip

is only enabled if the current line segment is an arc. Flip switches the current arc to the 
opposite side of the virtual center point of the arc.

Reverse Points in line

is used for changing the line direction. If this option is chosen, the current point marker 
is placed at the neighbored segment and it is reverted.

Undo, Redo

Undo is used for canceling the last action. The button Redo is activated after undoing the 
first time. Redo performs the working step again which was undone before. You can 
undo several actions.

Line Point Properties

opens the Line Properties dialog which, allows you to:
• adjust the style of the current line inside the Line Properties tab (for details see “Line 

Properties” on page 352).
• adjust, for example, the coordinates of the current point inside the Line Point Properties 

tab (for details see “Line Point Properties” on page 358).
Exit Tool

quits the tool.
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Closed Geometry

This section contains information on the most common tools for creating closed geometry. 

Tools

The closed geometry tools enable you to draw closed geometrical shapes. The tools are shown 
in the figure below.

Figure 311 Closed Geometry Toolsets in the Home Tab

Each toolset contains several tools for the appropriate geometry, circle, rectangle and slot. The 
tools differ in the way of drawing. For example, rectangles can be drawn by probing either oppo-
site corners or the center and a corner. Look at the message line displayed in the status area for 
the steps you have to do.

Creating Closed Geometry

The following procedure describes an exemplary flow for creating a closed geometry: 

1. Set a working line style by choosing the create line tool representing the line type you 
need, for example the Create thin solid lines tool .
The Dashboard shows the line style you selected.

2. Choose one of the closed geometry tools, for example, the Creates boxes - defined by oppo-

site corners tool .
3. Probe the first corner by clicking the LMB inside the graphics area.
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You also can enter the point exactly by typing the coordinates inside the X Coord / Y 

Coord fields (see chapter ”In Graphics Probe Bar”, “Entering Points using Cartesian 
Coordinates” on page 117).

4. Probe the opposite corner. You have following possibilities:
• Click the LMB inside the graphics area.
• Enter the exact width and height in the appropriate fields.

Figure 312 Example for drawing a rectangle, second point

The rectangle is drawn. The tool is still active for further drawing.
5. For finishing drawing you can either choose another tool for drawing, or choose the Exit 

Tool from the popup menu (see ”Popup Menu for Closed Geometry”).

Please note: You can enter values either directly by using the key board and switch to the next 
field via Tab-key or you can keep the Ctrl-key pressed, move the cursor into the 
input, type in the values and apply using the Enter-key or check mark.

Popup Menu for Closed Geometry

While drawing a closed geometry the following popup menu is available by clicking the RMB.

Figure 313 Popup Menu While Drawing

Please note: It depends on the stage of drawing which entries inside the popup menu can be 
chosen. For example, if the tool is active but no point is positioned, the functions 
Paste and Undo are deactivated.

The following entries are provided inside the popup menu:
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Closed Geometry Properties

opens the dialog for defining the properties of the closed geometry (see “Closed 
Geometry Properties” on page 347).

Paste

After placing the first closed geometry you can repeat placing this geometry with the 
same properties. After having chosen Paste, the geometry to be pasted is attached to 
the mouse cursor The following popup menu is provided while pasting:

Figure 314 Popup Menu While Pasting

Rotate 
opens a text field below the Dashboard for entering the value of rotation. Posi-
tive values apply clockwise rotation angles, negative values apply counter-
clockwise angles. Entered values are applied either by using the Return key 
on your keyboard or the check mark.

Undo 
cancels the last pasting.

Dyn. scaling off 
switches off dynamic scaling in a scale view. After choosing this option it 
changes to Dyn. scaling on for switching it on again.

Exit Tool 
quits pasting.

Switch Center Lines On

If you choose this entry, centerlines are displayed on the closed geometry that you cre-
ate. The entry in the popup menu turns to Switch Center Lines Off in order to be able to 
switch off drawing centerlines (for details see “Centerline and Centerline Overlap” on 
page 348).

Base Angle

determines the angle at which closed geometry elements are drawn on the sheet (for 
details see “Base Angle” on page 347).

Undo

is used for canceling the last action. You can undo several actions.
Exit Tool

quits the tool.
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While drawing closed geometry choose the Closed Geometry Properties from the popup menu to dis-
play the following dialog.

Figure 315 Closed Geometry Properties Dialog

The Closed Geometry Properties dialog provides the following entries:
Base Angle

determines the angle at which closed geometry elements are drawn on the sheet.
Some examples are provided in “Base Angle” on page 347. 

Add center lines at time of creation

is the option for creating center lines. Further information is given in “Centerline and 
Centerline Overlap” on page 348

Center lines overlap

determines the amount by which the centerlines extend the outline of the element. For 
details see “Centerline and Centerline Overlap” on page 348.

Start Point Function, End Point Function

Each button opens the Point Functions dialog for setting the appearance how centerlines 
start and finish. The edit fields on the right of the buttons allow you to specify a point 
function by its number. For further details see “Point Functions” on page 360. 

OK, Apply, Cancel, Help

work as usual.

Base Angle

The base angle determines the angle at which closed geometry elements are drawn on the 
sheet. The base angle is set to +0.00000 degrees by default. Following figure shows some 
examples.
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Figure 316 Elements Created Using Different Base Angles

To change the base angle:

• Choose Base Angle... from the popup menu and enter a new angle in the Angle field. 
The following closed geometry elements you create with the current active tool are 
drawn using the defined angle. If you change the closed geometry tool the base angle 
is reset to the default value (0).

• Open the properties dialog, then enter the new value in the Base angle field and click left 
on OK. 
For all subsequent closed geometry elements you create, the defined angle is used. 
You can change this only inside the properties dialog by defining a new Base angle.

Centerline and Centerline Overlap

You can choose to display centerlines on the closed geometry that you create. The centerlines 
indicate the horizontal and vertical axis of the geometry rotated by the amount of the base angle 
as shown in Figure 316, “Elements Created Using Different Base Angles” on page 348. For the 
slot tools, the centerlines also pass through the center of the round-slot ends as shown in 
Figure 317.

Base angle 0 degrees Base angle 45 degrees

Base angle -30 degrees
348 © CAD Schroer GmbH



MEDUSA4 Drafting
Closed Geometry
Figure 317 Displaying Centerlines on Slots

You can specify whether centerlines are displayed by the following methods:

• Choose Switch Centerlines On/Off from the popup menu. 
Centerlines are displayed (or not displayed) for all following closed geometry elements 
you create with the current active tool. If you change the tool the option is set to default 
which is that centerlines are off.

• Open the Closed Geometry Properties dialog, then click the Add centerlines at time of creation but-
ton and click left on OK. Centerlines are displayed (or not displayed) for all subsequent 
closed geometry elements you create. You can change this only inside the Closed Geom-

etry Properties dialog by switching off the option Add centerlines at time of creation.

Shapes

All closed geometries can be created as Shapes. This mode allows the shape and center lines 
to be grouped together. In principal it is possible by using all the tools, which are used to create 
closed geometries even you are not in Shape mode. One exception thereby are the tools for 
creating slots; they are especially explained in section ”Lines - Lines Tab”, “Shapes” on page 
675.

Please note: In previous MEDUSA4 versions Shapes were named 2D-Features.

Slot created by 
Slot created by 

probing end points
probing center point 
and an end point
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Activate Shapes

To enable drawing closed geometries as Shapes:

1. Click the RMB on the Line tool group of the Home tab.
A pulldown list is displayed which contains all tools of the Lines tool group.

2. Scroll down the list.
You find the tools for creating closed geometries as Shapes in the lower part of the list.

Figure 318 Shapes Tools in Line Tool Group Selection List

3. Activate the Shape tools by setting a check mark in the relevant check boxes.
The tools are displayed in the Line tool group on the ribbon.

Figure 319 Home Tab > Line Tool Group > Shape Tools

Please note: Consider that you can save the activation of Shapes when saving the defaults at 
the end of the MEDUSA4 session.

Dashboard

The Shape Dashboard has a tool to add or remove center-lines  and a tool to smash the 
Shapes . Smashing has the same effect as if the shape was created conventionally. The 
Shape Dashboard also has a component display to set properties of the Outline and Centerline.
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Figure 320 Shape Box Dashboard: Create Box

Please note: Consider that the smash tool  is only active when selecting a Shape. It is not 
active while creating a Shape.

Properties

The Properties button  on the left of the General Properties header opens the appropriate proper-
ties dialog for the closed geometry. The parameters are the same as inside the Dashboard.

For a box the properties dialog looks like following:

Figure 321 Shape: Box Properties

Please note: The display of the Dashboard and the relevant properties dialog varies depending 
on the closed geometry which is created or selected.
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Line properties determine what the line will look like on the sheet. All lines have the properties 
Style, Layer, Color, Type and Thickness.

Figure 322 Line Properties Dashboard

Style

A style is a collection of properties that define what a line will look like, and the layer on 
which it is placed. For example, you can create a line style so that all lines created 
using this style have the same color and they are placed on the same layer. See “Line 
Styles” on page 353 for more information. 

Layer

The layer determines on which layer of the sheet a line is drawn. Changing the layer 
does not have a visible effect, except the layer is set to be invisible.
See “Layers” on page 143 for more detailed information on layers.

The color used to draw the line. You can edit and add colors (see ”Grids”, “Specifying 
Grid Line Style” on page 203).

Type

The available line types are listed in “Line Types” on page 354.
Thickness

is the line thickness. There are 8 different line thicknesses.
Area Fill

If it is switched on, an area which is defined by a line is filled with the color of this line. 
The line can be a single arc or multi-segment line, for example.

Please note: The number of properties displayed for a Style depend on the line Type. For super-
lines you have additional entries as shown in “Line Types” on page 354.

For changing line properties see “Changing Properties” on page 356.
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A line style is a collection of one or more line properties. For example, a line style may specify 
the line type, color and thickness of a line. Line styles are defined by your System Administrator 
who can tell you what the styles should be used for.

Style Variants

Each property of a line style can get a certain status. This is:

• Used and locked - you cannot change these properties
These properties are grayed out in the Dashboard and in the Line Properties dialog.

• Used but not locked - you can change these properties

• Not used and not locked - any change of such a property is applied but the style is not 
recognized as variant.

You can change any property of the line which is not used by the style.

If a style was changed so that it is a variant, an asterisk (*) is appended to the Style label in the 
Dashboard to indicate that the current style differs from the standard style.

For changing properties see “Changing Properties” on page 356.

Using a Style Variant

If you want to use the style of an existing line, including its variation, then:

1. Select the line whose style you wish to use.
The Dashboard shows the style and the properties of the selected line.
If the line is a variant, an asterisk (*) is appended to the Style label in the Dashboard.

2. Select the Creates lines of specified type and properties button .
3. Create points to define the line.
© CAD Schroer GmbH                             353



MEDUSA4 Drafting
Lines - Home Tab
Line Types

Figure 323 and Figure 324, “Decor Line Types” on page 355 show the available line types of 
MEDUSA4 separated to standard line types and modifiable decor lines. Decor lines have addi-
tional properties which are width, pitch, aspect and shear. 

Figure 323 Standard Line Types
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Figure 324 Decor Line Types

The following figure shows the frequently used line types again:

Figure 325 Frequently Used Line Types

Construction and group area line types have specific uses. Details on them are described in 
“Construction Lines - Home Tab” on page 479 and ”Transformation”, “Creating Group Lines” on 
page 332. 

Solid

Chain

Long Dash

Short Dash

Dotted Construction

Group Area
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You can change properties for a selected line either by using the Dashboard or using the 
Line properties dialog. You also can change line properties for several selected lines at the same 
time or while drawing a line. All possibilities are described in the following sub-sections.

Please consider the following statements:

• You may not be able to change line properties, if your site may have special conven-
tions which control how lines are created for particular projects, for example, the layer 
on which they are stored. Properties which are locked for editing appear grayed out.

• If the property you want to change is displayed grayed out, it is locked and you have to 
unlock it. You have to change the style for this purpose which is only possible in 
Administration mode. Therefore it is described in the Administration Guide, chapter 
Administration, section Creating and Editing MEDUSA4 Styles.

• If you change any of the properties of the line, an asterisk (*) is appended to the Style 
label in the Dashboard to show that this is a variant style. A variant style is a style 
which has one or more properties that are altered from the original style settings.

Using the Dashboard

To change a property of a line directly inside the Dashboard:

1. Select a line on the sheet.
The Dashboard changes to show the properties of the selected element.

2. Click the LMB on the arrow next to the property you want to change in the Dashboard.
3. Select the new value for the property from the list of displayed values.

The chosen property is changed for the selected element.

Using the Line Properties Dialog

Do the following steps for changing properties with the Line properties dialog:

1. Select a line on the sheet.
2. Click on the Properties button  on the left of the Dashboard header Common Properties or 

use the Properties entry from the popup menu.
The Line properties dialog is displayed. The entries are described at the beginning of this 
section on page 352.
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Figure 326 Line Properties Dialog

3. Change one or more properties and press Apply.
The changes are applied to the selected element.
If you choose OK the changes are also applied but additionally the dialog is closed.
If you choose Cancel the changes are not applied and the dialog is closed.

Changing Properties for More than One Line

You can also change the properties of several selected lines at the same time.

1. Select the lines you want to change.
The properties of the selected lines are displayed on the Dashboard.

Please note: If the lines do not have identical values for a particular property, the appropriate 
field is left blank.

2. Change one or more properties using the Dashboard or the Line Properties dialog.
The chosen properties are changed for all selected elements.
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You can display details about the properties of all points in a line. Assuming that a line is created 
or edited you can display the Line Properties dialog as follows:

• Select Line Point Properties from the popup menu.

• Click on the Properties button  on the left of the Dashboard header Common Properties.

• If you have the Line Properties dialog displayed then just click on the Line Point Properties tab.

Figure 327 Line Point Properties Dialog

The Line Point Properties tab displays:
X, Y

Horizontal and vertical coordinates of the point relative to the sheet origin. The coordi-
nates are always displayed as Cartesian coordinates (for details see “Point Coordi-
nates” on page 359).

Weight

The Weight column shows the weight given to the invisible control point that determines 
the shape of an arc. The weight of a point is how much the arc is pulled towards the 
control point. The weight of all other points is set to 1. You can change the weight, see 
”Lines - Dashboard”, “Circles/Arcs” on page 392.

Line Functions

Defines the geometry of the line segment that leads to the point. You cannot edit this 
field. The available entries are described in “Line Functions” on page 359.

Point Functions

defines the appearance of the point. You can change these functions if you are editing 
the line (for details see “Point Functions” on page 360).
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The X and Y columns give the horizontal and vertical coordinates of the point relative to the 
sheet origin. The coordinates are always displayed as Cartesian coordinates.

By default the sheet origin is located at the lower left corner of the sheet at (0, 0). The position of 
the top right corner of the sheet depends on the size of the sheet selected. For example, a hori-
zontal A4 sheet is 297 mm by 210 mm so the top right corner of a metric sheet would be the 
position (297,210) dependent on the sheet scale. The position of the sheet origin depends on 
the grid origin (see ”Grids”, “Changing Origin of the Grid” on page 206 for further information).

To change the X or Y coordinate of a line point: 

1. Ensure that the selected line is in edit mode (that is, the current point is displayed and 
a dynamic line is displayed between the current point and the cursor).

2. Select the Line Point Properties option from the popup menu.
3. Double click left in the X or Y coordinate field.
4. Edit the value.
5. Click Apply. 

Line Functions

The Line functions column shows the line functions defining the geometry of the line segment that 
leads to the point. You cannot edit this field. Some examples of line functions are:

Line Functions Descriptions

Lin Straight line segment

Clo Circular arc clockwise

Ant Circular arc counter clockwise

Arc Tangent point arc

Inv Invisible line segment

Nul Control point for a circular arc

Cir
Circle,
first point is center, second point on circumference

Con Control point for a tangent point arc

Cen
Circle,
first point on circumference, second point is center
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The physical appearance of a point in a line is specified by its point function. Every point in a 
line has an associated point function.

The point function is denoted by a number from 0 through 255 and a name having up to six 
characters. The point function at each point is used to define a symbol drawn at that point, such 
as an arrowhead or a cross. When you first create a point it is given a null point function, that is, 
it is not marked in any way.

Point functions are divided into the following ranges:

If you change the point function, the appearance of the point is changed. For example, you 
could change a point without any function to an arrowhead. Some examples of the appearances 
of different point functions are shown in Figure 328.

Figure 328 Point Functions

Using Gap Point Functions

The gap point function can be used for a number of applications. For example, a leader line 
pointing to a part of an object crosses an existing line and makes the drawing confusing. If you 
create an additional point in the leader line at the intersection of the two lines and then specify a 
gap point function, a part of the leader line becomes invisible and prevents ambiguity. The fol-
lowing figure shows an example. The leader line on the left is without gap point function, on the 
right it is with.

Figure 329 Application of the Gap Point Function

Ranges Point functions

0 Null point function

1 - 39 Default set of point functions

40 - 50 User-assignable point functions

51 - 100 Reserved for future MEDUSA4 development

101 - 255 User-defined point functions

Point function 8 Point function 11 Point function 25 Point function 34
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The direction in which an arrowhead points depends on the line direction. In MEDUSA4 the fol-
lowing conventions are used for arrowheads:

• Arrowheads facing right in the Point Functions dialog create arrowheads pointing in the 
current direction of the line

• Arrowheads facing left in the Point Functions dialog create arrowheads pointing against 
the current direction of the line

Arrowheads with point functions 30 through 33 inclusive are drawn with their bases on the 
required points. Figure 330 shows the effect of different point functions on an L-shaped line.

Figure 330 Point Function Arrowheads

Changing Point Functions

You can replace an existing point function with one of the predefined symbols shown in “Stan-
dard Point Functions” on page 362 although the point functions used at your installation may be 
different to these.

You can change point functions using either the point function tool  or the Line Properties dialog.

Changing Point Functions Using the Point Function Tool

1. Create or edit a line.
The line Dashboard opens.

2. If required, navigate to the point to which you want assign a point function.
3. Choose the point function tool  from the Dashboard.

The point function dialog opens.
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Figure 331 Standard Point Functions 

4. Choose a point function by clicking the appropriate button.
The number of the point function appears in the Point function field and the point function 
on the sheet changes immediately.

5. If you do not want to apply further point functions click the Close button.
The dialog can also remain open while you go on working on your sheet.

Changing Point Functions Using the Line Properties Dialog

1. If you are not already creating or editing a line, move the cursor to the point that you 
want to change and then double click left.
The current point marker appears at the chosen point indicating that you can change 
the point now.

2. Select Line Point Properties from the popup menu to open the Line properties dialog.
3. Change to the Line Point Properties tab if it is not yet active.
4. Click left into the Point Functions input field of this point to make the point current to which 

you want to assign another point function.
5. Open the pull-down menu via the arrow button by using the LMB.

The menu lists the point functions as symbols.

Null point function
Use this if you do not

at the selected point.
want a point function
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Figure 332 Using Line Properties Dialog to Change Point Functions

6. Select the desired point function symbol in the list.
If the required point function is not available as symbol, read ”Using Named Point 
Functions” below.

7. Click the Apply button.
The point function on the sheet changes promptly.

8. If required, change other point functions. 
When you have finished, press the OK button to close the Line properties dialog.

Using Named Point Functions

The Point Functions pulldown menu only displays the point functions as symbol which are in the 
range from 0 to 34. However, furthermore you are able to assign functions between 35 - 255 to 
a point. These point functions do not have icons in the standard product and are displayed as 
plain numbers. The pulldown menu provides the Other option at the end of the list.

Figure 333 Point Functions Pulldown Menu - Other Option

If you want to assign another function to a point than any from the standard set, proceed as fol-
lows. It is assumed that the line is still in edit mode.

1. Select the Other entry in the Point Functions pulldown menu.
2. Replace the Other entry by typing the number of the desired point function into the field.
3. Press Return.

If a symbol has been assigned to the number, it is displayed in the list now.
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4. Confirm the input by pressing the Apply or OK button.
The point function is displayed on the drawing.
For Apply the dialog remains open, OK closes the dialog.

Please note: You should determine the symbols (if any) that are given if you select point func-
tions 40 through 50. You can use these point functions to draw any special points 
required at your installation, based on the point functions in the default set.

Point functions 101 through 255 may also contain special symbols. These point functions can 
be defined as any symbol and do not have to be based on the default set of symbols. Ask your 
System Administrator if any of these or any other point functions have been used.
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Following figure shows the edit line tools which are available in the Home tab. 

Figure 334 Edit Line Tools

Tools for Changing Line Segments

Following tools for changing line segments are provided on the Home tab:

Figure 335 Tools for changing line segments

Move Segments

Moving segments is done by clicking left on the segment you want to move and then moving the 
mouse cursor. The final position of the segment can be determined either by:

• clicking left inside the graphics area, or

• typing values inside the edit fields at the mouse cursor. 
The edit fields provide either Offset and Length entries or a Radius value for fillets.

tools for changing line segments

tools for chamfers and fillets 

offset line tools
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Trim/Extend End Segments of Lines

After selecting the Trims/extends end segments of lines tool the following popup menu is available:

Figure 336 Trim/Extend Segments Popup

Options 
opens the Line Trim/Extend dialog which provides the following entries:
Trim and/or Extend against a selected boundary. 

If you move the cursor inside the selected boundary any line which can be 
trimmed/extended and which is close to the cursor is displayed as being 
trimmed/extended. For applying trimming/extension click left as you see the 
trimming/extension result.
If the mode Pick-N-Drop is selected Trim and Extend are disabled.

Ignore Boundaries is used for switching off the ability to select a boundary used for placing 
a line end point after trimming. This option is only available in Pick-N-Drop mode.

Pick-N-Drop is used for picking an end point of a line and move the point to its final trim/
extend position which is defined by crossing points with other segments on the 
sheet.

Apply 
is used for terminating boundary lines selection.

Undo 

cancels the last action. You can cancel several actions you did last time.
Redo 

does again the last canceled action. It is disabled until the first Undo is done.
Re-pick end point 

is used for picking another end point. It is enabled after picking an end point in case of 
Pick-N-Drop mode.

Exit Tool 
quits the tool.
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Selected points of elements can be moved on the sheet. You can either move complete ele-
ments, some points of one element, or points of several elements.

Following figure shows an example:

Figure 337 Example for Moving Points

To move selected points:

1. Choose the Selected tool .

Please note: Consider that there is a similar tool named Move points  located in the Transforma-

tion tool group, that is used for boundary groups, see ”Transformation”, “Trans-
forming Boundary Groups” on page 334. This is not meant here.

The message line below the status area shows you at any state of the function, 
what to do next.

2. Select the points that you wish to move by drawing a selection frame.
The selected elements become highlighted but only the points which were inside the 
selection frame will be affected by moving.
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Figure 338 Example for Moving Points, Geometry selected

3. Move the selected elements.
For this you have the following possibilities:
• Using the mouse 

Probe on the sheet to define the datum point.
The selected points are attached to the cursor.
As you move the cursor, you see rubber-band-like lines which are connected to the 
element points, which do not move.

Figure 339 Example for Moving Points, Moving with the mouse

Probe on the sheet to define the target point of movement.
• Using the input fields X Factor and Y Factor 
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Figure 340 Example for Moving Points, Input Fields By X and By Y

In the edit fields X Factor and Y Factor type in the movement values in X and Y direc-
tion. If you confirm the values by pressing the button Return on your keyboard or 
clicking left on the check mark behind the edit fields, the selected elements will be 
moved immediately.

Please note: You can enter values either directly by using the key board and switch to the next 
field via Tab-key or you can keep the Ctrl-key pressed, move the cursor into the 
input fields, type in the values and apply with Enter or check mark.

For further movement you need to select points again, so go on with step 2.

Please note: The elements, whose points were moved, are still shown highlighted in order to 
check whether movement was correct. Consider that the highlighted elements are 
not selected. 

Chamfers and Fillets

Following tools for chamfers and fillets are available in the Home tab:

Figure 341 Tools for chamfers and fillets

Chamfer Lines

A chamfer is defined by two values. 1st Length and 2nd Length. The order that these values are 
applied depends upon the line direction. In the example below all corners of the rectangle were 
chamfered. The original rectangle is visible. The line direction is counterclockwise and the value 
of the 2nd Length is twice as big as that one of the 1st Length.
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Figure 342 Example for Inserting Chamfers 

Fillet Lines

After selecting the Fillet lines tool the following popup menu is available:

Figure 343 Fillet Lines Popup

Join and Insert 
is used for filleting line segments and connecting them, if they are not connected 
(details are described below). By default this option is switched on, indicated by the 
check mark . Each click on this option toggles its activity. If Trace Old Line was active 
before, switching on this option deactivates Trace Old Line.

Trace Old Line 
keeps the selected line segments and puts additionally a new line consisting of the 
selected segments (or shortened or extended versions of them) and the filleting arc on 
the sheet. If Join and Insert is switched on, Trace Old Line is deactivated and can be chosen 
not until Join and Insert is switched off. By default this option is deactivated.

Create Tangent Arcs 
is used for changing standard arcs (fillets) into tangent arcs or for creating such arcs.
By default this option is deactivated. The option is activated by clicking on it. In this 
case a check mark  is displayed.

Undo 
cancels the last action. You can cancel several actions.
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Redo 
does again the last canceled action. It is disabled until the first Undo is done.

Exit Tool 
quits the tool.

After selecting the Fillet lines tool first enter the radius for the fillet inside the edit field at the 
mouse cursor. Consider that a Radius of zero creates a corner.
Now you can either select connected or non-connected line segments for filleting.

• Connected Line Segments:
You can fillet a single corner, several corners or all corners at the same time.
• Clicking left on a single corner fillets it. If filleting fails, an error message is shown.
• For filleting several corners of a line in one work step, press the LMB and select any 

desired corners by drawing a selection frame. As soon as you release the LMB any 
corners are filleted at the same time. 

• For filleting all corners of a line, double click left on the line.
For all cases of filleting connected line segments the following is valid, if a fillet does 
not fit, it remains unchanged. 

• Non-Connected Line Segments:
Non-connected line segments can be joined and filleted using the MMB. You can 
select only two line segments. On selecting the first line segment, it will be displayed in 
the default highlight color. After selecting the second segment, joining and filleting lines 
is performed according to the selected option Join and Insert or Trace Old Line. 
We distinguish three cases:
• If the option Join and Insert is on, line segments are either extended or shortened in 

order to add the filleting arc. The result is a single line consisting of the selected line 
segments (perhaps extended or shortened) and the new filleting arc. Only if a seg-
ment would be shortened to zero, filleting is aborted giving a message.

• If the option Trace Old Line is on, filleting is performed in the same way as for the 
option Join and Insert except that the selected line segments are kept.

• If both options are off, fillets are only inserted, when the radius causes the selected 
line segments to be extended. If the radius is too high and the segments would be 
shortened for inserting the fillet, filleting is aborted and a message appears.

The following figure shows some examples.
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Figure 344 Example for Inserting Fillets between Line Segments and Joining the Lines 

Row A shows the input line segments.
Row B shows the inserted fillets when using option Trace Old Line. The single line seg-
ments are not modified and remain unchanged.
Row C shows how the fillets are inserted and the line segments are joined to one line, 
when the mode Join and Insert is used. In this case the selected line segments were 
removed and a new line is created.

Offset Lines Tools   

MEDUSA4 provides three tools for tracing the line of a selected geometry and applying an off-
set to it.

A

B

C
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Figure 345 Tools for tracing a line with Offset

1. In principle all three tools work in the same way. The following steps show in detail how 
the first tool can be applied.Draw a simple rectangle by using one of the tools to create 
lines, for example.

2. Choose one of the tools for tracing a line.
3. Select the rectangle.

If you move the mouse, a parallel line is traced around the selected rectangle attached 
to the cursor. The offset of this line is shown in the Offset input field at the mouse cursor 
and it can be either outside or inside the rectangle.
Whether the offset value is negative or positive depends on the line direction. If the 
profile line is clockwise, an outside offset is positive. However, if it is counter-clockwise 
then it will be negative.

4. Now you have two possibilities to set the desired offset:
• Using the mouse:

Move the mouse as long as the line has the desired offset. Then press the LMB to 
place the line on the sheet. 

• Entering an offset value into the input field:
Press the Ctrl key, enter either a positive or negative offset value in the Offset field 
and apply with the Return key.

The line is created with the desired offset to the selected element.
If you move the mouse now, again a line is attached to the mouse cursor which can be 
placed with another offset.

Popup Menu

After having chosen a tool for tracing a line, the following popup menu is provided (RMB).

Figure 346 Popup Menu while tracing a line with offset

The following options are available:
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Reverse Offset

changes a line created with a positive offset to a line with negative offset and vice 
versa.

Reselect suspends the process and you can select another element, to which you want to 
create an offset line. The current tool remains active.

Offset Filter ON/OFF

controls, whether the offset line takes points from the original line which are not 
needed. If Offset Filter is ON, superfluous points are ignored for the offset line.
Example:
If two straight line segments of a line, from which you want to create an offset line, con-
tain intermediate points, and you activate the option Offset Filter ON, the Offset line has 
no intermediate points.
If the option is set to Offset Filter OFF, the offset line also contains intermediate points.

Figure 347 Example of the Offset Filter ON/OFF Option

Undo the placed line is removed and you can place a new one.
Exit Tool quits the tool.

Examples for Offset Lines with Chamfers

When you use the Creates a line with chamfered corners traced around the selected element tool , a second 
input field Cut is displayed next to the Offset field after selecting an element.

Figure 348 Input Fields while Creating an Offset Line with Chamfered Corners

The Cut value determines the position of the cut from the base line.The examples below show 
the evolution of the cut when changing the value from 0 to 1.414 for a square angle (square 
root). The default value is 1.
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Figure 349 Examples of different Cut Values for a square Angle 

The following figure shows another example with an acute angle.

Figure 350 Example for an acute Angle
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Editing a Line

You can make changes to a single point, to one or more line segments, or to the whole line. For 
example, you can edit a line by:

• Adding, deleting or moving a point 

• creating a fillet or chamfer at a point

• changing the length or angle of a segment

You can edit a line at any time.

Use following procedure for editing a line:

1. Choose the Select tool  from the In Graphics Tool Bar.
2. Move the cursor over the line you want to edit.
3. Now you have two possibilities:

• Click left to select a line and then choose Edit from the popup menu (RMB).
• Double click left to select a line.
The edit line icon  is displayed in the status area showing that you are now editing 
the line. The current point marker appears against one of the points in the line. 
Now the current point can be edited. You have the following possibilities:
• Use the editing entries in the popup menu, see “Edit Line Popup Menu” on 

page 377.
• Use the edit line tools, see “Lines - Dashboard” on page 379.
• Use the Enter Coords dialog for defining new coordinates of the current point (see 

chapter ”In Graphics Probe Bar”, “Entering Points using Cartesian Coordinates” on 
page 117).
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Edit Line Popup Menu

If a line is in edit mode a popup menu is available by clicking right.

Figure 351 Popup Menu While Editing a Line

Please note: It depends on the stage of drawing which entries inside the popup menu can be 
chosen. For example, if the current point is the end point of an arc the Flip entry is 
enabled.

The Edit Line popup menu offers the following options: 
New Line

finishes the currently edited line and sets up the function for drawing a new line.
Close Line

joins the first and last points in the line with a line segment. The current line is still 
active and you can go on editing this line. If you go on drawing after probing the next 
point of the line, a new segment is drawn and the whole line is closed again between 
the current point and the point in front of it.

Close and New Line

joins the first and last points in the line with a line segment and it finishes the current 
line leaving you ready to start a new line.

Move Point

is used for shifting the current point to another position. If this item is chosen you can 
probe the new point by clicking left inside the graphics area, or directly entering coordi-
nates by which the point is to be moved in X and Y direction (input fields By X and By Y). 

Delete Point

removes the current point. The current point marker is set to the previous point.
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Flip

changes a clockwise arc to a counterclockwise arc. Flip is only enabled if the current 
line segment is an arc.

Reverse Points in line

changes the line direction. If this option is chosen the current point marker is placed at 
the neighbored segment and it is reverted.

Undo, Redo

Undo cancels the last action. The button Redo is activated after undoing the first time. 
You can undo several actions.

Line Point Properties

opens the Line Properties dialog which allows you to:
• adjust the style of the current line inside the Line Properties tab (see “Line Properties” 

on page 352).
• adjust the coordinates of the current point inside the Line Point Properties tab (for details 

see “Line Point Properties” on page 358).
Exit Tool

quits the tool. 
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Dashboard Overview

If you select or edit a line, the properties of the line and the line edit tools are displayed in the 
Dashboard.

Figure 352 Line Dashboard

The upper part of the Dashboard shows the properties of the current line which were already 
explained in ”Lines - Home Tab”, “Line Properties” on page 352. The other part of the Dash-
board contains the tools described in this chapter.
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Navigating a Line

The line navigation tools are activated if you create or edit a line. With the help of these tools 
you can move on the line from point to point, for example, to reverse the line direction or getting 
to a certain point.

Figure 353 Line Navigation Buttons

This is how to use the line navigation tools:

1. Move the cursor upon the line you want to edit and double click left. The line will be 
selected and is in edit mode.

2. Navigate around the line by clicking the buttons shown in Figure 353.
3. If you want a certain point to be the current point, move the cursor to this point and 

click the MMB (or press the Shift key on your keyboard and then the LMB).

Reversing a line numbers the points in the opposite direction. The shape of the line is not 
changed. Reversing the line direction can be useful when you are adding a new point to a line 
or making changes to line segments. This application of reversing the direction of a line to add 
points is demonstrated in Figure 354. 

Figure 354 Result after adding a point, Dependent on the Line Direction

Please note: When you reverse a line the point functions may change because some of them 
depend on the line direction (e.g. arrows). 

First point in line Last point in line

Previous point
Reverse Next pointin line in linedirection of line

1

2

3 4

5

5

4

3 2

1
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Line Point Tools

If you create or edit a line, following tools for line points are activated below the line navigation 
buttons.

Figure 355 Line Point Tools

make the current point

move point

delete point
into the first point
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The Protractor

You can use the Protractor to:

• create lines of specified length in a specified direction.

• query base angles, incremental angles or a distance between two points.

To display the Protractor dialog select  from the Dashboard.

Figure 356 The Protractor Dialog

In the middle of the dialog you find tools which are used to query values (query tools).
The text fields display the prompted values or you can enter specific values in these fields.

At the border of the dialog numbers and arrows are given for setting a direction of currently cre-
ated or edited line (the so called setting tools).

Please note: The setting tools can only be used if you create a line and if you already set the 
starting point for that line, or if you are in the mode for editing an existing line. 
The query tools are available as soon as the dialog appears.

Using the Protractor to Create a Line Segment 

You can create line segments with a specified direction:

• by using fixed values for angles in steps of 45 degrees, or

• entering free values in the input fields.

Using Fixed Values in Steps of 45 Degrees

1. Set any values of the input fields to 0.
2. Choose one of the line creation tools.

tools to query:
- the incremental angle

- the base angle
- the distance

Input fields 
sets the incremental angle

to the specified values

sets the incremental angle
to the specified value according

to the direction of the arrow
(in steps of 45°)
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3. Probe in the sheet to set the starting point of the line.
The setting tools of the protractor are activated now.

4. Choose for example the  tool.
The Incremental angle input field displays a value of 45°.

5. Move the mouse cursor within the graphics area.
You see a line attached to the cursor. The line can be shortened or extended by mov-
ing the mouse.

6. To set the end point of the line: 
• probe anywhere in the sheet, or
• enter a value in the Distance input field to specify the length.

7. Press Return or click Apply.

The line is forced to the specified angle and it is designed in the desired length.

Any other of the setting tools, e.g.    ... / 30°, 60°, 120°..., work in this way. 

Entering Free Values

1. Set any value in the input fields back to 0.
2. Choose one of the line creation tools.
3. Probe in the sheet to set the starting point of the line
4. Type for example 30 in the Base angle input field .
5. Enter for example 50 in the Distance input field  to define the length of 

the segment.
6. Click the Apply button

MEDUSA4 creates a line segment 50 units in length at an angle of 30° from the hori-
zontal.

7. Leave the entered values in the input fields and repeat step 2 and 3.
8. Type for example 20°in the Incremental angle input field  and click Apply.

MEDUSA4 creates a second line segment 50 units in length at an angle of 50°. The 
base angle and the incremental angle have been added.

9. Click on Cancel to close the Protractor dialog.

Please note: The values in the input fields are not reset by closing. If you call the Protractor dialog 
again, the last defined values are displayed in the input fields.

The Extend to Segment Pulldown Menu

You can make some settings relating to the extend of line segments using the pulldown menu 
as shown in the figure below.
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Figure 357 The Extend to Segment Pulldown Menu

Near

If you probe on the sheet near an existing element, the point of the line you draw snaps 
automatically to the prolongation of the element or to the element itself. The distance 
between probed point and element depends on the hit radius defined in File > Default Set-

tings > Radii / Arc Fac (for details see ”Default Settings”, “Search Radii” on page 277).
On

Same as Near but the hit radius has no effect here. The existing element is used, which 
is next to the current cursor position, for drawing the next point.

Off

The point of the line you currently draw does not snap to any existing element. The 
automatism described above is switched off.

Using the Protractor to Query Angle and Distance

The protractor offers some tools which can be used to query the values of angles or distances 
by probing two points on the sheet. The appropriate input fields display the requested values.

Figure 358 The Query Tools

Query a Base Angle

The Specify an base angle by probing two points on the sheet tool  enables you to query the angle of a 
line based on a horizontal line, the base angle. The line can be an existing line or a virtual line. 
In both cases the angle is defined by probing two points on the sheet.

Specify an incremental angle
by probing two points on the sheet

Specify a base angle
by probing two points on the sheet

Specify a distance
by probing two points on the sheet

Incremental angle input field

Base angle input field

Distance input field
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Figure 359 Example of Specifying an Base Angle

1. Click on the tool .
2. Probe two points on the sheet to specify the direction of a line as shown in the figure 

above.
The value of the base angle is displayed in the Base angle input field.

Query an Incremental Angle

The Specify an incremental angle by probing two points on the sheet tool  enables you to query an incre-
mental angle by probing two points on the sheet. As described before you can either probe two 
points on an existing line or two free points (defining a virtual line) on the sheet.

1. Click on the tool .
2. Probe two points on the sheet to specify the direction of a line.

The Incremental angle input field displays the corresponding value.

Query a Distance

You can query a distance between two points in the sheet by using 
the Specify distance by probing two points on the sheet tool .

1. Click on the tool.
2. Probe two points on the sheet

The distance between the two points is displayed in the Distance input field.

point 1

point 2

base angle

existing line virtual line

two probed points on an existing line

point 1

point 2

base angle

two probe points on a free place of the shee
define the direction of a virtual line

0°0°

define its direction
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Modify Line 

You find following tools in the Modify Line area:

Figure 360 Tools for modifying lines

The tools are from left to right and top to bottom:
 Split line at selected point

If you select this tool, the current line will be split at the currently edited point in two 
parts. A new point is created which is the last point in one line, which remains selected 
for editing. The old current point is the first point in the second line which becomes 
deselected.

Please note: A closed line will be split in that way that the new line between start point of the 
formerly closed geometry and the current point remains selected. The second line 
runs from the current point to the start point of the formerly closed geometry and 
it is unselected.

 Orthogonalize line within set tolerance 
changes the current line into horizontal and vertical lines according to the defined toler-
ance angle. This angle gives the maximum deviation of a line segment from the hori-
zontal or vertical in order that it will be orthogonalized. Segments which have larger 
deviation angles will not be orthogonalized. You have two possibilities for defining the 
tolerance angle:
• Type a value into the edit field at the mouse cursor.
• Choose a value from the popup menu. 9 entries are available from 5 to 45, step 5.

 Remove the curve fitted through the current line

is the reverse function of Fit a smooth curve through the current line.
 Fit a smooth curve through the current line 

creates a smooth curve through all the points of a selected line.
 Orthogonalize whole line

changes the segments of the whole line into horizontal and vertical lines. No sloping 
segment remains.

 Split line between two points 
When you use this tool, from the current line a line section will be split which you define 
by probing a start and an end point. The tool is also active if no line is edited. The pro-
cedure is as follows:
a. Probe a line on the sheet (if a line is already selected, this step is skipped).
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b. Probe the start point on the line.
c. Probe the end point on the line.

The line section between start and end point is split. The tool is ready for splitting 
the next line. Look at the message area for the next step to do for splitting.
The RMB provides a popup menu including the entry Reselect, for selecting another 
line, if you selected the wrong line for splitting.

 Join current line to selected line

When you use this tool, the current line is joined to the line you select by probing inside 
the graphics area. The duplicated point is deleted, and the complete line remains 
selected for editing.
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Modify Segment 

You find following tools in the Modify Segment area:

Figure 361 Tools for modifying segments

The tools are from left to right and top to bottom:
Extend line 

allows you to extend or reduce the length of the current line segment by typing into the 
entry box. The values in the entry boxes automatically update as you move your cur-
sor. You can either:
• Enter an Increment value by which to extend the line (positive or negative).
• Enter an Absolute length for the line (positive or negative).
• Move your cursor until the entry boxes show the required increment or absolute 

length and click left.
Extend line to probed segment 

allows you to extend or reduce the length of the current line segment, so that the line 
meets another line segment 

Halve segment length 

shortens the length of the current segment by the half of its current length.
Double segment length

doubles the length of the current segment.
Extend by factor

extends a line by a certain factor. You can either type a value for the factor into an entry 
box which appears, or you can select a factor from the popup menu shown below.

Figure 362 Extend by Factor Popup

Divide segment into two 

splits the current segment into two equally-sized pieces.
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Divide segment into specified number of divisions or at selected point

splits the current segment into a certain number of equally-sized segments. You have 
the following possibilities:
• Enter the number of resulting segments in the entry box.
• Probe the current segment to split it at a certain point.

Hide or show the line segment 

shows or hides the current segment.
Rotate segment by fraction 

rotates the current segment by a specified value for fraction of the enclosed angle 
which is defined as angle between current and last segment. You have following possi-
bilities:
• Type a Fraction into the entry box and press Return. 
• Move the cursor until the line is positioned correctly and click left to place the new 

point.
• Use the popup menu which provides the values quadruple, triple, double, half, third and 

quarter for Fraction.
Rotate segment, halving angle

rotates the current segment by half of the angle against the previous segment.
Rotate segment, doubling angle

rotates the current segment by doubling the angle against the previous segment.
Rotate segment by specified angle

rotates the current segment counterclockwise by the value for an angle using degrees. 
To specify the new angle you have following possibilities:
• Type an Increment or an Absolute angle into the entry box and press Return.
• Move the cursor until the line is positioned correctly and click left.
• Select one of the options (90 degrees, 45 degrees, -45 degrees, -90 degrees) from the popup 

menu.
Rotate segment by -90 degrees

rotates the current segment clockwise by 90 degrees.
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Fillets/Chamfers   

You find following tools in the Fillets/Chamfers area:

Figure 363 Tools for fillets and chamfers

The tools are from left to right:
Create a fillet of specified radius

deletes the current point and replaces it with two new points describing the start and 
end of the fillet. After choosing the tool an entry box appears for entering the radius of 
the fillet. Type in the value and either press the button Return on your keyboard or 
click left the check mark behind the entry field. 

Create a (tangent-point) fillet of specified radius

deletes the current point and replaces it with two new points describing the start and 
end of the fillet. The difference to Create a fillet of specified radius is that the second point of 
the fillet is not the virtual center of the fillet arc but the crossing point of the tangents in 
the start and end point of the fillet arc. Use the Line Navigation tool to see this.

Remove fillet

deletes the fillet segment and replaces the original point.
Create chamfer 

deletes the current point and replaces it with two new points describing the start and 
end of the chamfer. After choosing the tool an entry box appears for entering the 
lengths (1st Length and 2nd Length) for the chamfer. Type in the values and either press 
the button Return on your keyboard or click left the check mark behind the entry field. 

Remove chamfer

deletes the chamfer segment and replaces the original point.
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Circles/Arcs      

You find following tools in the Circles/Arcs area:

Figure 364 Tools for circles and arcs

The tools are from left to right and top to bottom:
Create circle

creates a circle around the current point. Use one probe to define a point on the circle 
circumference. Instead of probing you can also type in the Radius or Diameter inside the 
edit fields at the mouse cursor.

Center point circular arc

creates an arc between the current point and any end point. First define the end point 
of the arc by clicking left on the sheet. Afterwards define the center of the arc either by 
a further left click on the sheet or by entering the value for Radius or Diameter. 

Circular arc through three points

creates an arc between the current point and any end point. First define the end point 
of the arc by clicking the LMB on the sheet. Afterwards define the circumference of the 
arc either by a further left click on the sheet or by entering the value for Radius or Diame-

ter.
Create segments tangential to surfaces

creates an arc which starts and ends tangential at two probed surfaces. After choosing 
the tool look at the message area for the further steps to do.
The following figure gives an example:
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Figure 365 Example for Creating Segments Tangential to Surfaces

After probing the tangent points the Tangent Arc dialog comes up.

Figure 366 Tangent Arc Dialog and an Example for the Resulting Tangential Arc

Choose the options and Preview for displaying the result.
Choose OK for final confirmation of the arc you want to use.

Create tangent point conic arc
Create tangent point elliptical arc

Create tangent point parabolic arc 
These tools create elliptical, parabolic or conic arcs beginning at the current point. The 
first probe defines the end point of the arc and a second probe defines its vertex.

edited line

first probed surface

second probed surface

mouse pointer with attached rubber band

displayed arc after
applying the settings

given in the dialog
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Convert the selected circular arc to a tangent point arc 
converts a circular arc to a tangent arc.
When you are in line edit mode navigate to the end point of the arc and click on the
tool . The center point arc is converted into a tangent point arc.
Navigate to the tangent point by using the line navigation tools to see the result of the 
conversion:

Figure 367 Example Convert Circular Arc to Tangent Arc

Modify the weight of the selected tangent arc 
changes the weight of the selected tangent arc. 
To apply this tool, edit a line with a tangent point arc, move the current point marker to 
the tangent intersection point of the arc and choose this tool. You can now change the 
weight either by entering a value in the text field below the Dashboard, or by probing 
on the sheet (on the line specified in the example below).

Circular arc Tangent arc

center point

tangent point

X

X
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Figure 368 Example Modify Weight of Tangent Arc

Change curve of the selected tangent arc 
changes the curve of a tangent arc by probing on the sheet. The application of this tool 
works similar to the Modify the weight of the selected tangent arc tool except that you cannot 
enter a certain value. The following figure illustrates how to work with this tool.
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Figure 369 Example Modify Curve of Tangent Arc
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SMART Drafting allows fast and easy designing without drawing construction lines manually 
before drawing the geometry itself. SMART Drafting works with construction points, easy to set 
at any position on the sheet at any time. In SMART Drafting construction lines are generated 
automatically between the placed construction points and the current point. The construction 
lines are displayed dynamically as you move the mouse cursor inside the graphics area.

• Calling SMART Drafting......................................................... 398

• Drawing Lines ........................................................................ 404

• Drawing Arcs.......................................................................... 406

• Flipping Arcs .......................................................................... 407

• Using Construction Points...................................................... 408

• Extending an Existing Geometry with SMART Drafting ......... 411

• Changing Line Direction......................................................... 412
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Calling SMART Drafting

To call up SMART Drafting, choose the SMART Drafting tool  from the Lines tool group.

The line Dashboard is opened. On top special ”Properties” for SMART Drafting are shown. To 
make drawing easier a ”Popup Menu” is provided and some ”Shortcuts” are available.

Properties 

Figure 370 SMART Drafting Properties

The following buttons are provided:
AUTO Snap

If this button is pressed (default) automatic snapping is switched on and when probing 
on the sheet for example near or segment points are found. You can switch to several 
snap modes using the popup menu (see “Popup Menu” on page 400). Default snap 
mode is Auto Point.
If this button is off, snapping is off and you can probe anywhere on the sheet, no point 
will be found for snapping to. 

Grid Steps Length

If this button is pressed, the grid steps length given in the field on the right hand side of 
the button is used for drawing the next point. The value can be increased or decreased 
with the arrow buttons on the right of the field. Default value is 1.00. By default this 
button is off.

Angle absolute/incremental

If this button is pressed, the angle is displayed incremental relatively related to the last 
line.
If this button is not pressed (default), the angle is displayed absolutely related to the 
global coordinate system.

Grid Steps Angle

If this button is pressed (default) the grid steps angle given in the field on the right hand 
side of the button is used for drawing the next point. The value can be increased or 
decreased with the arrow buttons on the right of the field. Default value is 5.00.

AUTO Snap Grid Steps Length

Grid Steps AngleAngle absolute/incremental

Define fixed values
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Define fixed values 
In these fields the values for the current point are displayed while drawing. For lines 
Length and Angle are displayed, for arcs it is Radius and Angle. If you select an option, the 
appropriate input field is activated.

Mouse Cursor

In the graphics area the mouse cursor changes after calling SMART Drafting. Information fields 
are attached now, which are empty until you have drawn the first point:

Figure 371 SMART Drafting Mouse Pointer

The information fields are:
Length gives the length of the currently drawn segment.

If you draw an arc, the Radius field is displayed
Angle gives the angle of the currently drawn segment.

Both information fields update immediately when moving the mouse. Also additional information 
will be given while drawing as shown in “Drawing Lines” on page 404 and “Drawing Arcs” on 
page 406.
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Popup Menu

If you press the RMB on the graphics area, the following popup menu opens:

Figure 372 SMART Drafting Popup Menu

AUTO Snap 
Selecting this entry provides the following popup menu showing the available snap 
modes which can be pre-defined.

Figure 373 AUTO Snap Popup Menu

The snap modes work in the same way as the probe specifiers, therefore these are not 
explained in detail here. For each snap mode a cross reference to the appropriate 
probe specifier explanation is given below:
Auto Point 

described in “In Graphics Probe Bar”, “Auto Probe” on page 115.
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Nearest Point 
described in “In Graphics Probe Bar”, “Near Probe” on page 117.

Middle Point 
described in “In Graphics Probe Bar”, “Mid Segment Probe” on page 122.

Tangent Point 
described in “In Graphics Probe Bar”, “Tangent Probe” on page 122.

Center Point 
described in “In Graphics Probe Bar”, “Center Probe” on page 121.

Per Point 
described in “In Graphics Probe Bar”, “Perpendicular Probe” on page 120.

Line defines the current element to be a line (default, for details see “Drawing Lines” on 
page 404).

Arc defines the current element to be an arc (for details see “Drawing Arcs”, “Standard 
Arcs” on page 406).

Perp. Arc defines the current element to be a perpendicular arc (for details see “Drawing Arcs”, 
“Perpendicular Arcs” on page 406).

Flip Arc draw the bending of the current rubber band arc the other way round. This entry is only 
active if Arc or Perp. Arc was chosen (for details see “Flipping Arcs” on page 407).

New Line 
Close Line 
Close and New Line 
Delete Point 

All these entries work in the same way as the usual line editing options given in “Lines 
- Home Tab”, “Popup Menu While Drawing a Line” on page 342.

Add Construction Point 
At the current position of the mouse cursor a construction point will be created. If you 
move the mouse, a construction line will be drawn between construction point and the 
mouse cursor. 

Remove this Construction Point 
If there is a construction point at the current mouse cursor position, it will be deleted. 

Undo 
cancels the last work step.

Redo 
executes the work step canceled before. It is not activated if there is no previous work 
step in the history stack.

Exit Tool 
quits SMART Drafting.
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Shortcuts

Shift Key

The Shift key fixes the angle to the current value as long as you keep the Shift key 
pressed.

The direction from the last point is indicated by the background of the Angle information field. It is 
blue as you move the cursor on the same side related to the last point when you pressed the 
Shift key. It turns to orange if you move the mouse cursor to the opposite side of the last 
point. Following figure illustrates this behavior.

Figure 374 Example Background Color Angle Field

Alt+a

Toggle AUTO Snap in the properties area of the Dashboard to be on or off. 

Alt+c

If you press Alt+c on your keyboard a construction point is created at the current position of 
the mouse cursor. When moving the cursor after placing a construction point, a construction line 
is drawn between the construction point and the cursor.

Alt+d

The shortcut Alt+d deletes a construction point. Move the mouse cursor on a construction 
point and press Alt+d on your keyboard.

Alt+g

Toggle Grid Steps Length in the properties area of the Dashboard to be on or off. 
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Alt+q

Toggle Grid Steps Angle in the properties area of the Dashboard to be on or off. 

Alt+x

Toggle Angle absolute/incremental in the properties area of the Dashboard to be on (incremental) or 
off (absolute). 

For details on the properties area of the Dashboard see “Properties” on page 398.

Shortcuts for using Fixed Values

Alt+v

Sets the focus on the input field Length/Radius for entering a fixed value.

Alt+b

Sets the focus on the input field Angle for entering a fixed value.
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Drawing Lines

As you draw lines with SMART Drafting a rubber band and the current point is displayed while 
moving the mouse cursor.

Please note: If the snap mode is not Auto Point, the rubber band between last point and mouse 
cursor turns into chain style until the cursor approaches an existing point on the 
sheet, which matches the current snap mode, then it turns back into dotted style. 

Snap Mode Information

As you move the cursor close to existing elements and the snap mode is Auto Point, the informa-
tion window expands showing the current snap mode. If another snap mode than Auto Point is 
defined, this one is shown permanently in the information window independent from the mouse 
cursor being close to an existing element or not.

The following table shows the snap modes which can be predefined in the SMART Drafting 
popup menu (see “Calling SMART Drafting”, “Popup Menu” on page 400) and its display in the 
information window:

Snap Mode Display Example

Nearest Point Near

Middle Point Middle

Tangent Point Tangent

Center Point Centre

Per Point Perpendicular
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The information window also gives snap modes, which cannot be set in the SMART Drafting 
popup menu:

Snap mode information is also given when drawing arcs (see “Drawing Arcs” on page 406).

Relation to Last Segment

As you draw a line the relation to the last segment is displayed according to the current mouse 
position. 

If the current segment is parallel against the last one, two parallel short lines are shown.

Figure 375 Example: Segment is parallel against last one

If the current segment is perpendicular against the last one, a uppercase letter L is drawn at the 
intersection point, see figure below.

Figure 376 Example: Segment is perpendicular against last one

Snap Mode Display Example

Segment Segment

Intersection Intersection
see Figure 386, “Example: Using 
construction points 4” on page 410
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Please note: Before you can draw an arc you have to draw a line. 
You cannot draw an arc as first segment.

SMART Drafting provides two types of arcs, one is drawn tangential at the last segment (see 
”Standard Arcs”) and the other is drawn perpendicular at the last segment (see ”Perpendicular 
Arcs”).

Standard Arcs

Choose Arc from the SMART Drafting popup menu. The arc is drawn tangential at the last seg-
ment. This is indicated by the uppercase letter T in the graphics area. In addition to this con-
struction lines are drawn between the center point and the end points.

Figure 377 Example: Drawing Arcs 1

Also between arcs the intersection is always tangential.

Figure 378 Example: Drawing Arcs 2

Perpendicular Arcs

Choose Perp. Arc from the SMART Drafting popup menu. The arc is drawn perpendicular at the 
last segment. This is indicated by the uppercase letter L in the graphics area. In addition to this 
construction lines are drawn between the center point and the end points.
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Figure 379 Example: Drawing Perpendicular Arc 1

Also between arcs the intersection is always perpendicular.

Figure 380 Example: Drawing Perpendicular Arc 2

Flipping Arcs

If you want the arcs bending to be on the opposite side of the last point (respectively the current 
point), use Flip Arc from the popup menu. 

For example, draw an arc and then move the cursor as given in the following figure related to 
the last drawn point.

Figure 381 Example: Flip Arcs 1

Now choose the entry Flip Arc from the SMART Drafting popup menu.
The bending of the arc changes to the opposite side of the last point.
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Figure 382 Example: Flip Arcs 2

Using Construction Points

At any time you can place construction points on the sheet helping you to draw your design. A 
construction point is displayed as a prim. The number of construction points is not restricted. 

To place a construction point, do the following:

1. Move the cursor to the coordinates where to place the construction point.
2. Press Alt+c on your keyboard.

A prim is drawn at the current position.

Please note: When quitting SMART Drafting all construction points are deleted.

The following example illustrates the use of construction points:

1. Draw a line and a construction point which is perpendicular to the last segment.
2. Move the mouse to the left and top and press the Shift key on your keyboard when 

the Angle is 40.0000, to keep this value (the background color of the field turns to blue).
3. Move the mouse cursor above the construction point to see the vertical construction 

line as shown in the Figure 383.
4. Then click left to create the point which is marked by the red cross in Figure 383.

Figure 383 Example: Using construction points 1
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5. Go on creating the geometry as shown in the following figure.
After completing the vertical and horizontal lines, create the second construction point 
at the intersection of the angle and vertical line as shown (Figure 384).

6. Create a third construction point at the end of the horizontal line.

Figure 384 Example: Using construction points 2

7. Move the mouse down.
8. Place the next point of the polygon at the intersection point of the construction lines 

created by the construction points.

Figure 385 Example: Using construction points 3

9. Move the mouse cursor to the right and down on the y-coordinate of the first construc-
tion point.
Now two construction lines are drawn, from 2nd construction point to current point and 
from 1st construction point to current point. The intersection of both construction lines 
is the point to draw next in this construction.
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Figure 386 Example: Using construction points 4

10.Place the next point of the polygon according to the figure below.
The result of this example construction looks like in the following figure.

Figure 387 Example: Using construction points 5
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Extending an Existing Geometry with SMART Drafting

If you have a geometry and you want to extend it using SMART Drafting, you have to edit the 
element and then choose the SMART Drafting tool. In SMART Drafting the rubber band always will 
be attached to the last point of the element.

For example, you have the following geometry:

Figure 388 Example: Continue Geometry 1

1. Double click on the element or choose Edit from the popup menu.

Figure 389 Example: Continue Geometry 2

The geometry is displayed highlighted.
2. Choose the SMART Drafting tool .

Figure 390 Example: Continue Geometry 3

SMART Drafting is activated and the information window appears close to the cursor. 
Now you can go on smart drafting as usual.
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While drawing in SMART Drafting it can be helpful to continue drawing at the opposite side of 
the polygon. This is done easily by changing the line direction.

For example, in the following polygon you want to have a similar arc on the left hand side on the 
same y-coordinate as the arc on the right side.

Figure 391 Example: Change Line Direction 1

Toggle the line direction for changing the last point to be the first point and vice versa. The point 
which was the first point in the polygon becomes the last point.

Figure 392 Example: Change Line Direction 2
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This chapter contains background information and procedures for creating and editing dimen-
sions.

• Dimensioning Standards ........................................................ 414

• Setting the Default Dimension Standard ................................ 415

• Properties, Styles and the Dashboard ................................... 419

• Dimension Tools..................................................................... 420

• Creating Linear Dimensions................................................... 421

• Linear Dimension Properties.................................................. 427

• Creating Circle and Arc Dimensions ...................................... 437

• Radial Dimension Properties ................................................. 439

• Creating Angular Dimensions ................................................ 441

• Angular Dimension Properties ............................................... 442

• Editing Dimensions ................................................................ 444

• Creating Notes ....................................................................... 450

• Feature Control Frames and Datum ...................................... 452

• Surface Finish Symbols ......................................................... 455
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Dimensioning Standards

In conventional drafting, dimensioning is generally drawn to recognized national or international 
standards, which determine the format of the dimensioning. The dimensioning may also be sub-
ject to internal company standards, which may define the way in which dimensioning values are 
presented.

MEDUSA4 allows you to create dimensions to one of five standards, namely:

• ANSI

• BSI

• DIN

• ISO

• JIS

The dimensioning standard that you use determines how the dimensioning is presented. For 
example, Figure 393 illustrates the difference between ISO and ANSI standards.

Figure 393 Dimensioning Standards
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Setting the Default Dimension Standard

In MEDUSA4 it is possible to preset the dimension standard which is to be used and to adjust 
different parameters for it, like the dimension text height. In the File tab choose Default Settings and 
then the tab Dimensions:

Figure 394 Defaults Dialog: Dimension Tab

You find the following entries inside the Dimension tab:
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Standard
ISO, DIN, ANSI, BSI and JIS

enables you to select from one of the standards

Arrows

shows the definitions for arrows for the selected Standard.
Move the mouse cursor on any symbol to read its tool tip for more information.
You can change the settings by clicking the LMB on the relevant button and choose a new sym-
bol from the Point Function dialog (see ”Lines - Home Tab”, “Point Functions” on page 360).
Line Dimension

shows the definitions for arrows on dimension lines for the selected Standard.
Angular / Arc Dimension

shows the definitions for arrows on dimension lines of angles and arcs.
Symbol of Start Point (Coord Dimension)

Symbol of the starting point when using coordinate dimensioning
Radial Dimension

Radial dimensions can be drawn with or without the line witnessing the radius. With 
this option one of the possibilities can be chosen.

Please note: The ISO standard also allows you to draw flipped out diameter dimensions with or 
without a witness line exhibiting the diameter.

Gap
Dimension Line Gap

defines the distance between witness/leader and dimension line, respectively the 
excess length of the witness/leader line beyond the dimension line.

Leader/Witness Line Gap 

defines the distance between witness line and probe point.
To change the gap, click on the symbol next to the option.
The Point Functions dialog is displayed. By choosing a different symbol from the dialog 
the gap between witness line and probe point changes.

Gaps in overlapping Leader/Witness Lines

defines the size of the gap, if witness lines are overlapping.
To change the gap, click on the symbol next to the option.
The Point Functions dialog is displayed. By choosing a different symbol from the dialog 
the size of the gap changes.

Gap Mode

Horizontal

defines that the gaps in overlapping witness lines are inserted in horizontal lines only
Vertical

defines that the gaps in overlapping witness lines are inserted in vertical lines only
416 © CAD Schroer GmbH



MEDUSA4 Drafting
Setting the Default Dimension Standard
Natural

defines that the gaps in overlapping witness lines are inserted wherever it fits

Prefix / Suffix

For following settings you can define Prefix and Suffix of the dimension text for the appropriate 
dimensioning. Clicking the LMB on the button  opens the Special Characters dialog. You can also 
enter values by typing them on your keyboard.
Radial Prefix/Suffix

defines prefix and suffix of text for the dimension of radii.
Diametric Prefix/Suffix

defines prefix and suffix of text for the dimension of diameters.
Thread Prefix/Suffix

defines prefix and suffix of text for the dimension of threads.
Chamfer Prefix/Suffix

defines prefix and suffix of text for the dimension of chamfers.

Text
Dimension Text

Normal

displays dimension text with normal font weight (default setting).
Bold

displays dimension text with font weight bold for printing or plotting.
If this option is set, boldness of plotted dimensions can be set to a certain value by 
defining environment variables inside the login.bat (for details see the Administration 
Guide, chapter Setting up Boldness for Plotting Dimensions).

DIN Tolerance Text Height

Normal

sets the text height for the tolerance according to the text height of the dimension.
Small

sets the text height for the tolerance smaller than the text height of the dimension.

Settings
Save Damaged Dimensions

Prompt

If this option is set, you are asked how to handle damaged dimensions every time, you 
try to change a dimension (for details see ”Editing Dimensions”, “Possible Messages 
while Changing Dimensions” on page 448).
Never

Damaged dimensions are never saved but are always reverted to their original struc-
ture if possible.
Always

Damaged dimensions are always saved.
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Reset Tool Properties

Automatic Reset

If this option is activated each time one of the dimensioning tools is activated, tempo-
rary dimensioning attributes (text height for instance) are reset in accordance with the 
default values in the same way they are when using the button Reset of the properties 
dialog.
Keep User Settings 
If this option is selected, temporary dimensioning attributes (text height for example) 
are left as they were from the last use of a dimension creation tool.

Escape

is a placeholder for the display of the formats. It is used internally.

The buttons at the bottom of the dialog are:
OK

applies the changed settings and uses them for the next new dimensions.
Cancel

undoes the last changes
Reset

resets all settings to the defaults

Please note: Changed dimension options are only available in the current MEDUSA4 session 
unless you save the defaults when quitting MEDUSA4 (see ”File Tab”, “Quitting 
MEDUSA4” on page 258).
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Properties, Styles and the Dashboard

All properties of any dimension may be set by using the appropriate dialog. Depending on the 
kind of dimension following dialogs are available:

• Linear Dimension Properties dialog (see “Linear Dimension Properties” on page 427)

• Angular Dimension Properties dialog (see “Angular Dimension Properties” on page 442)

• Radial Dimension Properties dialog (see “Radial Dimension Properties” on page 439)

• Arc Dimension Properties dialog (see “Arc Dimension Properties” on page 623)

As with other MEDUSA4 entities, the most commonly accessed attributes are displayed on the 
Dashboard, an example is given below.

Figure 395 Dashboard: Dimensioning

The Dashboard and the properties dialogs are used to display properties and set them, both for 
single dimension and multiple dimension types. You can:

• Add a diameter symbol to the dimension text

• Specify the number of decimal places

• Position the text outside the dimension line

• Select a different dimension style

• Access the full dimension properties

• Create a new dimension in the last selected dimension style

Properties may be set before the dimension is positioned, during positioning and after a dimen-
sion has been positioned. Any particular dimension set-up may be stored as a style, with a 
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name for instant re-use. To store a style MEDUSA4 has to be in administration mode. Therefore 
appropriate explanations are given in the Administration Guide, chapter Administration, section 
Creating and Editing MEDUSA4 Styles.

Dimension Tools 

Figure 396 Dimension Tools
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Creating Linear Dimensions

You can create linear dimensions in one of three formats, coordinate, chain or datum format. 
Figure 397 shows an example for each format. 

Figure 397 Linear Dimension Formats

Procedure

To create linear dimensions:
1. Choose one of the linear dimension tools (for coordinate , chain  or datum  

dimensioning).
Once you have chosen a tool, a popup menu is available, see “Popup Menu While 
Dimensioning Linear” on page 422.

2. Move the cursor to the point where you want to start the dimension and then click the 
LMB.
The dimension appears at the cursor.

3. Move the cursor to the next point that you want to dimension and then click the MMB.
4. Repeat step 3 until you place the last point that you wish to dimension.

The dimension lines move to wherever you position the cursor.
5. Move the cursor to the position where you want to place the dimension text and click 

the LMB.
The dimension is created.

Please note: If you are creating a single linear dimension between 2 points only, then you can 
use the LMB for each probe in the above procedure.
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Popup Menu While Dimensioning Linear

While dimensioning the following popup menu is available by clicking the RMB.

Figure 398 Popup Menu For Linear Dimensions

The following entries are available:

Please note: The first five entries define the orientation of the dimension. 
Always one of them is chosen (by default it is Automatic as shown in the figure 
above) and it is displayed grayed out (disabled). 

Horizontal

snaps dimensioning to the horizontal direction. 
Vertical

snaps dimensioning to the vertical direction. 
Parallel

snaps dimensioning parallel to the line which runs between the first and second point 
probed for dimensioning (or which can be created if there is none). An example is 
shown in “Example - Parallel Dimension” on page 424.

Perpendicular

creates the dimension perpendicular to the line which runs between the first and last 
points probed for dimensioning. An example is shown in “Example - Perpendicular 
Dimension” on page 424.

Please note: It may be useful to create a construction line to position the last probe.
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Automatic

snaps dimensioning to that direction which comes closest to the current position of the 
cursor related to the points probed for the dimension. 

Probe points

is used for snapping probing inside the graphics area to the next point of an element. If 
this option is chosen Probe line is enabled. This option is enabled only before probing the 
first point for dimensioning.

Probe line

is used for snapping probing to the next line segment of an element. This option is use-
ful for dimensioning a single segment. If this option is chosen Probe points is enabled. 
This option is enabled only before probing the first point for dimensioning.

Properties

opens the Linear Dimension Properties dialog (for details see “Linear Dimension Properties” 
on page 427).

Undo

is used for canceling the last action. You can undo several actions.
Exit Tool

quits the tool. 

Dimensioning Trick for Simple Line Segments

If several simple line segments have to be single dimensioned, the MMB can be used for seg-
ment selection instead of point to point dimensioning (3 click points). This way saves time and 
even prevents errors when grasping the vertices with the LMB.

To create a dimension for a single line segment follow this procedure:

1. Click middle on a line segment.
2. Move the mouse to the desired position where to place the dimension line.
3. Click left to place the dimension.

Figure 399 Example for the dimension trick having selected the line segment

click point of the MMB
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Example - Parallel Dimension

Figure 400 Example of Parallel Dimension

Example - Perpendicular Dimension

Figure 401 Example of Perpendicular Dimension

first probed point
second probed point

dimension is parallel to this line

first probed point second probed point

last probed point

construction line

(places the
dimension)
424 © CAD Schroer GmbH



MEDUSA4 Drafting
Creating Linear Dimensions
Example - Position Elsewhere Dimension

For chained and axonometric dimensions the text can be dragged away from the dimension line 
and positioned anywhere else on the sheet. The repositioned text is linked to the relevant 
dimension line in the same style as a note.

The following example assumes that you have created a chain dimension and then set the Posi-

tion Elsewhere option for text positioning (see ”Linear Dimension Properties”, “Text Position” on 
page 432). So you should have a dimension similar to that one in the following figure. 

Figure 402 Example - Position Elsewhere Dimension, Input 

Following tasks can be done:

• Changing the position of the arrowhead on the dimension line 

• Changing the position of the dimension text and its linked line 

• Changing the text orientation 

The steps to perform are:

1. Select the Position Elsewhere dimension.
2. Choose Edit from the popup menu.
3. Click left on a dimension text. 
4. Choose Linked Text Options from the popup menu to open the following dialog:

Figure 403 Editing a Position Elsewhere Dimension, Linked Text Options Dialog
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The options on this dialog are:
• Edit Line Position allows the arrowhead to be moved along the dimension line.

This is the default edit mode. Note that the link line is restrained to be kept within the 
dimension line, just like Force Inside text positioning.

• Edit Text Position allows you to relocate the text.
If this option is chosen, the text can be dragged to any desired position. The 
attached link line is changed accordingly. 
Normally the text will be displayed as for a note. If the text is too close to the dimen-
sion line to allow the line to be drawn clearly, the link line is omitted and the Force 

Inside layout is used.
• Edit Text Orientation allows you to select the angle that the text is displayed.

If this option is chosen, the Text Orientation options and Angle are activated. The text 
can be angled absolutely (relative to the X axis of the sheet), parallel (relative to the 
dimension line) or as perpendicular (relative to the witness lines of the dimension). 

5. Choose the option
• Edit Line Position or Edit Text Position, confirm with OK and place the dimension text with a 

left click on the sheet.
• Edit Text Orientation, the sub-option Absolute, Parallel or Perpendicular, define an Angle and 

confirm with Apply or OK. The orientation is applied immediately on the dimension 
text.

In the following figure the results of the different options are shown from left to right.

Figure 404 Example - Position Elsewhere Dimension, Result
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Linear Dimension Properties

You can use the Linear Dimension Properties dialog to edit the default linear dimension properties. To 
display the Linear Dimension Properties dialog, select a dimension line, and then select the Properties... 

option from the popup menu.

The Linear Dimension Properties dialog has two tabs:

• ”Style and Format” (see below) and 

• ”Text and Arrows” are explained on page 432.

Style and Text Lock are explained on page 435.

The buttons are explained on page 436.

Style and Format

Figure 405 Linear Dimension Properties: Style and Format Tab 

The entries of this tab are explained on the following pages.
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Dimension and Tolerance Style

The Dimension and Tolerance style buttons control the manner in which the basic dimension value is 
displayed. 

Figure 406 Dimension and Tolerance Style Buttons

The upper row defines how tolerance values are displayed, from left to right it is:

• No tolerance values 

• Tolerance shown as limits of dimension 

• Tolerance shown as dimension plus variations 

• Tolerance shown as dimension plus symmetrical variation 

The lower row defines the style of the dimension. The options, from left to right are:

• Normal dimension (no identification marking of dimensions)

• Absolute dimension (marked by a rectangle)

• Unscaled or Underlined dimension 

• Test dimension (marked by a sausage)

Please note: To change the calculated value of an unscaled dimension, see “Dimension and 
Tolerance Format” on page 429, parameter Value.

Standard

Figure 407 Standard

Standard 
allows you to change the standard for selected dimensions. The Standard option is 
merely the same functionality as can be accessed by using the popup menu when edit-
ing a dimension, see ”Editing Dimensions”, “Popup Menu 1 for Editing Dimensions” on 
page 446.
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Tolerance Text Height 
These buttons apply on DIN dimensions only. The DIN standard supports two layouts 
of dimension with variance.
• The main dimension value and the two variances can all have the same height, in 

which case the lower limit and main value are adjacent to each other . 

• Alternatively the two variance values are drawn with a smaller height (70%) and the 

main dimension value is raised to be between the two variance values  
(default).

Draw Underline 
These buttons can be applied only on unscaled or underlined dimensions. 
• Unscaled dimensions have no calculated dimension value but an assigned Value, 

see “Dimension and Tolerance Format” on page 429. The text of these dimensions 

can be displayed underlined  (default) or not underlined .

• Underlined dimensions have a calculated value. The text of these dimensions can 

be displayed underlined only  (default).

Dual Dimension

The Dual dimension buttons allow dimensions to be simultaneously displayed in metric and impe-
rial units. The basic display is always in sheet units and the dual display is in the other. 

Figure 408 Dual Dimension Buttons

The options, from left to right are:

• Toggle dual dimensioning On/Off

• Dual dimension beneath primary dimension

• Dual dimension other side of dimension line

• Dual dimension alongside primary dimension

• Spaces is the value defining the space MEDUSA4 will leave between primary and dual 
dimension components. This distance is in sheet units. The setting is valid if using dual 
dimension alongside primary dimension.

Dimension and Tolerance Format

This area controls the numerics and text parts of the dimension.
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Figure 409 Dimension and Tolerance Format Options

On top of this area you find buttons for frequently used dimension and tolerance formats:

•  Default linear dimension format 

•  Linear dimension format for diameter 

•  Linear dimension format for radius 

•  Linear dimension format for metric threads 

•  Linear dimension format for chamfers 45° 
Prefix, Suffix

The Prefix and Suffix fields control any fixed text surrounding the numerical dimension 
data. You have following possibilities:
• Use the options on top of this area. 

It is also possible to specify user defined prefixes and suffixes in the defaults.dat (see 
the Customization Guide, User Interface, Defaults.dat, Dimensioning Defaults).

• Select an option from the Prefix or Suffix pulldown menu
• Type a value into the Prefix or Suffix entry box
• Enter a special symbol by clicking one of the Symbol buttons and selecting the 

required symbol from the Symbol dialog.
Value

This option is only activated if the Text type is Unscaled or Underlined dimension.
By default the dimension value is automatically calculated from the drawing. For 
Unscaled or Underlined dimensions you can change the calculated value, by setting the Value 
choice box and type in the required dimension value in the text entry box below.

Limit/Fit

Limit and Fit values may be entered for any dimension style which uses them. 
To define and display limit and fit values, select the Limit/Fit choice box, and then type 
the required information into the text entry box.
If required, you can select the text from a lookup table which shows all company stan-
dard options. This function is only available, when the MEDMECH product is included 
in the product list of your project. To display this lookup table, select the Look up table but-

ton. The button is grayed out until you select the Limit/Fit choice box.
430 © CAD Schroer GmbH



MEDUSA4 Drafting
Linear Dimension Properties
Figure 410 Limits and Fits Dialog 

Tolerance

Tolerances, in the form of upper and lower limits, may be entered for any dimension 
style which displays them. You can enter the values manually or you can select the 
Auto tolerance choice box to allow MEDUSA4 to calculate them. Auto Tolerance is only appli-
cable if the option Limit/Fit is on.

Dual

gives the tolerances for a dual dimension. If Auto Tolerance is used then the values are 
calculated automatically.

Test percentage

is active when Test dimension is set for Text type. This option is limited to the range of 0 to 
100, and if it is set to zero, the test percentage text block is not displayed in the dimen-
sion.

Figure 411 Example Test Dimension 
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Text and Arrows

The graphical display of dimensions is controlled by the Text and Arrows tab on the Linear Dimension 

Properties dialog.

Figure 412 Linear Dimension Properties: Text and Arrows

Text Position

MEDUSA4 automatically calculates whether there is sufficient space within the witness lines to 
accommodate the dimension text. If there is not sufficient room, it repositions the text outside 
the witness lines. This Text position area allows the user to override these defaults. 

Figure 413 Text Position buttons

The options from left to right are:

• Position Auto (default)

• Force Inside 

• Force Outside 

• Position Elsewhere is a special case for Force Inside but only for chain and axonometric 
dimensions (for details see “Example - Position Elsewhere Dimension” on page 425).
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Layer

Layer allows the dimension to be positioned on an alternative layer. By default the layer Dimension-

ing and Baselines is selected.

Figure 414 Layer selector

Direction

Direction allows the selection of the direction of geometry being dimensioned to be set. 

Figure 415 Direction buttons

The following options are available from left to right:

• Automatic direction selection

• Horizontal

• Vertical

• Parallel

• Perpendicular

Imperial Text

When dimensioning an imperial sheet, or using dual dimensioning on a metric sheet, you have 
several extra options. Drawings tend to be constructed in inches, but large dimensions are often 
displayed in feet. 

Figure 416 Imperial Text Options

The following options are available from left to right:

• No units

• Display as inches

• Display as feet and inches

• Display as feet
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You can also choose to display imperial dimensions using Fractions.

Dimension Type

This area shows the dimension type. By default Type is locked and cannot be changed. 

Figure 417 Dimension Type Options

The following types of dimension are available from left to right:

• Coordinate dimension

• Datum dimension

• Chain dimension

• Symmetrical dimension

• Half a symmetrical dimension

• Dimension offset from a datum

Spacing

You can use this area to control the spacing between witness lines for dimensions which have 
multiple witness lines.

Figure 418 Dimension Spacing Option

Text Format

This area provides control over the physical display of the dimension text. You can choose the 
text height (in sheet units) and a special scale for a particular dimension.

Figure 419 Text Format Options
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You can format the dimension with any number of decimal places, also with a different number 
being displayed for the dual part of a dual dimension. Formats for primary and dual part of dual 
dimensions are arranged to display the required number of decimal places.

There is a toggle option to control the display of trailing zeros on exact dimensions. So with a 
dimension format set to show three decimal places you can choose whether to display 15.000 
or 15. Decimal places which are non zero are always displayed, for example 15.5, 15.75.

Arrows and Gaps

You can set the point functions for arrows and gaps, which appear on witness lines, to suit spe-
cial requirements. Click left the icon displaying the sign that you want to change and a dialog of 
all point functions appears. Select the required point function.

Figure 420 Arrows and Gaps Options

The basic set-up for arrows and gaps is a function of the dimension standard, see “Dimension-
ing Standards” on page 414.

Graphic Scaling

Graphic Scaling changes arrow heads, gaps and texts of the selected dimension to the set Graphics 

Scale value (default is 1.00). 

Figure 421 Graphic Scaling Option

For example, if you set the value to 2.00, arrow heads, gaps and texts will be enlarged by the 
factor 2. If a Null is entered an error message is given. Values lower than Null are impossible. 
Scaling is valid for the graphical display only. Properties like the text format are not changed.

Style and Text Lock

Style 
shows the style of the current dimension. You can change the style by clicking the 
arrow and selecting another one from the pulldown list or from the style tree.
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Text Lock 

enables or disables changing the dimension text value when moving witness lines.
By default text is unlocked, indicated by the open lock icon. So if you move a witness 
line, the dimension text updates appropriately. If you click left on the icon Text lock on, 
text is locked and will not change when a witness line will be moved.

Buttons

OK and Apply 
apply the current settings on the selected dimension. OK additionally closes the dialog.

Cancel 
closes the properties dialog. The settings are not applied on the selected dimension.

Style 
is only active in Administration Mode (for details see the Administration Guide, chapter 
Administration, section Creating and Editing MEDUSA4 Styles).

Reset 
updates the properties of the dialog to reflect the various defaults defined in the file 
styles.xml. 

Help 
This button opens the online documentation.
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Creating Circle and Arc Dimensions

For circles and arcs following dimensions are possible:

• The radius and diameter of a circle or an arc

• The radius of a circle or arc when the center of the circle or arc is outside of the sheet

Dimensioning the Diameter of a Circle 

1. Choose the Dimensions the diameters of circles and holes tool .
2. Probe the position on the circumference of the circle or arc where you want the dimen-

sion line to exit.
A diametric dimension line appears on the sheet.

3. Move the cursor to the position where you want the dimension text, then click left.
The dimension text is placed on the sheet.

Dimensioning the Radius of a Circle

1. Choose the Create radial dimension tool .
2. Probe the position on the circumference of the circle where you want the dimension 

line to exit.
A radial dimension line appears on the sheet.

3. Move the cursor to the position where you want the dimension text, then click left.
The dimension text is placed on the sheet.

Dimensioning a Radius with an Off Sheet Center

1. Choose the Dimensions the offset radius tool .
2. Probe the position on the arc, where you want the dimension line to start.
3. Probe the position where you want the dimension text to be.
4. Probe the position to place the end of the dimension line and then click left.
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Popup Menu While Dimensioning Circles and Arcs

While dimensioning circles and arcs clicking the RMB opens the following popup menu:

Figure 422 Popup Menu for Dimensioning Circles and Arcs

Properties

opens the properties dialog as described in “Radial Dimension Properties” on 
page 439.

Exit Tool

quits the tool. 
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Radial Dimension Properties

The radial dimension properties are similar to linear dimension properties. The difference is the 
buttons for Radius Visibility which are additionally in the Standard section of the Style and Format tab 
(see “Standard” on page 440). Furthermore the section Type is available in the Text and Arrows tab 
(see “Type” on page 440). Details on the other parameters are described in the “Linear Dimen-
sion Properties” on page 427 in the relevant descriptions).

Figure 423 Radial Dimension Properties: Style and Format Tab   

Figure 424 Radial Dimension Properties: Text and Arrows Tab   
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Standard

Figure 425 Standard

The options in the area Standard work in the same way as given in ”Linear Dimension Properties”, 
“Standard” on page 428). The Radius Visibility buttons allow you to show or hide (default) the line, 
which indicates the radius inside the arc or circle.

Please note: In addition the ISO standard allows flipped out diameter dimensions to be drawn 
with or without a witness line indicating the diameter. Radius Visibility is used for that 
case too.

Type

The Type buttons show the type of radial dimension. By default Type is locked and cannot be 
changed. 

Figure 426 Type

From left to right the dimension will be displayed as a radius, diameter or a offset radius. 
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Creating Angular Dimensions

You can dimension the internal or external angle between two existing line segments.

When you create angular dimensions, you use a number of probes to define different elements 
of the dimension, depending upon the dimensioning tool you selected. The three methods of 
dimensioning angles are shown in the figure below.

Figure 427 Creating Angular Dimensions

Please note: If you use the three- or four-point method to define your dimension, it is important 
to probe all the points either in a clockwise or counterclockwise manner to form 
the dimension. 

To change the dimension from an internal to an external angle or vice-versa, before placing the 
final point, move the cursor across one of the lines defining the angle.

While dimensioning angles clicking the RMB opens a popup menu (see ”Creating Circle and 
Arc Dimensions”, “Popup Menu While Dimensioning Circles and Arcs” on page 438). The entry 
Properties opens the Angular Dimension Properties dialog, see page 442. Exit Tool quits the tool. 

Using 2 Probes Using 3 Probes Using 4 Probes

Angle defined by:
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Angular Dimension Properties

The angular dimension properties are similar to linear dimension properties. The main differ-
ence is in formatting. There are no dual dimensions and the format options are different.
Text Format is explained in “Text Format” on page 443. Details on the other entries are described 
in “Linear Dimension Properties” on page 427.

Figure 428 Angular Dimension Properties: Style and Format Tab

Figure 429 Angular Dimension Properties: Text and Arrows Tab
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Text Format

Figure 430 Angular Dimension Text Format Options 

Angles may be displayed in the following formats:

• Degrees

• Degrees to the required number of decimal places (0-3)

• Degrees and minutes

• Degrees, minutes and seconds
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Editing Dimensions

Dimensions can be edited in different ways. This section provides following information:

• ”Repositioning, Adding or Deleting Dimension Parts” 

• “Popup Menus while Editing Dimensions” on page 445 

• “Possible Messages while Changing Dimensions” on page 448 

Repositioning, Adding or Deleting Dimension Parts

Consider the following figure which shows the different parts of a dimension for editing a dimen-
sion. You see a witness line (A), the dimension text (B) and the dimension line (C). 

Figure 431 Linear Dimension Example

Repositioning a Dimension Part

1. First select the part of the dimension you want to change either by:
• double click left on it, or
• click left on a dimension, then choose Edit from the popup menu and finally click left 

on the part of the dimension you want to reposition.
2. Move the mouse and see the dimension part moving attached at the cursor.
3. Click left on the sheet to reposition according to your selection:

• If you selected a witness line (A in Figure 431, “Linear Dimension Example” on 
page 444) you can probe a new point for changing the points which are dimen-
sioned.

• If you selected a dimension text (B in Figure 431) you can move it to a new position.
• If you selected a dimension line (C in Figure 431) you can probe a new point for 

changing the spacing of the dimension text to the dimensioned points.
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Adding a Segment to an Existing Dimension

To add a further dimension to a line that is already dimensioned:
1. Select the dimension.
2. Choose Edit from the popup menu.
3. Choose Add from the popup menu.
4. Move the cursor to the position where you want to define the new dimension line.
5. Click left to create the dimension.

You automatically use the format and standard of the existing dimension line.

Deleting a Part of a Dimension

To delete a part of a multi-segment dimension:
1. Select the dimension.
2. Choose Edit from the popup menu.
3. Choose Delete from the popup menu.
4. Move your cursor over the witness line you want to delete, and click left.

The according dimension segment is deleted. The other parts of the dimension are 
altered if necessary to display the adjusted dimension values (for example, if the mid-
dle segment of a chain dimension is deleted).

Deleting a Whole Dimension

To delete a whole dimension:
1. Select the dimension.
2. Choose Delete from the popup menu.

The dimension is deleted.

Popup Menus while Editing Dimensions

In each phase of editing dimensions a popup menu provides further editing possibilities. These 
popup menus are explained on the next pages.

Popup Menu 1

This popup menu is available when the whole dimension was selected and Edit was chosen 
from the general popup menu.
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Figure 432 Popup Menu 1 for Editing Dimensions

Change to BSI, Change to ANSI, Change to DIN, Change to JIS, Change to ISO

sets the dimension text to be in BSI, ANSI, DIN, JIS or ISO standard.
Text Lock disables changing the dimension text value when moving witness lines.

By default text is unlocked, indicated by the entry Text Lock. So if you move a witness 
line, the dimension text updates appropriately. If you click left on the entry Text Lock, text 
is locked and will not change when a witness line will be moved. The entry changes to 
Text Unlock.

Add allows you to add a single witness line by probing a new point which will be dimen-
sioned from the previous/first point in the dimension chain (for details see “Adding a 
Segment to an Existing Dimension” on page 445).
This option is disabled for angular and arc dimensions.

Delete allows you to remove one witness line. If a witness line is removed from the middle of a 
dimension chain, after removing the other dimensions are adjusted for correct appear-
ance of the whole chain. If the dimension is a single one, an error message is given 
(see “Possible Messages while Changing Dimensions” on page 448). Details on dele-
tion are described in ”Deleting a Whole Dimension” and “Deleting a Part of a Dimen-
sion” on page 445.

Modify allows you to change each sub-element of a dimension either as text or line. After 
selected Modify the “Popup Menu 3” on page 447 is available.
We recommend not to do that because the dimension can get wrong.

Undo is used for canceling the last action. You can undo several actions.
Exit Tool quits the tool. 

Popup Menu 2 

This popup menu is available when the position of a line or text of a dimension is attached to the 
mouse cursor for repositioning.
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Figure 433 Popup Menu 2 for Editing Dimensions 

Linked Text Options 
Chain dimension support a Linked Text option that allows the dimensioning information 
to be offset from the dimension line in a manner similar to a note. This option allows 
you to re-orientate the text, or move it to a new location or to slide the text along the 
dimension line. Note that this option is only enabled when the Position Elsewhere text posi-
tion option is selected for the dimension (see ”Linear Dimension Properties”, “Text 
Position” on page 432).

Reselect is used for selecting another part of the dimension.
Exit Tool quits editing the dimension. 

Popup Menu 3 

This popup menu is available when dimensions are edited as simple lines or texts.

Figure 434 Popup Menu 3 for Editing Dimensions 

Edit If a sub-element of a dimension is selected, Edit changes into the appropriate edit 
mode either for texts or lines. 
If no sub-element is selected, Edit switches back into first edit mode for dimensions and 
the popup menu as given in “Popup Menu 1 for Editing Dimensions” on page 446 is 
available again.

Delete deletes either the whole dimension or a dimension line. It depends on the current 
selection. If a dimension line is removed from the middle of a dimension chain, after 
removing the other dimensions are adjusted for correct appearance of the whole chain. 
If the dimension is a single one, an error message is given (see “Possible Messages 
while Changing Dimensions” on page 448). Details on deletion are described in ”Delet-
ing a Whole Dimension” and “Deleting a Part of a Dimension” on page 445.

Exit Tool quits editing the dimension. 
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Possible Messages while Changing Dimensions

If you have changed a dimension, after quitting the modification tool, it will be checked whether 
the structure of the dimension is correct. If a dimension is damaged after the change, different 
messages can appear. The messages are not displayed if the entries Never or Always for the Save 

Damaged Dimensions option in the Defaults dialog, Dimension tab, were chosen (see ”Default Settings”, 
“Settings” on page 275).

Example 1 - Changing a Sub-Element of a Dimension

1. Select a single span dimension.
2. Choose Edit from the global popup menu.
3. Choose Modify from the edit popup menu.
4. Click left on a witness line.
5. Choose Delete from the popup menu.
6. Choose Exit Tool from the popup menu.

The following message is given.

Figure 435 Message when Changing Dimensions 1

7. Now you can cancel or apply your change:
• If you choose Cancel, the change of the dimension will be undone and the status 

before your change will be restored. If you have additionally switched on the option 
Do not ask again in the Defaults dialog, Dimension tab, the Save Damaged Dimensions option is 
set to Never and in future no more messages will be displayed. However, you also 
cannot change anymore a dimension, because the correct dimension structure will 
always be re-created automatically. 

• If you choose Retain, your change will be applied and the dimension will be dam-
aged. If you additionally have switched on the option Do not ask again in the Defaults dia-
log, Dimension tab, the Save Damaged Dimensions option is set to Always and in future no 
more messages will be displayed. Future changes of a dimension will be applied 
always. The correct dimension structure, existed before the change, can only be 
restored if you set back the option Save Damaged Dimensions to Prompt in the Defaults dia-
log. Then the message given in Figure 436, “Message when Changing Dimensions 
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2” on page 449 will be displayed with the next change and you can revert the dimen-
sion back to its original structure.

Example 2 - Changing an Already Changed Dimension Again

1. Select an already changed dimension.
For example, by doing the steps of the last example and finally choosing Retain.

2. Choose Edit from the global popup menu.
3. Click left on a witness line.

The following message is given:

Figure 436 Message when Changing Dimensions 2

4. Now you can cancel or apply your change:
• If you choose Cancel, editing the dimension will be finished.
• If you choose Revert, your original, most recent correctly structured dimension will be 

restored. All changes you made on the dimension since then will be undone.

Example 3 - Changing a Dimension of an Earlier Revision of MEDUSA4

If you load a sheet with damaged dimensions created in an earlier revision of MEDUSA4 (e.g. 
3.0 or before) and if you want to change a dimension, by selecting the dimension, choosing Edit 
from the global popup menu and then, for example, click on a witness line, a warning is given: 
The geometry of this dimension is LOCKED. After confirming the message, you can 
re-select the dimension. Then select Edit from the global popup menu and Modify from the edit 
popup menu to change this dimension.

This message will also appear if the selected dimension cannot be reconstructed even using 
the latest valid information. For example, if the dimension is an Off Sheet Datum dimension 
(see ”Dimensioning - Annotation Tab”, ”Creating Datum Offset Dimensions” on page 634) and 
the Off Sheet Datum group, which provides essential information, can no longer be found on the 
sheet, reconstruction is impossible.
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MEDUSA4 provides a toolset containing different tools for creating notes.

A note consists of a leader line and a text. The tools differ in the orientation of text and leader 
line.

Figure 437 The Creates Notes Tools

Procedure

Do the following steps for creating a note:

1. Choose, e.g., the Creates notes with horizontal notes tool .
The Dashboard displays the properties like Style and Layer and a text input field.

Figure 438 Dashboard During Creating a Horizontal Note

2. Type in the text of the note.
3. Move the cursor to the position where the arrow of the leader line for the note is to be 

placed and click left.
4. Move the cursor to the position where the text of the note is to be placed and click left.

Popup Menu

While creating a note following popup menu is available.
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Figure 439 Popup Menu while creating a note

Horizontal, Vertical, Parallel, Perpendicular 
changes to other predefined note orientations. All entries are disabled until you change 
the style to Free or Default, see Properties.

Properties 
opens the Note/Feature Frame Properties dialog shown in the figure below (the Creates note with 

horizontal orientation tool was chosen).

Figure 440 The Note/Feature Frame Properties Dialog

The dialog provides properties like Style, the Layer on which the note text is created, the 
text Height and the note Text itself. For the other properties please consider following: 
• The text Type is only enabled for style Free. If the style is not Free, the area Presentation 

is activated and the text can be displayed with rectangular or sausage frame, or 
underlined.

• The area Direction is disabled until you change the style to Free or Default. For the other 
note styles the direction is fixed, e.g. for the style horizontal.

• Symbol opens the Special Characters dialog to enter a symbol at the current cursor posi-

tion in the Text field. The frequently used special character Vertical Bar  is given by 
a separate button on the left hand side of Symbol. 

• The Arrow button opens the Point Functions dialog to change the arrow of the leader 
line.
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Please note: The Note/Feature Frame Properties dialog can be used to switch between note and fea-
ture control frame tools by changing the Style and then pressing OK or Apply.

Feature Control Frames and Datum

To specify geometric tolerances MEDUSA4 provides different tools.

Figure 441 The Feature Control Frame Tools

Creating a Feature Control Frame Datum

A feature control frame datum defines the element used as reference for a geometric tolerance.

Procedure

1. Choose the Creates a Feature Control frame datum tool .
A symbol, consisting of a prim, two lines and a text, is attached to the cursor.
In the Dashboard an edit field opens for changing the text.

2. If you want to change the text, type it on the keyboard.
If the edit field is not active, click left into the edit field.

3. Place the feature control frame datum by probing on the element that should be set in 
correlation to another one.

Popup Menu

While creating a feature control frame datum following popup menu is available.
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Figure 442 Popup Menu while creating a Feature Control Frame Datum 

Revert returns the symbol to its default orientation. 
Rotate 90 Degrees 

rotates the symbol by 90 degrees counter-clockwise. Clicking again on the entry 
repeats the rotation.

Dyn. aligning on 
switches on dynamic aligning to any line. By default automatic aligning is off.

Dyn. scaling off 
switches off dynamic scaling. By default automatic scaling is on.

Please note: Dynamic aligning and scaling work in the same way as for normal symbols, see 
”Symbols - Home Tab”, ”Transforming Symbols”, ”Aligning Symbols Dynamically” 
on page 609 and “Dynamic Scaling” on page 610.

Exchange the Feature Control Frame Datum Symbol File

The symbol for the feature control frame datum is located in <medusa4>\med2d\m2d\sym-
bol\fcdat.sym. This symbol can be replaced by another symbol using the same name. 

Creating a Feature Control Frame

Feature control frames are used to specify geometric tolerances.

Procedure

1. Choose one of the tools for creating feature control frames as shown on page 452.
The Dashboard is displayed as shown below.
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Figure 443 Dashboard While Creating a Horizontal Feature Control Frame

2. Type the text of the feature control frame in the text input field. 
Feature control frames can also contain special characters available by the icon  
which opens the Special Characters dialog. If you select a special character symbol it is 
inserted at the current position of the text.

3. Move the cursor to the position where the arrow of the leader line for the feature con-
trol frame should be placed and click left.

4. Move the cursor to the position where the text of the feature control frame should be 
placed and click left.

Popup Menu

While creating a feature control frame following popup menu is available.

Figure 444 Popup Menu while creating a Feature Control Frame 

Horizontal, Vertical, Free, Right Angled

Each of these entries switches to the appropriate feature control frame tool. The cur-
rently used one is shown deactivated.

Properties

opens the Note/Feature Frame Properties dialog. For details see Figure 440, “The Note/Fea-
ture Frame Properties Dialog” on page 451.
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Surface Finish Symbols

MEDUSA4 enables you to create surface finish symbols with or without coordinating lines. To 
create a surface symbol two different tools are available.

Figure 445 The Load Surface Finish Symbol Toolset

Each of the tools opens the Surface Finish Symbol dialog.

The Load surface finish symbol tool  opens the Surface Finish Symbol dialog.

Figure 446 The Surface Finish Symbol Dialog

From top to bottom and left to right the dialog provides following parameters:
Process Symbols 

small or large

These options define the size of the symbol. small is default.
Roughness factor 

basic symbol - no production process is regulated

symbol with crossline, surface is created by machining

symbol with circle, the surface is produced via non-cutting processing
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2nd Roughness factor 
Manufacturing process 
Direction of crease 
Machining allowance 
3nd Roughness factor 

are the possible parameters for the surface symbol.
Use on complete surface 

is used to apply the symbol on the whole surface.
In this case, a circle is added to the symbol which is displayed in the dialog.

Reset removes any entry made for the parameters Roughness factor to Use on complete surface. The 
process symbols and the size are not affected.

Close quits the dialog.

Please note: The Load surface finish symbol (without leading line) tool can be placed free on the sheet; 
a line is not required in order to place the symbol. However, if a line is close-by, 
the symbol will be aligned at this line.
The Load surface finish symbol tool is a two phase tool. You place the arrow with a first 
left click and the symbol with a second one.

It is possible to specify certain user defined parameters like the text styles for small and large sur-
face symbols in the defaults.dat (details are given in the Customization Guide, User Interface, 
Defaults.dat, Surface Symbol Defaults).

If a Load surface finish symbol tool is active, clicking the RMB over the graphics area opens the fol-
lowing popup menu.

Figure 447 The Surface Finish Symbol Popup Menu

0 degree, 90 degree, 180 degree, 270 degree

rotates the symbol according to the chosen degrees.

Please note: If you use the Load surface finish symbol (without leading line) tool and the symbol is close 
to a line, it will be aligned at the line and the setting of degrees will be ignored.
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Sheet level, Current level

defines whether the surface symbol is created on the current level, i.e. within the cur-
rent group, or on sheet level. Default setting is Current level. In this case the item 
Sheet level is displayed. When you click on Sheet level, this option will be active and the 
popup menu displays the item Current level.

Input

opens the Surface Finish Symbol dialog.
Undo

allows you to take back the last processing step.
Exit Tool

quits the tool.
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This chapter explains the functionality of SMART Edit.

Please note: SMART Edit is only available with the advanced version of MEDUSA4, which can 
be started with the option -advanced. Details on starting MEDUSA4 is described 
in “Starting MEDUSA4” on page 23.

• Introduction ............................................................................ 460

• General Selection Hints ......................................................... 460

• Calling SMART Edit ............................................................... 461

• SMART Edit Tools.................................................................. 464

• Edit Dimension Values ........................................................... 465

• Edit Dimension and Leader/Witness Lines ............................ 468

• Datum .................................................................................... 470

• Geometry ............................................................................... 471

• Dragging ................................................................................ 474

• Show Relations ...................................................................... 476
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Introduction

The SMART Edit tool is provided to enable you to edit geometry and dimensions. The general 
idea is that the geometry or dimensions can be dragged to new positions or new values are 
given and it will behave intelligently.

SMART Edit is designed to work on geometry that is undimensioned, partly dimensioned, fully 
dimensioned or over-dimensioned.

• If a dimension value is edited, other dimension values are not changed. 

• If a line is dragged, it retains its orientation which remains horizontal, vertical or at an 
angle.

• If an arc or circle is dragged, it retains either its center or its tangency condition. 

Connectivity is retained so that joined lines remain joined, relations are maintained so that tan-
gencies remain tangent and coincident lines remain coincident.

General Selection Hints

Before choosing SMART Edit, select geometry and dimensions you wish to edit. This might be:

• part of a view

• a whole view

• a number of related views

MEDUSA4 provides various possibilities of selection. Details are described in “Selection Meth-
ods” on page 127.

SMART Edit changes the color of the selected elements. Dimensions are displayed using
color 3 (for default blue) and Geometry is displayed using color 4 (for default cyan). Reference 
dimensions, which are uneditable, are displayed using the usual highlight color (for default) red.

Whilst in SMART Edit, the cross-hair cursor is removed leaving a simple arrow cursor.

Please note: The selection is limited to 1000 elements. If this limit is exceeded, an error mes-
sage will be displayed.
The limit is defined by smart_size_limit in the defaults.dat file of the product. 
If necessary, you can change the value of smart_size_limit. However, larger 
selections take longer to process and might result in an error because of system 
resource limits.
460 © CAD Schroer GmbH



MEDUSA4 Drafting
Calling SMART Edit
Calling SMART Edit

SMART Edit is available on selected elements. To call up SMART Edit do the following steps:

1. Select geometry you wish to edit.
2. Click the RMB 

In the general popup menu the entry SMART Edit is activated.

Please note: SMART Edit is active only if a geometry is selected.
If no element is selected SMART Edit is disabled.

Figure 448 General Popup Menu

3. Choose SMART Edit.
The selection is highlighted in a specific color and a prim indicates a datum point. The 
Smart Edit - Dashboard is displayed. 
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Figure 449 Display of selected Geometry while SMART Edit is active

You may now drag the geometry or dimensions or enter new values in the input fields which 
appear at the top of the drawing area below the ribbon once you have selected an element.

The following popup menu is available:

Figure 450 SMART Edit Popup Menu

Set datum

This option allows you to move the reference point of the selected geometry defined by 
the prim, which was placed automatically after starting SMART Edit mode.

Show over-dimensions

This option shows all dimensions which are extra. If you choose this option extra 
dimensions are highlighted.

Reset all dimensions

This option resets all dimensions of the selection to the values they had when started 
SMART Edit. An undo option is not available for this option, so if you delete any dimen-
sion you cannot get it back with this option.
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Deselect All

is used for deselecting an element in order to display all relations for the whole geome-
try again (see “Show Relations” on page 476).

Undo

is used for canceling the last action. You can undo several actions. Its number 
depends on the number of actions stored to the history stack.

Exit Tool

quits SMART Edit. You can also exit SMART Edit by choosing another tool.

Please note: If you want to undo all changes done in a SMART Edit session, quit SMART Edit 
and then choose the Undo tool on the In Graphics Tool Bar (see “Undo and Redo” 
on page 96).
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SMART Edit Tools

After calling SMART Edit, the SMART Edit Dashboard is displayed. It contains the selection fil-
ter tools in the General Properties area and a tool for showing relations.

Figure 451 SMART Edit Dashboard with SMART Edit Tools

By default, you can select any geometry and any dimension element, all tools are active. With 
the selection filter tools you can restrict the selection to the entities of interest.

The tools in detail are (from left to right):

•  Select dimension value
(see “Edit Dimension Values” on page 465)

•  Select dimension line
(see “Edit Dimension and Leader/Witness Lines” on page 468)

•  Select geometry
(see “Geometry” on page 471)

•  Select leader/witness line
(see “Edit Dimension and Leader/Witness Lines” on page 468)

•  Show relations
(see “Show Relations” on page 476)
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Edit Dimension Values

You can edit linear, radial or angular dimension values.

When in SMART Edit mode, you can change a dimension value by selecting the dimension text 
in the sheet. The dimension value dialog appears at the top of the drawing area:

Figure 452 SMART Edit: Dimension Value Dialog

From left to right you see the following options:
Dimension value

If you enter a new value and press Return, the dimension(s) will change to this value. 
The mouse wheel can also be used to change dimension values. When a dimension 
value is changed in this way, all other dimension values will remain unchanged unless 
they are over-dimensioned.

 Reset dimension value to original

This button will change the dimension to the value it had when you entered 
SMART Edit. The original value is shown at the right of the button. Please read “Reset-
ting All Dimensions” on page 467.

 Reverse dimension

turns down the dimension.  
 Set dimension value to zero

This button not only sets the value to zero but also deletes the dimension. Zero cannot 
be entered as a dimension value. This can be used, for example, for making angled 
lines orthogonal.

 Delete dimension

This button deletes the dimension.
 Toggle reference dimension

This button makes the selected dimension(s) editable or uneditable. Please read 
“Over-Dimensioning” on page 466.

If you wish, you may select further dimension values using the MMB and edit them at the same 
time. For example, you may wish to select a number of corner radii and set them to the same 
value. If you do so, consider that the field showing the original measure is cleared if the values 
differ.
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Over-Dimensioning

Geometry is over-dimensioned when there are too many dimensions. In that case, SMART Edit 
marks some dimensions as reference. Reference dimensions cannot be edited directly, 
although the value is shown, but they will change when other dimensions in the chain are 
edited.

When SMART Edit is initialized, reference dimensions are indicated with the usual highlight 
color (for default red, see Figure 453, left picture for an example).

If a reference dimension is selected, the dimension lines forming the chain are indicated with 
the usual highlight color (see Figure 453, picture in the middle).You can change which dimen-
sion in the chain is the reference dimension in two ways:

• You can select the current reference dimension and press the Toggle reference dimension 
button  in the dialog. The selected dimension is now editable and another dimen-
sion in the chain is shown as reference. (see Figure 453, right picture).

• Alternatively, you can select the dimension you wish to be marked as reference and 
press the Toggle reference dimension button. The dimension which previously was reference 
is now editable and the selected dimension is not.

Figure 453 SMART Edit: Over-Dimensions

If you wish to know which dimensions are reference, use Show over-dimensions from the popup 
menu (see Figure 450, “SMART Edit Popup Menu” on page 462).

Dragging Dimension Values

Instead of using the dialog to enter a new dimension value, you can also drag the dimension 
value. Select a dimension text with the LMB but do not release the button. Drag the dimension 
text along the dimension line (see “Dragging” on page 468).
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Resetting All Dimensions

How to reset a single dimension was described on page 465. You can also reset all dimensions 
by using the option Reset all dimensions from the popup menu (see Figure 450, “SMART Edit Popup 
Menu” on page 462).

Reset all dimensions changes all dimensions back to the values they had when SMART Edit was ini-
tialized.

Reset all dimensions only changes dimensions and does not affect undimensioned geometry.
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Dimension lines and leader/witness lines can be moved. First select the dimension or leader/
witness line you wish to move using the LMB.

The lines and leader/witness lines dialog will appear in the top of the drawing area.

Figure 454 SMART Edit: Dimension and Leader/Witness Lines Dialog

Distance

The value shown is the distance of the selected line from the datum.
Enter a new distance in the dialog and press Return or use the mouse wheel. (To 
change the datum see “Datum” on page 470)
 If multiple lines have been selected which are not at the same distance from the 
datum, the value is shown as 0.0. If this value is changed, all the selected lines will 
move to the given distance from the datum. This can be used, for example, to align all 
dimension lines at a particular position. If the line selected is at the datum, or if no 
datum is visible, the value is shown as 0.0 and any value entered will move the 
selected line by the given value.

Move

If you enter a value and press Return, the selected line will move by the given dis-
tance. The value in the dialog will return to 0.0 because the value is always relative to 
the current position.The mouse wheel may be used.

Dragging

Instead of entering a value, the dimension line or leader/witness line can be dragged by using 
the LMB and holding the button down while dragging (see also “Dragging” on page 474).

Leader/witness line

Moving the leader/witness line will also move all the geometry and dimensions associated with 
it. Unlike editing a dimension value, this change is not propagated along a dimension chain. All 
the dimensions associated with the selected leader/witness line will change its value so that the 
other end of each dimension is not moved.
468 © CAD Schroer GmbH



MEDUSA4 Drafting
Edit Dimension and Leader/Witness Lines
Figure 455 SMART Edit: Drag Leader/witness Line

Dimension line

If you move a dimension line across the geometry it relates to, the ends of the leader/witness 
lines will automatically be re-evaluated.

Figure 456 SMART Edit: Drag Dimension Line
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Datum

When you change a dimension in a fully dimensioned view, there is a unique interpretation. 
However, where the revised geometry is placed on the sheet depends on which point in the 
object is considered to be the datum.

SMART Edit sets an arbitrary datum when it initializes. The datum is shown using a datum prim 
- a circle divided into quarters.

You can change the position of the datum by selecting Set datum from the popup menu (see 
Figure 450, “SMART Edit Popup Menu” on page 462). If you now select a point or a vertical or 
horizontal line on the geometry or on a dimension, the datum will move to that position. If a line 
is selected, the datum will be moved in one axis only. If a point is selected then the datum will 
move in X and Y.

Once the datum has been changed, any edit to a dimension value will leave that position fixed.

If you move a leader/witness line or geometry that the datum is on, then the datum will move 
with that entity.

Figure 457 SMART Edit: Datum
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Geometry

When in SMART Edit, you can edit the geometry whether or not it has dimensions. Any line, cir-
cle or arc can be selected and moved either by entering a value and confirming it with Return, 
by using the mouse wheel after clicking left into the text field, or by dragging (see “Dragging” on 
page 474).

The lines are identified as being one of the following types:

• Orthogonal lines - vertical or horizontal lines

• non-orthogonal lines - any angled line

• Arcs and circles

Orthogonal lines

If you select an orthogonal line, you will see a dialog at the top of the drawing area.

Figure 458 SMART Edit: Orthogonal Line Dialog

Distance

The value shown is the distance of the selected line from the datum. Enter a new dis-
tance in the dialog and press Return or use the mouse wheel. (To change the datum see 
“Datum” on page 470). If multiple lines have been selected which are not at the same 
distance from the datum, the value is shown as 0.0. If this value is changed, all the 
selected lines will move to the given distance from the datum. If the line selected is at 
the datum, or if no datum is visible, the value is shown as 0.0 and any value entered 
will move the selected line by the given value.

Move

Enter the value by which you want the line to move and press Return. The movement 
is perpendicular to the direction of the line. The mouse wheel can be used to change 
the position of the line (see Figure 459, left and middle picture).

Length

The length of the line is given and might be editable. If the length is changed, one end 
moves depending on the direction in which the line was defined. Enter a new value in 
the dialog and press Return or use the mouse wheel (see Figure 459, left and right 
picture).

Alternatively, orthogonal lines can be dragged by holding down the LMB. The line keeps the 
angle.
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Figure 459 SMART Edit: Drag Orthogonal Lines

Non-orthogonal lines

If you select a non-orthogonal line, you will see a dialog at the top of the drawing area.

Figure 460 SMART Edit: Non-Orthogonal Line Dialog

Distance

The value shown is the distance of the selected line from the datum (see also “Orthog-
onal lines” on page 471).

Move

Enter the value by which you want the line to move and press Return. The movement 
is perpendicular to the direction of the line. The mouse wheel can be used to change 
the position of the line (see Figure 461, left and middle picture).

Angle

Enter a new angle in the dialog and press Return or use the mouse wheel (see 
Figure 461, left and right picture).

Alternatively, angled lines can be dragged by holding down the left mouse button. The line will 
maintain its angle but pass through the cursor.

Figure 461 SMART Edit: Drag Non-Orthogonal Lines
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Arcs and circles

If you select an arc or a circle, you will see the following dialog at the top of the drawing area.

Figure 462 SMART Edit: Dialog for Arcs and Circles

Radius / Diameter

give radius or diameter of the current arc or circle.
Centre X / Centre Y

give the XY coordinates of the centre point.
Fix circle centre

The center remains unchanged, only the arc/circle itself can change.
Drag circle centre

The arc/circle remains unchanged, only the position of the center can change.
Previous solution / Next solution

Click left on one of these buttons displays a possible arc solution.

Figure 463 SMART Edit: Solutions for Arcs
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Dragging

When you drag any dimension or geometry, the previous image can be seen in grey in the 
background:

Figure 464 Example of dragged Geometry

Except when dragging dimension values, the probe specifiers are in operation, see “In Graphics 
Probe Bar” on page 111.

This means that the line being dragged will "stick" to other elements depending which specifiers 
are set. This includes the original grayed out image which means that, if drag an element back 
over the gray image, it will snap back to its original value.

Geometry can be dragged to coincide with other geometry:

Figure 465 Example of Dragged Geometry 2

Dimension lines can be dragged to line up with other dimension lines:

Figure 466 Example of Dragged Dimension Line 
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The geometry used for the probe need not be part of the SMART selection. In this example, an 
Intersection probe has been used to position a dragged line.

Figure 467 Example of Dragged Geometry 3

The distance that the probe snaps within is controlled by the Hit Radius (see ”In Graphics Probe 
Bar”, “Hit Radius” on page 114).
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When running SMART Edit, the tool  for displaying relations between attaching segments  is 
available in the dashboard. With this tool relations can be displayed using symbols. It has two 
modes:

• when nothing is selected, it displays all the relations

• when an entity is selected, it displays just the relations on that entity

The defining relations are displayed in red and the dependent ones are gray. This means that, if 
you select an entity, the red relations show the relations that construct that entity. 

Figure 468 SMART Edit - Display of Relations

For example, selecting an arc might show:

• in red: a tangency with another arc and a tangency with a line

• in gray: the center lines

If you change the radius of the arc, it will remain tangential to the neighbored arc and line but 
the center will move. 
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Figure 469 SMART Edit - Display of Relations, Selected Arc, Keep Tangential Transition 

On the other hand, you might have the reverse:

• in red: the center lines

• in gray: a tangency with another arc and a tangency with a line

In this case, the center will remain fixed. If the radius is changed, the neighbored elements are 
moved in that way that tangential transitions and connections are maintained.

Figure 470 SMART Edit - Display of Relations, Selected Arc, Keep Center 

Some relations are not displayed:

• those on the datum

• hidden relations, for example to position dimension

• dimensions because these are themselves relations

• symmetry

• parallel and perpendicular

With the Deselect all option on the popup menu all relations can be seen.
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This chapter shows the different kinds of construction lines and how to create and delete them.

• Introduction .................................................................................... 480

• Tools............................................................................................... 481

• Dynamic Construction Lines .......................................................... 483

• Creating Dynamic Construction Lines............................................ 487

• Creating Construction Circles ........................................................ 493

• Creating Construction Lines traced around a line .......................... 496

• Creating Construction Lines through tangential chord of circles.... 496

• Deleting and Hiding Construction Lines ......................................... 497

• Confining Construction Lines to a Specific Area ............................ 498
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Introduction

In conventional drafting, it is often convenient to set up temporary construction lines. 
MEDUSA4 therefore provides a range of tools that enable you to create different types of con-
struction lines, such as circles and angled lines. You can use the construction lines as a basis 
on which to make the actual drawing. When you no longer require the construction lines, you 
can hide them or delete them.

You can either create:

• Freehand construction lines point by point in the same manner as standard lines

• Automatic construction lines, either one at a time or in sets of parallel lines

You can place construction lines exactly where you want them, either in free space, or in rela-
tion to the points of an existing line. Construction lines extend to the limits of the current view 
window.

You can change the default settings for the extent of construction lines using the Construction Line 

Extent options in the Default Settings dialog (File > Default Settings > Drawing Elements > Construction Lines) 
(for details see ”Default Settings”, “Construction Lines” on page 269). 

For the following chapters it is assumed that the default settings are kept, i.e. construction lines 
extend to the limits of the current window.

Please note: If you want to enter values into an input field which is attached to the cursor, there 
are two different ways to proceed:
Type the values directly using the keyboard and confirm with the Enter-key. 
Using the Tab-key you can switch between the fields.
or
Keep the Ctrl-key pressed. Now you can move the cursor into the fields, enter 
the values and confirm by using the Enter-key or click on the check mark to the 
right of the input field.
480 © CAD Schroer GmbH



MEDUSA4 Drafting
Tools
Tools 

The tools for creating dynamic construction lines are in the In Graphics Tool Bar. If you click the 
RMB on the tool , all available tools are shown. Explanations on the tools are provided in 
“Dynamic Construction Lines” on page 483 and “Creating Dynamic Construction Lines” on 
page 487.

Figure 471 Tools for creating dynamic construction lines

The following figure shows the construction line tools and tool sets in the Home tab.

Figure 472 Tools for creating construction lines in the Home tab

The tool Deletes all temporary construction lines  deletes all construction lines from the drawing, 
see“Deleting and Hiding Construction Lines” on page 497.

The first tool set contains following tools for creating construction lines with certain angles (see 
“Creating Construction Lines with certain angles” on page 492):

Figure 473 Tools for creating construction lines with certain angles

The second tool set contains following tools for creating free, horizontal and vertical construc-
tion lines (see “Creating a Free, Horizontal or Vertical Construction Line” on page 492):

Figure 474 Tools for creating free, horizontal and vertical construction lines

The third tool set contains following tools for creating construction circles (see “Creating Con-
struction Circles” on page 493):
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Figure 475 Tools for creating construction circles     

The tool Creates a construction line with angular corners traced around selected element  creates a construc-
tion line with offset along the selected geometry. It works the same way as explained for offset 
lines in ”Lines - Home Tab”, “Offset Lines Tools” on page 372.

The fourth tool set contains following tools for creating construction lines through tangential 
chord of circles (see “Creating Construction Lines through tangential chord of circles” on 
page 496):

Figure 476 Tools for creating construction through tangential chord of circles
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Dynamic Construction Lines 

MEDUSA4 provides extremely powerful tools for producing dynamic construction lines. The 
tools draw dynamic construction lines tangential, perpendicular or crossed to lines, circles and 
arcs.

The use of these tools is explained later in “Creating Dynamic Construction Lines” on page 487. 
In this section you get information on the topics ”Popup Menu”, ”Point Recognition”, ”Angle”, 
”Fixed Point Definition”, ”Offset” and ”Keyboard Buttons” related to dynamic construction lines.

Figure 477 Dynamic Construction Lines Tools

Popup Menu

For dynamic construction lines the following popup menu is on the RMB:

Figure 478 Popup Menu

Deletes auxiliary lines 
deletes all construction lines on the sheet.

Undo 
removes the dynamic construction lines last created with this tool.

Exit Tool 
terminates the function.

Point Recognition

When you select a Dynamic Construction Lines tool, MEDUSA4 automatically recognizes suitable 
points at which the construction lines may be created as you move your cursor around the 
drawing. The points that are recognized depend upon the type of element that is within the 
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search radius. As each suitable point is found, the cursor display changes to show the point, 
and the possible construction line that could be created at that point. 

The search radius for finding points is configurable in the Default Settings dialog (File > Default Settings 

> Drawing Elements > Construction Lines, Dynamic Construction Lines, Search Radius).

• With circles, tangent points are defined as suitable locations. When these are found, 
the cursor display changes to a T (=Tangential) or inverted T.

• With lines, the point, through which the auxiliary line is drawn, is always indicated as a 
small box. This moves, depending on the adjusted point function, dynamically along 
the line or stops at the point found last, until the next point is found.

When no geometry is found within the search radius, the display of the point switches over to 
FRE for a free point.

Angle

If you select one of the tools for tangential or perpendicular dynamic construction lines, Angle 
and Offset entry boxes appear at the mouse cursor.

Figure 479 Offset and Angle Entry Boxes for tangential and perpendicular dynamic construction lines

If you select the tool for crossed dynamic construction lines, only the Angle field appears. 

Figure 480 Angle Entry Box for the crossed dynamic construction lines tool

For example, to create a construction line tangential to a circle:

1. Move the cursor close to a circle.
2. Move the mouse cursor along the circle line.

The data in the Angle entry box update dynamically.
3. Once you have identified the location where to create the construction line tangentially, 

leave the mouse in that position and type the desired angle into the Angle entry box. 
4. Press Return.

The dynamic construction line is created at the specified angle.
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Figure 481 Example Dynamic Construction Line

Offset

Tangential and perpendicular dynamic construction lines can be drawn with offset. 

Offsets can be negative or positive. A positive value creates the line on the same side of the 
recognized point as the cursor. A negative value places the line on the opposite side of the rec-
ognized point to the cursor. This is dynamically shown on the screen as you move your cursor 
around the drawing.

construction line
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Figure 482 Positive and Negative Offsets

Fixed Point Definition

1. Choose File > Default Settings > Drawing Elements > Construction Lines, Dynamic Construction Lines 
and define the Angular increment width as 20. 

2. Select an construction line tool. 
3. Move your cursor over the drawing until the display shows a free point.
4. Press and hold the Ctrl+Shift key to define a datum point.
5. Move the mouse.

As you move your mouse you will notice that sample construction lines are displayed 
at 20 degree intervals through the datum point.

6. If you are satisfied with the line, click the MMB to create the construction line.

Keyboard Buttons

Ctrl+Shift Pressing Ctrl+Shift fixes the datum point as described in section “Fixed Point 
Definition” on page 486.

Shift Pressing Shift helps you to create tangents between circles and circular arcs.

positive offset negative offset
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Creating Dynamic Construction Lines

You can create dynamic construction lines tangential, perpendicular or crossed to an element. 
This is described in the following sections.

Tangential Dynamic Construction Line

The Dynamic auxiliary line, tangential tool  creates a dynamic construction line which is tangential 
to the selected geometry.

1. Click left on the Dynamic auxiliary line, tangential tool .
The Angle and Offset input fields appear at the mouse cursor. You can switch between 
the input fields by using the tab key.
If you changed the setting during the session, the last used value is displayed.

2. Move the mouse cursor close to the line you would like to work on.
The tool detects the line closest to the cursor and snaps to the closest point on the line. 
The dynamic construction line is always displayed dynamically and tangentially to the 
found line.

3. Click left to create the construction line.

Figure 483 Tangential Dynamic Construction Line

cursor position

current point of line

dynamic construction line
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Perpendicular Dynamic Construction Line

The Dynamic auxiliary line, perpendicular tool  creates a dynamic construction line, perpendicular to 
the selected geometry. This function works in the same manner as explained in ”Tangential 
Dynamic Construction Line”.

Figure 484 Perpendicular Dynamic Construction Line

Crossed Dynamic Construction Line

The Dynamic auxiliary line, crossed  creates two dynamic construction lines which are perpendicu-
lar to each other. One of the construction lines is tangential to the selected geometry. This func-
tion works in the same manner as explained in “Tangential Dynamic Construction Line” on 
page 487 with the difference that only an Angle input field is displayed.

current point of line

cursor position

construction line
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Figure 485 Crossed Dynamic Construction Line

Examples for Dynamic Construction Lines

The following sections give you some examples for using the dynamic construction lines.

Creating Dynamic Construction Lines Parallel to Angled Lines with Offset

You can quickly produce offset lines in both directions for diagonal lines:

1. Select the Dynamic auxiliary line, tangential tool .
2. Enter a value in the input field Offset.
3. Move the cursor close to, but below the diagonal line, and click left. 

An offset construction line appears below the line.

construction line 1

construction line 2

current line point

Cursor position
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Figure 486 Example Dynamic Construction Lines with Offset 1

4. Now move the cursor until it is slightly above the line and click the LMB again.
A second offset construction line appears, but this time, it is offset above the line.

Figure 487 Example Dynamic Construction Lines with Offset 2

Creating Construction Lines Perpendicular to Diagonal Lines

To create construction lines perpendicular to diagonal lines:

1. Select the Dynamic auxiliary line, perpendicular tool .
2. Enter the value of 0 in the input field Offset.
3. Move the cursor close to the diagonal line and click left.

Figure 488 Example Dynamic Construction Lines Perpendicular to Diagonal Outlines
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Creating Dynamic Construction Lines as Tangents Between Two Circles

To create a construction line tangential to two circles:

1. Select the Dynamic auxiliary line, tangential tool .

2. Move the cursor close to the first circle.
3. As soon as the tangent is found, press and hold down the Shift key.

Figure 489 Example Dynamic Construction Line as a Tangent between 2 Circles 1

4. Move the cursor close to the second circle until the required tangent point is found.
Now you see a further tangential mark T at the second arc or circle.

5. Click the LMB to create the tangent between both circles.

Figure 490 Example Dynamic Construction Line as a Tangent Between 2 Circles 2

Creating Dynamic Construction Lines as Crossed Tangents Between Two Circles

1. Select the Dynamic Auxiliary Line, Crossed tool .
2. Repeat steps 2 to 5 of the previous example.

Figure 491 Example Dynamic Construction Lines as a Crossed Tangent Between Two Circles
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Creating Straight Construction Lines

This section provides information for creating straight construction lines.

Creating a Free, Horizontal or Vertical Construction Line

Figure 492 Tools for creating free, horizontal and vertical construction lines

A free construction line is created in the same way as any line. Having chosen the Creates con-

struction lines tool, each left click places a point on the sheet. Details on creating lines can be 
found in ”Lines - Home Tab”, “Creating a Line” on page 341.

Horizontal and vertical construction lines consist of one line segment. To create a horizontal 
or vertical construction line:

1. Choose either the Creates horizontal construction lines tool  or 
the Creates vertical construction lines tool .

2. Select a point on the drawing which the construction line shall pass and click left.
A horizontal/vertical construction line is drawn on the sheet through the point you 
selected. The selected point becomes the datum point which can be used for further 
drafting (see “Reusing the Current Datum Point” on page 493).

Creating Construction Lines with certain angles

Figure 493 Tools for creating construction lines with certain angles

These tools work in the same way as shown in ”Creating a Free, Horizontal or Vertical Con-
struction Line”, select the tool and then click the LMB on the sheet to place the appropriate con-
struction lines.
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Reusing the Current Datum Point

While creating straight construction lines (but not free ones) a popup menu is available which 
allows you to use the last probe in the graphics area as datum point for creating further con-
struction lines.

Procedure:

1. Create a single, straight construction line but no free one.
2. Click the RMB to display the popup menu.

Figure 494 Popup Menu while Creating Construction Lines

The upper four entries create straight construction lines through the datum point with 
the specified orientation.

3. Choose an option from the popup menu.
The new construction line is drawn through the datum point. Its orientation depends on 
the chosen option.

Creating Construction Circles

This section provides information for creating construction circles.

Figure 495 Tools for creating construction circles     
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Creating Simple Construction Circle

1. Choose the Creates a construction circle defined by a center point and radius tool .
2. Probe in the sheet to set the center point of the circle.

An entry box appears at the mouse cursor.

Figure 496 Diameter and Radius Entry Box

3. Type a value either in the Diameter input field or in the Radius input field 
4. Click the check mark behind the entry fields or press the button Return on your key-

board.
The construction circle appears on the sheet corresponding to the requested dimen-
sion.
You can repeat Step 2 to Step 4 to create further construction circles.

5. Choose Exit Tool from the RMB popup menu to quit the tool.

Creating Construction Circle tangential to a Line

1. Choose the Creates construction circle tangential to a line tool .
2. Click the LMB on a line.

When you move the mouse, you see a construction circle attached to the cursor which 
is aligned tangential to the line. When you move the mouse, the size of the circle and 
its position along the line are changed.

3. Define the size of the circle and place it on the desired position by doing one of the fol-
lowing:

• Move the mouse to find the desired position and its size and click the LMB.

• Enter a value in the Diameter or Radius input field and press ENTER.

Creating a Construction Circle tangential to two Lines

1. Choose the Creates construction circle tangential to two lines tool .
2. Click the LMB on the first line and subsequently on the second.
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When you move the mouse, you see a construction circle attached to the cursor which 
is tangential aligned to both lines. By moving the mouse, the circle changes its position 
along both lines and its size. Two examples of construction circles in different positions 
are shown below. For clarity the cross-hair is left out.

Figure 497 Examples of Construction Circle in different Positions

Input fields for Diameter and Radius are displayed at the mouse cursor.
3. Define the size of the circle and place it on the desired position by doing one of the 

following:
• Move the mouse to find the desired position and its size, and click left.
• Enter a value in the Diameter or Radius input field and press ENTER. 

The circle automatically jumps to the possible position for the defined size.

Creating Construction Circle tangential to a line with appropriate position

Using this tool you also create a construction circle tangential to a line as shown in “Creating 
Construction Circle tangential to a Line” on page 494. Unlike the tool described earlier, size and 
position of the circle are set in two steps.

1. Choose the Creates construction circle tangential to a line with appropriate position tool .
2. Click the LMB on the line.

When you move the mouse, you see a construction circle attached to the cursor which 
is aligned tangential to the line.

3. Define the size of the circle by moving the mouse until the circle has the desired size 
and click the LMB.
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The size of the circle is fixed now but you can still move the circle along the line using 
the mouse. The size of the circle will be kept.

4. Move the circle to the desired position and click the LMB to place it.

Creating Construction Lines traced around a line

The Creates a construction line with angular corners traced around selected element  creates a construction 
line with offset along the selected geometry. It works the same way as explained for offset lines, 
see ”Lines - Home Tab”, “Offset Lines Tools” on page 372.

Creating Construction Lines through tangential chord of circles

MEDUSA4 provides two tools for creating construction lines tangential at two circles.

Figure 498 Tools for creating construction through tangential chord of circles

The first tool works as follows:

1. Choose the Creates construction lines through tangent points of two circles tool.
2. Click the LMB on the first and then on the second circle.

Promptly both appear as construction line on the sheet, the tangent at the two circles 
and the perpendiculars through the tangent points.

Figure 499 Example of the Creation of Construction Lines through Tangent Points

The second tool Creates construction lines tangential at two circles works the same way as the first but 
only the construction line through the tangent points is drawn, the perpendiculars are missing. 
496 © CAD Schroer GmbH



MEDUSA4 Drafting
Deleting and Hiding Construction Lines
Deleting and Hiding Construction Lines

Construction lines are drawn on a single layer of a MEDUSA4 sheet. You can remove the con-
struction lines either by deleting them or by hiding them.

Deleting all Construction Lines

You delete all construction lines on the sheet by clicking the LMB on the Deletes all temporary con-

struction lines tool .

Deleting Selected Construction Lines

1. Select the construction lines you want to delete on the sheet.
2. Choose Delete  from the popup menu.

MEDUSA4 deletes the selected construction line. 

Hiding Construction Lines

You can hide construction lines by making the construction line layer invisible.

1. Open the Layer Manager dialog via File > Options > Layer Management.
By default the Layer Properties tab is displayed.

Figure 500 The Layer Manager Dialog: Layer Properties Tab

2. Select the Construction lines layer from the layer list.
3. Deactivate the Visible switch by clicking on the check mark.
4. Click OK to apply the setting and quit the dialog.

The construction lines are now hidden but not deleted.

For details on the Layer Management dialog see ”Layers”, “Layer Properties” on page 150.

Switch to set the selected layer visible or invisible
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Confining Construction Lines to a Specific Area

You often need construction lines to help designing small or detailed parts of a sheet. Lines 
extending from one side of the sheet to the other may complicate areas where the lines are not 
required. To prevent such long construction lines zoom into the sheet so that the area you want 
to work on fills the screen. Now draw the required construction lines. Remember that construc-
tion lines extend to the limit of the current view window, unless you changed the default settings 
of the construction line extent (see “Introduction” on page 480).

The following steps give an example on limiting construction lines to a certain area:

1. First zoom in to the area in which you want to work.

Figure 501 Example Confine Construction Line 1

2. Then draw the construction lines you require.

Figure 502 Example Confine Construction Line 2

3. Finally redraw the sheet at full size. 
The construction lines do not extend beyond the area of the previous window.

Figure 503 Example Confine Construction Line 3
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This chapter explains the basic concepts that you need to understand in order to effectively cre-
ate and edit text. 

• Tool Overview ........................................................................ 500

• Creating Text.......................................................................... 502

• Text Properties ....................................................................... 504

• Editing Text ............................................................................ 509

• Special Characters................................................................. 511

• URL Text ................................................................................ 512

• Multi-Line Text........................................................................ 515

• Find Text and Replace Text.................................................... 518

• Un-number & Re-number....................................................... 520

• Item Number Balloons ........................................................... 536
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Tool Overview

The following figure shows the text tools in the Home tab.

Figure 504 Text Tools in the Home Tab  

Following tools create text without feature.

Figure 505 Tools creating text without feature  

Following tools create text with special feature.

Figure 506 Tools creating text with special feature  

Create boxed text arrows 
creates arrows for multi line texts which have a text box, for details see “Multi-Line 
Text”, ”Create Arrows at a Text Box” on page 516.

Following tools search, replace and numerate texts. Details can be found in “Find Text and 
Replace Text” on page 518 and in “Un-number & Re-number” on page 520.

Figure 507 Tools for searching, replacing and numerating text

Following tools create prims. For details see “Predefined Graphical Shapes (Prims)”, ”Adding 
Prims to a Sheet” on page 545.
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Figure 508 Tools for creating prims

Additionally the Text + Prims tool group still contains following tools:
 Create a Table

For details see “Tables”, ”Creating a Table” on page 557.
 Create new Item Number Balloon

 Reads all balloon texts to a table

For details see “Item Number Balloons” on page 536.

Please note: Text appearance may also be affected by settings in the Default Settings dialog, see 
“Default Settings”, ”Text” on page 270.
The Tab key on your keyboard cannot be used in text entry fields in MEDUSA4.
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Creating Text

This section shows you how to comment your drawing by adding text elements.

Popup Menu While Creating Text

After choosing a text creation tool a popup menu is available by clicking the RMB.

Figure 509 Create Text Popup Menu

The following entries are given:
Rotate 90 Degrees

rotates the text by 90 degrees counterclockwise.
New Text...

deletes any entry in the text input field and you can type a new text.
Fixed Size

is applicable on multi line text only (see “Multi-Line Text” on page 515). By default this 
option is off. If you choose this entry, it is switched on indicated by a check mark .

Properties...

opens the Text properties dialog explained in “Text Properties” on page 504.
Undo

cancels the last action. 
Exit Tool

quits the tool.

Procedure

1. Select one of the text creation tools, for example, Create small plain text .
The Dashboard displays the properties of the chosen text tool.
A cursor blinks in the input field for entering the text.
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Figure 510 Text Dashboard

2. Type a text in the text field or insert ”Special Characters” with the button .
The text appears at the crosshair. Any time you change the text MEDUSA4 updates 
the text on the mouse cursor.

3. Move the cursor to an empty area on the sheet and click left to place the text.
MEDUSA4 displays the text on the sheet. The text remains on the mouse cursor so 
you can place it again.

If you change the text tool the properties of the text change but the text, which you typed in at 
last, remains unchanged. This is because MEDUSA4 retains the current text until you change it 
or exit from MEDUSA4.

You can change the properties of the text you are creating at any time. This is explained in 
detail in “Text Properties” on page 504.

Please note: The text input field can be undocked from the Dashboard and displayed as sepa-
rate window by clicking on the button . (see also “Dashboard”, ”Input Area” on 
page 82)
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Text Properties

Text elements have specific properties in addition to the standard properties. Text properties are 
available either in the Dashboard or in the text properties dialog. 

Changing properties works the same way as already described for lines in “Lines - Home Tab”, 
“Line Properties”, ”Changing Properties” on page 356.

Dashboard

If you chose a text creation tool or if you edit text the Dashboard displays the text properties. In 
addition to the standard properties like type, layer and style (explained in “Dialog” on page 506) 
you find some specific properties as shown in the figure below.

Figure 511 Text Properties Dashboard

The Input Field area provides the following properties and buttons:
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undocks the input field and its buttons from the Dashboard and opens a separate win-
dow. Press the button again to re-dock the input field.

 
opens the special characters dialog (for details see “Special Characters” on page 511).

Height

When you create text it is created at a standard height. You can change this by enter-
ing a new height in the Height field and then pressing the Return key on your keyboard 
or by clicking on the arrows to increase or decrease the height value by steps of 0.5, 
or by using the wheel if available on your mouse.

 Single line text,  Multi line text

allows you to define texts which have only one line and texts which have more than 
one line. If you are in Multi line mode and if you press Return on your keyboard, a new 
line is created (for details see “Multi-Line Text” on page 515).

Bold, Italic, Underline

These options apply the usual text decoration and they can be used together for get-
ting a bold, italic, underlined text.

Please note: For the settings Bold, Italic, Underline, Superscript, Subscript and Height changes will only 
affect the text selected when the change is made, or to text entered after the 
change is made.

Superscript, Subscript

is used for placing text parts high and low (e.g. ). 
Justification

Changes the vertical or horizontal justification of the text.
Increment

The first number found inside a text is counted up (+n) or down (-n) by the factor defined 
in the text field (default value is 1).

Text Case

is the toolset for changing selected text into upper- or lowercase font. The available 
tools are Uppercase (tt->TT) , Lowercase (TT->tt) , Capitalise (tt->Tt) .

The General Properties area provides the standard properties style, layer, type and font (see ”Dia-
log”), and the following ones:
Box 

is activated only for multi line texts (for details see “Multi-Line Text” on page 515).
 

launches an URL in the default Internet browser. This button is only activated when the 
current text was defined with a True Type font (for details see “URL Text” on page 512).
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Dialog

Just as changing the properties of a text element using the Dashboard you can also use the Text 

Properties dialog. If you have selected the text you want to change or select a text tool, do one of 
the following:

• Click left on the Properties tool  in the Dashboard on the left of the General Properties 
header, or

• select the Properties option from the popup menu (RMB).

Figure 512 Text Properties Dialog

Please note: Disabled properties cannot be changed. If the button Style is disabled you are not 
in Administrator mode and therefore you can change properties temporary only.

The options on the Text Properties dialog are:
Style

A text style is a collection of properties. For example, you can create a text style so that 
all text elements using that style are drawn in one color and are placed on a specific 
layer. 
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Layer

determines which layer the text is drawn on. Changing the value does not have a visi-
ble effect (unless the layer is set not to be visible). Normally you should not change the 
layer on which a text element is created as your site may have special conventions 
which control how layers are used for particular projects. Please read the chapter “Lay-
ers” on page 143 for more detailed information on layers.

Color

determines which color is used to draw the text element. You can also edit and add the 
color to the default colors.

Thickness

This option sets the unbold value of the text. Text that is set to bold using the Dash-
board is thicker than this value. You choose between eight thicknesses to draw the 
text.

X Position, Y Position

The X Position and Y Position entry boxes define the position of the text datum on the 
sheet. To move the text datum and the associated text to a specific location, change 
the values in the X Position and Y Position fields and click Apply or OK.

Type

changes the appearance of the text element. Some text types are shown below:

Figure 513 Text types:

Font

defines the font used for the text. Select the required font from the list of available 
fonts.

Rotate

determines the amount by which a text element is rotated around its datum. The angle 
of rotation is relative to the horizontal and it is an absolute angle. A positive value 
rotates counter-clockwise, a negative vice versa.

Height

When you create text it is created at a standard height. You can change this by enter-
ing a new height in the Height field.

Shear

defines the amount by which the font is sheared. To remove any shear from the text 
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enter a shear value of 0. Shear may not be available or visible unless switched on in the 
Defaults dialog. 

Spacing

is the line spacing for multi line text. This option is deactivated for single line text.
Width

defines the width of the text string. An alternative way of specifying this is to set the Gap 
and Aspect ratio.

Aspect,

Aspect determines how changing the height of the character affects its width.
Gap

Gap defines the distance between each character in the font (depending how the font is 
defined by your System Administrator).

Justification 
determines how the text is aligned relative to the datum point. By default the datum 
point is positioned in the center of the text element. The text datum is positioned at the 
intersection of the cross on the cursor, allowing you to position the text with precision.

Figure 514 Text Justification Panel

The selected position on the justification panel defines the datum. To change the justi-
fication of the selected text element, click one of the other buttons on the justification 
panel.
When you click Apply on the Text Properties dialog, the selected text moves relative to the 
datum point to the position you chose in the justification panel. The datum point 
remains in the same place on the sheet unless you change the X Position or Y Position 
values as well.

 Single line,  Multi line

allows you to change the selected text into single line and multi line text. If you edit 
multi line text and if you press Return on your keyboard, a new text line is created (for 
details see “Multi-Line Text” on page 515).

Textbox 

is activated only for multi line texts (for details see “Multi-Line Text” on page 515).
Url 

is activated only when a True Type Font is used either for the whole text or a part of it 
(for details see “URL Text” on page 512).
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Editing Text

This chapter shows you how to edit and copy text, and it gives some hints on working with mul-
tiple selections of text.

Changing the Text Content

You can change the content of a text element using the input field in the Dashboard:

1. Select some text in the graphics area.
The text is displayed highlighted inside the input field of the Dashboard. At this stage, 
the text is still in the read only mode.

2. Move the mouse cursor into the graphics area and choose Edit from the RMB popup 
menu.
Now you can modify the text in the input field of the Dashboard.

3. Type the new text or modify existing text.
The text is automatically updated on the sheet.

Repeat Texts

If you edited text you can place the same text again.

1. Select a text inside the graphics area.
The input field in the Dashboard displays the selected text.

2. Now choose a text creation tool:
a. If you want only the text string to be repeated without using its properties, choose 

one of the text creation tools as given in Figure 504, “Text Tools in the Home Tab” on 
page 500.

b. If you want the text to be repeated with its current properties choose the text cre-
ation tool in the Creation tool group (see ”Creation Tool Group - Overview”, Figure 280 
and “Creating New Element with Properties of an Existing” on page 311).

The text is attached to the crosshair of the cursor.
3. Move the cursor to the position where you want to place the text and click the LMB.

The previously selected text is placed and you have copied it now. If you want to 
repeat the text, go on placing it at other positions.

Please note: If you want the new text to have exactly the same properties as the original text, 
alternatively you can use the copy and paste tools as described in “Cut, Copy and 
Paste” on page 315.
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Multiple Selections of Text

This section gives you some explanations in the case of selecting several texts, either single-
line texts, multi-line texts or a mixture of them.

General

• If the texts are the same, the text string will be displayed inside the text edit field other-
wise it is blank.

• You can select different texts and change the properties without losing the text string.

• You can select different texts and replace all the texts by typing a new text in the empty 
input field.

Increase/Decrease Numbers

• The increase/decrease buttons (see “Text Properties”, ”Dashboard” on page 504) work 
on all the selected texts even if they are different. The example below shows three dif-
ferent single texts. The numbers were counted up at the same time using the counter 
button +1.

Figure 515 Example Text Count

Multi line - Single line

• If you have a number of single line texts selected, pressing the multi-line button will col-
lect them into a single multi line text, in case they are positioned over each other in y 
direction. Texts which are placed side by side are put into different multi-line texts.

• If you have one or more multi line texts selected, pressing the single line button will 
change them into single line texts.

• If you have a mixed selection of single line and multi line texts and press the multi line 
text button, it will not change the multi line texts but it will collect all the single line texts 
into a multi line text in case that they are not positioned side by side.
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Special Characters

You can add special characters to any text element.

1. Select a text creation tool, e.g. Create small plain text .
2. Enter a text in the Input Field of the Dashboard and place the cursor at the position 

where you want to have the special character.
3. Press the Special Characters button  to display the Special Characters dialog.

Figure 516 Special Characters Dialog

4. Click the button for the special character you want to use.
MEDUSA4 inserts the special character at the position of the cursor in the Input Field 
of the Dashboard.

5. Place the text on the sheet.
6. Close the special character dialog if no longer needed.
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URL Text

You can apply an URL (Uniform Resource Locator) to any text using the properties dialog.

Creating an URL

Follow the steps below to apply an URL to a new text (see “Creating Text” on page 502) or a 
currently selected text (see “Editing Text” on page 509). 

1. Open the Text Properties dialog by clicking on the Properties tool  on the left hand side of 
the General Properties header in the Dashboard or select the Properties option from the 
popup menu.

Figure 517 Text Properties Dialog

The text field Url is activated only when a True Type font is used either for the whole 
text or a part of it. 

2. Choose a True Type font (e.g. TT Arial) from the pull-down list of the Font option.
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Figure 518 Text Properties Dialog, Fonts, Pull-down List

3. Insert a text into the Url text field, e.g. http://www.cad-schroer.de. 
Details on possible entries are described in ”Possible URLs”.

4. Apply the properties to the current text.
Now the current text has an URL attribute attached and the Dashboard button  is 
activated for launching the URL in the default internet browser (see ”Launching an 
URL”). 

Possible URLs 

Generally you can define any type of URL which your default internet browser supports. URLs 
can be either addresses in the internet, files located on the network or on your computer locally. 
The following table shows some examples:

How an URL is handled by a browser (i.e. Internet Explorer or Mozilla Firefox) is given in the fol-
lowing list:

• Internet Addresses, text files, Word documents, PDF files and other file formats will be 
displayed inside the browser if the appropriate plugin was installed, or the appropriate 
application will be started.

• If the URL is a sheet file and CSGJustview is installed on your computer, the file will be 
displayed inside the browser using CSGJustview.

URL Type Example

Internet Address http://www.cad-schroer.de

File on the network \\Csgftp\MPDS4Brochure_en.doc

Local file file://c:/example.pdf

MEDUSA4 Sheet file e:\work\drawings\example.she
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• If an URL is not supported by your browser, a menu is shown for selecting the applica-
tion to open or other handling is provided (this depends on the used browser and URL 
type).

Please note: We recommend to enter the URL always completely with protocol (e.g. file://
c:/example.pdf) because we cannot guarantee that your browser supports the 
simple syntax (e.g. c:\example.pdf).

Launching an URL

You only have to select a text and then press the Dashboard button  for launching an URL. 
The default internet browser opens, handling the URL accordingly (see list in “Possible URLs” 
on page 513).

If the selected text has no URL attribute, the Dashboard button  remains deactivated.

Deleting an URL

For deleting an URL from a text: Select the text, open its text properties, delete the Url text string 
and Apply the text properties.

You can also delete an URL by applying a font which is not True Type. After Apply, the URL text 
will be deactivated which can be seen in the properties dialog.
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Multi-Line Text

Multi-line text is handled a little different to single line text. The following sections show you how 
to create, edit, place, save, reload and modify multi-line text.

Create Multi-Line Text

Do the following steps for creating multi-line text:

1. Select one of the text creation tools, e.g. Create small plain text .
The Dashboard displays the properties of the chosen text tool and the cursor changes 
to a crosshair. The Input Field for entering the text is active, so you can type in a text 
now.

2. Click the LMB on the Multi-Line button .
3. Type a text in the text field.

Use the Return key on your keyboard for creating a new line.
The text appears immediately at the crosshair. Any time you change the text MEDU-
SA4 automatically updates the text on the cursor. 

4. Move the cursor to an empty area on the sheet.
5. Place the text.

You have two possibilities:

• If the option Fixed Size from the popup menu is switched on , click left at the posi-
tion in the sheet, where you want to position the text.

• If the option Fixed Size is off, do this:
a.Click the LMB to place the text.

As you move the cursor the width of the text changes and line breaks adjust auto-
matically.

b. Click the LMB to define the width of the text.
MEDUSA4 displays the text on the sheet. The text also remains on the cursor so you 
can place it again. If you want to place single line text again, choose the button . 
The first line of the multi-line text remains in the text entry field. The multi-line text 
remains in the buffer until you change the current text.

Create a Text Box around Multi-line Text

If you want to create a text box around multi-line text, click the LMB on the option Text box inside 
the Dashboard while adding or editing multi-line text. This option is disabled if you add or edit 
single-line text.
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The text box can be visible (checkmark is set) or invisible. During creation or editing of text box 
arrows (see next section) the text box will be always visible.

Create Arrows at a Text Box

The Create Boxed Text Arrows tool  in the Dashboard creates and edits arrows emanating from a 
text box. The RMB provides the following popup menu:

Figure 519 Popup Menu of the Create boxed Text Arrows Tool

When you choose the Create Boxed Text Arrows tool  all deletion entries are disabled. The entries 
are used for the following tasks:

• Delete a Single Arrow - by editing an arrow and choose Delete Arrow.

• Delete all arrows - entry Delete All.

• Delete intermediate points - by moving the point and choose Delete Point.

• Change the point function of all arrowheads - entry Arrowheads. This option opens the 
usual point function dialog for selecting the new point function used for arrow heads of 
the arrows of the current text box.

The two options Delete All and Delete Box require the text box to be selected. A text box is selected 
if you draw a new arrow, edit an existing one, or click left on the text inside a text box.

Create Arrows

Use the LMB to draw an arrow starting from the text box and pointing outwards. 

With the first left click you place the start point and with a further left click you place the end 
point of an arrow. For kink or knee points use the MMB. 
516 © CAD Schroer GmbH



MEDUSA4 Drafting
Multi-Line Text
Figure 520 Example for an arrow with two intermediate points

Canceling to draw an arrow is done with a left click in the text box.

Extend an Existing Arrow

To extend an arrow, start drawing from its tip. 

• If you start drawing with the LMB, the tip becomes a kink. 

• If you start drawing with the MMB, the tip becomes attached to the mouse cursor and 
you can move it to another position (see ”Moving Arrow Points”).

Moving Arrow Points

Use the MMB to pick and move any arrow kink point. After you have picked an arrow kink point, 
use the MMB again for placing the point at the new position.

If you press the LMB, moving the current arrow point is aborted.

Please note: If you are editing the first arrow point (the one that is on the box) there is auto clip-
ping and you can only move the point where it is valid to do so while you are guar-
anteed that the new arrow will not cross the box. 

Move the Text Box while Dragging Arrows 

Use the MMB to pick a multi-line text in the center and press the MMB again to drop where 
desired. While moving the text box the tips of the arrows remain at its positions.

The operation cannot be canceled. Use the Undo button from the In Graphics Tool Bar if you 
want moving to be undone.
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Find Text and Replace Text

The Search Text  and Replace Text  tools enable you to search/find a text inside a MEDUSA4 
sheet to edit it or to replace it with another text.

Searching Text

1. Choose the Search Text tool  from the Text + Prims tool group in the Home tab.
The Search Text dialog appears:

Figure 521 Search Text Dialog

2. Enter the text you are searching for in the Search for input field.
You can insert a text string or only a part of it.

3. If required, restrict your search by the options of the dialog as shown in “Restricting the 
Search” on page 519.

4. Click the LMB on the Search button at the bottom of the dialog. 
MEDUSA4 zooms in on the text which accords to the search text. The text is high-
lighted and it is in the edit mode. The text appears in the input field of the Dashboard. 
If required you can edit the text now.

5. Click the LMB on Search next.

If there is another text which accords to the search string, MEDUSA4 zooms in on this 
text. If all texts were searched and there is no further text matching the search string, a 
message is given.

6. Close the dialog by using the Exit button.
The last settings remain until you call up the dialog once more and change them.
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Restricting the Search

You can restrict the search for text by using different settings.

You can define the search area on the MEDUSA4 sheet by using two different Search in options.
• Whole sheet 

The search text will be searched on the whole sheet.This is the default setting.
• Selection 

The search text will only be searched within the selected text elements.

The two items Match whole word only and Match case restrict the search with regard to the text input.
• Match whole word only 

The search string will be only found if it is a whole word. Upper and lower case is not 
considered.

• Match case 

Upper and lower case will be considered with the search.

Replace Text

The Replace Text tool  from the Text + Prims tool group in the Home tab enables you to search a 
text according to the description before and replace it with another text. The tool opens the fol-
lowing dialog:

Figure 522 Replace Dialog

In addition to the parameters which have already been described with the Search Text dialog (see 
“Searching Text” on page 518 and “Restricting the Search” on page 519) the Replace dialog con-
tains parameters which are relevant for replacing:
Replace with 

Enter here the text string which replaces the search string.
© CAD Schroer GmbH                             519



MEDUSA4 Drafting
Text - Home Tab
Replace 
replaces the currently selected text or parts of it by the replace string if the current 
selection or parts of it match the search string and the search criteria. This button will 
be activated after having pressed Search and if a text was found.

Replace All 
replaces all texts or text parts on the sheet matching the search string and the search 
criteria.

Un-number & Re-number

MEDUSA4 provides the possibility to search on a drawing for text strings and numerals, which 
follow defined strings, and replace them with consecutive numbers. This enables you to create 
e.g. consecutive part numbers on a sheet.

Choose the Number tool from the Text + Prims tool group in the Home tab. The Number dialog is dis-
played.

Figure 523 Number Dialog

The Search String area provides following input fields:
Textstyle 

You can display a pulldown list of all available text styles by using the arrow.

Figure 524 Textstyle Pulldown Menu of Number Dialog 
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String

defines the text string to search for (e.g. A, ABC)
Wildcard

Here a wildcard (e.g. #,$) can be entered. First existing numerals on the sheet are 
replaced with the wildcard. In a second step this wildcard is searched in order to 
replace it with new numbers (see Un-number and Re-number below).

In the lower area of the dialog definitions for the search direction are made.
Primary Direction

You can choose between searching in vertical or horizontal direction.
Vertical Direction

The search is performed in the defined primary search direction either from bottom to 
top (bottom up) or from top to bottom (top down).

Horizontal Direction

The search is performed in the defined primary search direction either from left to right 
or from right to left.

The dialog provides following buttons:
Un-number

prepares the entered text String for Re-numbering. This is done by scanning the complete 
drawing for numbers, which follow to the defined text String. Each single numeral of the 
numbers is replaced with the defined Wildcard.

Re-number

scans the complete drawing for text, which begins with the defined string, and replaces 
the wildcards, which are added to this string, with consecutive numbers.
If no wildcard is defined, it is searched for texts, which begin with the defined string. 
Then, the last character of each string is replaced with consecutive numbers. For 
example, if the search string is text, the result will be tex1, tex2, tex3 etc.

Please note: Un-numbering as well as re-numbering searches for text of the defined style only.

Number

executes the Un-number and Re-number command automatically in succession.
Cancel

quits the dialog.
Help

displays the documentation on the dialog.
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Examples

The result of different settings is to be clarified with some examples. On basis of the drawing in 
Figure 525 firstly the parameters of the search direction will be explained.

Figure 525 Basic Sheet

Text of style slot and string A will be searched; A wildcard is not entered.

Figure 526 Search String Settings

In each case the examples show the result of numbering with the appropriate different settings, 
after pressing the Re-number button.
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Primary Direction: Horizontal

Figure 527 Search Direction: horizontal-bottom up-from left 

Figure 528 Result

Horizontal Direction: from left (to right)

V
er

tic
al

 D
ire

ct
io

n:
 b

ot
to

m
 u

p

Primary Direction: horizontal
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Figure 529 Search Direction: Horizontal-bottom up-from right

Figure 530 Result

Primary Direction: horizontal

Horizontal Direction: from right (to left)
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Figure 531 Search Direction: Horizontal-top down-from right 

Figure 532 Result

Primary Direction: horizontal

Horizontal Direction: from right (to left)
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Figure 533 Search Direction: Horizontal-top down-from left 

Figure 534 Result

Primary Direction: horizontal

Horizontal Direction: from left (to right)
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Primary Direction: Vertical

Figure 535 Search Direction: Vertical-bottom up-from left

Figure 536 Result

Horizontal Direction: from left (to right)
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Figure 537 Search Direction: Vertical-bottom up-from right

Figure 538 Result

Horizontal Direction: from right (to left)
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Figure 539 Search Direction: Vertical-top down-from left

Figure 540 Result

Horizontal Direction: from left (to right)
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Figure 541 Search Direction: Vertical-top down-from right

Figure 542 Result 

Horizontal Direction: from right (to left)
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Seed Number

If there are already numbers on the sheet, MEDUSA4 recognizes the highest number and uses 
that as a seed number. That is, the re-numbering starts with the number, which follows the high-
est existing number. An example will clarify that. Down right on the basic drawing text C has 
been replaced with number 15 and B with 24.

Figure 543 Basic Sheet with existing Numbers 15 and 24

Following settings have been made in the Number dialog:

Figure 544 Example

Pressing the Re-number button effects the result shown below.
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Figure 545 Result

24 has been recognized as highest existing number on the sheet; therefore re-numbering starts 
with number 25.
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A next example gives the result, if both is set within the Search String fields, a String (text) and a 
Wildcard (#).

In this case the input sheet contains following texts.

Figure 546 Basic Sheet

You can find on the sheet:

• the string text in lower case followed by different numbers

• the string TEXT in upper case followed by different numbers

• the string Text in upper and lower case followed by different numbers

• the string text in lower case with prefixed numbers

• strings, only alphabetic characters (A, B, text, TEXT)

• strings, only numeric characters (345)

It is to be searched for String text followed of a number. With re-numbering the numbers are to 
be replaced with consecutive numbers. For clarification the relevant strings are highlighted in 
the drawing. 
© CAD Schroer GmbH                             533



MEDUSA4 Drafting
Text - Home Tab
Following entries are required in the Number dialog.

Figure 547 Search String Settings: String and Wildcard

Pressing the Un-number button effects the following result:

Figure 548 Result of the Un-number Command 

Any numerals which follow the text string text were replaced with the defined wildcard (#). You 
can see that the search has been taken place case sensitive. Only text written with small let-
ters has been considered. Any other numerals and strings have been ignored.

Now the drawing is ready for re-numbering.
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The next step replaces the wildcards with consecutive numbers.

Figure 549 Result of the Re-number Command 

The wildcards have been replaced with consecutive numbers. The number of wildcards, which 
follow the text string, is irrelevant.
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Item Number Balloons

The Item Number Balloon texts are used for numbering elements inside your drawing, for exam-
ple, to mark components on your sheet. MEDUSA4 provides the Create a new Item Number Balloon 
tool  for creating balloon texts. It opens the following dialog:

Figure 550 Create Item Number Balloon Dialog

The dialog has the following parameter and buttons:
Item Number

gives the number of the balloon text to place next.
Lowest, Next, Highest

finds the lowest, next or highest Item Number. After clicking on one of these buttons the 
entry for Item Number is updated.

Part Number

is a user defined number. By default there are the placeholders #####.
Quantity

is a user defined number for the amount of components marked with the balloon text. 
By default this value is 1.

Issue

is a user defined number for the version of components marked with the balloon text. 
By default this value is 1.

Symbol file

provides a pulldown list for selecting the symbol used for the balloon text. The default 
symbol is named balloon_def (for details on using and defining symbol files for bal-
loon texts see “Use Symbols for Item Number Balloons” on page 540).
536 © CAD Schroer GmbH



MEDUSA4 Drafting
Item Number Balloons
Please note: The following explanations use the standard symbol balloon_def for balloon 
texts.

Leader line

applies a leader line to the balloon text. If this option is chosen, you can define the 
Pointer in the field below by choosing one of the arrows.

Pointer

is only available if the option Leader Line is chosen. Pointer provides several buttons which 
are used to attach different arrows to the leader line.

Multisheet check

enables a consistency check for balloon texts on all sheets of a loaded working set.
For loading a working set see “File Tab”, ”Working Sets” on page 231. 

Cancel, Help

work as usual.

Creating Item Number Balloons

For creating Item Number Balloons:

1. Select the Create a new Item Number Balloon tool .
The Create Item Number Balloon dialog opens (see “Editing Balloon Texts” on page 539).
The Item Number Balloon is attached to the cursor.

2. Click the LMB on the button Lowest to ensure that the lowest available item number is 
used.

3. Adjust the other settings to your needs.
4. Move the cursor to the position where you want to place the balloon and click left.

The Item Number Balloon is placed on the sheet.
5. If the option Leader line is on probe into the graphics area for placing the end point of the 

leader line.
Now the first Item Number Balloon is finished and you can go on placing the next.

6. Choose the button Next in the Create Item Number Balloon dialog.
The item number changes to the next number.

7. Move the cursor to the position where you want to place the Balloon and click left to 
place it.

8. If the option Leader line is on probe into the graphics area for placing the end point of the 
leader line.
Now the second balloon is finished and you can go on placing further Item Number 
Balloons. For this do the steps 6 to 8 again until all Item Number Balloons are placed.
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If you deleted some Balloons and you want to place some new which shall use the numbers of 
the deleted texts use the buttons Lowest and Highest inside the Create Item Number Balloon dialog to 
find and use them.

Creating Item Number Balloons for Design Objects

If you want to create Item Number Balloons for design objects, its name is automatically 
inserted into the Part Number field of the Create Item Number Balloon dialog.

Procedure (assuming that the Leader Line option is off):

1. Select a design object on the sheet.
2. Select the Create a new Item Number Balloon tool .

The Create Item Number Balloon dialog opens (see “Editing Balloon Texts” on page 539).
The Item Number Balloon is attached to the cursor.
The Part Number field is filled with the name of the selected design object.

3. Click left on the button Lowest to ensure that the lowest available number is used.
4. Adjust the other settings to your needs.
5. Move the cursor to the position where you want to place the text and click left.

The balloon is placed on the sheet.
Now the first Item Number Balloon is finished.

6. For the next design object click right and choose Reselect from the popup menu.
The fields in the dialog are deactivated.

7. Click the LMB on the design object which is to get the next Item Number Balloon.
If you want to abort selecting the next design object, choose Continue from the popup 
menu.
The fields in the dialog are activated again.

8. Choose the button Next in the Create Item Number Balloon dialog.
The item number changes to the next number.

9. Move the cursor to the position where you want to place the balloon and click left to 
place it.
Now the second Item Number Balloon is finished and you can go on placing further. 
For this do the steps 6 to 9 again until all Item Number Balloons are placed.

Error Messages while Creating Item Number Balloons

If there is an error while creating balloon texts, in the Create Item Number Balloon dialog the text field 
background for Item Number changes its color from white to either yellow or red. Additionally the 
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tool tip displays what conflict occurred. For example, if the background color is yellow, the cur-
rent Item Number is already used in a balloon on the sheet.

Editing Balloon Texts

As you edit Item Number Balloon text the Dashboard shows the properties Item Number, Part Num-

ber, Quantity and Issue which were already explained at the beginning of this section on page 536.

If more than one balloon text was selected, text fields with different properties remain empty.

Figure 551 Item Number Properties in the Dashboard

When you click the LMB on the Properties tool  on the left hand side of the General Properties 
header in the Dashboard, the following dialog will be opened.

Figure 552 Item Number Properties Dialog

The figure shows the properties dialog and a balloon text. The arrows show you which entry of 
the dialog is which part of the balloon text.
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Creating a Parts List from Data of Item Number Balloons

You can write balloon texts automatically into a table (Parts List) by using the Writes data of Item 

Number Balloons to a table (parts list) tool . As a result all data of Item Number Balloons are read 
and written to a file. Details on creating a parts list are described in “Tables”, ”Parts List” on page 
565.

You can also create a parts list table from multiple sheets. Details are described in “Text - Anno-
tation Tab”, “Parts Lists”, ”Parts Lists” on page 647.

Use Symbols for Item Number Balloons

MEDUSA4 provides the ability to create Item Number Balloons from custom symbol file with 
custom edit fields. In the balloon create dialog (see Figure 550, “Create Item Number Balloon 
Dialog” on page 536) there is a Symbol File pulldown menu to choose the Item Number Balloon 
symbol.

The standard symbol is ballon_def but also any symbol files that are found in the symbol 
folder in the MED2D product are listed in this menu. When a customized balloon symbol is cho-
sen, the Create Item Number Balloon dialog changes showing custom edit fields as defined for the 
appropriate symbol. Following figure shows an example:
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Figure 553 Create Item Number Balloon Dialog, Example Symbol

Please note: Symbols which are to be used as balloons can only be created by the system 
administrator. Details on this are described in the Administration Guide, chapter 
Administration, section Create Item Number Balloons.

The custom fields in the creation dialog (Figure 550, “Create Item Number Balloon Dialog” on 
page 536) also appear in the Item Number Properties dialog (see Figure 552, “Item Number Proper-
ties Dialog” on page 539) and in the Parts List table (see “Tables”, ”Parts List” on page 565).
For demonstration of using symbols as Item Number Balloons MEDUSA4 is installed with one 
additional balloon symbol called balloon_usr which can be found in the directory med2d\m2d\sym-
bol.
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Introduction

Prims are a special type of element that are used to represent predefined graphical shapes. In 
its simplest form, a prim consists of one or more line elements that define a commonly used 
shape.

Prims are similar to symbols although you cannot edit the geometry of a prim once it is dis-
played on the sheet. For this reason you only can use a prim which is predefined.

Storage of Prims

Prims get their name from the fact that they are Primitive elements. They are termed primitive 
because only the prim properties are stored in memory with the other sheet information (see 
“Prim Properties” on page 549 for a description of the prim properties).

A description of the geometry of the prim is not stored on the sheet. For this reason very little 
space is used to store the prim information. This means that prims are very useful on sheets 
which contain large numbers of similar items.

For example, in applications where you need to draw electronic circuits, you may need to create 
hundreds of components on a single sheet. Using prims less memory is required to store that 
sheet.

Automatic Updating of Prims on Sheets

The central storage of prims offers the advantage of storing a large number of identical symbols 
held in separate directories. Suppose that the design of a prim needs to be modified. Only the 
prim definition needs to be changed. Any sheets that reference the prim are updated with the 
modified design the next time they are redrawn or plotted. You can incorporate changes to the 
original prim definition into all your relevant drawings very quickly.
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Adding Prims to a Sheet

There are two ways that you add a prim to a sheet:

• Using a prim tool, see “Adding Standard Prims” on page 545

• Choosing a prim from a prim library, see “Adding a Named Prim” on page 546

Positioning a Prim Using the Datum Point

Prims, like text elements, contain a single reference point known as the datum point. This point 
is used to position the prim on the sheet. You cannot reference any other point on the prim. The 
datum point of a prim is marked inside MEDUSA4 with a little cross. Figure 554, “Standard Prim 
Tools” on page 545 show the position of the datum points for standard prims.

Adding Standard Prims

To add a standard prim to a sheet:

1. Choose one of the standard prim tools from the Home tab of the Text + Prims tool group.

Figure 554 Standard Prim Tools        

The cursor changes its shape to a cross and the prim is displayed attached to the cur-
sor with the prim datum at the center.

2. Change the properties of this prim if required.
Details are described in “Prim Properties” on page 549.

3. Place the prim on the sheet and click left.
The prim will be placed. Now you can place another prim, cancel the placement of the 
last prim (RMB > Undo) or quit the tool.
As long as you do not change the prim tool the currently set properties are also used 
for further placements of the prim. If you change to another prim tool, the properties 
revert to the default properties. This is also if you choose the same prim as before.
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Adding a Named Prim

Prims are stored in separate directories referred to as prim libraries. If you do not have the right 
prim tool, then you can choose a prim from a library using the Dashboard.

1. Choose any prim tool.
2. Choose default as the style in the Dashboard.

The prim Type is set to Superprim and the Superprim Picture button  on the right hand side 
of the Type text field of the Dashboard is activated.

Figure 555 Prims Dashboard     

3. Click the Superprim Picture button  to open the Prims dialog.

Figure 556 Prims Dialog

4. You have two possibilities to select a prim:
a. Use the pull-down menu to select the required prim library and select the required 

prim from the dialog.
b. Enter the prim code directly into the text field and click either the Prim button or the 
Return key. The input of the code in the Prim text field is independent from the prim 
library displayed in the dialog

In both cases the chosen prim is attached to the cursor.
5. Move the cursor to position the prim datum and click left to place the prim on the sheet.
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While placing a named prim you can change its properties at any time by selecting the Properties 

option from the popup menu and use the Prim Properties dialog (see “Prim Properties” on 
page 549), or by using the prim Dashboard. 

Having chosen a Superprim from the Prims dialog the Superprim Picture button changes appropri-
ately.

Popup Menu While Placing Prims

While placing a prim the following popup menu is available by clicking the RMB.

Figure 557 Popup Menu While Placing a Prim

Properties

opens the Prim properties dialog, see “Prim Properties” on page 549.
Undo

is used for canceling the last action. You can undo several actions. Its number 
depends on the number of actions stored to the history stack.

Exit Tool

quits the tool. 
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Transforming and Deleting Prims

A prim is treated as a single element. You can manipulate a prim in a number of ways but you 
cannot shear it.

Transforming Prims

You can magnify, rotate, or move prims as for any other element. To do this you use any of the 
transform tools, see “Transformation” on page 319 for further information.

Deleting Prims

To delete prims:

1. Select the prim(s) using the Select prims tool  or the Select tool  using any of the 
selection methods described in ”Selection Methods”, ”Selecting with the Mouse” on 
page 129.

2. Choose Delete from the popup menu.
The selected prims are deleted.
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Prim Properties

Prims have the standard properties of Style, Layer, Color, Thickness, and Type and additional 
properties that are specific to prims which are described below.

Prim properties are available in the Dashboard (see ”Dashboard”) and in the Prim properties dialog 
(see “Dialog” on page 550).

Changing properties is given in “Changing Prim Properties” on page 551.

Dashboard

If you have chosen a prim tool or if you selected a prim inside the graphics area, the Dashboard 
displays its properties. 

Figure 558 Prims Dashboard

The following list explains the parameter of the figure above:
 Properties

opens the Prim properties dialog, see “Dialog” on page 550).
Style

gives the style of the selected prim. 
Layer

gives the layer of the selected prim. 
Type

gives the type of the selected prim. 
If the Style is set to Standard, the Superprim Picture on the right hand side of the text field 
changes to  and is activated. Now you can add a named prim as described in ”Add-
ing Prims to a Sheet”, ”Adding a Named Prim” on page 546.

Magnify

is the value for increasing or decreasing the default size of the prim. The default value 
is 1.00. If you use the arrows for changing this value it changes step wise up or down 
by one (e.g. 2.00, 3.00).
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Rotate

gives the value (units are degrees) by which a selected prim rotates. The default value 
is 0.00. If you use the arrows for changing this values it changes step wise up or down 
by five (e.g. 5.00, 10.00).

Dialog

The Prim properties dialog can be opened by clicking left on the Properties tool  on the left of the 
prim Dashboard heading General Properties or by using the Properties entry in the popup menu.

Figure 559 Prim Properties Dialog

The following entries are found in the dialog:
Style, Layer, Color, Thickness

are the standard properties 
X position, Y position

gives the coordinates of the datum point of the current prim.
Type

gives the type of the current prim.
Picture

opens the Prims dialog for selecting another picture for the current prim (for details see 
”Adding Prims to a Sheet”, ”Adding a Named Prim” on page 546).

Magnify

is the value for increasing or decreasing the default size of the prim. The default value 
is 1.00. If you use the arrows for changing this value it changes step wise up or down 
by one (e.g. 2.00, 3.00).

Rotate

gives the value (units are degrees) by which a selected prim rotates. The default value 
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is 0.00. If you use the arrows for changing this values it changes step wise up or down 
by five (e.g. 5.00, 10.00).

Changing Prim Properties

You can change prim properties in the Dashboard or in the properties dialog.

Using the Dashboard

1. Select a prim on the sheet.
The Dashboard shows the properties of the selected prim.

2. Choose the property you want to change.
You can either select from a pull-down list by clicking left on the arrow next to the prop-
erty (e.g. Style) or you can type a new value inside the edit field for the property (e.g. 
Magnify).
The chosen property will be immediately changed for the selected prim.

Using the Properties Dialog

1. Select a prim on the sheet.
2. Click right for displaying the popup menu.
3. Click left on the Properties entry.

The Prim properties dialog opens. 
You also can open the properties dialog by using the Properties tool  on the left of the 
General Properties header on the Dashboard.

4. Choose the property you want to change.
You can either select from a pull-down list by clicking left on the arrow next to the prop-
erty (e.g. Style) or you can type a new value inside the edit field for the property (e.g. 
Magnify).

5. Click left on the button OK or Apply to apply the changed property to the selected prim.

Please note: Deactivated (grayed out) properties cannot be changed until you switch into 
Administration mode. For details see the Administration Guide, chapter Adminis-
tration, section Creating and Editing MEDUSA4 Styles.
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MEDUSA4 provides the creation of tables. You can enter data directly in the table or you can 
load data from CSV files (Comma Separated Values).

• Dialog for Creating Tables...................................................... 554

• Creating a Table..................................................................... 557

• CSV Format Files................................................................... 559

• Saving Tables......................................................................... 560

• Loading Tables....................................................................... 560

• Editing Tables......................................................................... 561

• Parts List ................................................................................ 565
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Dialog for Creating Tables 

In MEDUSA4 tables are displayed inside a dialog before they are placed on the sheet or saved 
in an external file. This Table Creation dialog is opened by clicking left on the Create a Table tool  in 
the Text + Prims tool group.

Figure 560  Table Creation Dialog, Table Data tab

The contents of the dialog are explained in following sub-sections:

• ”Toolbar”

• “Tab Table Data” on page 555

• “Tab Properties” on page 556

• “Buttons” on page 557

Toolbar

The toolbar contains several tools, for example, to change the amount of table rows and col-
umns, or to define the alignment of table texts.

 New Table

creates a new table (for details see “Creating a Table” on page 557).
 Load Data

is used for loading a CSV file, see “Loading Tables” on page 560.
 Save Data

is used for saving the table in an existing CSV file. This entry is available if you loaded 
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a table from a file or if you already saved the table with Save Data as (see also “Saving 
Tables” on page 560).

 Save Data as

is used for saving the table to a new CSV file (for details see “Saving Tables” on 
page 560).

 Delete Selection

removes the selected table text. If a complete row or column is selected it is deleted 
completely from the table. If several cells are selected which do not make a complete 
row or column only the containing text is deleted and the cells remain empty.

 Left justify selection,  Mid justify selection,  Right justify selection

is used for justifying the text inside the table cell (for details see “Editing Tables”, ”Jus-
tifying Text” on page 564).

 Set table justification

This toolset provides justification of the table to the left bottom, left top, right bottom 
and right top corner. According to this setting the table is attached at the crosshair of 
the cursor while placing.

 Synchronize table with balloons on sheet

updates the table according to the currently available balloon texts on the sheet (see 
“Parts List”, ”Updating a Parts List” on page 566).

Tab Table Data

The tab Table Data is displayed by default after having opened the Table Creation dialog and it pro-
vides the rows and columns of the table. 

How to edit table data is explained in “Editing Tables” on page 561.
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Tab Properties

The tab Properties allows you to define properties text and lines of the table. 

Figure 561 Table Creation Dialog, Properties tab

The Properties tab provides the following parameters:
Style

is the name of the table style.
Use row height

is the option for defining a row height which differs from the default value (7.00). If this 
option is chosen the edit field below is enabled for specifying the value for the height of 
the row.

Table layer 

defines the layer of the table.
Text Type, Text Color, Text Thickness, Text Height, Font 

These parameters define the style of the text inside the cells and the used font (Quick 

Text by default). 
Line Type, Line Color, Line Thickness

These parameters define the style of the lines surrounding the cells. 
File entry separator

defines the sign used for separating the column entries for each table row. It is used for 
the case of storing the table as a CSV file (see “CSV Format Files” on page 559 and 
“Saving Tables” on page 560).
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Buttons

At the bottom of the Table Creation dialog you find the following buttons:
OK, Apply

are used for applying the current settings of the dialog. OK additionally closes the dia-
log. 

Cancel, Help

work as usual.
Style

is only available if you are in Administrator mode.

Details on adding, editing and deleting styles are given in the Administration Guide, chapter 
Administration, section Creating and Editing MEDUSA4 Styles.

Creating a Table

By default MEDUSA4 provides a table with four rows and five columns.

Do the following steps for creating a table:

1. Choose the Create a Table tool  located in the Text + Prims tool group.
The Table Creation dialog is opened with the Table Data tab displaying the default table.

Figure 562 Table Creation Dialog, Table Data tab

2. If you want to change the amount of rows and columns, choose the New Table tool  
from the toolbar of the dialog. 
The following window opens:
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Figure 563 Create Table Dialog

The left edit field shows the number of rows and the right one the number of columns.
3. Choose the amount of rows and columns.
4. Click on the button OK to apply the settings.

The table in the Table Creation dialog changes immediately to the new number of rows 
and columns.

5. Click into a cell and type the text for filling the cells of the new table.
6. If you want to change the load point for placement you can define the datum point by 

using, for example, the Set table justification to bottom right tool .
7. Select OK or Apply.

The table is attached to the crosshair of your cursor. 
You can go on changing the table before placing it on the sheet. In this case consider 
that you have to choose again OK or Apply to use your changes on the table attached to 
the mouse cursor.

8. Click at the position inside the graphics area where you want to place the table.
The Create a Table tool  is deposited.
The table placed on the sheet remains selected and the dialog opened in order to con-
tinue editing the table if required.
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CSV Format Files

Comma Separated Values (CSV) files are used to specify tables of information. A CSV file con-
tains lines of text which are divided into data elements using commas. Each data element rep-
resents a table cell. For example, to represent the elements 1,2,3 and 4, each in its own table 
cell, the CSV file appears as follows:

1,2,3,4

The table data shown in Figure 564 would be created like this:
Name,Address,Age,Telephone
Mr P Eye,1 The Heights,54,6494 8371
Ms O Oyle,33 Sun Lane,33,2075 9320
Mr B Rutus,7 Frazer Street,49,4443 2398

Please note: If you copy the example, do not forget to finish the fourth row with a Return 
otherwise only three rows are displayed in the Table Creation dialog.

Figure 564 Table Creation Dialog, Table Data with loaded CSV file tab 

Occasionally you may need to put a comma into one of the data elements (or fields), and need 
to ensure that this comma is not used as a separator.

• To include commas in fields, begin and end the field with quotation marks.

• To include a quotation mark in the middle of a field, put in two consecutive quotation 
marks.

A field that needs to have a quotation mark and a comma in the middle would be created like 
this:

"The quotation mark goes here"" and the comma goes here, and that's 
it"
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and would expand to show the following field:
The quotation mark goes here" and the comma goes here, and that's it

Saving Tables

Tables can be saved as CSV files, see “CSV Format Files” on page 559. 

If the current table is new:

1. Choose the Save as tool .
A dialog opens.

2. Type in the new Filename or select a file from the Filename list to overwrite this file.
3. Click on the button Save.

The dialog closes and the table is saved under the chosen Filename.

If the table was loaded from a file (see “Loading Tables” on page 560) or if you already saved 
as CSV file the Save tool  is available. In this case saving is done as follows:

1. Choose the Save tool .
The following message comes up:

Figure 565 Message Overwrite File 

2. Choose Overwrite for saving the table.
Cancel closes the message and aborts saving.

Loading Tables

Tables can be loaded from CSV files (see “CSV Format Files” on page 559). 

1. Choose the Load data tool  for opening the Load Table Data dialog.
2. Type in the new Filename or select a file from the list.
3. Click on the button Open.

The dialog closes and the table is loaded into the Table Creation dialog.
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Editing Tables

Editing table data can be edited in different situation, for example while creating or after placing 
on the sheet. In all cases editing is performed in the Table Creation dialog.

In this section it is assumed that a table is placed on the sheet. The Table Creation dialog can be 
opened as follows for editing this table:

• Double click left on any part of the table.

• Click the LMB on any part of the table to select it and then choose Edit or Properties from 
the popup menu.

Now you have following possibilities for editing:

• ”Adding, Appending, Deleting and Sorting Rows and Columns”

• “Selecting One Table Cell” on page 562

• “Selecting Several Table Cells” on page 563

• “Expanding and Reducing the Selection - Shortcuts” on page 563

• “Justifying Text” on page 564

• “Deleting Text” on page 564

Adding, Appending, Deleting and Sorting Rows and Columns

If the cursor is on the table inside the Table Data tab of the Table Creation dialog, a popup menu is 
available to add, delete or sort rows and columns.

Figure 566 Default Popup Menu in the Table Creation Dialog

• To add rows or columns, click on Insert Row or Insert Column.
Rows are added above the currently selected table cell. 
Columns are added to the left of the currently selected table cell. 
If no cell is selected rows and columns are added at the end of the table.
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• To delete rows or columns, click Delete Row or Delete Column.
If a cell is selected the current row or column is deleted.
If no cell is selected rows and columns are deleted from the end of the table. 

• To append a row or column at the end of the table click on Append Row or Add Column.

• To sort the table according to a column move the cursor on the appropriate column 
and choose Sort Up or Sort Down.

Selecting One Table Cell

You can select text in two ways for changing it in a table cell:

• Click the LMB in a table cell. 

Figure 567 Table Creation Dialog, Table Data tab, Cell Selected by single click

• Double click left in a table cell. 

Figure 568 Table Creation Dialog, Table Data tab, Cell Selected by double click

In both cases, as you type a new value, the existing entry will be overwritten. 
If you edit a table cell by double click additionally the usual popup menu of the table 
dialog (see Figure 566, “Default Popup Menu in the Table Creation Dialog” on 
page 561) changes to the following one:

Figure 569 Popup Menu While Typing into a Table Cell

As you see, MEDUSA4 provides the common functions for editing table cell entries. 
You can cut, copy, paste and clear, as well as undo and redo actions. The shortcuts 
shown beside the command functions in the figure above are for Windows operating 
systems. They may be different on other operating systems.
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Selecting Several Table Cells

To justify or delete text (see “Justifying Text” on page 564 and “Deleting Text” on page 564) you 
can select several table cells at the same time by selecting either one or more rows or columns, 
or certain table cells:

• To select a complete row click the LMB on the row button in front of a table line.

Figure 570 Table Creation Dialog, Table Data, Row Selected tab

• If you want to select a column click the LMB on a column button on top of the table.

Figure 571 Table Creation Dialog, Table Data, Column Selected tab

• To select certain cells:
a. Click the LMB on the first cell and hold the mouse button.
b. Move the mouse to the last cell you want to select.

As you move the mouse the selected cells become highlighted.
c. Release the mouse button.

All selected cells are highlighted. Now, for example, you can justify them.

Figure 572 Table Creation Dialog, Table Data Tab, Multiple Cells Selected

Expanding and Reducing the Selection - Shortcuts

The current selection of table cells can be expanded and reduced using the buttons Shift and 
Ctrl on your keyboard.

• The button Shift adds all table cells between the former selection and the table cell, 
in which you click left if they are not yet selected. If table cells are already selected, 
they will be deselected.
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• The button Ctrl adds only the table cell in which you click left to the former selection if 
this cell is not yet selected. If the cell is already selected, it will be deselected.

Justifying Text

Text can be justified either to the left , middle  or right .

Do the following for justifying text:

1. Select one or more table cells.
Details for selecting can be found in “Selecting One Table Cell” on page 562 and 
“Selecting Several Table Cells” on page 563.

2. Click left on one of the justification tools on top of the Table Creation dialog (page 554).
The text is justified appropriately.

Deleting Text

Do the following for deleting text:

1. Select one or more table cells.
Details for selecting can be found in “Selecting One Table Cell” on page 562 and 
“Selecting Several Table Cells” on page 563.

2. Click left on the Delete selection tool .
All selected table texts are deleted.
If a whole row or column is selected, it will be removed completely.

Please note: For deletion you can also use the buttons Del and <-- on your keyboard. But note 
that for a multiple selection (e.g. a whole column) only the content of the first or 
last table cell will be removed from the selection.
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You can use the Item Number Balloons in your sheet to create a parts list. This parts list can be 
updated at any time if the drawing has been changed (see ”Updating a Parts List”).

Creating Item Number Balloons is described in “Text - Home Tab”, ”Item Number Balloons” on 
page 536.

Creating a Parts List

To create a parts list do the following steps:

1. Open a sheet with Item Number Balloons.
2. Choose the Writes data of Item Number Balloons to a table (parts list) tool  located in the 

Text + Prims tool group.
The Parts List dialog opens containing all data of the Item Number Balloons of your 
sheet.

Figure 573 Table to create Parts List

3. Choose Apply.
The table is attached to the cursor.

4. Click the LMB on the sheet to place the table.
You can also save the table to a comma separated file (CSV file, explained in “CSV 
Format Files” on page 559) as described in “Saving Tables” on page 560.

5. Save the sheet in order to store the parts list table with the sheet.
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Updating a Parts List 

Having changed a drawing it can happen that the parts list is not correct anymore and has to be 
updated. To update a parts list do following steps:

1. Double click left on the parts list table that you want to update.
You can also select the table with a single click left at first and then choose Properties or 
Edit from the popup menu.

2. Choose the Update parts list tool , in the right top corner of the Parts List dialog 
(Figure 573).
The Item Number Balloon data in the table are updated according to the informations 
from the current sheet. Widths and sort order of the columns remain unchanged.

Please note: A parts list generated from the balloon texts of several sheets (see “Text - Anno-
tation Tab”, ”Creating a Parts List from Several Sheets” on page 647) cannot be 
updated. Such a parts list table has to be created new.
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This chapter describes how to fill enclosed areas with a specified pattern. You can fill areas with 
lines using the crosshatch tool and with a pattern using the stipple tool. 

• Introduction to Crosshatching and Stippling........................... 568

• Defining a Closed Area .......................................................... 569

• Using the Crosshatch or Stipple Tools ................................... 572

• Crosshatch Properties ........................................................... 576

• Stipple Properties................................................................... 580

• Selecting and Deleting Stippling or Crosshatching ................ 584

• Multiple Crosshatching........................................................... 585

• Filling Disjoint Areas .............................................................. 586

• Create Gaps Under Text in Crosshatching ............................ 587

• Masking Hidden Lines............................................................ 588

• Boolean Operations ............................................................... 590
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Introduction to Crosshatching and Stippling   

You can cover an area of a drawing with regularly spaced lines, known as crosshatching, or 
with a pattern of predefined symbols, known as stippling. 

Crosshatching

The crosshatching tool allows you to cover an area of a drawing with a regularly spaced pattern 
of lines. You can change the style of the crosshatching by changing its properties. Figure 574 
shows some examples of crosshatching.

Figure 574 Examples of Crosshatching

Stippling

The stipple tools allow you to stipple an area with a symbol. For example, you could create a 
star, save it as a symbol, and then stipple an area of a drawing using the star as the stippling 
symbol. 

You can either create a solid pattern of symbols, with no spacing between the symbols, or you 
can specify the spacing between adjacent symbols. Figure 575 shows some examples of stip-
pling patterns.

Figure 575 Examples of Stippling
568 © CAD Schroer GmbH



MEDUSA4 Drafting
Defining a Closed Area
Defining a Closed Area      

The area that you want to fill has to be enclosed. A closed area can be defined by:

• Closed line(s), either at sheet level or in a group (you can use any line type).

• A closed temporary line (see below).

• Any number of individual lines if they make up a closed area.

You can create these lines using any of the normal techniques for drawing lines. The area can 
have any shape you like. 

Drawing a Temporary Line

If you want to fill an area bounded by a number of existing lines you must create a temporary 
line that coincides with the separate lines so that it encloses the area to be filled. For example, 
you could create a construction line to enclose the required area as shown in Figure 576.

Figure 576 Temporary Lines Defining the Area to be Filled

Deleting a Temporary Line

You can delete the temporary line when the area has been filled. It is recommended that you 
use a construction line type for the temporary lines. This makes it easier to delete the temporary 
line as construction lines are created on a separate layer.

Area to be
crosshatched

Temporary
closed line

Resulting area
of crosshatching

Area to be
crosshatched

Crosshatched
area

Closed
temporary line
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Seed Point Crosshatching or Stippling     

As an alternative to drawing a temporary line to define the area that you want to fill, you can use 
the Seedpoint menu item, which is on the popup menu for the crosshatch or stipple tools. 

Seed Point enables you to fill the area shown in Figure 576, “Temporary Lines Defining the 
Area to be Filled” on page 569 without first having to define a temporary line. MEDUSA4 calcu-
lates the boundary marked by the selected lines that enclose the probed point and creates the 
crosshatching. Proceed as follows:

1. Choose the Crosshatch tool .
2. Select all the lines that surround the area to be crosshatched.
3. Click the RMB to open the popup menu.
4. Choose Seed Point.
5. Probe a point inside the area to be crosshatched.

The crosshatching is created.

Figure 577 Crosshatching Area by using Seed Point

If there is a problem with the area as defined by the lines that you select, an arrow appears on 
the drawing at the appropriate point.

Area to be
crosshatched

Resulting area
of crosshatching

X

probed point

Using Seed Point
on RMB Popup Menu
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Figure 578 Error Message

Please note: Click on the OK button to close the message and use the Refresh Graphics tool  on 
the In Graphics Tool Bar to remove the arrow.
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You can fill any shape assuming it is defined by a suitable line as explained in “Defining a 
Closed Area” on page 569. You cannot fill text elements or prims. 

Figure 579 Crosshatch and Stipple Tools on the Home Tab

The following sections give the steps for hatching and stippling separately as each operation 
works a little different.

Crosshatching Areas

Crosshatching areas works in general by choosing the crosshatch tool, selecting elements and 
then using the popup menu. Therefore, before giving the steps for hatching areas, here is the 
popup menu available on the RMB after selecting the crosshatch tool:

Figure 580 Popup Crosshatch Tool

Apply

executes crosshatching on all areas defined by the currently selected elements.

Please note: If the elements which enclose an area do not belong together, the result of cross-
hatching can get wrong. In this case use Seed Point for defining the area which is to 
be filled.

Seed Point

makes MEDUSA4 to find an area enclosed by several selected elements which inter-
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sect. If you choose Seed Point, you have to probe the appropriate area inside the graph-
ics area to execute filling.

Sheet Level

forces the crosshatch to be placed on sheet level, also if the selected elements are on 
another level.

Properties

opens the Crosshatch Properties dialog explained in “Crosshatch Properties” on page 576.
Undo

is used for canceling the last action. You can undo several actions. Its number 
depends on the number of actions stored to the history stack.

Exit Tool

quits the tool.

To crosshatch do the following steps:

1. Select the Crosshatches the selected areas tool .
2. Change the properties of the Crosshatch tool if required.

Details are described in “Crosshatch Properties” on page 576. 
3. Select element(s), or the line(s) defining the area that you want to fill.
4. Either choose the Apply or the Seed Point option from the popup menu

• If you chose Apply, the selected area will be filled and the crosshatch becomes 
selected after the operation.
If you want to fill the same area with a different pattern, you have to select it again.

• If you chose Seed Point, move the cursor inside the area to fill and click the LMB.
The area in which you placed the seed point is filled. The elements selected in step 
3 remain selected and you can go on filling the area with other patterns (for exam-
ples see “Multiple Crosshatching” on page 585).

Now you can

• cancel the area fill by choosing Undo from the popup menu, 

• fill other areas using the same properties, or

• change the area fill properties and then fill other areas.

Filling Areas with Symbols

Filling areas with symbols, the so called stippling, works in general by choosing the stippling 
tool, selecting elements and then using the popup menu. Therefore, before giving the steps for 
stippling areas, here is the popup menu available on the RMB after selecting the stippling tool:
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Figure 581 Popup Stippling Tool

Apply

executes stippling on all areas defined by the currently selected elements. 

Please note: If the elements which enclose an area do not belong together the result of stippling 
can go wrong. In this case use Seed Point to define the area which is to be filled.

Seed Point

makes MEDUSA4 to find an area enclosed by several selected elements which inter-
sect. If you choose Seed Point you have to probe the appropriate area inside the graphics 
area to execute filling.

Properties

opens the Temporary Stipple Properties dialog explained in “Stipple Properties” on page 580.
Undo

is used for canceling the last action. You can undo several actions. Its number 
depends on the number of actions stored to the history stack.

Exit Tool

quits the tool. 

To fill areas with symbols do the following steps:

1. Select the Stipples the selected areas tool .
The Load Named Symbol dialog appears:
a. Choose the symbol that you want to use.
b. Select Load.
The dialog closes and the chosen symbol is attached to the cursor.

2. Change the properties of the stipple tool if required.
Details are described in “Stipple Properties” on page 580.

3. Select the element(s), or the line(s) defining the area that you want to fill.
4. Fill the selected area.

• If the area is defined by one line, choose the Apply option from the popup menu.
• If the area is defined by several lines intersecting each other, choose Seed Point from 

the popup menu, move the mouse cursor into the area and finally click left.
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The selected area is filled with a pattern of the chosen symbol. The elements defining 
the area to be filled remain selected.
Now you can
• cancel the area fill by choosing Undo from the popup menu,
• fill the same areas again, for example, by rotating the stipple symbol with Rotate by 90 

from the popup menu (see also “Multiple Crosshatching” on page 585),
• fill other areas using the same properties (re-start with step 3),
• stipple other areas using a different symbol by choosing New Symbol from the popup 

menu and go on with step 3, or
• change the area fill properties (for example, spacing) and then fill other areas.

Please note: If you know the path name of the symbol you want to stipple with, you can point to 
the stipple tool, choose Properties from the popup menu, and type in the pathname 
of the symbol. 
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To crosshatch an area, the system first constructs a temporary reference line. This is known as 
the seed line, based on the angle that you specify as shown in Figure 582. The rest of the 
crosshatching lines are then drawn parallel to the seed line and on both sides using the offset 
and spacing that you specified. However, only those crosshatch lines that fall within the cross-
hatching boundary are displayed on the sheet.

Figure 582 Angle, Spacing, and Offset

The default settings for the crosshatch properties are:

Crosshatch properties are available in the Dashboard (see “Dashboard” on page 577) and 
inside the Crosshatch Properties dialog (see “Dialog” on page 578).

Changing properties is explained in “Changing Crosshatch Properties” on page 579.

Property Default Setting

Offset 0 mm

Line Type Solid

Layer Crosshatching

Angle 45 degrees

Spacing 5mm

Seed

Offset

Spacing

Crosshatching
Angle
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Dashboard

If you have chosen the crosshatch tool or if you have selected a crosshatch, the Dashboard dis-
plays its properties.

Figure 583 Crosshatches Dashboard

The following list explains the parameters as shown in the figure above:
 Properties

opens the Crosshatch properties dialog (for details see ”Crosshatch Properties”, ”Dialog” on 
page 578).

Style gives the type of the crosshatch. Predefined crosshatches are Free, default, single and 
double. single and double are available with angles of +/- 30, 45 and 60 degrees.

Layer gives the layer Crosshatching which is the default layer for crosshatching and stippling.
Type sets the type of line.

 Color

sets the color of the line.
Thickness

sets the thickness of the line.
Angle gives the angle of the crosshatch lines from the horizontal.
Spacing sets the distance between neighboring crosshatch lines in sheet units.
Offset sets the offset for the seed line from the sheet origin. This is used to calculate the posi-

tion of the other crosshatch lines.
The options Angle, Spacing and Offset are illustrated in Figure 582, “Angle, Spacing, and 
Offset” on page 576.

Double line

option for drawing two lines instead of one. Once the Double line option is switched on 
the Gap option is also enabled.

Gap is the offset for the spacing between first and second line of a double lined crosshatch. 
If Double line is off this entry is disabled.
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If you have chosen the crosshatch tool or if you have selected a crosshatch, the Dashboard pro-
vides the properties tool  on the left of the Common Properties header which opens the Crosshatch 

Properties dialog.

Figure 584 The Crosshatch Properties Dialog

The dialog provides the same properties as explained for the Dashboard on page 577. Follow-
ing buttons are additionally available:
Create, Apply

applies the changes you made inside the dialog. The dialog window remains open.
Create additionally draws the crosshatch into the selected geometry.

OK, Cancel, Help

work as usual (for details see ”Work Environment”, ”Dialogs”, ”Common Buttons” on 
page 52).

Style opens the Style Creation Dialog (for details see the MEDUSA4 Administration Guide, chap-
ter Administration, section Creating and Editing MEDUSA4 Styles).
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Changing Crosshatch Properties

Crosshatch properties can be changed temporary or permanently.
•

Change Temporary

Use the Crosshatch Properties dialog to set the crosshatch properties temporary. 

1. Select the Crosshatches the selected areas tool .
2. Select elements which define an area.
3. Click the RMB to display the popup menu.
4. Choose the Properties option.

The Crosshatch Properties dialog appears as shown in Figure 584, “The Crosshatch Prop-
erties Dialog” on page 578.

5. Choose crosshatch properties as required.
Details are given in “Dashboard” on page 577 and “Dialog” on page 578.

6. Click
• Apply to apply the properties and retain the Crosshatch Properties dialog.
• OK to apply the properties and close the dialog.
If the changed properties differ from the defaults, this is indicated by an asterisk 
appended to the Style label in the Dashboard.

Figure 585 Dashboard - Display of the Style Label for Temporary Crosshatch Properties

Once you have changed properties temporary, the new properties are used for further cross-
hatches until you change them again or choose another style from the Style pulldown menu. 

Change Permanently

Please note: If you want to change crosshatch properties permanently, the Administrator mode 
must be enabled. 

To change properties permanently please read the MEDUSA4 Administration Guide, chapter 
Administration, section Creating and Editing MEDUSA4 Styles.
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When you fill an area with a stipple pattern, you create the pattern from a symbol. Therefore the 
properties dialog includes some options for transforming symbols. These options work in the 
same way as described, for example, in ”Symbols - Home Tab”, ”Transforming Symbols”, 
”Rotating a Symbol” on page 606.

Properties Dialog

You can open the properties dialog while creating stipples by clicking the RMB and choosing 
Properties from the popup menu.

Figure 586 Temporary Stipple Properties Dialog

The Stipple Properties dialog provides the following parameters:
File

is the path and file name of the currently used symbol. You can change the symbol that 
is used for stippling by typing a new name for the symbol. If this field is blank, the Load 
New Symbol dialog is displayed when you choose the Stipples the selected areas tool.
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Layer

on which stippling is placed. It is Crosshatching by default, see ”Layers”, ”Default Layer” 
on page 145.

Move

The Horizontal and Vertical fields enable you to move the datum of the symbol that you 
used for stippling. The datum point is the position on the sheet that you probed when 
the symbol was saved (see “Symbols - Home Tab” on page 593). 

scaled, unscaled

displays the symbol scaled or unscaled.
Rotate

is used for rotating the stipple symbol by the defined angle. A positive value rotates 
counterclockwise. A negative value rotates clockwise.

legible, fixed, rigid

defines the display of texts within a symbol.
• legible guarantees that the text is always readable (either from left to right or from 

bottom to top) also in the case that the symbol is rotated or mirrored.
• fixed keeps the text orientation as saved with the symbol, the legibility of the text 

remains.
• rigid defines that texts are displayed the same way as other elements of the symbol. 

This means, that the text possibly is no longer readable, e.g. after rotating the sym-
bol.

Magnify

is used for sizing the symbol separately in Horizontal and Vertical direction.
Step

sets the spacing between the symbols in rows and columns. You can set the row and 
column spacing and the horizontal and vertical offset between the symbols as shown in 
Figure 587, “Settings of Spacing between Symbols” on page 582. The default spacing 
is zero, no space between the symbols. To increase the spacing you need to enter a 
value greater than the dimensions of the symbol.

Shear

is used for shearing the symbol separately in Horizontal and Vertical direction.
Angle, Ratio

defines that the values for shearing are evaluated either as an Angle or a Ratio. 
Mirror

is used for mirroring the symbol across either a Horizontal or Vertical axis.
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Figure 587 Settings of Spacing between Symbols 

Changing Stipple Properties

You can change the stipple properties permanently or temporarily.

Change Permanently

For changing the properties for stippling permanently, you have to change the default proper-
ties. The following steps show you how to do that:

1. Move your cursor over the Stipples the selected areas tool .
2. Click right to open the popup menu.
3. Select Properties to open the Stipple Properties dialog. 

20

10

100

60
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Figure 588 Permanent Stipple Properties Dialog

4. Change the properties as required.
5. Choose Apply or OK for confirming your changes.

Please note: The properties are used for all stipple operations you do in the current session. To 
get back the default settings, use the Defaults button.

Change Temporary

To set temporary stipple properties:

1. Select the Stipples the selected areas tool .
If you call the tool the first time, the Load Named Symbol dialog appears. Choose the sym-
bol that you want to use and click left on the button Load. The dialog closes and the 
chosen symbol is attached to the cursor.
If you have already used the tool, the last chosen symbol is attached to the cursor.

2. Click the RMB to open the popup menu and select Properties.
The Stipple Properties dialog opens. 

3. Change the properties as required.
A list of properties is shown in ”Stipple Properties”, ”Properties Dialog” on page 580.
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4. Choose Apply or OK for confirming your changes.
The stipple properties are changed and used until you change the properties again or 
you exit the tool.

Please note: Changing the temporary properties does not affect the default property settings. 

Selecting and Deleting Stippling or Crosshatching

After creating stippling or crosshatching you can select them using the selection tools available 
on the selection tools pulldown menu of the In Graphics Tool Bar.

Figure 589 Selection Tools for Stippling and Crosshatching

Selecting Area Fills

To select stippling or crosshatching:

1. Move the cursor over the Selects elements of any type tool  in the In Graphics Tool Bar.
2. Click the RMB to open the selection tools pull-down menu.
3. Select the stipple or crosshatch selection tool.
4. Move the cursor on the filled area and click lthe LMB.

The crosshatch or stipple below the mouse cursor becomes highlighted and is now 
selected.

Deleting Area Fills

To delete all the crosshatching or stippling on a sheet:

1. Choose the Select Stipple  or Select crosshatching tool  from the selection-pulldown 
menu of the In Graphics Tool Bar and drag a selection rectangle around the elements 
from which you want to delete the crosshatching or stippling.

2. Choose the Delete  button. This is available on the RMB popup menu and on the 
Ribbon > Home > Clipboard.
The crosshatching or the stippling is deleted but not the selected elements.
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Multiple Crosshatching

You can create complex patterns by crosshatching the same area several times using different 
crosshatch properties.

Examples

To achieve the pattern shown in Figure 590:

1. Crosshatch the selected element at 45 degrees.
2. Choose Negative Angle from the popup menu.
3. Choose Apply from the popup menu.

Figure 590 Creating Multiple Crosshatching

To achieve the pattern shown in Figure 591.

1. Choose Vertical from the popup menu.
2. Select the element.
3. Choose Temp Properties... from the popup menu.
4. Set the offset to 2, and click Apply.
5. Choose Apply from the popup menu.

Figure 591 Creating Offset Multiple Crosshatching
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Filling Disjoint Areas

You can crosshatch or stipple disjoint areas at the same time leaving one or more islands that 
are not crosshatched within the crosshatch boundary as shown in the example below.

Figure 592 Crosshatching Disjoint Areas: Example

1. Select either the Crosshatches the selected areas tool  or the Stipples the selected areas tool .
2. Choose the Selects elements of any type tool  and drag a selection box around the areas 

which are to be crosshatched.

Figure 593 Selecting the Disjoint Areas which are to be Crosshatched

3. Choose Apply from the popup menu.
The area is crosshatched and the crosshatching is highlighted.

Move the cursor
and press the LMB

Release the LMB
at this position

to this position
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Create Gaps Under Text in Crosshatching

To make text clearly readable on a crosshatched area, MEDUSA4 provides a tool, which 
removes an existing crosshatching under the text and creates a gap between text and cross-
hatching.

1. Select the desired text and the crosshatching, which should be removed under the 
text.

2. Choose the Create gaps under text in crosshatching tool .
The crosshatching under and around the text will be immediately removed.

Figure 594 Example of Using the Create Gaps Under Text in Crosshatching Tool
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Masking Hidden Lines

MEDUSA4 provides the Perform HLR operations on geometry tool  which works on two selection 
sets. One selection set is masked by positioning the other selection set above it. The part of the 
geometry which is masked is displayed as hidden line (e.g. dashed or dotted). 

Please note: The selected geometry which is on top has to consist of closed geometry. 

2D shapes that take part in HLR operations are post-processed as follows:
• shapes that are still valid are left intact
• shapes that have become invalid are smashed
• shapes that have become empty (or with only centerlines) are deleted

The selection sets can be crosshatched or stippled. In that case you have to select the geome-
try as well as the crosshatching or stippling.

Setting Properties for Masking

Before using the masking tool you can set some properties for the operation which are used for 
the whole MEDUSA4 session. To open this popup menu, move the cursor over the 
Perform HLR operations on geometry tool  and click on the RMB.

Figure 595 Popup Global Settings for HLR Operations

Create hidden lines

controls the display of hidden lines. When the option is activated (check mark is set), 
hidden lines are displayed.

Consider centerlines

defines, whether centerlines of geometries which have been created with centerlines, 
are also displayed as hidden lines or not; i.e., when the option is activated (check mark 
is set), the centerlines of a hidden geometry are displayed according to the settings for 
hidden lines, e.g. dotted or not at all. When the option is deactivated (default setting), 
centerlines are shown as usual.

Please note: When quitting MEDUSA4 and saving the defaults, the settings for both options will 
be saved too.
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Change HLR type

opens the dialog for defining the line style of hidden lines.

Figure 596 HLR Type Dialog

You can display a list of available styles which can be used for hidden lines by using 
the arrow.Apply uses the defined line style and the dialog remains opened. With OK the 
chosen line style will be applied and the dialog is closed.

Perform Masking a Selection Set

1. Select the Perform HLR operations on geometry tool .
Now the following popup menu is available whose entries are explained in the follow-
ing steps.

Figure 597 Popup HLR Operations

2. Choose the first selection set.
3. Depending if you want the current selection set on top or beneath:
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• select Above if you want the current selection on top, or
• select Below if you want the current selection below the next selection.

4. Choose the second selection set.
The Apply option is enabled now.

5. Choose Apply for masking the hidden lines.
6. If you do not agree with the result, you can Undo the masking and re-do steps 2 to 4.

Boolean Operations

The Perform boolean operations on geometry tool  combines two selection sets with each other and 
creates a new closed geometry from them. You can do the following operations:

• Connect two areas (Union).

• Subtract one area from another. 
The result depends on the succession of selection (Difference).

• Subtract one area from another but keeping the subtracted area (Difference (keep)).

• Intersect two areas (Intersection).

After a boolean operation both selection sets are replaced by the result. This tool works on 
closed geometry, crosshatching and stippling only.

Please note: 2D shapes that take part in boolean operations are post-processed as follows:
• shapes that are still valid are left intact
• shapes that have become invalid are smashed
• shapes that have become empty (or with only centerlines) are deleted

To apply boolean operations on closed geometries:

1. Select the Perform boolean operations on geometry tool .
Now the following popup menu is available whose entries are explained in the list on 
top of this page.

Figure 598 Popup Boolean Operations
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2. Choose the first selection set.
3. Choose a boolean operation from the popup menu.
4. Choose the second selection set.

Inside the popup menu the entry Apply is enabled now.
5. Choose Apply for executing the operation.
6. If you do not agree with the result, you can Undo the operation.

The type of line used for the result is determined by following rules:

• Using the operations Union, Intersection and Difference the resulting elements contain the 
line types of the first selection only.

• Using the operation Difference (keep) the resulting elements contain the line types of the 
first and the second selection.

The following examples give the results for the union, difference and intersection operations. 
The outermost left picture always gives the input for the results given on the right.

Figure 599 Example Boolean Operation Union

For boolean operations which subtract the succession of selection is important. The following 
figures show the results for selecting first the horizontal bar (on the left) and selecting first the 
vertical bar (on the right).

Figure 600 Example Boolean Operation Difference
© CAD Schroer GmbH                             591



MEDUSA4 Drafting
Area Fills
Figure 601 Example Boolean Operation Difference (keep)

Figure 602 Example Boolean Operation Intersection
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This chapter describes the use of symbols and explains how you can change its properties.

• Introduction to Symbols ......................................................... 594

• Overview of Symbol Tools...................................................... 595

• Named Symbols..................................................................... 596

• Temporary Symbols ............................................................... 602

• Symbol Properties.................................................................. 604

• Transforming Symbols ........................................................... 605

• Symbol Size ........................................................................... 610

• Moving a Symbol’s Datum ..................................................... 611

• Reversing Symbol Property Changes.................................... 612
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Introduction to Symbols

A symbol consists of elements from a sheet that have been stored in a symbol file. This file can 
then be used to load the stored elements onto other sheets, or onto the same sheet. A symbol 
may be a single element or a number of elements.

Symbols are a powerful instrument of quickly creating a new drawing where a high degree of 
repetition is involved, or where extensive use is made of standard symbols such as in electrical 
schematics and logic diagrams. The availability of standard symbol libraries considerably 
reduces the work required to create such a drawing and also ensures a uniform drawing stan-
dard.

Please note: Default settings for symbols are made in the Defaults Settings dialog which you can 
open via File > Default Settings > Drawing Elements > Symbol. 
For details see ”Default Settings”, ”Symbol” on page 271.

Temporary and Named Symbols

Symbols are distinguished according to their use:

• Symbols that you require only for a short time are called temporary symbols.
Temporary symbols are stored on the hard disk in the path defined by the environment 
variable HOMEPATH. Names of temporary symbols are created automatically and 
cannot be defined by the user.

• Symbols that you want to keep for a longer time are called named symbols.
Named symbols can be stored at any location of the hard disk under any name.

Symbol Libraries

Symbol libraries are directories where regularly-used symbols are stored. There can be up to 30 
symbol libraries on your system. You can load a symbol onto your sheet from a symbol library. 
You may also be able to create symbols and store them in a library assuming that you have 
write permission to the directory.

For symbol libraries available on your system consult your System Administrator.
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Overview of Symbol Tools

The symbol tools described in this chapter are shown in Figure 603. 

Figure 603 The Symbol Tools
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Named Symbols 

In this section you find following sub-sections:

• ”Loading Named Symbols”

• “Saving Named Symbols” on page 599

• “Editing Named Symbols” on page 600

• “Adding Group Name to a Symbol” on page 601

Loading Named Symbols

While loading a named symbol you can change its properties. Therefore first the popup menu is 
described. After this the “Symbol Manager” on page 598 is introduced before explaining how to 
load a symbol (“Perform Loading” on page 599).

Popup Menu

Having chosen the Load Named Symbol tool , you can open the following popup menu by click-
ing the RMB.

Figure 604 Loaded Symbol Popup Menu

The popup menu provides the following entries:
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New Symbol

The symbol browser is closed after loading a symbol if the Hide Symbol Browser after loading 

a symbol option is activated in the Default Settings dialog (see page 271). Choosing the New 

Symbol option the symbol browser is opened again.
Rotate by 90

rotates the current symbol by 90 degrees. For rotation of 180 and 270 degrees use this 
entry twice or three times.

Mirror Vertical, Mirror Horizontal

is used for mirroring the symbol at the Y (Mirror Vertical) or X axis (Mirror Horizontal).
Move Datum by Probing

is used for changing the datum point of the symbol temporary. If you choose the sym-
bol again the original datum point is used again. An example for changing the datum 
point is given in ”Moving a Symbol’s Datum”, ”Specifying the New Datum by Probing” 
on page 611.

Temporary Properties

opens the Load symbol Temporary Properties dialog (see “Symbol Properties” on page 604).
Revert

reverses all transformation you did on the loaded symbol (see “Reversing Symbol 
Property Changes” on page 612).

Sheet Level, Current Level 

defines that the symbol is placed on sheet level. If switched on, the entry changes to 
Current Level in order to use the level saved with the symbol.

Use DLL translation

If this option is chosen elements are changed according to the settings in the file 
ddltrans.dat.

Undo

is used for canceling the last action. You can undo several actions. Its number 
depends on the number of actions stored to the history stack.

Dyn. aligning on, Dyn. aligning off

is used for aligning the symbol to an element on the sheet.
Dyn. scaling on, Dyn. scaling off

is used for scaling the symbol to the current scale on the sheet. If you switch off scaling 
with Dyn. scaling off, then the scale stored with the symbol is used.

Create Shortcut

When you have loaded a symbol and choose this option a creation tool of this symbol 
is placed in the Tools > Shortcut area of the Symbol Dashboard. Now you can easily use the 
tool from the Shortcuts to create a new symbol of this type.

Exit Tool

quits the tool.
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Figure 605 Symbol Manager 

Symbol libraries
In the upper part of the dialog by default the symbol libraries are shown which are 
delivered.The symbol libraries which are displayed can be configured. Please read the 
Administration Guide, chapter Administration section Setting up the Symbol Manager.

Add Directory 
is used for adding a further symbol library. Having pressed this button a Directory Selector 
window will be opened. Having chosen a directory, it will be added at the end of the list 

Symbol libraries

Symbol files

Slider for changing size
of the Preview thumbnails 
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of symbol libraries. This directory can be deleted again by choosing Remove from the 
popup menu.

Choose File 
is used for loading symbols which are not available in one of the symbol libraries. Hav-
ing pressed this button a file browser for selecting a symbol file will be opened. Having 
loaded a file, the directory will be added as symbol library. This directory can be 
deleted again by choosing Remove from the popup menu.

Symbol files
This area shows the symbol files of the selected symbol library. By default the Preview of 
each symbol file is shown. If you select Details, the file name, the datum of the last 
change and the file size are shown for each symbol.

Perform Loading

Procedure for loading a named symbol:

1. Choose the Load Named Symbol tool .
The symbol manager is opened, see Figure 605, “Symbol Manager” on page 598.

2. Select a symbol file. You have two possibilities:
• Select a symbol library and then select a symbol file.
• If the symbol file to be loaded, is not in one of the shown symbol libraries, choose 

Open, to open the file in a file browser. Afterwards this directory will be added to the 
symbol libraries.

The symbol will be loaded and attached to the cross hair of the mouse cursor.
The Symbol-Manager will be closed.

3. If you want to transform the symbol (e.g. rotating or mirroring), use the popup menu.
For details see “Popup Menu” on page 596.

4. Click on a point in the sheet to place the symbol.
The symbol is still attached to the mouse cursor and is available for further place-
ments. If you want to place another symbol, you have to choose the Load Named Symbol 
tool  again.

Saving Named Symbols

While saving named symbols a popup menu is available which is described first before explain-
ing how to save a symbol (“Perform Saving” on page 600).

Popup Menu

Having chosen the Save Named Symbol tool  clicking right provides the following popup menu:
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Figure 606 Saving Named Symbol Popup Menu

The popup menu provides the following entries:
Sheet Level

is used for ignoring the level information of the symbol while saving. If this option is 
chosen, it changes to Current Level in order to reset storing the information of the current 
level with the symbol again.

Exit Tool

quits the tool. 

Perform Saving

1. Select the elements you want to save as a symbol.
2. Select the Save Named Symbol tool . 

A file browser opens.
3. Choose the path in which the symbol is to be saved.
4. Enter the file name for the symbol.
5. Click the Save button.

The file browser will be closed.
6. If you want to save the symbol elements on sheet level, choose Sheet Level from the 

popup menu.
7. To finish saving, define the datum point for the symbol by probing on the sheet.

Please note: The symbol file is not saved until you probe a datum point.

Editing Named Symbols

Certain symbols loaded from the Symbol Manager and placed on the sheet will be created as a 
protected group.

When you select the symbol on your sheet the complete symbol is highlighted.
The Structure tree in the catalog, tree and browser area displays the symbol as a named group. 
The single elements (line segments) of this group are not selectable neither on the sheet nor in 
the Structure tree. For details on the Structure tree see ”Groups & Sheet Structure”, ”The Structure 
Tree” on page 183.

The Symbol Dashboard is displayed. It contains a closed lock  in the General Properties area.
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Figure 607 Symbol Dashboard

The closed lock indicates that only the complete group can be edited.

If you click the lock , the button changes to an opened lock . Now you are able to select 
and edit a single element of the symbol. The Structure tree changes accordingly displaying the 
components of the named group which you also can select in the Structure tree.

When you click the open lock again the button changes into the closed lock and the group is 
selectable completely only.

Adding Group Name to a Symbol

Users can add a name to a symbol, i.e. they can define a group name for a symbol. Just type a 
name in the Name field on the Dashboard and press the Enter key.

Figure 608 Group Name of a Symbol in the Dashboard and the Structure Tree

The group name is displayed in the Structure tree. When you change the name in the Dashbaord, 
the name is updated in the Structure tree.

If no name is entered in the Name field on the Dashboard, then the file name of the symbol is dis-
played as group name in the Structure tree.
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Temporary Symbols

Temporary symbols are stored on the hard disk in the path defined by the environment variable 
HOMEPATH. Names of temporary symbols are created automatically and cannot be defined by 
the user as it is for named symbols (see “Named Symbols” on page 596). 

Saving a Temporary Symbol

Popup Menu

While saving elements as temporary symbol clicking right provides the following popup menu:

Figure 609 Saving Temporary Symbol Popup Menu

The popup menu provides the following entries:
Sheet Level

is used for ignoring the level information of the symbol while saving. If this option is 
chosen it changes to Current Level in order to reset storing the information of the current 
level with the symbol again.

Exit Tool

quits the tool. 

Perform Saving

You can save up to 99 temporary symbols. To save a temporary symbol:

1. Select the elements you want to save as a symbol.
2. Select a Save temporary symbol tool from the toolset. 

Figure 610 Save Temporary Symbol Toolset

The Save temporary symbol tools save the symbol under the corresponding temporary sym-
bol number, e.g. 3.sym.
The Save temporary symbol 4 to 99 tool displays the Symbols dialog.
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Figure 611 Symbols Dialog

Use this dialog to enter the number with which to save the symbol.
3. Probe the sheet to define the datum point for the symbol.

The temporary symbol is stored.

Loading a Temporary Symbol 

1. Select one of the Load temporary symbol tools.

Figure 612 Load Temporary Symbol Toolset

The Load temporary symbol tools load the symbol that is saved under the corresponding 
number.
The tools numbered 1 through 3 load immediately. 
The Load temporary symbol 4 to 99 tool first displays the Symbols dialog shown in Figure 611, 
“Symbols Dialog” on page 603 where you enter the number of the symbol you want to 
load.

2. If you want to transform the symbol use the popup menu (see ”Named Symbols”, 
”Popup Menu” on page 596).

3. Probe the sheet to position the symbol.
The symbol remains attached to the cursor for further placement.
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Once you have loaded a symbol, you can change its properties before you place it on the sheet. 
Select Temporary Properties... from the popup menu to open the Load Symbol Temporary Properties dialog:

Figure 613 Load Symbol Temporary Properties Dialog

The Load Symbol Temporary Properties dialog allows you to: 

• Transform a symbol by rotating, shearing, magnifying or mirroring, see “Transforming 
Symbols” on page 605.

• Specify whether the symbol is loaded scaled using the current sheet scale or unscaled, 
see “Symbol Size” on page 610.

• Move a symbol’s datum, see “Moving a Symbol’s Datum” on page 611.

• Specify the layer on which symbol’s elements are loaded by entering the layer offset 
(incrementally from the symbol element’s existing layer(s)) into the Layer Offset field. For 
background information on layers refer to “Layers” on page 143.

Some of the more commonly changed symbol properties are also accessible directly from the 
popup menu itself, for example Rotate by 90 degrees and Move Datum by Probing.

Changes that you make to the properties of a symbol apply only until you select another tool. If 
you load the symbol again, it is loaded with the original properties.

Please note: While the Load Symbol Temporary Properties dialog is displayed, you can undo any 
changes to the symbol on the cursor by clicking the Untransform option. This undoes 
the transformation but leaves the values defining the transformation displayed in 
the dialog.
604 © CAD Schroer GmbH



MEDUSA4 Drafting
Transforming Symbols
Transforming Symbols

You can transform a symbol, after you have loaded it but before you place it on the sheet. You 
do this using the Load Symbol Temporary Properties dialog (see Figure 613, “Load Symbol Temporary 
Properties Dialog” on page 604) or the transformation options on the popup menu (see 
Figure 604, “Loaded Symbol Popup Menu” on page 596).

Compared with the popup menu and transformation tools, the dialog Load Symbol Temporary Proper-

ties has the advantage that you can carry out several transformations at once. The Load Symbol 

Temporary Properties dialog also gives you greater control on transforming a symbol. For example, 
it allows you to rotate a symbol by a specified angle, whereas the popup menu only allows to 
rotate a symbol in increments of 90 degrees.

You can also transform a symbol after you have placed it on the sheet using the transformation 
tools which are explained in “Transformation” on page 319. 

This chapter gives you following information:

• ”Modifying a Symbol that Contains Text”

• “Rotating a Symbol” on page 606

• “Magnifying a Symbol” on page 607

• “Mirroring a Symbol” on page 607

• “Shearing a Symbol” on page 608

• “Aligning Symbols Dynamically” on page 609

Modifying a Symbol that Contains Text

If you are rotating, shearing, mirroring, or magnifying a symbol that contains text, be aware that 
the text is changed too. You can control the effect that property changes have on text using the 
text field on the Load Symbol Temporary Properties dialog which is on the right hand side of the Rotate 
field. The pulldown menu provides the following options which specify what will happen to the 
associated text when transforming the symbol:

• Legible changes both the orientation and justification of the text but leaves it readable 
when viewed from bottom and right of the drawing.

• Fixed changes the position of the text if necessary and retains the orientation, justifica-
tion and original scale of the text.

• Rigid retains the original justification and orientation of the text.

• Legible changes both the orientation and justification of the text but leaves it readable 
when viewed from bottom and right of the drawing.

The following figure shows an example of rotating a symbol through 90 degree increments with 
each of different settings.
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Figure 614 Example of Rotating Symbol with Text

Rotating a Symbol

You can rotate a symbol to any angle that you require. The symbol is rotated about its datum 
point. To rotate a symbol using the Load Symbol Temporary properties dialog:

1. Load the symbol that you require.
2. Select Temporary Properties... from the popup menu.

The Load Symbol Temporary Properties dialog is displayed.
3. Enter the angle into the Rotate field.
4. Specify whether the text in the symbol is to be Legible, Fixed, or Rigid.
5. Click OK. 
6. Click the LMB to place the symbol on the sheet.
7. Use the popup menu to exit the tool or place another copy of the symbol on the sheet.

To rotate a symbol using the popup menu:

1. Load the symbol that you require.
2. Select Rotate by 90 from the popup menu.
3. Click left to place the symbol on the sheet.
4. Use the popup menu to exit the tool or place another copy of the symbol on the sheet.

Original

Legible Fixed Rigid

x

x x

x x x

x x

x x

x x

x
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Magnifying a Symbol

You can magnify a symbol along its X-axis and Y-axis. To do this:

1. Load the symbol that you require.
2. Select Temporary Properties... from the popup menu.

The Load Symbol Temporary Properties dialog is displayed.
3. Enter the magnification factors that you want to apply to the symbol into the Magnify X 

field, Magnify Y field, or both fields.
4. Specify whether the text in the symbol is to be Legible, Fixed, or Rigid.
5. Click OK.
6. Click the LMB to place the symbol on the sheet.
7. Use the popup menu to exit the tool or place another copy of the symbol on the sheet.

Mirroring a Symbol

You can mirror a symbol horizontally and vertically. To mirror a symbol:

1. Load the symbol that you require.
2. Select Temporary Properties... from the popup menu.

The Load Symbol Temporary Properties dialog is displayed.
3. Click on either or both of the Mirror horizontal and Mirror vertical options.
4. Specify whether the text in the symbol is to be Legible, Fixed, or Rigid.
5. Click OK.
6. Click the LMB to place the symbol on the sheet.
7. Use the popup menu to exit the tool or place another copy of the symbol on the sheet.

To mirror a symbol using the popup menu:

1. Load the symbol that you require
2. Select Mirror Horizontal or Mirror Vertical from the popup menu.
3. Click the LMB to place the symbol on the sheet.
4. Use the popup menu to exit the tool or place another copy of the symbol on the sheet.
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You can shear a symbol to the left or to the right. To do this:

1. Load the symbol that you require.
2. Select Temporary Properties... from the popup menu.

The Load Symbol Temporary Properties dialog is displayed.
3. Choose Angular or Ratio from the pulldown menu on the right of the shear fields to spec-

ify the shear factor.
4. Enter the shear factor either by:

• Typing the ratio in the Ratio field
• Typing the angle in the Angle field
To shear the symbol to the left enter a negative value for the shear factor.

5. Specify whether the text in the symbol is to be Legible, Fixed, or Rigid.
6. Click OK.
7. Click the LMB to place the symbol on the sheet.
8. Use the popup menu to exit the tool or place another copy of the symbol on the sheet.
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Aligning Symbols Dynamically

You can dynamically align loaded symbols with other geometry on the sheet before placing the 
symbols on the sheet.

Figure 615 Dynamically Aligning Symbols

To do this:

1. Load the symbol that you require
2. Select Dyn. Alignment On from the popup menu.

As you move your cursor around the sheet the symbol dynamically alters its orientation 
to align perpendicular to any adjacent geometry.

3. Click the LMB to place the symbol on the sheet.
4. Use the popup menu to exit the tool or place another copy of the symbol on the sheet.

Please note: Once the function is activated, you can align the symbol until it is in the desired 
position. After deactivating the function the orientation from last alignment 
remains. You can place the symbol with the same orientation in another location. 
Use Revert from the popup menu for getting back the orientation input conditions.
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By default, a symbol is loaded onto a sheet the same size as it was originally created. If a sym-
bol is created on a sheet with a scale of 1:10, then it will be drawn ten times larger when loaded 
onto a sheet with a scale of 1:1. While this result is desirable when the symbol is a scale draw-
ing of a real object, it may not be desirable when you are using schematic symbols, which 
should normally be drawn at the same size, regardless of the sheet scale. Further information 
about sheet scale are given in ”Dashboard”, ”Sheet Scale” on page 70.

Controlling the Effect of the Sheet Scale on Symbols

You can control the effect of the sheet scale on symbols by clicking the Unscale button in the 
Load Symbol Temporary Properties dialog. When you do this, the sheet scale is ignored and the sym-
bol is loaded at the same size that it was originally created. For example, a symbol created and 
saved on a sheet with a scale of 1:10 and then loaded onto a sheet with a scale of 1:100 is 
loaded at the same size that it was created originally.

Dynamic Scaling

This function is relevant in connection with scaled views (see ”View - Misc Tab”, ”Scaled Views” 
on page 732).

If you select Dyn. scaling on from the popup menu the loaded symbol is automatically and dynami-
cally sized according to the scale of the view. It does not have any impact when loading the 
symbol into a drawing without scaled views.

To turn this function off, select Dyn. scaling off from the popup menu.
610 © CAD Schroer GmbH



MEDUSA4 Drafting
Moving a Symbol’s Datum
Moving a Symbol’s Datum

When you create a symbol, you specify the datum that will be used to position the symbol when 
you load the symbol onto a sheet. You can change the datum for a symbol after you have 
loaded it but before you place it on the sheet.

Please note: For both methods shown below you can return a symbol’s datum back to its orig-
inal position. For details see “Reversing Symbol Property Changes” on page 612.

Specifying the Coordinates of the New Datum

1. Load the symbol that you require.
2. Choose Temporary Properties from the popup menu.
3. Click the Move datum button.
4. Specify the new position for the datum by entering values into the fields below the 

Move datum button according to the following definitions:
• Enter Cartesian coordinates into the By fields.
• Enter grid units into the By grid fields.
• Enter polar coordinates into the Polar fields.

5. Click Apply or OK.
The symbol at the cursor uses the new datum position.

Specifying the New Datum by Probing

1. Load a symbol.
2. Choose Move Datum by Probing from the popup menu.
3. Temporarily place the symbol on the sheet by clicking left into the graphics area.
4. Probe the position where you want to move the datum.

The symbol at the cursor uses the new datum position.
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Reversing Symbol Property Changes

Changed symbol properties can be reversed in several ways:

• Reverse all property changes on the currently loaded symbol and the properties dia-
log, see ”Reversing all Property Changes”

• Reverse all property changes on the currently loaded symbol but keep changed prop-
erty values in the properties dialog, see ”Untransforming a Symbol”

• Reverse a changed symbol datum back to its original position and keep other changed 
values in the properties dialog, see ”Moving a Symbol’s Datum Back to its Original 
Position”

Reversing all Property Changes

If you made changes to the symbol properties, and then decide that you want to return the sym-
bol to its original state, select Revert from the popup menu. All changes are undone and the orig-
inal symbol properties are reinstated.

The Standard button in the Load Symbol Temporary Properties dialog does the same.

Untransforming a Symbol

Before you place a symbol on the sheet, you can undo property changes that you have applied 
using the Load Symbol Temporary Properties dialog by activating the check mark Untransform.

The advantage of using Untransform compared with the Defaults button is that the values defining 
the transformation remain in the dialog. So you can transform the next symbol before you place 
it on the sheet by switching off the check mark Untransform previously.

Moving a Symbol’s Datum Back to its Original Position

If you have changed the datum of the loaded symbol, you can move it back to its original posi-
tion before you place the symbol on the sheet. Other property changes are not affected by this 
operation.

To move a symbol’s datum back to its original position:

1. Select Temporary Properties from the popup menu.
The Load Symbol Temporary Properties dialog is displayed.
The check mark Move Datum is active because it was set when you moved the datum 
either in the Load Symbol Temporary Properties dialog or with the popup menu item Move Datum 

by Probing.
2. Click left on the check mark Move Datum to switch it off. 
3. Click left on the Apply button.

The symbol’s datum is reverted to its original position.
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The chapter “Groups & Sheet Structure” on page 179 provides extensive information about 
function and importance of groups in MEDUSA4.

This chapter introduces you to the tools which are available on the Home tab of the ribbon in tool 
group Groups.

• Tools to Create Groups .......................................................... 614

• Creating Groups..................................................................... 615

• Exit Groups ............................................................................ 618
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Tools to Create Groups

The tools for creating groups are provided on the Ribbon > Home tab > tool group Groups.

Please note: By default the tool group is located at the far right of the ribbon. If the Groups tool 
group is not visible use the small blue triangle to move the ribbon far right.

Figure 616 Home Tab - Tool Group Groups

Overview of Functions

The groups tools provide the following functions:

Table 11    Functions of the Groups Tools

Button Function

Group Selected
Creates a Named Group containing the selected geometry. The tool is 
enabled only if elements on the sheet are selected.
(see “Creating a Group Containing Existing Elements” on page 615)

Creates a Named Group
(see “Creating an Empty Group” on page 615)

Creates a Named Level 2 Group
creates an empty group on the hierarchy level 2

Creates a Named Level 1 Group
creates an empty group on the hierarchy level 1
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Basically there are two different ways to create groups:

• You create a group of already existing elements.

• You first create an empty group and then add new elements as part of this group.

Please note: To quickly get an overview of the group structure display the structure tree.
(See ”Groups & Sheet Structure”, “The Structure Tree” on page 183)

Creating a Group Containing Existing Elements

1. Select the elements in the drawing which should belong to the group.
2. Select the Creates a Named Group containing the selected geometry tool .

A new group is created. The Group Dashboard is displayed at the left hand side of the user 
interface showing the General Properties of a group.

Figure 617 Group-Dashboard

3. Type a group name into the relevant text field.
In the structure tree you can see that the elements were moved into the new group.
If you now create new elements, they are created inside the new group.

Creating an Empty Group

1. Ensure that nothing is selected.
If there is anything selected on the sheet, choose Deselect All from the popup menu.

2. Click on the Creates a Named Group tool .
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A new group is created. The Group Dashboard is displayed at the left hand side of the user 
interface showing the General Properties of a group.

3. Type a group name into the relevant text field.
Any elements that you now create are automatically placed in this group. If you have 
the structure tree visible you see that a new group is added to the structure.
(See ”Groups & Sheet Structure”, “Interacting with the Structure Tree” on page 187)

Creating a Nested Group

A nested group is a group which is created inside another group.

1. In the structure tree, select the name of the group in which you want to create the new 
group.
The group is displayed highlighted in the structure tree.

2. Select the Creates a Named Group tool .
A new group is created. The Dashboard displays the properties of the group.

3. Type a group name into the relevant text field.
A new group is created inside the selected group.
If you now draw elements, they are created inside the new group.

Please note: The deepest group level is limited to 32. If you try to save the sheet and the limit 
is exceeded, a warning appears. Then you first have to correct the group structure 
before you can save the sheet.

Creating a Locked Group

If you created a group of several elements, you can usually select the individual elements in 
both the drawing and the structure tree. This means, the group is not locked. This is indicated in 
the Group Dashboard by a symbol of an opened lock.
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Figure 618 Group Dashboard with Lock Symbol of an Unlocked Group

Figure 619 Structure Tree - Selectable Elements in an Unlocked Group

When you click on the lock in the Dashboard, the group is locked. The symbol changes to a 
locked lock.
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Figure 620 Group Dashboard with Lock Symbol of a locked Group

Single elements of the group are not selectable neither on the drawing nor in the structure tree. 
A closed group can only be selected as a whole and is therefore protected.

Figure 621 Structure Tree - Closed Group, Single Elements are not selectable

Click on the lock button again to unlock the group.

Exit Groups

When you have finished creating the elements in a group, press the Go to Sheet Level  button on 
the In Graphics Tool Bar to return to sheet level.

The Sheet Dashboard indicates that you are on sheet level now.

Please note: All tools provided on the ribbon > Home tab > tool group Groups are also available 
on the Group Dashboard.
618 © CAD Schroer GmbH



MEDUSA4 Drafting
DIMENSIONING - ANNOTATION TAB
• Tools....................................................................................... 620

• Dimensioning the Length of an Arc........................................ 622

• Arc Dimension Properties ...................................................... 623

• Creating Symmetrical Dimensions......................................... 625

• Creating Half Symmetrical Dimensions ................................. 626

• Fit Tables................................................................................ 627

• Handling Dimension Parts as Texts or Lines ......................... 631

• Creating Isometric Dimensions .............................................. 632

• Creating Datum Offset Dimensions ....................................... 634

• Arranging Coordinate Dimensions Text ................................. 636

• Exploding Dimensions ........................................................... 637

• Gaps in Overlapping Dimension Witness Lines..................... 638
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Tools 

In the Annotation tab the same tools can be found which were already explained in the Home tab, 
see “Dimensioning - Home Tab” on page 413. Therefore in this chapter only descriptions on 
additional tools are given, for example, “Dimensioning the Length of an Arc” on page 622.

Figure 622 Tools for dimensioning in the Annotation tab

Symmetrical and half symmetrical dimensions are provided in a separate tool set. The tools are 
explained in “Creating Symmetrical Dimensions” on page 625 and “Creating Half Symmetrical 
Dimensions” on page 626.

Figure 623 Tools for symmetrical and half-symmetrical dimensions

The Creates a table of fits from whole sheet or selection tool  is explained in “Fit Tables” on page 627.

For editing dimensions a tool set exists which allows to edit dimension parts as simple lines or 
texts. Explanations on the tools are in “Handling Dimension Parts as Texts or Lines” on 
page 631.

Figure 624 Tools for editing dimension parts as simple texts or lines

The Arrange coordinate dimensions text tool  is explained in “Arranging Coordinate Dimensions 
Text” on page 636.

The Explode dimensions tool  is explained in “Exploding Dimensions” on page 637

The Dimensions tool group also contains a tool set for gaps in overlapping leader or witness lines 
explained in “Gaps in Overlapping Dimension Witness Lines” on page 638.
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Figure 625 Tools for Gaps in Overlapping Leader/Witness Lines

If you click the RMB on the tool group name Dimensions, all available tools for this group are 
shown, also those which are hidden by default. Details on the tool Dimension offset from a datum are 
given on page 634.

Figure 626 All available tools for dimensions in the Annotation tab
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Dimensioning the Length of an Arc

1. Choose the Dimension the length of the arc tool .
2. Probe the position on the arc where you want the dimension line to start.
3. Probe the position on the arc where you want the dimension line to end.
4. Click on the arc between the previous two probes to indicate the section of the arc you 

wish to measure the length of. On a circle this identifies the major or the minor arc 
length.
The dimension appears on the cursor.

5. Position the dimension on the sheet by moving the cursor to the desired position and 
then click left.

While dimensioning clicking the RMB opens a popup menu. The entry Properties opens the prop-
erties dialog described in “Arc Dimension Properties” on page 623.
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Arc Dimension Properties

The arc dimension properties are similar to linear dimension properties. The difference is the 
additional Arc Length Indicator in the Standard section of the Style and Format tab explained in “Stan-
dard” on page 624. Details on the other parameters are described in ”Dimensioning - Home 
Tab”, ”Linear Dimension Properties” on page 427.

Figure 627 Arc Dimension Properties: Style and Format Tab   
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Figure 628 Arc Dimension Properties: Text and Arrows Tab   

Standard

Figure 629 Standard

The options in the area Standard work in the same way as given in ”Dimensioning - Home Tab”, 
”Linear Dimension Properties” on page 427. The parameter Arc Length Indicator is additionally 
available for indicating that a dimension is an arc length. Two methods are supported, a long arc 
is drawn above the dimension value or a small arc is drawn just in front of it (default).
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Creating Symmetrical Dimensions

MEDUSA4 provides a tool to create dimensions which are symmetrical to a specified point.

Figure 630 Example of a Symmetrical Dimension

Do the following steps for creating a symmetrical dimension:

1. Choose the Symmetrical dimension tool .
2. Click left on a point which is in the middle of the dimension you want to create (e.g. on 

the center line in the figure above).
The dimension is displayed attached to the mouse cursor. As you move the mouse, the 
dimension extends symmetrically to both sides of the specified point.

3. If you want the dimension to be orientated in a certain direction, press the RMB to open 
the popup menu and choose the appropriate entry.
In the figure above Horizontal was chosen for each dimension. 

4. Move the cursor to the point where you want to end the dimension and click left.
Click middle if you want to dimension more than one point.

5. Move the cursor to the point where you wish to place the dimension text and click left.
The dimension is placed on the sheet.
© CAD Schroer GmbH                             625



MEDUSA4 Drafting
Dimensioning - Annotation Tab
Creating Half Symmetrical Dimensions

MEDUSA4 provides a tool to create a half symmetrical dimension. The text denotes the whole 
symmetrical geometry even though only one half is designed.

Figure 631 Example of a Half Symmetrical Dimension

Do the following steps for creating half symmetrical dimensions:

1. Choose the Half a symmetrical dimension tool .
2. Click the LMB on a point which is in the middle of the dimension you want to create 

(e.g. on the center line in the figure above).
The dimension is displayed attached to the mouse cursor. As you move the mouse, the 
dimension extends half symmetrically to one side of the specified point.

3. If you want the dimension to be orientated in a certain direction, press the RMB to open 
the popup menu and choose the appropriate entry.
In the figure above Vertical was chosen for each dimension.

4. Move the cursor to the point where you want to end the dimension and click the LMB.
Click the MMB if you want to dimension more than one point.

5. Move the cursor to the point where you wish to place the dimension text and click the 
LMB.
The dimension is placed on the sheet.
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Fit Tables

Please note: The function Fit Tables is only available with the advanced version of MEDUSA4, 
which can be started with the option -advanced. Details on starting MEDUSA4 
are described in “Starting MEDUSA4” on page 23.

This section shows you how to create and edit tolerance (fit) tables.

Creating Fit Tables

In MEDUSA4 fit tables are created automatically. You can decide, whether all or only selected 
fits on the sheet should be transferred into the table.

1. If you only want to create the fit table for certain dimensions, first select these dimen-
sions on the sheet.

2. Choose the Creates a table of fits from whole sheet or selection tool .
The Fit table properties dialog is opened.

Figure 632 Dialog Fit Table Properties

The following table properties can be defined:
• General

Here you can choose whether the table should be created with Column title on top or 
Column title at the bottom.
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• Format

Here you can define the content of the table. Two table formats are available:
Format 1 provides the columns Fit size, Max. extent and Min. extent.
Format 2 provides the columns Nominal width, ISO, under-allowance and over- allowance.

3. Choose the button OK to apply the table properties.
The Table Creation dialog opens.

Figure 633 Table Creation Dialog

The tab Table Data shows a table with the selected format. Either all the fits on the sheet 
or only the selected dimensions are shown. Now you can define further properties of 
the table. Details are described in ”Tables”, “Tab Properties” on page 556.

4. Choose OK or Apply.
The table is displayed attached to the crosshair of the mouse cursor.

5. Click left on the sheet to place the table.
If the table is placed the tool is exited automatically.

Editing Fit Tables

You can edit the table contents and the properties of the table.

1. First select one or several fit tables.
2. Inside the popup menu choose the entry Properties or Edit.

The Table Creation dialog opens. 
Now you can change the contents of the table on the tab Table Data or the Properties (see 
”Tables”, “Tab Properties” on page 556).

Please note: A double click on a tolerance table also opens the Table Creation dialog.
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Example

The following figure shows examples of tables with different properties.

Figure 634 Example for Fit Tables with Different Properties

Distributed Example Fits XML File

With the release of MEDUSA4 an example file is delivered, which contains some fit definitions. 
The file fits.xml can be found in <installation directory>\med2d\m2d\src\.

Please note: Consider that we cannot guarantee correctness and completeness for any defini-
tion in <installation directory>\med2d\m2d\src\fits.xml. The user has to create its 
own file to ensure correct and complete fit definitions.
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Because the creation of this file is a little bit exhausting a Bacis2 conversion program is avail-
able, which generates a new fits.xml from, for example, an old MEDAS-X file.

The Bacis2 command is:
fittab_import_fit2xml (fileinput, fileoutput, format)

where:
fileinput  is the path to the source file
fileoutput is the path to the target file
format     is either !ascii or !csv

If the source file is processed, empty and comment lines (lines starting with two dashes --) are 
ignored.

For the import of a MEDAS file the command can look like this:
fittab_import_fit2xml ("c:\tmp\mytol.dat", "c:\tmp\fits.xml", !ascii)

How to start MEDUSA4 with a console in which you can type in the Bacis2 command is given in 
“Starting MEDUSA4” on page 23.
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Handling Dimension Parts as Texts or Lines

Any part of a dimension can be edited as a simple line or text. For this the following quick selec-
tion tools are provided in the toolset on the ribbon. 

Figure 635 Quick Selection Tools for Dimensions

From top to bottom the tools select dimension texts, leader lines or dimension lines. For each 
tool only one element can be selected at a time and a popup menu is available, as explained in 
”Dimensioning - Home Tab”, ”Editing Dimensions”, ”Popup Menu 3” on page 447.

Please note: Using these tools allows changing line points and/or text values which can result 
in damaged dimensions.
If you want to move a leader line or the position of the dimension text, use the 
methods explained in ”Dimensioning - Home Tab”, ”Editing Dimensions”, ”Repo-
sitioning, Adding or Deleting Dimension Parts” on page 444.
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Creating Isometric Dimensions

Dialog

The Creates isometric dimensioning tool  opens the Isometric Dimension dialog.

Figure 636 Axonometric Dimension Dialog

The dialog contains the following entries.
Isometric

sets the angles for the dimension to the standard isometric defaults.
All isometric default dimensions are displayed in the picture on top of the dialog. Each 
shown dimension is a button. As you press one of them, the appropriate dimension 
can be placed on the sheet (see “Procedure” on page 633).

Base angle

activates the base angle input field. The default entry is 45 degrees but you can also 
enter a different value. The orientation of the dimension complies with the entered 
angle.

Define angles

activates the angle input fields for entering your own angles.
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Isometric Scaling 

You have two possibilities:

•  The dimension text shows the real length of the line according to the sheet 
scale.

•  The dimension text shows the projected length of the line according to a 3D 
point of view.

Procedure

Do the following steps for creating a isometric dimension:

1. Choose the Creates isometric dimensioning tool .
The Axonometric Dimension dialog is displayed, see “Dialog” on page 632.

2. You can use the isometric default angles or enter your own angle values:
• If you want to use the isometric default angles, set the check mark for the Isometric 

option.
• If you want to specify your own angles for the dimension, activate either the Base angle 

or the Define angles option.
3. Click the LMB on top of the dialog on the standard isometric button that you require.
4. If you want the dimension text to show the projected length instead of the real length of 

the line, activate the button  in Isometric Scaling.
5. Move the cursor to the start point for the dimension and click the LMB.
6. Move the cursor to the end point for the dimension and click the LMB, or click the MMB 

if you wish to dimension more than one point.
7. Place the dimension text on the sheet by moving the cursor to the requested position 

and click the LMB.
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Creating Datum Offset Dimensions

You can dimension an element when only half of the element is drawn on the sheet, or when the 
location of an element is important with regard to another point which is not on the sheet. You 
do this by using the tools creating a datum offset dimension.

Please note: By default these tools are not visible. To display the tools on the ribbon click the 
RMB on the Dimensions tool group label and set a check mark in the relevant box of 
the popup menu.
(see also Figure 626, “All available tools for dimensions in the Annotation tab” on 
page 621)

Figure 637 The Datum Offset Dimension Creation Tools

The tools are:

•  Dimension offset from a datum creates the dimension with regard to the datum point.

•  Creates a datum named group for an offset datum dimension creates a group with a datum prim 
and text to define the datum position. It is important that you know the exact location of 
the datum prim on the sheet as the start of the dimension line will be based on this 
location.

Figure 638 Example of Offset Dimensioning
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Do the following steps for creating a datum offset dimension:

1. Choose the Creates a datum named group for an offset datum dimension tool .
A coordinates input field is displayed at the cursor.

Figure 639 The coordinates input field

2. Enter the coordinates for the datum into the X Position and Y Position fields (you can use 
the Tab key to move from the X field to the Y field) and press the Enter key or click on 
the check mark to apply the entries.
The datum prim and the inscribed X- and Y coordinates appear attached to the cursor.

3. Move the cursor to the position on the sheet where you want to place the datum prim 
and click left.
The datum prim and the coordinates for the datum location are placed on the sheet.
This acts as the datum for the dimensions.

4. Choose the Dimension offset from a datum tool .
5. Probe the datum prim on the sheet.

A dimension appears attached to the cursor.
When you move the cursor, the dimension text changes according to the distance 
between the offset datum to the current mouse cursor position.

6. Click left on the point of the element where you want to end the dimension, or click 
middle if you wish to dimension more than one point.

7. Place now the dimension on the sheet by moving the cursor to the requested position 
and click once more the LMB.

While creating the dimension a popup menu is available. You can use it for changing the 
arrangement and properties. Details are described in ”Dimensioning - Home Tab”, ”Creating 
Linear Dimensions”, ”Popup Menu While Dimensioning Linear” on page 422).
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Arranging Coordinate Dimensions Text

For coordinate dimensions it may happen that the individual dimensions are so close together 
that their texts overlap each other. The Arrange coordinate dimensions text tool  rearranges the wit-
ness lines such that the texts become legible. 

The following figure shows an example for a coordinate dimension whose texts overlap each 
other on the left hand side:

Figure 640 Example for Arranging Coordinate Dimensions 1

If you select this dimension now and click left on the Arrange coordinate dimensions text tool, the wit-
ness lines are adjusted and each of the texts is readable.

Figure 641 Example for Arranging Coordinate Dimensions 2
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Exploding Dimensions

If you want to explode a dimension consisting of several measures in order, for example, to add 
a fit value, MEDUSA4 provides the Explode dimensions tool . This tool splits the dimension cre-
ated as one element into its segments. After running this tool each segment is a single dimen-
sion and you can change each of them individually.

The following figure gives an example, in which a dimension was exploded in its segments in 
order to add tolerance values to the middle dimension.

Figure 642 Example Explode Dimension
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Gaps in Overlapping Dimension Witness Lines

After finishing dimensioning it can happen that dimension witness lines overlap or cross each 
other. For this MEDUSA4 provides tools which enable you to create and remove gaps in dimen-
sion witness lines. 

Figure 643 The Gap Tools

The properties of gaps can be defined in the Default Settings dialog (see ”Dimensioning - Home 
Tab”, ”Setting the Default Dimension Standard” on page 415).

For adding gaps in single selected dimension witness lines:

1. Select dimensions whose witness lines overlap or cross each other.
2. Choose the Gap Create tool .

Gaps are added to the dimensions using the defined gap parameters.

The Gap Sheet  tool is the same as the Gap Create  tool except that all dimensions on the 
whole sheet are automatically selected and gaps are added if required. 

Removing gaps (Gap Remove tool ) works the same way as given for adding with the Gap Create 
 tool. First select a dimension from which you want to remove gaps and then press the Gap 

Remove tool .
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This chapter provides information to additional text tools which are not explained in chapter 
“Text - Home Tab” on page 499.

• Tool Overview ........................................................................ 640

• Replacing Text Properties ...................................................... 641

• QRCode Symbols .................................................................. 642

• Short-Info ............................................................................... 645

• Parts Lists .............................................................................. 647
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Tool Overview

The following figure shows the text tools in the Annotation tab.

Figure 644 Text Tools in the Annotation Tab 

The Annotation tab contains the following tools additionally to those already explained for the 
Home tab in “Text - Home Tab” on page 499:

 Replaces the properties of the selected text with the properties of another text element 
For details see “Replacing Text Properties” on page 641.

 Creates prims of specified type and properties 
is used for placing any prim. For details see ”Predefined Graphical Shapes (Prims)”, 
”Adding a Named Prim” on page 546.

 QR Code

creates a QR Code symbol. For details see “QRCode Symbols” on page 642.
 Writes data of Item Number Balloons of multiple sheets to a common table (parts list)

For details see “Creating a Parts List from Several Sheets” on page 647.

Following tools are not default in MEDUSA4:
Short-Info of sheet contents

Delete Short-Info

For details on both tools see “Short-Info” on page 645.

Figure 645 All Tools in the Text + Prims tool group of the Annotation Tab 
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Replacing Text Properties

When you use the Replace text properties tool  you do not need to know what the properties of 
any text element are. If they look correct, you can simply apply them to other text elements on 
the sheet.

1. Select the Replace text properties tool .
2. Select the text with the properties you want to use.
3. Select the text with the properties you want to replace.

The properties of the first selected text are applied to the second selected text. 
You do not have to select text of the same type. For example, you can replace the 
properties of boxed text with properties derived from text enclosed in a circle.

Please note: Replacing text properties uses all the properties of the first selected text except for 
the text input value.
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QRCode Symbols

A QRCode symbol provides information in an encoded form, for example a web address (URL). 
For reading the information you need a QRCode reader on your device (e.g. mobile phone or 
tablet). The symbol is scanned, analyzed and decoded. In this way information can be passed 
on to a user very fast.

Figure 646 QRCode Symbol - Example CAD Schroer URL

The QRCode Dialog

A QRCode is created via the QRCode dialog. The dialog is displayed when you click on the Creates 

QRCode symbol tool  (Annotation > Text + Prims).

Figure 647 QRCode Dialog
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The dialog shows in the upper area the input field for the information which is to be encoded. 
The Options area contains following parameters:
Size

defines the edge length of the symbol (mm).
Version

defines the number of modules (black or white squares) along the edge of the symbol.
The versions 1 (21x21 squares) to 20 (97x97 squares) are supported.

Error correction

defines the method how to handle damaged symbols. Depending on the selected 
method more or less data can be recalculated if the symbol is damaged.
Possible values are: Low, Medium, Quality and High quality

Text encoding

defines the method how the characters are encoded.
Color

defines the color of the symbol.
Enter the color index or select a color from the Select color dialog. The color selector is 
displayed by a click on the button right of the input field.

Area fill

defines the method of filling the squares.
Possible values are: Crosshatch and Area.

Border

If the check mark is set, a free area is created around the symbol.

Creating a QRCode Symbol

1. Select the Creates QRCode symbol tool  to open the QRCode dialog.
2. Enter text in the input field.

In our example we entered the URL of CAD Schroer.
3. Make the settings in the Options area as required.
4. Start the tool with OK or Apply.

OK starts the process and the dialog disappears. 
If you use Apply, the process starts and the dialog remains opened.
The QRCode symbol is generated and attached to the crosshair.
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Figure 648 QRCode Symbol - Example URL CAD Schroer

5. Place the symbol with a left click at the desired position in the drawing area.

Editing a QRCode Symbol

Click double on the symbol or select the symbol and choose Edit from the RMB popup menu. 
The QRCode dialog is displayed again and you can change your settings as required.
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Short-Info

Please note: Short Info is only available with the advanced version of MEDUSA4.
By default the button is not visible. To display the Short Info button set the relevant 
check mark in the RMB popup menu of the Text + Prims tool group. (Please, see 
”Tool Overview”, ”All Tools in the Text + Prims tool group of the Annotation Tab” 
on page 640)

This function allows you to attach a short information containing the login name of the author, 
the date of modification and a brief description text on the current sheet. 

The Short-Info of sheet content tool  is available for adding, displaying and modifying. If you have 
chosen this tool, the Short-Info dialog opens.

Figure 649 Short Info Dialog

The dialog contains following information:
Author is the login name of the user who added or modified the short information.
Date is the date of last modification.
Message is the brief description of the sheet contents or other information which should be 

saved with the current sheet.

The buttons are:
OK attaches the current short information to the sheet and closes the dialog.
Cancel closes the dialog without changing the short information.
Delete removes the short information from the sheet.
Help opens the Online-Documentation.

If a sheet was saved with short information and if it is opened in MEDUSA4, the Short-Info dialog 
opens automatically.
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Once a sheet contains short information, the Delete Short-Info tool  becomes active and the 
short information can be removed. If this tool is chosen the short information text, author and 
date will be removed immediately from the sheet. Deletion becomes definite, when the sheet 
will be saved.
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Parts Lists

You can use the Item Number Balloons in your sheet to create a parts list. This is explained in 
“Tables”, “Parts List”, ”Creating a Parts List” on page 565.

This section shows how to create a parts list from Item Number Balloons from several sheets 
(see “Creating a Parts List from Several Sheets” on page 647) and how to customize the col-
umn headers (see “Configure Column Headers” on page 648).

Creating a Parts List from Several Sheets 

The procedure for creating a parts list from Item Number Balloons of several sheets is similar to 
the procedure in “Parts List” on page 565. The difference is that you have to choose the files 
first, from which Item Number Balloons are to be read.

1. Choose the Writes data of Item Number Balloons of multiple sheets to parts list tool  from the Text 

+ Prims tool group in the Annotation tab.
The sheet selector dialog is opened:

Figure 650 Item Number Sheet Selector Dialog

Directory 
is the current working directory. You can change it with a directory selector by 
choosing the button behind the text field on the right hand side.

left list
shows all sheet files in the selected Directory.
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 add selected files to selection list 
On the left side all sheet files of the selected directory are listed. Select the ones 
you want to scan and add them to the list on the right side with this button.

 remove selected files from selection list 
To remove drawings from the right list select them and use this button: 

 clear selection list 
To clear the complete right list, use this button.

right list, selection list 
shows all sheet files whose parts data will be adopted in the parts list.

2. In the left list choose all sheets which are to be scanned.
3. Click left on  to adopt the files to the selection list (on the right).
4. Click left on OK. 

The system checks whether the drawings are already open. If not, they will be opened, 
scanned and closed again. As result you will get a table with the data of all selected 
sheets.

5. Choose Apply.
The table is attached to the cursor.

6. Click left on the sheet to place the table.
You can also save the table to a comma separated file (CSV file, explained in “Saving 
Tables” on page 560) as described in “Saving Tables” on page 560.

7. Save the sheet in order to store the parts list table with the sheet.

Configure Column Headers

To change the table column headers for the parts list you need to edit the following file:
<MEDUSA4_installationpath>\MED2D\M2D\SYMBOL\PARTS_BALLOON\balloontable.bac

The entries of the default file are:
-- Configuration for Partsballoon table tool
balloontable_props :- dict_new()
-- table header position (!top or !bottom)
balloontable_props!header_pos :- !top
-- description of columns
balloontable_props!cols :- []

col         :- dict_new()
col!datatyp :- !item_number
col!label   :- mui_message_get(mui2d_messages, !SUB_BALL2TAB, 
!position)   
col!width   :- 6
balloontable_props!cols :- balloontable_props!cols  >< [col]
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col         :- dict_new()
col!datatyp :- !quantity
col!label   :- mui_message_get(mui2d_messages, !SUB_BALL2TAB, !max)   
col!width   :- 7
balloontable_props!cols :- balloontable_props!cols  >< [col]

col         :- dict_new()
col!datatyp :- !part_number
col!label   :- mui_message_get(mui2d_messages, !SUB_BALL2TAB, !part)   
col!width   :- 8
balloontable_props!cols :- balloontable_props!cols  >< [col]

--col         :- dict_new()
--col!datatyp :- !issue
--col!label   :- mui_message_get(mui2d_messages, !SUB_BALL2TAB, !num)   
--col!width   :- 5
--balloontable_props!cols :- balloontable_props!cols  >< [col]

col         :- dict_new()
col!datatyp :- !material
col!label   :- "Material"  
col!width   :- 10
balloontable_props!cols :- balloontable_props!cols  >< [col]

col         :- dict_new()
col!datatyp :- !weight
col!label   :- "Weight"  
col!width   :- 8
balloontable_props!cols :- balloontable_props!cols  >< [col]

The entries which define the column header and width are:

For editing the column header consider:

• Other values than label and width should not be changed.

• The first three columns may not be removed.

• Commenting out a whole column description (--) removes it from the table creation 
(e.g. in the default file this has be done for issue).

The following example shows the first columns after customization:
col         :- dict_new()
col!datatyp :- !item_number
col!label   :- "Column 1"  
col!width   :- 6
balloontable_props!cols :- balloontable_props!cols  >< [col]
 

col!label defines the column header

col!width defines the column width
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col         :- dict_new()
col!datatyp :- !quantity
col!label   :- "Column 2" 
col!width   :- 7
balloontable_props!cols :- balloontable_props!cols  >< [col]
 
col         :- dict_new()
col!datatyp :- !part_number
col!label   :- "Column 3"
col!width   :- 8
balloontable_props!cols :- balloontable_props!cols  >< [col]

To use the customized column headers of balloontable.bac, simply re-start one of the parts list 
creation tools.
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Processing Symbols - Overview

The Annotation tab > Processing Symbols tool group provides the following tools:

Figure 651 Annotation Tab > Processing Symbols Tool Group 

Welding Symbols are explained in detail in the following section.

Surface Symbols are also available on the Home tab > Dimensions tool group.
For details on surface symbols see chapter ”Dimensioning - Home Tab”, “Surface Finish Sym-
bols” on page 455.
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Welding Symbols

You can create welding and soldered joint symbols conforming to the current standard. The 
welding symbol consists of different parts which can be put together dynamically in a dialog win-
dow. It remains alterable on the cross hair until you place the welding symbol with a second left 
click.

Click the LMB on the Load welding symbol tool  to open the Welding symbol input dialog.

Figure 652 The Welding Symbol Input Dialog

The dialog contains text input fields and icons. Text input fields are used to enter information at 
the relevant welding symbol position. Icons can be expanded to select other symbols than the 
default ones. The following figure shows the different parts of a welding symbol, which are 
explained in the following paragraphs.

Figure 653 The Welding Symbol Input Dialog, details 

Part 1
defines the symbol for the beginning of the line. The arrow opens a set of all available 
symbols.

Figure 654 Welding Symbols Part 1

If you click the LMB on a symbol, it is used as point function for the welding symbol.

1

2 3
4

5

6

7
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Part 2
serves auxiliary symbols which gives hints on the run of the seam. The arrow opens a 
set of all available symbols.

Figure 655 Welding Symbols Part 2

One mouse click on the desired symbol sets it into the welding symbol.
Part 3

defines the reference line of the seam. The arrow opens a set of all available symbols.

Figure 656 Welding Symbols Part 3

One mouse click on the desired symbol sets it into the welding symbol.
You can enter additional specifications in the upper and lower text field.

Part 4
defines the upper basic symbol which specifies the kind of the seam. The arrow opens 
a set of all available symbols.

Figure 657 Welding Symbols Part 4

One mouse click on the desired symbol sets it into the welding symbol.
As soon as you have chosen the upper basic symbol a further icon appears providing 
additional symbols as shown below.

Figure 658 Welding Symbols Part 4a
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Part 5
defines the lower basic symbol which specifies the kind of the seam. The arrow opens 
a set of all available symbols.

Figure 659 Welding Symbols Part 5

One mouse click on the desired symbol sets it into the welding symbol.
As soon as you have chosen the lower basic symbol a further icon appears providing 
additional symbols as shown below.

Figure 660 Welding Symbols Part 5a

Part 6
Clicking on the icon for shifted seams enables it and two text input fields become avail-
able. You can enter additional specifications.

Figure 661 Welding Symbols Part 6

Part 7
The arrow opens a set of symbols which activate additional text input fields used for 
the specifications of the welding process.
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Figure 662 Welding Symbols Part 7

If you select the fork, there are four input fields available where you can enter free text. 
For the entry in the Process field you can also call up a selective list which contains the 
current standards of welding and soldered process. 

Figure 663 Welding Symbols Part 7a

Figure 664 Welding Symbols Part 7b

Named Welding Symbols

After creating a welding symbol you can save it under a defined name. You have to 
enter the name in the input field and click the Save button at the bottom of the dialog.
The name is written into a list which can be displayed by using the arrow.

Figure 665 List of Named Welding Symbols

Selecting a named welding symbol from the list displays the accordingly saved symbol 
in the dialog window. Probing on the sheet sets the start point for the loaded symbol.

Exit

closes the dialog.
Reset

reverses any entries you made in the dialog back to the default settings. 
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Save

stores the current settings of the dialog as a new symbol with the name given for Named 

Welding Symbols. If no name is defined, an error message is given. 
Delete

removes a selected named welding symbol from the session buffer. 

Please note:  If you made changes to the session buffer (e.g. saved a named symbol or deleted 
a named symbol) and close MEDUSA4, the following dialog opens:

Figure 666 Dialog: Save or Discard a Named Welding Symbol as Default

If you confirm with Save, the named symbols are saved permanently into the file <proj-
ect>\user\<username>\weldsym.xml and you can use them in further sessions. If you Dis-

card, the welding symbols stored in this session will be lost.

Please note: If you want to make your welding symbols system wide available, you can put the 
file weldsym.xml into the path <customer_product>\m2d\src and/or <proj-
ect>\user\common. Consider that saving is always done in the user directory only, 
so you have to copy the file weldsym.xml manually into the customer product or 
<project>\user\common path.

Rotating a Welding Symbol

You can rotate a selected welding symbol by choosing one of the four available options of the 
RMB popup menu.

Figure 667 Popup Menu

Please note: The alignment can be set only before setting the endpoint of the welding symbol.
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Introduction

Bore hole tables are used to display all relevant data of drillings (coordinates, diameter, toler-
ance data, comments) at minimum expenditure in clear tabular form. Thus an inconvenient and 
unclear measuring of each individual drilling is omitted, as well as the manual gathering of the 
necessary information. With the arranged information the creation of CNC programs, for exam-
ple, is substantially accelerated, since the information is to be found fast and is represented 
clearly.

Terms

The Reference Coordinate System (RCS) defines the origin which the X/Y coordinates of a 
drilling refer to and it can be placed freely. The RCS consists of a prim and a text containing a 
number which identifies the RCS.

The bore hole table first consist of two rows after creation (see “Creating a Table” on 
page 661), the base table. One row contains the table name and the other contains the column 
titles. The data of the drillings are added later (see “Adding Drillings to a Table” on page 664). 
The table name contains an identification number which is identical to the number within the text 
of the RCS.

Drillings entered in a bore hole table are marked with an arrow and a bore hole number text. 
The circle of the drilling gets an attribute consisting of the identification number of the bore hole 
table and the number text of the drilling. With this attribute it is impossible to add the drilling to 
another bore hole table.

Tools

Please note: The tools for bore hole tables are only available with the advanced version of 
MEDUSA4, which can be started with the option -advanced. Details on starting 
MEDUSA4 are described in “Starting MEDUSA4” on page 23.

The bore hole table tools are in the Annotation tab.

Figure 668 Bore Hole Table Tools
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Creating a Table

A drilling table consists of a reference coordinate system (RCS), which can be positioned freely 
on the sheet, and a base table. The RCS and the table are thereby connected by an identifica-
tion number, which is displayed both in the symbol of the reference coordinate system and in 
the table foot.

Creating a table is divided into two work procedures, positioning the RCS symbol and position-
ing the base table. The base table consists of two rows providing the table name and the col-
umn titles for the data lines.

Step 1 - Position the RCS Symbol

Click the button Create a new borehole table  to open the following dialog:

Figure 669 Create a new Borehole Table Dialog

In this dialog you have the following adjustment possibilities:
Tab number

is the identification number of the new table. 
Name of origin of coordsystem

is the text written below the RCS symbol together with the Table number. 
Name of table

is the text written into the table foot together with the Table number.

All parameters of the dialog can be edited until the RCS symbol is placed on the sheet by click-
ing the LMB. The RCS symbol is attached to the cross hair until it is placed and any parameter 
modification is applied to it immediately. Having placed the RCS symbol, this data cannot be 
changed any longer.

Following popup menu is available as long as the RCS symbol is attached to the cross hair:
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Figure 670 Popup While Creating a New Borehole Table

0 degree aligns the RCS symbol horizontal.
+30 degrees

rotates the RCS symbol by +30° (counter clockwise).
-30 degrees

rotates the RCS symbol by -30° (clockwise).
If you select one of the options, the adjustments will transfer dynamically to the symbol 
placed at the cross hair.

Properties opens the following dialog, which enables you to apply any angle.

Figure 671 Properties

OK applies the defined angle and closes the dialog.
Apply applies the defined angle and the dialog remains open.
Cancel closes the dialog without applying the angle.

Step 2 - Position the Base Table

Having placed the RCS symbol on the sheet, a frame is attached to the cross hair. This frame 
shows the dimensions of the base table. You can change the Name of table in the Create a new bore-

hole table dialog (see Figure 669, “Create a new Borehole Table Dialog” on page 661) until you 
placed the table.
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Example

The following figure shows a placed RCS and the associated drilling table.

Figure 672 Example Drilling Table 1
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Adding Drillings to a Table

Adding a drilling to a table is divided into the following steps: 

• the selection of a reference coordinate system (RCS)

• the selection of the desired drilling

• the positioning of a marking arrow with an identification number for the drilling

Step 1 - Select Reference Coordinate System (RCS)

1. Choose the Add data to table tool .
2. Click close to the RCS-symbol, to which the drilling is to be assigned. 

The RCS symbol and the associated table are shown highlighted. At the same time the 
Add Data to table dialog is opened:

Figure 673 Add Data to Table Dialog

Step 2 - Select Drilling

3. Click the desired drilling to select it.
The drilling is shown highlighted. You now have the possibility to select another drilling. 

4. To add the selected drilling to the bore hole table, choose Apply from the popup menu. 
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Figure 674 Popup Menu While Adding Data to Table

Step 3 - Position Arrow

5. Move the mouse.
A rubber band is displayed starting from the circular line of the drilling to the current 
cross hair position. This line is the first part of the marking arrow. 

6. Click left to place the arrow head at the circular line of the drilling.
Now the identification number of the drilling is shown at the end of the marking arrow.

7. Click left to align the identification number horizontally or vertically.
The marking arrow for the current drilling is finished and its data is added to the current 
bore hole table and is displayed on the sheet.
You can now process further drillings or terminate the procedure via OK in the dialog or 
Exit tool from the popup menu.

Figure 675 Example Drilling Table 2
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Editing Drilling Data

You can edit the data of a drilling entered into a table using the Update circle data in table tool . 
The Edit data of circle dialog will open. Its data entries are empty until you select a drilling.

Figure 676 Edit Data of Circle

If you now select a drilling on the sheet, the associated reference-coordinate system (RCS), as 
well as the table row will be displayed emphasized.The data from the table row are read into the 
dialog and can be modified except x-/y-coordinates and diameters.

OK applies the changed data of the drilling and closes the dialog. 

Apply applies the changed data of the drilling but the dialog remains open. 

Cancel discards the changed data and closes the dialog.
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Updating a Single Table 

In the course of the life cycle of a drawing various modifications are made to the geometry, for 
example, drillings are shifted, or its diameter is modified or they are deleted. The position and 
the angle position of the reference coordinate system (RCS) can change and drillings can be 
removed from the table. It is also conceivable that a part of the database of a table is deleted 
accidentally or that changed setup adjustments (see “User-adjustable Parameters” on 
page 669) makes updating necessary.

For updating the table in all these cases, choose the Update single table tool .

Please note: A prerequisite for correct functioning of this tool is that the structure of the table is 
intact. For further information please read the section “Group Structure” on 
page 671.

Having selected a reference coordinate system (RCS), first the data of the associated bore hole 
table is checked and all data records are deleted which are no longer complete. Afterwards the 
complete data records are re-calculated regarding its geometry. User inputs (tolerance data 
etc.) are not changed thereby. Basis of the update are the adjustments in the user parameters 
(see “User-adjustable Parameters” on page 669).
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Cleanup   

Having created a bore hole table for a geometry it can happen, that you need the drillings 
slightly changed on another drawing. For this you copy the drillings onto the other drawing and 
then you create a new bore hole table there. Because the drillings were already used for a bore 
hole table, they contain appropriate system information. The Cleanup tool  deletes the system 
information from the drillings and releases them for the new bore hole table. 

If you choose the Cleanup tool , a safety query takes place before starting the Cleanup in order 
to prevent an unwanted start of this process:

Figure 677 Warning: Start Cleanup

OK runs the Cleanup function.

Cancel terminates the Cleanup function.
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User-adjustable Parameters

The appearance of the drilling tables is determined by a number of parameters, from which the 
user can adapt some of them. All parameters adjustable by the user are summarized in the 
Setup coordinate table dialog which is available by the Setup tool .

Figure 678 Setup Coordinate Table

The dialog provides the following parameters:
Sorting

Determines the sequence of the drilling entries in the table. 
• Ascending

The drilling entries are sorted in ascending order, the smallest drilling number is sit-
uated directly over the column inscriptions.

• Descending

The drilling entries are sorted in reverse succession than Ascending.
Base Number

is the initial number of bore holes, default is 100. So the first bore hole gets the number 
100 and the following 101, 102, 103 and so on.

Places

sets the number of decimal places for the coordinate values in the table.
Text Styles 

The text styles for the table name, column titles, table contents and for the texts at 
arrows and prims are defined here.
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Line Prim Styles 
The styles for table and arrow lines and for prims are defined here.

Column 

Width

Here you can enter the width of each column.

Buttons:
OK 

applies the current settings and closes the dialog.
Cancel 

rejects the current settings and closes the dialog.
Default 

loads the predefined settings for tables and overwrites the current settings.
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Group Structure

Following figure shows the group structure of a bore hole table. The group with all relevant data 
is selected in the structure tree. The names of the groups located in there were renamed 
according to their content.

Figure 679 Group Structure of a Bore Hole Table

The structure of the bore hole table must be error free for updating an individual table (see 
“Updating a Single Table” on page 667). If this structure was damaged, for example by the dele-
tion of the reference coordinate system symbol (RCS), important system information is lost. In 
such a case the bore hole table has to be created new. For this you first have to delete the 
whole group structure. If you only delete the visible elements on the sheet, the group structure 
is not removed completely and it will not be possible to enter drillings, which were in the dam-
aged bore hole table, to the new bore hole table. Therefore please delete the groups belonging 
to the damaged bore hole table in the structure tree.
© CAD Schroer GmbH                             671



MEDUSA4 Drafting
Bore Hole Tables
672 © CAD Schroer GmbH



MEDUSA4 Drafting
LINES - LINES TAB
• Tools....................................................................................... 674

• Closed Geometry ................................................................... 675

• Trace a Line Tool ................................................................... 678

• Connect and Tidy Lines ......................................................... 680
© CAD Schroer GmbH 673



MEDUSA4 Drafting
Lines - Lines Tab
Tools

The Lines tab provides tools for creating and editing lines.

Creating Lines

The standard tools for creating lines are in the Home tab, see ”Lines - Home Tab”, “Create Line 
Tools” on page 340. In the Lines tab some standard tools (e.g. for drawing straight solid lines), all 
tools for closed geometry and less commonly used tools (like tools for long dashed lines) are 
available.

Figure 680 Create line tools in the Lines tab

Editing Lines

Figure 681 Edit line tools in the Lines tab 
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Closed Geometry

Compared with the Home tab the tool group Lines in the Lines tab contains all tools for closed 
geometry.

Figure 682 All tools for closed geometry in the Lines Tab

Shapes

All closed geometries can be created as Shapes. This mode allows the shape and center lines 
to be grouped together. In principal it is possible by using all the tools, which are used to create 
closed geometries even you are not in Shape mode. One exception are the tools for creating 
slots which are especially explained in the following.

To enable drawing closed geometries as Shapes:

1. Click the RMB on the Lines tool group of the Lines tab.
A pulldown list is displayed which contains all tools of the Lines tool group.

2. Scroll down the list.
The last option enables the tools for creating closed geometries as Shapes.

Figure 683 Lines Tab - Tool Selection List of Lines Tool Group - Shapes Tools 

3. Activate the Shape tools by setting a check mark in the relevant check boxes.
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The tools are displayed in the Line tool group on the ribbon.

Figure 684 Lines Tab - Lines Tool Group - Shape Tools

Creating Slots in Shape Mode

Once you are in Shape mode, the tools for creating round-ended angled slots are deactivated. 
Now the tools for creating horizontal slots are only available which can also create vertical and 
angled slots.

Figure 685 All Tools for Creating Slots in Shape Mode

Procedure:

1. Choose one of the tools for creating slots.
The Dashboard of a closed geometry as Shape is displayed.

Figure 686 Dashboard of Slot

The dashboard shows the Width, Length and Rotation fields. By default the option Horizon-

tal/Vertical is displayed in the Rotation field. 
The Rotation pulldown menu contains following entries:

Figure 687 Rotation Pulldown Menu

Horizontal/Vertical

creates horizontal or vertical slots (default setting)
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Free

creates slots with any angle.
Custom

creates slots with specified angle.
If this option was chosen, the input field on the right side is enabled and you 
can either enter the desired angle directly or use the arrows to define a value.

2. Choose one of the following options:
• If you choose Free, the slot is attached to the cursor and can be freely rotated around 

the starting point. Now you can place the slot at any angle on the sheet.
• If you have chosen Custom and if you entered the desired angle in the appropriate 

field, the slot can be only extended toward the given angle.
3. Click left into the drawing to place the starting point of the slot.
4. Click left into the drawing to place a second point on the sheet.

The slot is now created.
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Trace a Line Tool

MEDUSA4 provides a tool which can be used to trace a complex line quickly and comfortably. 
The line may be both an open or closed geometry. You can trace a line completely or partially. 
You define the start and the end of the line to be traced. The use of the Trace a line tool  will be 
demonstrated with the help of a car lock lever.

Please note: The tool is only enabled if your are in line edit mode.

1. Choose one of the create line tools to define the line style used for drawing.
2. Start drawing a line on the outline which is to be traced by performing following steps:

a. First probe on the outline to set the starting point of the new line.
b. Then set a second point, which defines the drawing direction.
c. Finally probe the end point of your new line.
Following figure shows the phases of drawing.

Figure 688 Probing a Start, Direction and End Point

3. Choose the Trace a line tool .
The new line is drawn promptly between the start and end point with the defined direc-
tion (see Figure 689, left side).
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Figure 689 Traced Line

The new line is still selected and in edit mode. In our example (Figure 689) the traced 
line has been moved to the right.
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Connect and Tidy Lines

With MEDUSA4 you can remove points, which lay over each other in order to have only one 
point at a place. You can also connect single lines with overlapping points in order to create a 
poly line.

Figure 690 Connect and Tidy Lines Toolsets

The following tools are displayed in the figure above:
 Join (Sheet)

connects all lines on the sheet which have overlapping end points to one new line (for 
details see “Details on the tool for connecting all lines” on page 680).

 Join

connects the currently selected line(s) with adjoining line(s).
 Tidy (Sheet)

tidies lines, i.e. removes redundant points that are co-linear or coincident, on the whole 
sheet.

 Tidy

tidies the currently selected line(s).

Details on the function of the tools

The tools which run on all lines of a sheet are executed immediately. There are some character-
istics for the Join (Sheet) tool which are explained in ”Details on the tool for connecting all lines”.

The tools which run on currently selected lines are only active if at least one line is selected on 
the sheet.

Details on the tool for connecting all lines

The Connect lines to one new line tool evaluates all lines on the sheet except closed lines and circles. 
Only line segments of the same type and on the same level and layer are connected. Since the 
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tool works fully automatic, non-explicit connecting situations are omitted (e.g. if the direction can 
not be determined clearly).

Since all lines are verified the execution time of the function can be several seconds with larger 
drawings. The use of this tool results in a reduction of the amount of data when importing DXF 
files. This becomes apparent in improved performance.

When you move the cursor over the tool and click right a popup menu opens. The Properties item 
opens the JoinLine Properties dialog.

Figure 691 JoinLine Properties Dialog

Within the dialog you can select different settings, which are used to control the joining of lines 
to one line. All the options are self-explanatory. By default the options are set as shown in the 
figure above. The default values can be modified in the defaults.dat file (see the Customization 
Guide, chapter User Interface, section DEFAULTS.DAT, sub-section Joinline Properties).

Ignore 3D link lines will be applied on line types, not on styles, and it includes the line types LP0 
LP1 LP2 LP3 LP4 LP5 LP6 LP7 LP8 LP9 LCL LPS LS LF LE LFP LLP LL LOL LOP LTU LTC 
LRS LRE LVR SLL LSL LDT LVB LPV LBL.

If you deactivate Join tangent point arcs, too, such arcs are not included within a line but remain as 
separate line segments.
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Tools

The following figure shows the tools and tool sets for creating construction lines in the Lines tab.

Figure 692 Tools for creating construction lines in the Lines tab

The following figures show the different tool sets from top to bottom and left to right:

Figure 693 Tools for creating straight construction lines

Figure 694 Tools for creating construction lines by tracing a line

Figure 695 Tools for creating construction lines with certain angles

Figure 696 Tools for creating construction circles and rectangles

Figure 697 Tools for creating different construction lines by probing two points
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Figure 698 Tools for projecting construction lines from section lines

Figure 699 Tools for activating and deactivating transportation lines

Figure 700 Tools for creating transportation and section lines

Most of the tools are self-explaining therefore only tools for following topics are explained in this 
chapter:

• “Creating an Oblique Construction Line” on page 686 

• “Offset Construction Lines” on page 688 

• “Transported Construction Lines” on page 692

• “Projected Construction Lines” on page 695
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Creating an Oblique Construction Line

MEDUSA4 provides different tools for creating an oblique construction line. Additional to the 
tools with fixed angle there is one tool for creating construction lines at any angle:

1. Select the Creates oblique construction line tool .
An angle entry box appears at the cursor.
If it is the first time you draw an oblique construction line in the current MEDUSA4 ses-
sion, the default entry is 45.00 degrees.

Figure 701 Angle Entry box

2. Move the cursor into the Angle input field and type the requested angle value.
3. Select a point on the drawing through which the construction line is to pass and click 

the LMB.

Creating a Construction Line at Any Angle to 2 Probes 

MEDUSA4 offers tools for creating construction lines at any angle. One tool creates a construc-
tion line which can be placed at any angle related to two probes. The other tool covers the spe-
cial case placing the construction line exactly in the middle between the two probes.

Both tools work similar, therefore only one is explained in detail here:

1. Choose the Creates a construction at any angle to two probes tool .
2. Probe in the sheet to set the first point.
3. Probe in the sheet to set the second point.

In the drawing area a construction line is drawn attached to the cursor. The angle is 90 
degree (default value), perpendicular to an imaginary line defined by the two probes.

Figure 702 Example for a Construction Line at any Angle 1 

4. Overwrite the current value in the Angle input field simply by typing a new value on your 
key board.

Please note: To be able to move the cursor into the input field and type a new value you have 
to press the Ctrl key.
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When moving the mouse just a little bit, the construction line attached to the cursor 
changes immediately to the current Angle.

Please note: If you do not want to place the line at the current mouse cursor position do not 
press Return on your keyboard.

Figure 703 Example for a Construction Line at any Angle 2 

5. Move the mouse to the position, where you want to place the construction line, and 
click the LMB.
If you used the Creates a construction at any angle in the middle of two probes tool , the construc-
tion line will be placed exactly in the middle between the two probes.

Creating a Bisection Line

MEDUSA4 provides a tool, which can be used to create the bisection line between two straight 
line segments. The line segments can be created in any angle to each other. They can intersect 
themselves but need not do this. They can also be arranged parallel; in this case the 
construction line is placed axial between the two parallels.

1. Choose the Creates construction line bisecting two line segments tool .
2. Click the LMB on the first line segment and then on the second.

The bisection line is promptly created.
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Offset Construction Lines

You can offset construction lines from a datum point using the tools shown below: 

This section explains the offset definition and how to create offset construction lines.

Offset Definition

By default:

• A vertical construction line is offset to the right (positive side) of the datum point

• A horizontal construction line is offset above (positive side) of the datum point

Using Negative Offsets

You can enter a negative value in the Offset field to offset a line on the other side.

Figure 704 Positive and Negative Offsets 

Create offset horizontal construction lines

Create offset vertical construction lines

Create offset oblique construction lines

Create offset construction lines at +45 degrees

Create offset construction lines at -45 degrees

Vertical offset: 20 Vertical offset: -20

Horizontal offset: 20 Horizontal offset: -20

Datum PointDatum Point

Datum PointDatum Point

Construction
Lines
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Reversing the Offset

If you have created a construction line, you can reverse the offset direction by clicking right in 
the drawing area to open the popup menu and then choosing the Reverse offset item.

Entering a Positive and Negative Offset

You can enter a positive and negative offset of the same value, prefixing the value with an aster-
isk (*). Two construction lines will appear at the same time, one to the left side of the datum 
point and the second one to the right side of the datum point.

Figure 705 Positive and Negative Offset Created at the Same Time

Creating an Offset Construction Line

1. Choose one of the tools shown above.
The Offset entry box appears at the mouse cursor.

Figure 706 Offset Entry Box

2. Enter the offset distance by typing a value into the Offset field.
The last entered offset value is valid until you modify it. 

Please note: If you press Return or if you click on the tick button, the construction line is drawn 
immediately using the current mouse cursor position as datum point. If you want 
to probe on the sheet, do not do this.

3. Probe on the sheet to define the datum point for the construction line.
MEDUSA4 creates a construction line offset from the specified point.

4. Now you can either 
a. select Exit Tool from the popup menu to quit the tool or 
b. create more offset construction lines of the same type. 

Details are described in “Creating More Offset Construction Lines” on page 690.

Vertical - offset: *20

2020
Datum Point

Positive OffsetNegative Offset
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Figure 707 Vertical and Horizontal Offset Examples 

Figure 708 45 Degree Offset Examples 

Figure 709 Oblique Offset Example

Creating More Offset Construction Lines

Using the Same Datum

After you have created an offset construction line, you can create more construction lines, using 
the same datum, by entering a new value in the Offset field and then pressing Return.

If you created an oblique offset construction line, you can also enter a new angle.

Using a New Datum

If you want to create another offset line of the same type but with a different datum, enter the 
new offset value and then probe on the sheet for the new datum.

If you created an oblique offset construction line, you can also enter a new angle.

Vertical - offset: 20 Horizontal - offset: 20

Datum Point

20

Construction Line

Offset

+45 degrees - offset: 20 -45 degrees - offset: 20

45°20

Oblique - offset: 20 angle: 30

30°20
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Creating Series of Offset Construction Lines

You can create series of construction lines by specifying the interval between the lines (incre-
mental offset) or the absolute distance from the datum point (absolute offset). 

Figure 710 Example of Offset Vertical Construction Lines 

You can create the construction lines shown in Figure 710 in two ways. 
a. You enter the incremental offsets for the construction lines as: i60 i30

The letter i denotes incremental offsets.
b.  You enter absolute offsets for the construction lines as: a60 a90

The letter a denotes absolute values and specifies that the dimension is taken from 
the datum.It will have no effect on any following incremental number.

Please note: The Administrator can set a default for your project either for incremental or abso-
lute offsets.
Depending on the defaults, you will not need to specify the a or the i. 
For example, if the default is for incremental offsets, the entry of the i is dispens-
able, you only need to specify a when you want to use an absolute offset 

You can also combine incremental or absolute values with using the asterisk (*) to enter multiple 
positive and negative offsets. The example below shows the offset entry if the default is set to 
an incremental offset.

Figure 711 Example for Incremental Default Offset

Please note: If the default for your project is absolute offsets, you have to type *60 *i30 to 
achieve the result shown above.

60 30

60

Incremental Offset

90

Absolute Offset

Default setting: incremental offset, Offset *60 *30

60 306030
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Transported Construction Lines

In conventional drafting you can set up temporary construction lines running from one drawing 
elevation to another. That is you can create construction lines between elevations that are per-
pendicularly adjacent. You can also project construction lines into elevations that are not per-
pendicularly adjacent. This process involves transporting ordinary construction lines to different 
locations on a sheet. You can do this using transportation lines.

Transportation Lines

1. Choose the Creates transportation lines tool .
2. Probe in the sheet to enter the start point of the transportation line.
3. Probe once again to enter the end point.

A dashed line appears on the sheet. Start and end point of the transportation line are 
marked with small squares.

You can activate or deactivate a transportation line via the Switch on/off transportation line tools (see 
Figure 699, “Tools for activating and deactivating transportation lines” on page 685). 

Please note: The tools for activating and deactivating transportation lines are only enabled if the 
transportation line is selected otherwise they are disabled.

Figure 712 Tools to Switch Transportation Lines On and Off

• If the transportation line is activated start and end point squares are filled out.

• If the transportation line is deactivated start and end point squares are empty.

You can deactivate all of the transportation lines at once.

1. Open the Default Settings dialog via File > Default Settings.
2. Choose the tab Switches.

switch on switch off

transportation line
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Figure 713 Default Settings Dialog: Switches Tab

By default the Enable Transportation lines option is activated.
3. Delete the check mark in the field and quit the dialog by clicking the Close button.

The transportation lines are no longer active.

Please note: In this case start and end point squares are still filled out. So you cannot recognize 
active or inactive transportation lines by their start and end point.

4. To reverse the action and activate the transportation lines again, click the Default Settings 
button of the Switches tab.

Deflection Angles

When a construction line intersects a transportation line that is switched ON, the resulting trans-
ported construction line is projected at a deflection angle. The deflection angle is equal to the 
angle of the intersection between the construction line and the transportation line.

Figure 714 The Deflection Angle of Transported Construction Lines

The construction line intersects the
Transportation line at q angle 

The transported construction line is deflected
at q angle to the transportation line

Construction line

Transported
Construction line

Transportation line
© CAD Schroer GmbH                             693



MEDUSA4 Drafting
Construction Lines - Lines Tab
Using Transported Construction Lines as Construction Aids

When you have transported construction lines to different locations on the sheet, you can use 
these lines as a basis on which to make a new drawing elevation. Following figure shows an 
example of a construction line that has been transported to different locations on a sheet.

Figure 715 Transporting a Construction Line

Transportation line Transported
construction
line

Transportation line

Second
intersection

First 
intersection

Transported construction line Vertical construction line
created at this point
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Projected Construction Lines

You can project orthogonal construction lines from existing design geometry and use the result-
ing construction lines to create other drawing elevations.

You can project construction lines:

• Horizontally, vertically, or obliquely through a profile

• From a section line through part of the design

• From a rotated section line through part of the design

Projecting Construction Lines Through a Profile

When you project construction lines through a profile, construction lines are projected through 
points of interest on the selected geometry that would be seen as edges when viewed from the 
projection direction. Following figure shows an example.

Figure 716 Projecting Construction Lines from a Profile

To create construction lines through a profile:

1. Select the profile.
2. Choose the Projection construction lines from profiles tool .
3. Move the mouse cursor into the drawing area and click the RMB to open the popup 

menu.
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Figure 717 Popup Menu For Projection Construction Lines from Profiles

4. Select the direction of the construction lines which are to be created:
• Horizontal 

Horizontal lines are created considering each important point of the profile.
• Vertical 

Vertical lines are created considering each important point of the profile.
• Oblique 

Oblique lines are created considering each important point of the profile.
The angle of the oblique position can be specified by entering a from and to point by 
probing on the sheet.

Construction lines are created according to the specified direction.
5. Click Exit tool to discard the tool.

Projecting Construction Lines Through a Section

When you project construction lines through a section line, construction lines are projected 
through each intersection of the section line with the associated geometry and through each 
vertex in the section line (except the end points).

To create construction lines through a section line:

1. Choose the New section line tool .
2. Create a horizontal, vertical or oblique line which intersects the profile by setting start 

and end point of the line.
3. Select the Project construction lines from a section line tool .

Construction lines are projected through each intersection of the section line with the 
associated geometry.

The figures below show the use of the default projection angle of 90 degrees.
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Figure 718 Creating a Single Sectional View

Figure 719 Creating a Multi-plane Sectional View

The plane break line (B-B) is also projected as an aid to offset crosshatching. You can ignore 
the plane break line during crosshatching if you prefer as shown in Figure 720:

Figure 720 Crosshatching a View (Ignoring the Plane Break Line)
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You can also project construction lines from rotated section lines:

1. Choose the New section line tool .
2. Create a line which intersects the profile by setting first a start point, a second point 

where the line changes its direction and at last an end point.
3. Select the Project rotated construction lines from a section line tool .

The construction lines are projected as shown in the following figure.

Please note: The projection tools are only enabled if any object is selected on the sheet.
A section line must be selected to generate the construction lines with the tool.

Figure 721 Projected Construction Lines From a Rotated Section Line
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x
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This chapter describes how to use MEDUSA4’s 2D modeling functionality.

• Introduction to 2D Modeling ................................................... 700

• Centerlines, Hidden Lines and Crosshatching....................... 701

• Sweeping Profiles .................................................................. 704

• Edge Projection...................................................................... 707

• Popup Menu........................................................................... 708

• Project End Elevations of Shafts and Holes .......................... 709

• Rotate Profiles to Form Shafts ............................................... 711

• Rotate Profiles to Form Sectioned Shafts .............................. 712

• Rotate Profiles to Form Sectioned Holes............................... 713

• Restore Profiles ..................................................................... 714
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Introduction to 2D Modeling

With MEDUSA4’s 2D modeling functionality, you can quickly produce orthogonal views within a 
2D drawing from the minimum of geometry. Once you have created an initial view, using exist-
ing drafting facilities, you can then create orthogonal views of the geometry contained in the ini-
tial view.

The following modeling operations enable you to produce orthogonal views from an initial geo-
metric view:

• Profile extrusion

• Shaft volume of revolution

• Sectioned shaft volume of revolution

• Sectioned hole volume of revolution

• Volume of revolution end view

• Edge projection

2D Modeling Tools

The following figure shows the 2D modeling tools, which you can find in the Lines tab.

Figure 722 2D Modeling Tool
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Centerlines, Hidden Lines and Crosshatching

A Properties dialog associated with each 2D modeling tool (except Create surfaces from profiles and 
Restore Profiles) allows you to define whether you wish to create centerlines or hidden lines as 
default when you use the modeling tool.

To display the Properties dialog for a tool:

1. Move your cursor over the tool.
2. Press the RMB to display the popup menu.
3. Select Properties.

The properties dialog opens which looks similar to that one in the figure below.

Figure 723 Sectioned Shaft Properties Dialog

The following parameters and buttons are offered:
Create centerlines

If this option has a check mark, centerlines are drawn (for examples see “Create Cen-
terlines” on page 702).

Create hidden lines

If this option has a check mark hidden lines are drawn (for examples see “Show Hid-
den Lines” on page 702).

Hidden line style

is only available if Create hidden lines is chosen. It sets the line style of hidden lines.
Create crosshatching

Only available for the Rotate profiles to form sectioned shafts tool described in “Rotate Profiles 
to Form Sectioned Shafts” on page 712.
If this option has a check mark, sectioned areas are drawn crosshatched (for examples 
see “Create Crosshatching” on page 703).

OK, Cancel, Help

work as usual.
Defaults

resets the properties to the default values.

Please note: When using the 2D modeling tools, you can override the defaults using the cen-
terlines, hidden lines, and crosshatching options in the popup menus.
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Create Centerlines

Select the Create centerlines choice box inside the properties dialog to define the centerpoint of any 
2D modeled view with centerlines. An example of this is illustrated in Figure 724.

Figure 724 Showing Centerlines

Show Hidden Lines

Select the Show hidden lines choice box to draw lines that would normally be hidden from view 
direction. When you select this choice box, the Hidden line type text entry box becomes active. 
Enter the line style that you want to use for hidden lines.

An example of showing and hiding normally hidden lines is illustrated in Figure 725.

Direction of view

Selected geometry

Axis of rotation

Created
centerlines

Direction of view
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Figure 725 Showing and Hiding Normally Hidden Lines

Create Crosshatching

Select the Create crosshatching choice box to create crosshatching with the sectioned shaft volume 
of revolution operation. An example of showing crosshatching is illustrated in Figure 726.

Figure 726 Showing Crosshatching

Omit hidden lines

Axis of rotation

Show hidden lines

Direction of view

Axis of rotation

Selected geometry

Selected geometry

Axis of rotation

Result
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Sweeping Profiles

Profile sampling is a 2D modeling operation that produces an orthogonal view from selected 
geometry. The orthogonal view created is that which you would see by looking at the selected 
geometry from a specified view direction. An example of this is illustrated in Figure 727.

Figure 727 Example of Profile Sampling

Popup Menu While Sweeping a Profile

While sweeping a profile you use the popup menu available by clicking the RMB.

Figure 728 Popup Sweep Profiles

The popup menu provides the following entries:
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View Direction

sets up MEDUSA4 for probing two points for the direction of view. The first probed 
point is the from point (see the message area for Enter from point) and the second point 
is the to point (the message area displays Enter to point). 

View Direction...

opens the View Direction dialog (for details see “View Direction Dialog” on page 705).
Create centerlines

The check mark in front of this entry shows that drawing centerlines is switched on 
which is the default setting. If you click the LMB on the entry Create centerlines the check 
mark disappears and the option is deactivated.

Create hidden lines

Drawing hidden lines is off (default). If you click the LMB on Create hidden lines, hidden 
lines will be drawn for the resulting profile, a check mark appears in front of the entry 
and the option is activated.

Undo

is used for canceling the last action. You can undo several actions. Its number 
depends on the number of actions stored to the history stack.

Exit Tool

quits the tool. 

View Direction Dialog

The View Direction dialog allows you to specify the direction from which you look on the profile. 
This view is used for sweeping the profile. You can either choose an arrow or insert a value for 
an angle for defining the view direction.

While sweeping a profile open the popup menu by clicking the RMB and choose the View Direc-

tion... entry for displaying the View Direction dialog.

Figure 729 View Direction Dialog

The dialog offers the following entries:
Arrow field

is used for defining the view direction by fixed angles from 0 to 315 degrees, step 45 
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degrees. The arrowhead points to the profile. For example, the horizontal arrow on the 
left pointing to the right means that the profile is swept from the left. It is like you would 
stay at this position and look into the direction of the profile.

View Direction

shows the value for the angle defining the view direction. For example, 270 degrees is 
used for sweeping the profile from the bottom.

Performing Profile Sampling

You perform profile sampling by doing the following steps:

1. Choose the Sweep Profiles tool .
2. Select the geometry on which you want to perform profile sampling.
3. Select one of the View Direction items from the popup menu in order to define the view of 

the geometry which is swept.
Details for defining the view direction are described in “Popup Menu While Sweeping a 
Profile” on page 704 and “View Direction Dialog” on page 705.

4. Specify the angle and distance of the extrusion. 
According to the choice of step 3 you can either
• make two probes whilst the first one is the from point and the second one is the to 

point, or
• choose an arrow or type in the angle of extrusion inside the View Direction field.
Now MEDUSA4 knows from where to see the geometry for sweeping the profile.

5. Make a probe to define the datum point which defines where to begin the sampling 
(the message area displays Enter datum point).

6. Define the depth point which defines the distance for which the sampling is made (the 
message area displays Enter depth point). You can either
• make another probe to define the distance, or
• type a numerical distance in the Distance edit field appearing below the dashboard.
The profile is swept from the desired view direction at the defined datum point with the 
specified depth.
706 © CAD Schroer GmbH



MEDUSA4 Drafting
Edge Projection
Edge Projection 

Edge projection is a 2D modeling operation that creates a face from an object. The line created 
is that which you would see by looking along a specified view direction at the edge of the 
selected geometry, which is considered to be of zero thickness. You can create points of inter-
est on the face to aid subsequent construction. An example of edge projection is illustrated in 
Figure 730.

Figure 730 Example of Edge Projection

To perform edge projection:

1. Choose the Projects surfaces from profiles tool .
2. Select the geometry on which you want to perform edge projection.
3. Choose the type of view you wish to create from the popup menu. 

You can choose either
• Horizontal View to create edges perpendicular to the horizontal viewing direction from 

the selected data (this item is the default), or
• Vertical View to create edges perpendicular to the vertical viewing direction from the 

selected data, or
• Oblique View to make two probes in the drawing area to specify the direction of view-

ing (whilst the first probe is the from point and the second one is the to point).
The edge projection is displayed attached to the mouse cursor.

4. Make a probe to specify the datum point.
The edge projection is placed inside the drawing area at the position you defined.
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Popup Menu

The popup menu described in this section is valid for all the tools which create rotation profiles, 
elevations and sections. These tools are described in:

• “Project End Elevations of Shafts and Holes” on page 709

• “Rotate Profiles to Form Shafts” on page 711

• “Rotate Profiles to Form Sectioned Shafts” on page 712

• “Rotate Profiles to Form Sectioned Holes” on page 713

While rotating a profile the following popup menu is available by clicking the RMB.

Figure 731 Popup Rotate Profiles

The popup menu provides the following entries:
Axis of Rotation

defines the rotation axis by making two probes in the drawing area (whilst the first 
probe is the from point and the second one is the to point).

Create centerlines

The check mark in front of this entry shows that drawing centerlines is switched on 
which is the default setting. If you click left on the entry Create centerlines the check mark 
disappears and the option is deactivated.

Create hidden lines

Drawing hidden lines is off (default). If you click left on Create hidden lines, hidden lines will 
be drawn for the resulting profile, a check mark appears in front of the entry and the 
option is activated.

Create crosshatching

Only available for the Rotate profiles to form sectioned shafts tool described in “Rotate Profiles 
to Form Sectioned Shafts” on page 712.

Undo

is used for canceling the last action. You can undo several actions. Its number 
depends on the number of actions stored to the history stack.

Exit Tool

quits the tool. 
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Project End Elevations of Shafts and Holes

End elevation is a 2D modeling operation that produces an orthogonal view from selected 
geometry. The orthogonal view created is that which you would see along the axis of rotation by 
revolving the selected geometry around a given axis to produce a solid shaft. You can use end 
elevation to produce end views either of a shaft or a hole. 

To create an end elevation:

1. Choose either the Projects end elevations of shafts tool  or the Projects end elevations of holes 
tool . 

2. Select the geometry on which you want to create an end elevation.
In Figure 732, “Shaft End View” and Figure 733, “Hole End View” on page 710 this is 
the left-hand geometry in each case.

3. Use the popup menu to define whether you want to create or omit centerlines and hid-
den lines.
For details see “Popup Menu” on page 708

4. Select Axis of Rotation from the popup menu.
5. Make two probes in the drawing area to define the axis of rotation (the first probe is the 

from point and the second one is the to point).
The end elevation is attached to the mouse cursor and you can move it in x-direction to 
the left or right.

6. Move the end elevation to its target position and click left to specify the datum point. 
The end elevation is placed at the specified datum point.

Figure 732 Shaft End View
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Figure 733 Hole End View
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Rotate Profiles to Form Shafts

Rotate profile to form a shaft is a 2D modeling operation that produces an orthogonal view from 
selected geometry. The orthogonal view created is that which you would see by revolving the 
selected geometry around a given axis to produce a solid shaft. An example of this is illustrated 
in Figure 734.

Figure 734 Example of Rotating a Profile to Form a Shaft

To perform rotating a profile to form a shaft:

1. If needed draw the axis of rotation at the geometry you want to work on.
For example, in Figure 734, “Example of Rotating a Profile to Form a Shaft” you need 
not to do this because the upper two points can be used for defining the axis of rota-
tion.

2. Choose the Rotates profiles to form shafts tool .
3. Select the geometry you want to rotate.
4. Use the popup menu to define whether you want to create or omit centerlines and hid-

den lines.
Details on the popup menu are described in “Popup Menu” on page 708, see also 
“Centerlines, Hidden Lines and Crosshatching” on page 701.

5. Select Axis of Rotation from the popup menu.
6. Make two probes in the drawing area to define the axis of rotation whilst the first probe 

is the from point and the second one is the to point.
The selected geometry is rotated at the rotation axis you defined and you get the 
desired result.
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Rotate Profiles to Form Sectioned Shafts

Rotate profiles to form sectioned shafts is a 2D modeling operation that produces an orthogonal 
view from selected geometry. The orthogonal view created is that which you would see by 
revolving the selected geometry around a given axis to produce a solid shaft that has been sec-
tioned along its central axis. An example of this is illustrated in Figure 735.

Figure 735 Example of Sectioned Shaft Volume of Revolution

To rotate a profile to form a sectioned shaft:

1. Choose the Rotates profiles to form sectioned shafts tool .
2. Select the geometry which you want to rotate.
3. Use the popup menu to define whether you want to create or omit centerlines, hidden 

lines and crosshatching.
Details on the popup menu are described in “Popup Menu” on page 708, see also 
“Centerlines, Hidden Lines and Crosshatching” on page 701.

4. Select Axis of Rotation from the popup menu.
5. Make two probes in the drawing area to define the axis of rotation.

The selected geometry is rotated at the rotation axis you defined and you get the 
desired result.

Selected geometry

Result

Axis of rotation
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Rotate Profiles to Form Sectioned Holes

Rotate profiles to form sectioned holes is a 2D modeling operation that produces an orthogonal 
view from selected geometry. The orthogonal view created is that which you would see by 
revolving the selected geometry around a given axis to produce a sectioned hole. An example 
of this is illustrated in Figure 736.

Figure 736 Example of Sectioned Hole Volume of Revolution

To rotate a profile to form a sectioned hole:

1. Choose the Rotates profiles to form sectioned holes tool .
2. Select the geometry which you want to rotate.
3. Use the popup menu to define whether you want to create or omit centerlines and hid-

den lines.
Details on the popup menu are described in “Popup Menu” on page 708, see also 
“Centerlines, Hidden Lines and Crosshatching” on page 701.

4. Select Axis of Rotation from the popup menu.
5. Select two points in the drawing area to define the axis of rotation.

The selected geometry is rotated at the rotation axis you defined and you get the 
desired result.
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Restore Profiles

You can restore profiles after performing the following 2D modeling operations:
• ”Sweeping Profiles”
• ”Edge Projection”
• ”Rotate Profiles to Form Shafts”
• ”Rotate Profiles to Form Sectioned Shafts”
• ”Rotate Profiles to Form Sectioned Holes”

The Restore profile tool deletes the geometry that has been created using 2D modeling facilities 
and retrieves its original profile.

To restore a profile:

1. Choose the Restores profile tool .
The following dialog opens:

Figure 737 Restore Profile Dialog

As long as no profile is selected all entries are disabled except the buttons Cancel and 
Help.

2. Select the modeled geometry whose profile is to be restored by clicking left near to it 
inside the drawing area.
At this stage you can select components only. Accordingly the message area displays 
the entry Choose a component.

3. Click Continue to replace the component with the original geometry.
The original geometry is displayed again. The Restore Profile dialog remains open but the 
entries are disabled (except the buttons Cancel and Help) until you select a further com-
ponent.
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The reference sheet procedure is an easy way of getting a first overview of an assembly by ref-
erencing single drawings or parts of drawings in one sheet.

• Overview................................................................................ 716

• Porthole Tools ........................................................................ 717

• Creating Porthole Elements ................................................... 718

• Controlling the Copy Protect Flag .......................................... 720

• Reference Tools ..................................................................... 721

• Creating a New Reference..................................................... 722

• Loading, Converting, Deleting and Comparing a Reference . 724
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Overview

MEDUSA4 provides the possibility to reference drawings inside a sheet. Reference tools are 
located in the Lines tab, Sheet Reference tool group and they are shown in Figure 738.

Figure 738 Sheet Reference Tool group - Overview Tools
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Porthole Tools  

Porthole elements are used to define a certain part of a drawing for using it as reference. This 
section gives you an overview of the tools which create porthole elements.

Figure 739 Tools for Creating Porthole Elements

In the toolset you find the following tools from top to bottom:
CPH - Create a porthole group

allows you to create a group from the porthole elements.
LPH - Create a porthole line

creates a porthole line.
LPH Box - Create a rectangular porthole

creates a rectangular porthole.

On the right hand side of the toolset you find the following tools from top to bottom:
Create the porthole datum prim

creates the porthole datum prim.
Create porthole definition text

create the porthole definition text.
Control Copy Protect Flag

opens the copy protect flag dialog which allows you to switch whether a porthole ele-
ment can be copied or not. Details are explained in “Controlling the Copy Protect Flag” 
on page 720.

While creating porthole elements popup menus are available which provide the same functions 
as for creating regular elements like lines, texts and rectangles. Creating porthole groups and 
datum prims is executed immediately on the selected elements therefore there is no popup 
menu available.
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If you want a drawing or a part of a drawing used as reference inside other sheets, for example, 
to assemble a machine, then you have to define it as porthole. 

The following procedure shows you how to do that:

1. Open the sheet from which you want a part to be referenced.
2. Choose the CPH - Create a porthole group tool .

The field in the status area indicates that the current level is the porthole group (Port-
hole Group). As a result you are able to create porthole elements now.

3. Define the area containing the part of the sheet you want to use as reference either by

a. choosing the LPH - Create a porthole line tool  and then drawing a closed line, or

b. choosing the LPH Box - Create a rectangular porthole tool , then clicking the LMB to 
probe the first corner of the rectangle and then clicking the LMB to probe the second 
corner.

Now you have the area enclosing the elements which are to be referenced.
4. Choose the Create the porthole datum prim tool .
5. Click the LMB inside the drawing area to place the prim in order to define the point at 

which the porthole will be placed as reference inside the assembly sheet.
6. Choose the Create porthole definition text tool .

The Porthole Definition dialog opens.

Figure 740 Porthole Definition Dialog

7. Select a Porthole-Type.
Following options are available:
• Inside Group

Only elements, which are completely inside the porthole line/rectangle, belong to 
the porthole element.

• Points

Only elements on sheet level, which have at least one point inside the porthole line/
rectangle, belong to the porthole element.
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• Section

All elements, which are inside the porthole line/rectangle and which are cut by the 
border line, belong to the porthole element.

• Elements

Only elements, which have at least one point inside the porthole line/rectangle, 
belong to the porthole element.

8. Enter the name in the Porthole field by which the porthole will be called for referencing it 
inside the assembly sheet.

9. Click the LMB inside the drawing area to place the porthole definition text.

Please note: If you do not want porthole name and options texts to appear on the reference 
sheet, you have to place them outside of the porthole line.

10.Save the sheet.
The creation of the porthole is complete and the sheet can now be referenced inside 
an assembly sheet. How to create a reference to this sheet, see the section “Creating 
a New Reference” on page 722.
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Controlling the Copy Protect Flag

Choose the Control Copy Protect Flag tool  to open the following dialog to switch whether a port-
hole element can be copied or not.

Figure 741 Copy Protect Flag control Dialog

The options on the left hand side of the dialog (e.g. Selection set) are used to define the elements 
on the sheet which are to get a protect flag. Layer and Style provide pull-down lists containing the 
layer names and the element styles of the current sheet.

Select an option and press the Set button to define the copy protect flag for the elements which 
can be identified by the chosen option. The Unset button removes the protection from all ele-
ments that match the current option. The Reset button removes the protection from all elements 
that was set since the dialog was opened. Cancel does the same as Reset but it also closes the 
Copy Protect Flag control dialog.

The Query button highlights all elements of the sheet with copy protection and opens a dialog 
that lists all options. The following example shows the query result:

Figure 742 Copy Protect Flag, Query Result
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Once you defined references you can use them for an assembly, for example. This section 
gives you an overview of the tools which work on references.

Figure 743 Tools for References

You find the following tools in the toolset:
RefNew

This option creates a new reference on the sheet. Then you can display the referenced 
sheet with Ref Load and use the other reference tools (for details see “Creating a New 
Reference” on page 722).

Ref Load

This option loads referenced elements, i.e. allows you to display all or selected refer-
ences. You can use this option only if you already created at least one reference on the 
sheet with RefNew.

You find the following tools on the right hand side of the toolset from top to bottom:
Convert reference

This option allows you to convert all or selected loaded references to regular elements. 
This function only works on references which are already displayed with Load reference.

Delete reference

This option deletes (hides) all or selected references. This function only works on refer-
ences which are already displayed with Load reference.

Compare selected reference

The tool is used to compare a selected reference with the source drawing in order to 
make pending modifications of the source drawing visible. A click on the tool opens the 
Compare reference dialog and a file selector dialog (for details see “Comparing a Refer-
ence” on page 725).
© CAD Schroer GmbH                             721



MEDUSA4 Drafting
Reference Sheet Procedure
Creating a New Reference

Before you can display a drawing or part of it as reference you have to create this reference. To 
create a reference on your sheet, proceed as follows:

1. Open the sheet on which you want to reference the created porthole elements.
2. Choose the Ref New - Create a new reference tool .

Two dialogs open, the Open Sheet dialog and the Reference Group dialog.
3. Select the file name of the sheet with the porthole element you want to load as refer-

ence in the Open Sheet dialog and confirm your choice with Open.
The Reference Group dialog displays the chosen file name with the complete path in the 
Sheet field. 

Figure 744 Reference Group Dialog

4. Enter the porthole name, as defined while creating a porthole element, in the Porthole 
field (see “Creating Porthole Elements” on page 718).

Please note: The specification of the porthole name is the only mandatory command and is writ-
ten as REFSHT text string on your target sheet. Only one REFSHT command is 
allowed.

Following additional reference appearance commands can be specified within the 
Reference group dialog.
• Source layers/Target layers

Defines the layers of the source sheet, which are to be loaded into the target sheet. 
Source layers are mapped on the Target layers whereas the layers are automatically 
switched to visible and hitable. The command for source layers and target layers is 
written as REFLAY text string on the target sheet. Within one reference call several 
REFLAY-commands are possible.
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• Source lines/Target lines

Maps the line styles of the source to line styles of the target sheet. The commands 
for source lines and target lines is written as REFLIN text string on the target sheet. 
Within one reference call several REFLIN-commands are possible.

• Magnification

Specifies the magnification of reference information, which is loaded on the target 
sheet. The magnification command is written on the target sheet as REFMAG text 
string.

Furthermore you can define settings for visibility and selectivity. The command is writ-
ten as REFSWT text string on your target sheet.
• Visible/Hitable

The reference is visible and selectable on the sheet.
• Visible/Unhitable

The reference is visible but not selectable on the sheet.
• Invisible/Hitable

The reference is not visible but selectable - in the structure tree.
• Invisible/Unhitable

The reference is neither visible nor selectable.
5. Confirm your settings with Apply or OK.

The reference is attached to the mouse cursor and can be placed.
If you have pressed Apply the Reference Group dialog remains open.
OK closes the dialog.

6. Click left on the sheet to place the reference.
If you have chosen Apply in the last step, the Open Sheet dialog opens again for choosing 
another file. 
If you have chosen OK in the last step, the function is finished.

Now you should have at least one reference on your sheet which looks like the example given 
in the following figure. The first line REFSHT gives the file name, the second line REFMAG shows 
the magnification and the last line REFSWT shows you the set switches for visibility and selectiv-
ity (in the figure below it is set to visible VIS and selectable HIT)

Figure 745 Example For a Reference
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Loading, Converting, Deleting and Comparing a Reference

If you have created references, you can display, convert and hide referenced drawing elements 
with the help of the reference tools (see page 721). For all these reference tools a popup menu 
is available which allows you to apply the current function either on selected or all references of 
a sheet.

Loading References

1. Choose the Ref Load - Load referenced elements tool .
2. If you want to apply the function on selected references only, select references by 

drawing a selection frame.
3. Load the reference by using the popup menu.

Figure 746 Popup Menu for Reference Tools

After choosing an application entry from the popup menu the drawings or parts of 
drawings are displayed immediately on the sheet.

Please note: When using the Apply Selected option, all references that have the same sheet and 
porthole name as the selected references are renewed. This is to avoid having dif-
ferent versions of the same data on the sheet at the same time.

Converting References

The Convert reference tool  allows you to convert referenced drawings into regular elements. As 
a result you can edit these elements inside the current sheet. The procedure is the same as 
given for ”Loading References”.

Please note: There is no undo function for Convert reference. Converted references cannot be 
changed to references again.
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Deleting References

The Delete reference tool  allows you to make referenced drawings or parts of drawings become 
invisible. The procedure is the same as given for ”Loading References”.

Comparing a Reference

The function provides the possibility to compare a selected reference with the source drawing in 
order to show pending modifications of the source geometry.

1. Load a new reference and display it on the sheet.
The Reference Clump is created and shown in the structure tree, with a PDS sub-
group, which complies with the displayed referenced geometry.

Figure 747 Structure Tree showing the Reference Clump

2. Select the reference you wish to compare with its source either on the sheet or in the 
structure tree.

3. Choose the Compare selected reference tool .
A file selector dialog appears simultaneously with the Compare reference dialog.

4. Choose the source drawing of the reference in the file selector dialog.
The chosen filename with full path is transfered to the Sheet input field of the 
Compare reference dialog and the file selector dialog is closed.

Figure 748 Compare Reference Dialog with Input of Source File
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Sheet gives the full path to the sheet on which the original of the referenced geome-
try is placed.

Layer defines the layer on which the current geometry of the source will be written 
after having executed the compare process. Default setting is Graphical error 

messages. If desired, you can select another layer from a pulldown list.
Apply starts the compare process. The dialog remains open for the next comparison
OK starts the compare process. The dialog is closed.
Close closes the dialog and aborts the Compare selected reference tool.
Undo reverses the comparison process. The dialog remains open.
Help opens the online documentation.

5. Click Apply or OK to start the compare process.
The current geometry of the source reference is drawn into the sheet on the chosen 
layer.

6. Update the structure tree using the Refresh option from the right mouse popup menu.
A new RDS group is created within the Reference Clump.
The structure tree shows the differences between the previous (PDS group) and cur-
rent version (RDS group) of the referenced geometry.

Figure 749 Structure Tree showing the current (RDS) and previous Version (PDS) of the Reference

7. Select the RDS group in the tree to highlight the geometry of the current reference in 
the drawing, subsequently select the PDS group to highlight the previous state of the 
geometry - and compare both versions.

8. To delete the updated geometry use the Undo button from the Compare Reference dialog 
9. Press the Close button in the Compare reference dialog to close the dialog.
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Tools

Figure 750 View tools in the Miscellaneous tab

The tools have following functions:

Tool Function

Open individual detail view 2-5
The tool provides a pulldown menu to open the view window 2, 3, 4, or 5. Details are 
explained in “View Windows”, ”Opening a View Window” on page 729.

Displays a frame round a view in the presentation area and sets the style of the border
The tool opens the dialog for setting the properties of a view window. For details see 
“View Windows”, ”Setting View Properties” on page 730.

Drawing areas with a special scale
The tool opens the Scaled Views dialog where you can create and edit scale views with a 
special scale. By default the tool is activated. For details see “Scaled Views” on 
page 732.
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View Windows   

The view window facility enables you to open up to four windows showing views of your cur-
rent sheet, in addition to the main view window. The default window (that is, the main graphic 
display window) is named View 1 and the other windows are named Views 2 through 5. You 
can use this facility, for instance, to have the whole sheet displayed in one view window while 
you have a zoomed-in view in another.

Please note: All view operations like zooming and window view restorations (with the help of the 
tools from the In Graphics Tool Bar, see “In Graphics Tool Bar”, ”Overview of 
Functions” on page 88) occur in the current view window.

Opening a View Window

To display the sheet in a view window:

1. Click the arrow below the Open 2 tool to open the following pulldown menu:

Figure 751 Open View Windows Pulldown Menu

2. Select one of the views to open a new window in the drawing area.

Figure 752 View Window 2
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Each View has a Current View check button. It is automatically activated, when you open a new 
View window, i.e. this View is the current one and any zoom operation happens in the current 
view.

If you zoom in a detail within the main window, it is displayed in the current view window.

You have the possibility to zoom in any arbitrary view, either in the main window or in any other 
view, and display the detail in the current view.

If the Current View switch is not activated in any view, the main view is automatically made cur-
rent.

Setting View Properties

To set the properties for a view window, choose the Frames tool  from the View tool group. The 
following View Frames dialog is displayed:

Figure 753 View Frames Dialog

The View Frames dialog provides two settings for each view: 

• Whether frame borders are shown. 
When you select a Frame Border choice box, a frame border appears around the required 
selection area. You can see the frame in the main view as well as in the appropriate 
View, when you pan and zoom in.

• The pen type used for the frame borders.
The Pen number defines the line style for the border, for example, solid, dotted, chain, 
color and thickness.
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Figure 754 View Window Frame Property Example

Copy and Paste Between View Windows

Full copy and paste facilities are available between all view windows providing you with an 
effective means of working efficiently on complex drawings.

The example below shows the main view being used as a reference view to the whole sheet, 
while the view windows are used to copy geometry between different detail areas of the sheet.

Figure 755 Copying and Pasting Between View Windows
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Scaled Views

MEDUSA4 provides the Scaled Views functionality which allows you to work at several different 
scales within a sheet.

The scaled views are defined as specific areas on the sheet and are saved with the sheet 
including their scale information. The scales defined for these views become active when you 
move the cursor over them and special conditions are fulfilled.

This section contains the following sub-sections: 

• ”The Scale Views Dialog Buttons”

• “Creating Scale Views” on page 733

• “Editing Scale Views” on page 734

• “Displaying Scale Views” on page 735

• “Working with Scale Views” on page 736

• “Example: Detailing with Scale Views” on page 739 

The Scale Views Dialog Buttons

Click on the Scaled Views tool  to display the Scale Views dialog.

Figure 756 Scale Views Dialog

The buttons of the dialog have following functions:
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Creating Scale Views

To create a new scale view do the following:

1. Define the view area. There are several possibilities:
• Define a rectangular area on the sheet.

Click on the Defines the Size of the Scale View button .
Click the LMB on the sheet to define the first corner of the view. 
When you move your cursor a rectangle expands from this first point. 
When the rectangle has the required size, click again to set the second corner point. 
The coordinates of the corner points of this view appear in the coordinates entry 
boxes. Edit the coordinates in the entry boxes if required.

Table 12    Scale Views Dialog - Functions of the Buttons

Button Functions

Creates a new Scale View
After filling in the input fields and clicking on the button the data are stored in the sheet.

Deletes the selected Scale View
After selecting a Scale View on the pulldown list and clicking on the button the Scale View 
is deleted

Modifies the selected Scale View
After selecting a Scale View on the pulldown list and changing data in the input fields the 
data are applied for this Scale View

Shows all Scale Views
If you click on the button all Scale Views stored with the sheet are indicated by a frame. 
Name and scale are displayed inside the frame. The cursor has to be inside the dialog or 
outside the sheet area. Once you move the cursor over the sheet the Scale Views disap-
pear.

Refreshes the Scale View database
Clicking on the button re-loads the data of the Scale Views and the drawing is refreshed.

Defines the size of the Scale View
Click on the button and drag a rectangle around the area which is to be the defined as 
Scale View. The message line in the status area displays the necessary steps.

Actual view gets new Scale View
You can define a current view of the sheet as Scale View too. 
e.g., You have zoomed in on a detail of the drawing by using one of the tools in the quick 
menu bar. If you click on this button now, this detail view is defined as Scale View. Enter 
the data in the input fields and click on the Creates a new Scale View button. (see first table 
row)
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• Use the current window to define the view area:
Use the View tools from the quick menu bar to zoom into the required area.

Click on the Actual view gets new Scale View button . 
The coordinates of the corner points of this view appear in the coordinates entry 
boxes. Edit the coordinates in the entry boxes if required. 

• Define the view area by entering the coordinates of the required area directly into 
the Coordinate left below and Coordinate right top entry boxes.

2. Type a name for the view in the Name entry box.
3. Define the view Scale using the following format: 

• digit:digit    (For example 1:2) or
• digit/digit    (For example 1/2) or
• digit.digit    (For example 0.5)

4. Click on the Creates a new Scale View button  to create and save the scale view.
Now the name is displayed in the pulldown list of Available Scale Views.
If any of the fields is filled out wrong or if it is left empty, an error message appears (see 
Figure 757). In this case edit the required fields and click the Creates a new Scale View 
button  again.

Figure 757 Error Messages

Editing Scale Views

Modify Scale View Properties

Please note: You cannot change the name of a scale view.

To change the properties of a scale view: 

1. Click on the button  to display the Scale Views dialog.
2. Select the desired scale view from the pulldown list.

The scale view area is highlighted inside the drawing area and the properties are auto-
matically entered into the entry boxes.
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3. Edit the scale and coordinates as required. 
You can use the Defines the Size of the Scale View button  and the Actual view gets new Scale 

View button  to modify the coordinates.
4. Click the Modifies the selected Scale View button  to apply the modifications.

Delete Views

To delete a view, select a scale view from the list and press the Delete button . The view is 
deleted from the drawing.

Displaying Scale Views

Click the Shows all Scale Views button . All the scale views which are saved with the sheet are 
displayed by a frame. Use the Refresh button to redraw the graphics. The text displayed at the 
bottom of the outline area gives the view name and its scale. (See Figure 758, “Display Scale 
Views”)

Please note: The view frames are only visible whilst the cursor is over the dialog or if the cursor 
is over the appropriate part inside the drawing area.
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Figure 758 Display Scale Views

As required click on the Refreshes the Scale View database button  to redraw the data of the Scale 
Views in the drawing.

Working with Scale Views

Using the Scale of a Scaled View globally

If you wish to use the scale of a scale view in the entire drawing, you can do so by freezing it.

1. Open the Scaled Views dialog.
2. Choose the desired scaled view in the pulldown list.

The selected view is displayed on the sheet.
3. Activate the Use as temporary scale option.
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Figure 759 Scaled Views Dialog - “Use as temporary scale” Option

The temporary scale is displayed in the status area in brackets.

Figure 760 Status Area - Display of Temporary Sheet Scale

The view scale mechanism is switched off and the view scale can now be used tempo-
rarily for the entire drawing. The area defining the scale remains highlighted whilst its 
scale is active.

4. To switch off the temporary scale and reactivate the scaled views mechanism, remove 
the checkmark from the Use as temporary scale option and close the dialog.
Both the previously highlighted scaled view and the temporary sheet scale in the status 
area disappear.
Any existing scaled view is highlighted on the drawing once you move the cursor over 
it.

Copy / Paste

When you paste copied elements into a scaled view, the area scale is taken automatically.

Loading Symbols

When you load symbols, you are automatically given the temporary scale of the view in which 
you are loading the symbols.

The symbol size dynamically changes to correspond with the view area scale size as you move 
your cursor around the sheet. This allows you to see how the symbol size alters according to 
the view scale.
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For details on symbols see “Symbols - Home Tab” on page 593.

Dynamic Scaling

If you load symbols or if you paste copied elements you are able to switch dynamic scaling.

If dynamic scaling is not required select Dyn.Scaling OFF from the RMB popup menu.

If dynamic scaling is turned off select Dyn.Scaling ON from the popup menu to turn it on again.

Dimensioning

You do not need to switch the drawing-scale to dimension parts within the scaled view. Once 
dimensioning is active, the scale will automatically change whilst you are in a scale view.

During dimensioning you may extend the dimension line with the text beyond the scale view 
area, it will continue to keep the view scale. However consider that the dimension value can 
change when modifying the dimension later on because always the scale of the area is used, in 
which the cursor is located. You have the following possibilities for preventing a change of the 
dimension value:

• Extend the scale view in that way, that all dimensions are completely inside the scale 
view.

• Edit the dimension and switch on the option Text Lock from the popup menu. This option 
corresponds to all dimensions. Do not forget to switch it off again by clicking on Text 

Unlock after finishing the dimension modification. Details on the function Text Lock are 
described in “Dimensioning - Home Tab”, ”Popup Menu 1” on page 445.

• You can freeze the scale view by using the Use as temporary scale option on the Scaled Views 
dialog (see Figure 759).

Please note: Do not forget to switch it off the Use as temporary scale option after finishing the dimen-
sion modification, otherwise it is also applied to elements which are outside the 
scale view area. 

For details on dimensioning see “Dimensioning - Home Tab” on page 413.
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Figure 761 Scale Views

Measuring

The Measure function also works within scale views. The output of the measurements is to the 
correct scale. (For details on Measuring, please refer to “In Graphics Tool Bar”, ”Measure” on 
page 103)

Dynamic Auxiliary Lines

While drawing dynamic auxiliary lines (see “Construction Lines - Home Tab”, ”Dynamic Con-
struction Lines” on page 483) inside scaled views, the entered values are according to the area 
scale. 

Example: Detailing with Scale Views

To detail the view below:
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Figure 762 Detailing with Scale Views

1. Click on the ribbon > Misc > Scaled View on the Drawing areas with a special scale button .
2. The Scale Views dialog is displayed.
3. Create a scale view in the top right hand area of the sheet, with the name detail x 

and the scale 1:1.
4. Load the required detail graphics into this area. 

You have several options to do this:
• If the selection is a group or a multiple selection, either copy the section using copy 

and paste or unload it as a symbol (see “Symbols - Home Tab” on page 593).
• Use group lines (see “Transformation”, ”Boundary Groups” on page 332) and the 

Area Copy tool as explained in “Clipboard”, ”Area Cut and Area Copy” on page 318. 
The section is attached to the crosshair and can be inserted at the correct position.
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Figure 763 Detail

Figure 764 Insert Detail into Scale View

When inserting the detail into the scale view area, the scale is changed accordingly. Now it can 
be dimensioned without changing the temporary scale.
© CAD Schroer GmbH                             741



MEDUSA4 Drafting
View - Misc Tab
Figure 765 Detailed Scale View
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Tools

Figure 766 Transformation tools in the Miscellaneous tab

Shear Elements

Selected elements can be sheared on the sheet either in horizontal, vertical or oblique direction. 
As for moving elements you can copy elements one or more times before shearing them. 

Figure 767 Toolset for shearing horizontally    

Figure 768 Toolset for shearing vertically 

From top to bottom you find the following tools:
• Shears the selected elements horizontally

• Duplicates and shears the selected elements horizontally

copies the selection and then shears the copy.
• Duplicates and shears the selected elements horizontally with an optional repeat

copies the selection and then shears the copy. This operation will be repeated auto-
matically as often as you have defined this (for this the additional input field Repeat is 
provided).

• Shears the selected elements vertically

• Duplicates and shears the selected elements vertically 

• Duplicates and shears the selected elements vertically with an optional repeat 
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Shearing elements has the same work flow as it is for rotation (see “Transformation“, “Rotate 
Elements” on page 325). 

1. You select elements, 
2. choose the tool, 
3. define the datum point, 
4. specify the angle or ratio by which the elements are sheared,
5. and if requested enter the number of repetitions.

The shear tools provide a popup menu which allows you to switch between the tools. The cur-
rent tool is displayed grayed out. The options Undo and Exit Tool work as usual.
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Create Arrays

Selected elements can be copied and arranged as arrays by defining the number and spacings 
between the placements in X and Y direction.

The Array tool  opens the following dialog:

Figure 769 Array

The Array dialog has the following items:
Sheet Units, Grid Units

defines the kind of units used for the spacings in X and Y direction (X step and Y step).
X step, Y step

defines the spacing between the placements of the selected elements.
For example, if you define 100 for the X step and the selected element is a rectangle 
then the spacing between the left bottom points of the placed rectangles is 100 units.

Number in X, Number in Y

defines the number of placements of the selected elements in X and Y direction (col-
umns and rows).

OK, Apply

place the selected elements as an array. 
In case of OK the dialog is closed.
In case of Apply the dialog remains open. 
Whenever you apply placing an array, a new one is created. So, if you want to change 
an already placed array, Undo the last placement using the popup menu before apply-
ing your changes again.

Cancel, Help

work as usual.
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Figure 770 Example
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Dynamically Aligning Geometry Along a Line

You can dynamically align elements on existing line segments. Such line segment can be 
straight, circular arcs, complete circles or even ellipses. For this the selected geometry is cop-
ied. The original geometry remains unchanged.

This is how to align elements dynamically:

1. Select the geometry that you wish to align.
2. Select the Aligns geometry along a line tool .
3. Select the datum point of the selected elements.

A copy of the selected elements is attached to the crosshair with the chosen datum 
point.

4. Switch on dynamic aligning by using Dyn. aligning on from the popup menu. 

Figure 771 Popup Menu for the Tool Aligns geometry along a line

Now you are able to align the selected elements at any line of the sheet.
Details on the other entries of the popup menu can be found in “Symbols - Home Tab“, 
“Loading Named Symbols” on page 596.
• How to change properties of the selected geometry, for example, is explained in 

“Symbols - Home Tab“, “Symbol Properties” on page 604.
• An example for changing the datum point is described in “Changing the Datum 

Point” on page 749.
5. Move the cursor around the sheet, close to other elements until the elements are 

aligned as required.
6. Click the LMB to place the elements on the sheet.
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Changing the Datum Point

If you find out that the datum point of the selected geometry is not optimal when moving the 
mouse, you can change it at any time.

Figure 772 Example for Aligning Geometry along a Line, Datum Point is not optimal

The following procedure assumes that the geometry to be aligned at a line and the tool for doing 
it is already selected.

1. Press the RMB and choose the option Move Datum by Probing.

Figure 773 Example for Aligning Geometry along a Line, Popup Menu

The tool tip shows the next steps.
2. Click the LMB at a free place in the graphics area to place the selection temporary.

The selected geometry is no longer at the cursor but on the sheet and it is displayed 
highlighted.
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Figure 774 Example for Aligning Geometry along a Line, Geometry temporary placed

3. Click the LMB on the point of the geometry which is to be the new load point (datum 
point).
The selected geometry is attached to the mouse cursor again with the new load point 
and can be placed now.

Figure 775 Example for Aligning Geometry along a Line, Datum Point changed
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Move Geometry by Grid Spacing

MEDUSA4 provides the possibility to move a geometry by a specified factor of the current grid 
spacing in a defined direction.

1. First de-select all elements on the sheet.
2. Then choose the Grid header in the dashboard.
3. Activate the option Draw in the dashboard in order to display the current grid and clarify 

the mode of operation of the tool.

Please note: If the Polar option in the Grid Properties dialog is activated, moving the geometry is not 
possible by using the tool .

4. If the current grid is a polar one, click the Display/Edit Grid Properties button  in the sta-
tus area to open the Grid Properties dialog.

5. Then switch on Cartesian grid in the Cartesian area.

Figure 776 Grid Properties Dialog with Settings of Spacings

6. Select geometry on the sheet.
7. Choose the Moves geometry multiple of a grid offset tool .

The MoveByGrid dialog appears.

Figure 777 MoveByGrid Dialog

The arrows define the direction of movement. 
In the text field in the middle enter the factor. Then the movement in sheet units is the 
result of grid spacing multiplied by factor. For example, if you enter 3 and chose the 
arrow to the right, the selected geometry will be moved by 3 x 5 = 15 sheet units in X 
direction to the right.

8. Enter a factor and click the LMB on an arrow to move the selection.
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SELECTION - MISC TAB
This chapter provides information about selection tools which are available on the Misc tab of 
the ribbon in the Selection tool group.
These tools make possible a filtered selection.

• Selection Tools - Overview..................................................... 754

• Power Selection Tool ............................................................. 757

• Selecting Elements by Attributes ........................................... 764

• Changing Selection Sets........................................................ 765
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Selection Tools - Overview 

Following tools are available on the Misc tab > Selection tool group:

Figure 778 Misc Tab > Tool Group Selection

The tool displayed by default is the Power Select tool . When you click on the tool button the 
Power Selection Dialog is displayed. It allows to define selection criteria in order to make selection of 
elements from a large data amount easier. The dialog is described in detail in section “Power 
Selection Tool” on page 757.

Please note: You can also display the Power Selection Dialog from the general RMB popup menu.

The small triangle next to the tool text indicates that a pulldown menu can be displayed when 
you click on the button. The menu provides a set of selection tools. Once you select a tool it is 
displayed in the Selection tool group.

Figure 779 Pulldown Menu with Selection Tools - Example: Display of Toggle Tool
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The tools on the pulldown menu have following functions:
Table 13    Functions of Tools on the Selection Pulldown Menu

Tool Function

Power Select
opens the Power Selection Dialog on which you can define selection criteria. You can 
select elements by Type, Class and Layer.
The dialog can also be displayed via general RMB popup menu within the graphics 
area (see “Power Selection Tool” on page 757).

Select All
selects all the elements on the sheet.

Toggle Selection
selects any element which is currently deselected and it deselects all elements 
which are currently selected (see “Selection Methods”, ”Toggling a Selection and 
Extend Selection” on page 131).

Select Flagged
selects elements which previously were marked with the Flag Selected tool.

Flag Selected
marks selected elements. You can very quickly restore the marked selection later by 
using the Select Flagged tool.

Clear Flagged
removes flags from all elements marked with the option Flag Selected. After using this 
option the sheet has no element, which can be selected with the option Select 
Flagged.

Deselect All
deselects any selected element on the sheet.
You also find this tool in the RMB popup menu. (see “Work Environment”, ”Popup 
Menus” on page 44 and “Selection Methods”, ”Cancel Selection” on page 131).

Alternate Color
sets the selection to alternate color
displays all selected elements in alternative color. After selecting this function all ele-
ments are deselected. For not selected elements the alternative color is light gray, 
for selected it is violet.

Reset Alt. Color
resets alternate color on the sheet
sets the display of all elements on the sheet back on its standard colors
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Additional tools in the Selection tool group are:
Table 14    Additional Tools in the Selection Tool Group

Tool Function

Attribute
selects Elements by Attributes
opens the Select Elements by Attributes dialog. See “Selecting Elements by Attributes” 
on page 764.

Deselect Once
deselects elements inside a selection rectangle
is used while adding selections using the Shift key. (see “Changing Selection 
Sets” on page 765 and chapter “Selection Methods”, ”Toggling a Selection and 
Extend Selection” on page 131) Deselect Once avoids selecting currently deselected 
elements whilst dragging a selection rectangle. Any elements that are already dese-
lected remain deselected while dragging over them again.

Once
selects elements inside a selection rectangle
is used while adding selections using the Shift key. (see “Changing Selection 
Sets” on page 765 and “Selection Methods”, ”Toggling a Selection and Extend 
Selection” on page 131) Select Once avoids deselecting currently selected elements 
whilst dragging a selection rectangle. Any elements that are already selected remain 
selected while dragging over them again.
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Power Selection Tool

The tool allows selection by any combination of class, style, layer and color and their properties. 
Any deselected property is not considered as selection criterion.

You have several possibilities to display the Power Selection Dialog.
The button  to open the dialog is available on the ribbon > Misc tab > Selection tool group and 
on the RMB general popup menu > Power Selection option.

Figure 780 Power Selection Dialog 
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The dialog provides the following parameters:
Selection Criteria Options

From left to right you find the option boxes for Element Class, Style, Occupied Layers, Shape, 

Bold and Color. If a box contains a check mark the relevant selection criterion is chosen 
for selecting elements.

Element Class Buttons

These buttons predefine the element class which can be selected or not. You can pre-
define Lines, Single Line Texts, Multi Line Texts, Prims, Dimensions, Crosshatches, Notes, Part Balloons 
and Tables for selection. If a class is chosen the button looks like being pressed. Buttons 
of element classes which do not exist on the sheet appear grayed out, i.e. disabled.

Style list

gives you all element styles available in the current sheet. 
Occupied Layer list

gives all layers available in the current sheet.
Shape list

gives all shapes available in the current sheet. 
Bold list

gives all boldnesses available in the current sheet. 

For the Style, Layer, Shape and Bold lists the following is valid:

• Items which can be used for selecting elements are displayed black. 

• Items which are displayed grey are disabled and cannot be selected.

• If you deselect an item in one list, items in other lists will be deselected too. For exam-
ple, if you deselect the element class Lines, styles like construction and solid thick are dese-
lected too. 

Color list

gives all colors available in the current sheet. If a color can be used for selecting ele-
ments, a little white square is displayed inside the color. If a grey rectangle is dis-
played, there are no appropriate elements with this color. For example, if you open a 
new sheet and select the element class Single Line Texts, all colors have a grey rectangle 
except the black one, it contains a white square.

Selection mode

allows you to use properties of selected elements for predefining selection criteria, or 
to use the settings from the Power Selection dialog (for details see “Selection Modes” on 
page 759).

Save filter in custom selector button

allows you to save the current filter options to a user defined button placed inside the 
the RMB pulldown list of the In Graphics Tool Bar (for details see “Save Filter as User 
Selection Button” on page 762).

Multiple Selection Option Button

opens a further list allowing you to combine settings for filtering in order to define multi-
ple selection criteria (for details see “Multiple Selection” on page 761).
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Buttons:
Select all 

selects all elements using the current selection criteria on the whole sheet.
Draw Selection only

hides all elements of the sheet which are currently not selected and shows all elements 
which are currently selected. Refresh Graphics from the In Graphics Tool Bar redisplays all 
elements again.

Update 
After modifications in the drawing this button updates the lists.

Filter Selection 
applies the current selection criteria on the current element selection on the sheet. Use 
this button, if you want to select certain elements of a group, for example. Consider 
that you have to activate the option Modify filter / Use for selection before using this button in 
order to change the selection filter.

Close, Help 
work as usual.

The following sections give further information on using the dialog.

Lists Popup Menu - Select All and Deselect All Option

Inside the lists of the Power Selection Dialog a popup menu is available allowing you to select or 
deselect all enabled list entries:

1. Move the cursor either over the list of styles or layers.
2. Press the RMB for opening the popup menu.

Figure 781 Select All or Deselect All Popup Menu

3. Choose an option.
Select All selects all enabled entries of the current list and Deselect All deselects them.

Selection Modes

The Power Selection Dialog has two different modes:

• Building a selection filter by selecting elements within the sheet and
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• using the filter settings of the dialog to select elements within the sheet.

Build Filter from Element Selection within the Sheet

To build a selection filter by selecting elements within the sheet:

1. Select elements from the sheet.
The display of the dialog is updated and the properties of the selected elements are 
highlighted.

2. Click the Build filter from sheet selection radio button.

Figure 782 Selecting Modes (1) 

3. Press Select All to use the current criteria for selecting elements on the whole sheet.
Any elements in the current drawing become selected if their properties accord with 
the properties of the elements selected first (in step 1).

Modify Filter and Use for Element Selection

To use the selection criteria defined in the Power Selection Dialog to select elements on the sheet:

1. Click the Modify filter / Use for selection radio button.

Figure 783 Selecting Modes (2)

The top part of the dialog is then enabled for modification.
2. Set selection criteria in the dialog, for example, by clicking in the lists for choosing a 

certain style or layer.
As you click on a list entry it becomes highlighted.
Clicking a second time on the same entry deselects it.

3. Now you either 
a. select all elements with the defined properties on the sheet by clicking Select All, or
b. move the cursor over an element or select an area by drag selection (see “Dragging 

Selection Rectangle” on page 129) to select certain elements with the defined prop-
erties.
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Multiple Selection

The Power Select tool allows multiple selection criteria to be assembled. As a result you define the 
filter for selecting elements more precisely and you can combine any properties (for example, 
all elements colored green and all elements colored blue on a certain layer).

Do the following steps for defining a multiple selection table:

1. Click the button  right at the bottom of the dialog. 
The multiple selection table opens. Now you can define several selection criteria.

Figure 784 Multiple Selection Dialog

The  button extends the list of selection.
The  button removes entries out of the list.

2. Click on a line inside the table in order to select this line.
3. Choose a selection mode (see “Selection Modes” on page 759).

According to your choice, now settings inside the Power Selection Dialog or selections 
inside the drawing area are applied to this selected line.

4. Depending on step 3 either
a. select elements inside the drawing area, or
b. select the properties inside the Power Selection Dialog.
As you select an element or as you choose a property in the Power Selection Dialog the line 
(you chose in step 2) of the multiple selection table updates immediately.
Now you can define further lines.

5. Add a new line by clicking on the  button of the last line in the table.
The new line is appended at the end of the table and it has the same entries as the 
previously line you worked on.

6. Adjust this new line to your needs according to step 3 and 4.
7. Repeat the steps 5 and 6 until you defined all selection criteria used for filtering select-

ing elements on the sheet.
Now you can save these settings to a selector button (for details see “Save Filter as 
User Selection Button” on page 762).
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Save Filter as User Selection Button

MEDUSA4 allows you to store the criteria you defined within the Power Selection Dialog to a tool 
button which is available as selection tool on the RMB pulldown menu in the In Graphics Tool 
Bar. Then you have easy access on the defined filter settings used for selecting elements.

For saving filter settings to a user selector button:

1. Click on the Save filter in custom selector button  which opens the following dialog.

Figure 785 Save Filter Dialog

The edit field provides an automatically created name for the selection tool you are 
going to create. In front of this name an icon is displayed which will be used for the 
tool.

2. If you want to change the tool name click into the field and type a different name.
3. If you want to change the icon for the tool click the LMB on the icon in front of the edit 

field.
Another dialog is opened listing all symbols inside the default directory of the 
MEDUSA4 installation. You can choose another symbol and then click the LMB on OK.

4. Choose Save inside the Select Icon dialog.
The selection tool is created inside the pulldown menu of the In Graphics Tool Bar as 
shown in the following figure.
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Figure 786 In Graphics Tool Bar > RMB Pulldown Menu - User defined Selection Tool

By default the tool button looks like this: . When you move the cursor over the custom selec-
tion tool, a pulldown menu with three options is displayed:
Select

applies the saved selection filter to a selection.
Properties

opens the Edit Custom Selection Filter dialog displaying the selection criteria that you have 
previously saved.
Now you can change the filter criteria.

Apply to Selection

applies the saved selection filter to a selection which is already made.

Deleting User Selection Buttons

You can remove any user selector button. You only have to click the Delete custom selection tool button 
 which opens the Delete Custom Selector dialog in which you select one or more custom tools 

and then press the Delete button to remove them.

RMB
opens list
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Selecting Elements by Attributes

You can select all elements that have user attributes.

Click on the by Attribute tool located on the Misc tab, Selection tool group.

The Elements by Attribute dialog is displayed.

Figure 787 Elements By Attribute Dialog

The following options and buttons are available:
Elements with user attribute, Elements with attribute value

selects elements which have the defined user attribute or attribute value. The attribute 
or value has to be entered in the appropriate text field. 

Select

starts a new selection set containing the elements which can be identified by the 
defined attribute or attribute value.

Add

adds the elements which can be identified by the defined attribute or attribute value to 
the current selection set.

Remove

removes the elements which can be identified by the defined attribute or attribute value 
from the current selection set.

Toggle

combines Add and Remove in one button. It selects all elements with the specified attri-
bute or attribute value that are deselected and deselects all elements that are currently 
selected. 

Common

selects those elements that are common to existing or new selections. (This is equiva-
lent to a mathematical AND.) 

Undo

cancels the last select element action.
Close, Help

work as usual.
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Changing Selection Sets

On the Misc tab > tool group Selection both the Select Once  and the Deselect Once  buttons are 
available. They are used to change selection sets as described by the following examples.

Deselect Once

The Deselect Once button avoids selecting currently deselected elements whilst dragging a selec-
tion rectangle. Any elements that are already deselected remain deselected while dragging over 
them again.

The example below shows the effect of using the Deselect Once tool before performing a second 
drag selection. The second drag selection includes pressing the Shift key.

Figure 788 Example: Changing Selection Set by using Deselect Once Tool

Select Once

The Select Once button avoids deselecting currently selected elements whilst dragging a selection 
rectangle. Any elements that are already selected remain selected while dragging over them 
again.

The example below shows the effect of using the Select Once tool  before the second drag 
selection. The second drag selection includes pressing the Shift key.

Figure 789 Example: Changing Selection Set by using Select Once

First Drag Selection Second Drag Selection Result

Deselect Once

incl. pressing Shift

Select Once

First Drag Selection Second Drag Selection incl. Shift Result
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This chapter describes the ways in which you can customize the user environment:

• Customizing the User Interface.............................................. 768

• Other Customization and Configuration Possibilities ............. 776

• Controlling User Options........................................................ 781

• Customizing Style and Image of MEDUSA4 Tools................. 781

• Setting Background Color ...................................................... 782

• Saving Changes of the Work Environment Settings .............. 783
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Customizing the User Interface

You can customize the Graphical User Interface in different ways. It is possible to show and 
hide, for example tabs, tool groups and tools. This section explains the following items:

• ”Showing/Hiding Tabs”

• “Showing/Hiding Groups in Tabs” on page 769

• “Showing/Hiding Buttons in Groups” on page 769

• “Showing/Hiding Sub-groups in the Dashboard” on page 770

• “Showing/Hiding Buttons in Sub-groups inside the Dashboard” on page 771

• “The “More“ Button - Customization Dialog” on page 771

Showing/Hiding Tabs

The tabs displayed in the MEDUSA4 ribbon can be customized by showing and hiding them. 
The number of available tabs depends on your product list. The following figure shows the 
default entries if using the master_project created during installation.

If you press the RMB on the File tab, the following list is shown providing the available tabs. By 
default the Admin tab is not visible and therefore not checked in the list.

Figure 790 Tab Selection List

If you check or uncheck on option in the list, the graphical user interface updates immediately.
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Showing/Hiding Groups in Tabs

The groups displayed in the MEDUSA4 tabs can be customized by showing and hiding them.

If you press the RMB on the Home tab, for example, the following list is shown by default provid-
ing the available groups.

Figure 791 Group Selection List

If you check or uncheck on option in the list, the graphical user interface updates immediately.

Showing/Hiding Buttons in Groups

The buttons displayed in any group can be customized by showing and hiding them.

If you press the RMB on the Line tool group in the Home tab, the following list is shown. 
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Figure 792 Line Tool Group Selection List

If you check or uncheck on option in the list, the graphical user interface updates immediately.

Showing/Hiding Sub-groups in the Dashboard

The buttons and sub-groups displayed in the Dashboard can be customized by showing and 
hiding them. Consider that empty groups cannot be switched on to be visible until you entered 
at least one item. This is the case for Shortcuts by default.

If you select a line and press the RMB on the Tools sub-group inside the Dashboard, the follow-
ing list is shown.

Figure 793 Tools Selection List if a Line is Selected

If you check or un-check an option in the list, the graphical user interface updates immediately.
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Showing/Hiding Buttons in Sub-groups inside the Dashboard

The buttons displayed in the sub-groups of the Dashboard can be customized by showing and 
hiding them.

If you select a line and press the RMB on the Modify Line sub-group inside the Dashboard, the 
following list is shown by default.

Figure 794 Modify Line Selection List if a Line is Selected

If you check or uncheck on option in the list, the graphical user interface updates immediately.

The “More“ Button - Customization Dialog

Any list shown in the sub-sections before provides the More button which opens the Customization 
dialog.

Please note: The More button is only enabled, when you are in Admin mode.
(see ”Options”, “Administrator” on page 285)

In the figure below the dialog was opened from the Modify Line selection list shown in Figure 794, 
“Modify Line Selection List if a Line is Selected” on page 771.
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Figure 795 Customization Dialog

Source

is a fixed representation of the user interface and provides the Template for copying/
restoring objects.
You can copy any item from the Source list into the Customization list by pressing the arrow 
button. Once an item was copied, it cannot be reverted. If you want to get back the 
default settings, use File > Options > Reset Customization.

Customization

provides the settings available in the current session.
In this area you can rearrange the succession of items by using the up and down 
arrows on the right hand side.
Pressing the RMB on any item in the list opens a popup menu (see Figure 796).

Properties:

displays the properties of the selected element; the properties can be changed (see 
“Change Properties” on page 775).
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Popup Menu in Customization List

Figure 796 Popup Menu in the Customization List

Create Page 
creates a new tab page providing a default name which can be changed as required. 
The new tab page is shown in the Customization list and in the ribbon. The properties of 
the tab appear on the right side of the Customization dialog.

Figure 797 Default Name of a new Tab

Replace the default name as required and press Apply. The new name of the tab is dis-
played on the ribbon and in the dialog below Customization.

Figure 798 New Name of the Tab

Create Group 
creates a new group in the currently selected tab providing a default name which can 
be changed as required. The new group is shown in the Customization list and in the rib-
bon.

Figure 799 Default Name for a Group

Replace the default name as required and press Apply.
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Create Split Button 
adds a new split button to the currently selected group. The Split Button is a container 
for buttons which can be displayed as either a Toolset or Combo Box. By default the 
display type is a Combo Box. Following figure shows the difference for the Line button 
of the Creation tool group in the Home tab.

Figure 800 Example for the Display of Toolset and Combo Box

Delete 
removes the current item. If a group or a tab is selected, also toolsets and tools inside 
the tab/group are removed.

Move Up/Move Down

moves selected elements up or down in the list; alternatively you can use the Up or 
Down arrow right of the Customization list.

Unlike the Ribbon, the Dashboard is limited in what can be customized:
• Within each Dashboard a group called Tools exists. The Tools title bar does not exist 

in the Customization dialog. You can only add tools and sub-groups to this group.
• Buttons only can be copied from the Ribbon to the Dashboard (Split Buttons cannot 

be copied).
• Dashboard Groups (excluding Tools) and Buttons can be moved.
• RMB Options:

Create Group
Delete
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Change Properties

The properties of elements which are displayed on the Ribbon or in the Dashboard can be 
changed via the Properties options on the right hand side of the Customization dialog.

Figure 801 Customization Dialog - Properties Options, Example Annotation Tab

Which options can be changed depends on the selected item, for example, a tab, a tool group, 
a Dashboard group or a tool.
Label

Input for the name of a tab or a tool group in the ribbon and for the naming of Dash-
board groups or buttons

Title

defines if the title bar of a Dashboard group is displayed or hidden (see example Line-

Dashboard, General group). Title is available for Dashboard Groups only.

Figure 802 Example for a shown and hidden Group Title

Large Button

changes the size of a button or Split button into large (default is small)
Button-Style

defines the style of the button label,
available settings are:
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Icon Only
Text Only
Text Besides Icon
Text Under Icon

Popup Type

allows to display the popup menu of Split buttons either as Combo Box or as Toolset 
(see example Figure 800).

Resetting the Customization

All customization changes are saved automatically. If you want to reset them, choose either File 

> Options > Reset Customization or remove <medusa_project>\users\<username>\med2d.uid and restart 
MEDUSA4.

Other Customization and Configuration Possibilities

Icon Size and Fonts

MEDUSA4 provides three sizes of icon set, Large, Medium and Small. The icon size also 
affects the font used in the interface. To change the icon size set the environment variable 
M6ICONSIZE in the file login.bat in your project. Possible values are large, medium and 
small. Example:

set M6ICONSIZE=medium

Ribbon Visibility Level

You can change the visibility of the ribbon, to one of three levels, using the button on the top 
right hand side of the interface. You can show the whole ribbon, ribbon without labels or just the 
ribbon header.

Figure 803 Toggle Ribbon Button
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Favorites and Shortcuts

Favorites and Shortcuts are intended to allow the user to make the interface more efficient for 
their daily work. 

• Favorites are areas in the style tree to place your favorite context sensitive tools.

• Shortcuts are intended for your favorite creation tools. 

Favorites or Shortcuts: are created as follows:

• If you select a style in the style tree, the Add Style to Favorites entry in the popup menu 
copies the style to the Favorites section in the style tree. The popup menu entry Add to 

Shortcuts creates a creation tool in the Shortcuts area in the appropriate Dashboard.

Figure 804 Adding Favorite/Shortcut from Style Tree

• If you have selected an element on the sheet, the popup menu entry Shortcut from Selec-

tion creates a creation tool in the Shortcuts area in the appropriate Dashboard, also if the 
style had been changed.
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Figure 805 Adding Shortcut from Current Selection

• If you load a symbol with the Symbol Manager, the popup menu entry Create Shortcut cre-
ates a creation tool in the Shortcuts area in the Symbol Dashboard.

Figure 806 Adding Shortcut for a Symbol

• If you load a symbol from the Parts Library (see Parts Library Guide), the popup menu 
entry Create Shortcut creates a creation tool in the Shortcuts area in the Symbol Dashboard.
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Further information on Favorites and Shortcuts are explained in ”Styles”, “Popup Menu” on 
page 176 and ”Dashboard”, “Shortcuts” on page 78.

Tablet

The Tablet is a individually configurable tabbed drop area on which you can place different sized 
tool buttons by drag and drop.

For details see ”Admin Tab”, “Utilities Tool Group” on page 792.

Locked Groups

The Group Dashboard allows you to lock groups which then become “special” to the effect that 
if you select any element of that group, the group as a whole is selected. If you load a symbol, 
you can see that this is also a group, however it is locked by default. 

There are two different Dashboards, one for symbols and one for groups.

If you unlock a group or a symbol, you have to select the whole group either by means of the 
structure tree or the group selection tools to re-lock it.

Figure 807 Symbol and Group Dashboard with Locked Icon

Map keys and Accelerators

Map keys and Accelerators are created from the dialog accessed from File > Options > Accelerators 

and Mapkeys.
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The basic difference is that Accelerators use rarely used key combinations (like Alt+a, 
Strg+0 or F12), whereas Mapkeys use character combinations like at with the prefix Alt+s.

Further details are explained in ”Options”, “Accelerators and Mapkeys” on page 291.
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Controlling User Options

The Default Settings dialog (available via File > Default Settings) provides a number of user options to 
customize the user environment of MEDUSA4. Details on the parameters are given in the chap-
ter “Default Settings” on page 261.

Customizing Style and Image of MEDUSA4 Tools

Within MEDUSA4 you can assign a different style and image to some of the tools. The tools you 
can customize are mainly the more general creation tools such as Solid Thin.

MEDUSA4 pre-selects appropriate styles and images depending on the class of tool you are 
customizing. Classes within MEDUSA4 are Line, Text, Prim and Dimensions.

Please note: To customize a tool, you have to be in Administration Mode, see ”Options”, 
“Administrator” on page 285.

To modify a custom tool:

1. Move your cursor over the tool you want to customize and click the RMB. 
If the tool is one of the tools you can modify a popup menu appears with the Style Selec-

tion option.
2. Select the Style Selection option to display the Style Selection dialog.

Figure 808 Style Selection Dialog

The current style is shown on the left and the icon is shown on the right.
3. If you want to change the style select the required style from the pulldown menu avail-

able by clicking the LMB on the black arrow on the right of the style list.
4. If you want to change the icon of the tool click the LMB on the image on the right of the 

Style Selection dialog to open the Icon Selector dialog:
© CAD Schroer GmbH                             781



MEDUSA4 Drafting
Customizing the User Environment
Figure 809 Icon Selector Dialog

a. Search the icon you want to apply by using the scroll arrows on the right.
b. If you found the icon you want to use click the LMB on the appropriate line inside the 

list and click OK.
The Icon Selector dialog closes and the image of the tool inside the Style Selection dialog 
changes to the chosen icon.

5. Click OK for applying your settings. 
The tool button is updated immediately with your changes.

Please note: Consider that the changes are only valid in the current MEDUSA4 session and 
they are lost when you exit MEDUSA4.

Setting Background Color

MEDUSA4 opens sheets by default with an white colored background. You can change the 
background color by using the Select background dialog. For opening this dialog you have to be in 
Administration Mode therefore this topic is explained in ”Options”, “Change Background 
Color” on page 286.

Two things related to this topic have to be mentioned here in addition:

• When you close MEDUSA4 you will be asked if your changes should be saved as 
default setting. Details are described in “Saving Changes of the Work Environment 
Settings” on page 783.

• The System Administrator is able to modify any color of the background color scheme. 
For further information see the Administration Guide, chapter Administration, section 
Setting up Standard Colors.
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Saving Changes of the Work Environment Settings

All work environment settings like custom tool changes and background color settings are 
saved when the MEDUSA4 session ends.

If you have made any changes to your work environment and if you quit MEDUSA4 the follow-
ing dialog is displayed allowing you to save your work environment:

Figure 810 Save or Discard Defaults Dialog

Don‘t ask me this again 
If this option is on, any decision you made by clicking on the buttons at the bottom of 
the dialog will be remembered in the next MEDUSA4 sessions.

Save 
accepts the changes as default and closes MEDUSA4. 
When you reopen MEDUSA4 the work environment appears with the changed set-
tings.

Discard 
sets the work environment to the previous default and closes MEDUSA4. 
When you reopen the program the previous default settings are used. The current set-
tings are lost.

Cancel 
aborts closing MEDUSA4.
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Activating the Admin Tab

By default the Admin tab is not displayed in the ribbon. Click the RMB on the File tab to display all 
available tabs. Activate Admin.

Figure 811 File Pulldown Menu
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Trail File Tool Group

The Trail File tool group on the Admin tab provides tools which enable you to store any work step 
at and up to a particular time and reproduce it in the correct succession.

MEDUSA4 creates a text file containing the Bacis-commands in the order of execution. The file 
extension is BAC. You can open this file by using an usual text editor. It can be useful for debug-
ging.

Figure 812 Admin Tab > Trail File Tool Group

The buttons have the following functions:

Record Trail File

1. Click on the Record Trail File button .
The Record Trail File dialog opens.

Table 15    Trail File Tool Group - Functions of the Buttons

Button Function

Record Trail File
opens the Record Trail File dialog for starting to record action steps you do on the 
sheet.
(For details see “Record Trail File” on page 787).

Close Trail File
closes a record. Actions which are performed after clicking on this button are not 
noted any longer.
For replaying the recorded file it is required to close the record by using this button!

Replay Trail File
opens the Replay Trail File dialog where you can run recorded work steps.
(For details see “Replay Trail File” on page 789.)
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Figure 813 Record Trail File Dialog

2. Enter name and path of the file in the Filename input field (e.g. test) - the extension BAC 
is added automatically - or use the File Selector button.
If you choose File Selector a file browser opens, in which you can select the directory 
and the file name. After closing the file browser the filename and path are transmitted 
to the Filename input field.

3. Enter a Macro Name in the relevant input field.
The entry is mandatory. The Macro Name is written in the first line of the recorded file.
Enter a value for the Decimal places.
This entry is optional.
The recorded Bacis-file contains commands with coordinates. The value Decimal places 
defines the number of positions after the decimal point for these coordinates. If you left 
out this definition, coordinates are stored with maximum precision, which means up to 
15 decimal places.

4. Close the dialog using the OK button.
The record starts. Any action on the sheet which is executed from this time on is stored 
into the defined Bacis-file until you stop recording.

Please note: Please, keep in mind the following:
Every action is recorded.
I.e., when you do not quit a tool before stopping recording accordingly this tool is 
active, after replaying the trail file.
Consider whether you intend this!

Close Trail File

To stop the record click on the Close Trail File button . The record is completed and the Bacis-
file is saved.
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Replay Trail File

The replay of a trail file takes place by executing the commands saved with the Bacis file.

1. Open a new sheet.
2. Click on the Replay Trail File button .

The Replay Trail File dialog opens.

Figure 814 Replay Trail File Dialog

3. Enter a Filename or select a file by using the File Selector... button.
If you click on File Selector a file browser opens. Directory and file name are transmitted 
to the input field of the Replay Trail File dialog.

4. Click on OK.
The recorded actions are repeated in the saved order.
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Figure 815 Admin Tab > Configure Tool Group

The Configure tool group provides two buttons. Both are deactivated by default.

• To activate the Generate Styles from DDL Type button  set the autogenstyles variable 
in the med2d\m2d\src\defaults.dat to true and login as Administrator. 
Having changed the defaults.dat file requires to re-configure your project which is 
described in the Administration Guide. 

• To activate the Creates a user defined symbol for Item Number Ballons button  you have to be 
in Administrator mode (File > Options > Administrator > Insert Password).

The tool  is used to generate styles for DDL elements which do not yet have a specific style.
Details are explained in the Administration Guide, Chapter Administration, Section „Generate 
Styles from DDL Elements.“

The tool  is used to create your own symbol for Item Number Balloons.
Details are explained in the Administration Guide, Chapter Administration, Section „Create Item 
Number Balloons“.

Generates Styles
from DDL Types

Creates a user defined symbol
for Item Number Balloons
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Console Tool Group

This tool group provides buttons to enter the Bacis1-Mode and work with Bacis1 commands.

This chapter gives only an overview of the Bacis1 buttons available on the Admin tab > Console tool 
group.

Figure 816 Admin Tab > Console Tool Group

The Bacis1 command and programming language is explained in:

• the Bacis1 Design Commands Guide and 

• the Bacis1 Guide

Switches into Bacis1 Mode
All menu items are disabled and
you can enter Bacis1 commands
inside the input command line Switches off Bacis1 Mode
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The Utilities tool group contains a button to display the M4 Tablet.

Figure 817 Admin Tab > Tool Group Utilities

Introduction to the Tablet 

Figure 818 Tablet

The Tablet is an individually configurable tabbed drop area on which you can place different 
sized tool buttons by drag and drop.
Users can create their own arrangements of buttons to suit their particular usage pattern.

Please note: The question mark at the top of the Tablet leads you to the documentation.
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If users have an extra screen this provides a mechanism to use the additional screen space. 
Ideally it would be a touch screen. In this case the on-screen tablet could act as an additional 
input device.

The Tablet can be used with and without the touch-ability of the screen.

Please note: The RMB is disabled on the tablet.

Add a Button to the Tablet

1. Press the Ctrl key and press and hold the LMB on a tool on the ribbon.
You can now release the Ctrl key.
When you move the mouse, the icon of the tool is attached to the cursor.

2. Drag the button over the Tablet.
3. Release the LMB at the desired position.

Depending on the mouse position a copy of the tool-button is generated in a size of 1x1, 1x2, 
2x1 or 2x2 cells.

Figure 819 Possible Size of a button

Please note: You can use both buttons from the ribbon and the Dashboard.
If you drop a split button the active button is transferred to the Tablet.

Move a Button on the Tablet

1. Press the Ctrl key, press and hold the LMB on the button which is to be moved on the 
Tablet.
Drag the button by using the mouse over the Tablet.

2. Release the LMB at the desired position.
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1. Press the Ctrl key, press and hold the LMB on the tool which is to be deleted from the 
tablet.

2. Drag the button over the Tablet and drop the button in the delete-area.
The button is removed from the Tablet.

Figure 820 Delete-area

Please note: The delete-area is only displayed when you drag a button over the Tablet.

Options

When you click on the button shown below, three options are provided to define the display of 
the Tablet.

Figure 821 Setting Options

Show grid

sets the grid visible or invisible
Rows

defines the number of rows
Columns

defines the number of columns
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Please note: The number of rows and columns defines the size of the buttons.
The higher the number of cells on the tablet the smaller is the size of the buttons.

Pages

The Tablet has four pages. On each page you can drag and drop buttons for a different configu-
ration.

Save or Reset Configuration

All changes you have made in the Tablet are saved in your MEDUSA4 project:
User\<Username>\med2d.uid

Delete this file to reset your Tablet.

Please note: The Tablet is also accessible from the Status area in the MPDS4 user interface.
See the „MPDS4 User Guide“, „User Interface“, „Status Area“.
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Additionally to the standard symbol tools MEDUSA4 provides a diagram mode for basic appli-
cations in the schematics construction. The symbols for this are called Diagram Symbols. This 
chapter describes the use of Diagram Symbols.

Overview

The tools to create diagram symbols are shown in Figure 822.

Figure 822 Overview of Diagram Symbol Tools

A diagram symbol consists of a group which contains graphics, a datum prim and one or more 
connection point texts. Any other elements may be included.

Agreed to the standard symbols you can create and load:

• Temporary Diagram Symbols are stored on the hard disk in the path defined by the 
environment variable HOMEPATH. Names of temporary symbols are created automat-
ically and cannot be defined by the user.

• Named Diagram Symbols can be saved at any location on the hard disk with any file 
name.

You can work with self created diagram symbols but also MEDUSA4 provides a catalog of com-
plete diagram symbols which can be loaded.
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Creating

To create a diagram symbol you need a graphic element, a datum prim and at least one or more 
connection point texts.

1. Create an element, for example a rectangle.
For help placing the diagram connection texts and the diagram datum prim later on 
switch on center lines.

2. Switch to the Admin tab.
You find the Create diagram symbol tools There.

Figure 823 The Create Diagram Symbol Tools

3. Choose the Create diagram connector text tool . 
If you have already created a text, it is now attached to the mouse cursor.
The dashboard displays the properties of the connector text. The active cursor is posi-
tioned in the text field for input.

4. Type the text for the first connection point, for example P1.
The entered text is displayed at the mouse cursor.

Figure 824 The Diagram Symbol Connection Point Text Dashboard
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5. Click left to place the first connection point on the rectangle.
The connector text remain at the cursor.

6. Type a new text, for example P2, to create a second connection point.
Promptly the text attached to the cursor is replaced by the new text.

7. Probe the new connection point text on the rectangle. 

Please note: It is mandatory to make an input in the text field. If the text should be not visible 
set the character size to zero.

Figure 825 Creating Connection Point Texts 

8. Choose the Create diagram datum prim tool .  
9. Click left on the intersection point of the center lines of the rectangle to define the dia-

gram datum by placing the diagram datum prim.

Figure 826 Creating a Diagram Datum Prim

10.Select Exit Tool from the popup menu.
All three components required to create a diagram symbol are available now and you 
can save the symbol, see “Saving” on page 799.

Please note: A symbol with two connection point texts in line with its datum can be inserted into 
a straight line, one with three texts requires two or three intersection lines and so 

Connection point texts

Position of placing the datum prim
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on.

Saving

Corresponding to the standard symbols you can save diagram symbols either temporary or 
named. 

Please note: Saving a diagram symbol is only possible if all three components (geometry, con-
nection point texts and datum prim) are available. If any component is missing an 
error message is displayed in the output message area.

Saving a Temporary Diagram Symbol

1. Select all three components (geometry, connection point texts and datum prim) which 
you wish to be saved as a diagram symbol.

2. Choose one of the Save temporary diagram symbol tools.

Figure 827 Save Temporary Diagram Symbol Tools

The selection is saved as temporary diagram symbol.

Saving a Named Diagram Symbol

1. Select all three components (geometry, diagram connection texts and diagram datum 
prim) which you wish to be saved as a diagram symbol.

2. Choose the Save named diagram symbol tool .
The Save named symbol dialog is displayed.

3. Enter the file name and choose the directory in which you wish to save the file.
4. Select Exit Tool from the popup menu to finish saving.

The selection is saved as named diagram symbol.
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Loading and Inserting a Temporary Diagram Symbol

For loading a temporary diagram symbol use the Load temporary symbol tools. 

1. Choose one of the tools for loading temporary symbols in the Home tab, Symbol + Catalog 
tool group.

Figure 828 Load Temporary Symbol Toolset

The diagram symbol is loaded and is attached to the mouse cursor as you move the 
mouse over the drawing area. The symbol is crossed to indicate that it cannot be 
placed.

Figure 829 Diagram Symbol Attached to Cursor

2. Move the cursor over the line where you wish to insert the symbol.
The symbol is not crossed out any longer and it aligns at a line.

Figure 830 Diagram Symbol Over Line

The following popup menu is available:

Effect of the Auto Orient Mode
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Figure 831 Diagram Symbol, Popup Menu while Placing

Next and Prev Orientation are used to change the orientation of the symbol in a line. Both 
are deactivated if the symbol cannot be placed.
Mirror Horizontal and Mirror Vertical are used to mirror the symbol at a horizontal or vertical 
axis.
Disable Diagram Mode loads the diagram symbol as usual symbol.

3. Probe on the line to place the diagram symbol as required.
The symbol is inserted into the line. Between the two connection points the line is inter-
rupted. The loaded symbol remains on the cursor. You are able to insert it again until 
you select Exit Tool from the popup menu.

Figure 832 Diagram Symbol after Placement 

Please note: If you want to place a diagram symbol with 3 or 4 connection points at a intersec-
tion of lines, the two crossing segments must be owned by two different lines. You 
cannot place a diagram symbol with 3 or 4 connection points at a crossing where 
a line intersects itself.

Loading and Inserting a Named Diagram Symbol

The procedure for loading and inserting a named diagram symbol is the same as explained in 
”Symbols - Home Tab”, ”Loading Named Symbols” on page 596. Choose the Load named symbol 
tool  and then use the Symbol Manager for selecting the diagram symbol and loading it into 
MEDUSA4. Afterwards move the mouse cursor over the line in which you want to insert the 
symbol and click left to place it.
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For selecting diagram symbols you have two possibilities:

• Choose the Select a diagram symbol tool  (see Figure 822, “Overview of Diagram Sym-
bol Tools” on page 796).

• Choose the Select sheet-level named group tool  available in the selection tools pulldown 
menu inside the In Graphics Tool Bar.

Then select one or more symbols.

Please note: An incomplete symbol cannot be selected.

Deleting Diagram Symbols

First select one or more symbols by the methods shown in ”Selecting Diagram Symbols”. Then 
delete the selection by using the Delete option from the popup menu or the Delete button from the 
keyboard.

The selected diagram symbols are removed, the interrupted lines are restored automatically.
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View Tool Group

MEDUSA4 provides several possibilities for zooming into and out of the drawing. The frequently 
used tools are also explained in ”In Graphics Tool Bar”, ”Overview of Functions” on page 88.

Please note: By default the View tool group is not displayed in the ribbon. Having activated the 
Admin tab as explained in “Activating the Admin Tab” on page 786, click the RMB 
on the Admin tab to display all available tool groups and activate View.

The following figure shows the View tool group and the available pulldown menus.

Figure 833 View Tool Group and Pulldown Menus

The entries of the right pulldown menu are:
Zoom In 

zooms into the drawing by a fixed factor to a probed point. The probed point is cen-
tered on the display.

Zoom Out 

zooms out of the drawing by a fixed factor.
Half

zooms window of the current sheet to half size
You can also zoom out the window to half size by clicking on Zoom Out and then using 
the short cut Ctrl+H.

Double

zooms window of the current sheet to double size
You can also zoom in the window to double size by clicking on Zoom In and then using 
the short cut Ctrl+D.

Maximum 

zooms to the maximum extents of the sheet including any border area around the out-
side of the sheet (see ”File”, ”Sheet Properties” on page 81).

The entries of the left pulldown menu are:
Top Left , Top Right

zooms into the top left/right of the current sheet.
Bottom Left , Bottom Right

zooms into the bottom left/right of the current sheet.
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The Admin tab provides following functions in the Display tool group.

Figure 834 Admin Tab > Display Tool Group

The buttons have the following functions:

To display only selected elements first choose Clear  and then Draw 

To display all elements again click on the Refresh Graphics tool  of the In Graphics Tool Bar.

Table 16    Display Tool Group - Functions of the Buttons

Button Function

Clear
Hides all the elements on the current sheet

Draw
Displays the previously selected elements

Undraw
Hides the previously selected elements
804 © CAD Schroer GmbH



MEDUSA4 Drafting
MEDUTIL
The previous chapters of this manual explained functions which are provided in the graphical 
user interface. Most of the functions work on a single element but MEDUSA4 also includes the 
MEDUTIL utility program providing some functions for being processed in batch files, for exam-
ple.

• Starting MEDUTIL .................................................................. 806

• Adding Previews to Sheets and Symbols .............................. 807
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Starting MEDUTIL

1. Open a command prompt window.
2. Run the login.bat file of your project.
3. Enter medutil and press Return on your keyboard.
4. Enter help to list the MEDUTIL commands available for your project.

Figure 835 Command Prompt Window after Having Started MEDUTIL

5. Press Return on your keyboard to list further commands.

Please note: The listed commands depend on the product_list.dat file in your project, therefore 
the listed commands may differ from the ones shown in the figure above.
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Adding Previews to Sheets and Symbols

A sheet/symbol can have a preview image stored in the sheet/image. This will be used when 
the sheet/symbol is previewed in the open dialog/Symbol Manager.

The preview image can be added by the MEDUTIL command preview, which takes a filename 
to add a preview to. The filename may contain wildcards. Example

preview example*.sym

The option -R may be used to recursively descend a directory structure:
preview -R <path to top level folder>\*.sym

The preview added by the above options will be auto generated unless a file of extension .png 
with the same name as the sheet/symbol exists in which case that will be used instead.

Please note: The file the preview is being added to must not be open in MEDUSA4.
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Build filter from sheet selection 760
Build filter using sheet selection 760
Button, More in Customization dialog 771
Buttons

Unscale 610
buttons in dialogs 52
By Area, Dialog 93

C
CADConvert Configuration Path, open dialog 304
CADConvert Mapping Tables, open dialog 304
cadconvert.cfg file 304
Calculating chord angle 280
calling up SMART Drafting 398
calling up SMART Edit 461
Cartesian, Grid, cartesian 200
Cen line function 359
Center point circular arc, tool 392
Center Probe, Probe specifier 121
Centerlines

2D modeling 701
closed geometry 348
create when 2D modeling 702
overlap 348
override when 2D modeling 701

Chain dimensions 421
change accelerator key 293
Change curve of the selected tangent arc 395
Change Directory 296
Change Icon of shortcut 79
Change layer 153
Change Layer Properties 151
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change properties of lines 356
change properties of lines with Dashboard 356
Changing

appearance of points 360
coordinates of points 359
default

probe specifier 113
element style 170
hit radius 114
point functions 360, 361
properties 170

using Dashboard 85
stippling properties 582
Styles 170

Changing Element Properties 171
changing prim properties 551
Chord angle

calculating 280
Chords

angles
maximum and minimum 279

using to draw curves 240, 244, 278
Cir line function 359
Circle Dimension Properties dialog 623
Circles

appearance for plotting
chord length 240

appearance for printing
chord length 244

appearance on sheet
chord length 278

Construction line tools 684
creating point at center of 121
creating point on 122
dimensioning 437

diameter 437
radius 437

Tools for creating construction lines 481, 482, 493
Circular arc through three points, tool 392
Class Buttons 758
Cleanup 668
Clear Flagged 755
Clear option 804
Clip zoomed window 265
Clipboard

Area Cut 314
Copy 314
Cut 314
Delete, Elements

Delete 314
Paste 314

Clipboard tool group, Tools 314
Clipboard, Ribbon, Home,Tool group 313
Clipborad, Area Copy 314
Clo line function 359
Cloning element properties using Dashboard 311
Close and New Line 377
Close Line 377
Close Trail File 787, 788
Closed Geometry

popup menu 345
Closed geometry

centerlines 348

properties 347
tools 344

closed geometry
creating 344

Closed Geometry Properties 346
Closed Geometry Properties dialog 347
Closed geometry, Shape 349
Closing Sheets of a WSD File 237
Cloud

Logout 40
Search for file 40

Cloud Integration 39
Coincidence Radius 277
Color

Define Color dialog 204
columns

add to tables 561
Comma Separated Variable file 559
common button 764
Compare selected reference tool 721, 725
Comparing Reference 725
Con line function 359
Configuration file

printer 303
Configure, Tool group 790
confining construction lines 498
Connect lines, tool 680
Connect the current line with adjoining lines, tool 680
construction line

hiding 497
Construction lines

absolute offset values 691
confining 498
creating 492
datum point 493
deleting

all 497
selected 497

oblique 686
offsetting

multiple 691
single 688

overview 480
Overview tools 684
positive and negative offsets 688

construction lines
dynamic 483

angle 484
offset 485
point recognition 483
use keyboard buttons 486

project through a profile 695
project through a section 696
projected 695

Construction Lines, Default settings 269
Construction Lines, Tool group 479
Construction Points 408
Context-sensitive Help 29
Convert reference 724
Convert reference tool 721
Convert the selected circular arc to a tangent point arc 394
Coordinate dimensions 421
Coordinates
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of points
changing 359

of text element 507
coordinates

dialog for entering values 118
Copies

number to plot 240
number to print 243

Copy 315
Copy to clipboard 265, 314
Copy to Clipboard/Copy 315
Copying current WSD file 234
Create

empty group 615
group of already existing elements 615
Nested Group 616

create
gaps under Text in crosshatching 587

Create a (tangent-point) fillet of specified radius, tool 391
Create a fillet of specified radius, tool 391
Create a new reference, tool 722
Create a Table 557
Create Arcs, tools 392
Create chamfer, tool 391
Create circle, tool 392
Create Circles, tools 392
Create diagram connector text 797
Create diagram datum prim 798
Create diagram symbol 797
Create Item Number Balloon Dialog 536
Create Item Number Balloon Dialog, Example Symbol 541
Create Line Tools, overview 674
Create named group 615, 616
Create named group with existing elements 615
Create segments tangential to surfaces, tool 392
Create tangent point conic arc, tool 393
Create tangent point elliptical arc, tool 393
Create tangent point parabolic arc, tool 393
Creates a datum named group for an offset datum 

dimension, Tool 634
Creates a datum named group for an offset datum 

dimension, tool 635
Creates a Named Group 614
Creates a Named Level 1 Group 614
Creates a Named Level 2 Group 614
Creates a new reference, tool 721
Creates construction circle tangential to a line in three steps

Tool 495
Creates construction circle tangential to a line in two steps

Tool 494
Creates construction circle tangential to two lines

Tool 494
Creates construction lines tangential at two circles,Tool 496
Creates construction lines through tangent points of two 

circles,Tool 496
Creates isometric dimensioning, tool 632, 633
Creates transportation lines, tool 692
Creating

Balloon Texts for desing objects 538
bore holes

sectioned 713
centerlines when 2D modeling 702
closed geometry 344

construction lines 492
crosshatching

when 2D modelling 703
custom sheets 219
Dimension, angular 441
dynamic construction lines 487
elements

using Dashboard 310
faces 707
Grid 208
Item Number Balloons 537

error messages 538
linear dimensions 421
lines

use of current point 338
multi-line text 515
New Element with New Properties 310
New element with new properties 306
New Element with Properties of Existing 311
new groups 188
New Reference 722
orthogonal views 700
perpendicular line segments 120
points at grid points 116
Porthole Elements 718
solid shafts 711

sectioned 712
standard sheet 218
swept profiles 704
table data

CSV files 559
Table from Balloon Texts 540
Text 502
text, popup menu 502
WSD File 232
WSD File containing currently loaded sheets 233

creating
New element with properties of existing element 306

Creating a QRCode Symbol 643
Creating a sheet 218
Creating edges perpendicular to viewing direction 707
Creation Tool Group 305
Creation Tool Group, Overview 306
Creation Tool Group, Ribbon, Home tab 306
Creation tools 308
Crossed dynamic construction line 488
Crosshatches 92
Crosshatches Dashboard 577
Crosshatching

2D modeling 701
areas

defining 569
around areas 586
create when 2D modelling 703
default settings 576
defining area to fill 569
Deleting 584
filling areas 567
multiple times 585
override when 2D modeling 701
overview 568
properties 576

changing 579
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seed line 576
seed point 570
selecting 92, 584
tools 572

crosshatching
create gaps under text 587
popup menu 572

CSV files
overview 559

Ctrl-Key 51
Current

point 338
view

plotting 240
printing 243

current grid 209
Current Tool 37
Curve Factor 278
Curves

changing appearance for plotout 240
changing appearance for printout 244
changing appearance on sheet 278

custom selection tool 762
Custom selector button 758
custom sheets

creating 219
Customization dialog, More 771
Customizing

layer sets 162
layers 159
tools 781
user environment 767

Cut 315
Cut elements 315
Cut, Clipboard 314
Cutting

elements using Structure Tree 193

D
Dashboard 35

balloon text 539
changing properties 85
Circles/Arcs 392
cloning element properties 311
creating elements 310
crosshatches 577
Dimensioning 419
Display properties 84
displaying properties 84
element classes 75
element specific 75
Fillets/Chamfers 391
General Properties,Layer 145
General Properties,Style 166
Line, General Properties 306
Modify Line 387
Modify Segment 389
Note 454
parameters in the Grids area 67
parameters in the Origin area 67
prims 546, 549
Sheet Header Editor 63

Sheet level 63
Sheet Properties area 69
Shortcuts 78
Symbol 601
Text 504
Text, Properties 504

dashboard
2D Features 350

Dashboard element selection limits 266
Dashboard Sheet Dashbaord 63
Dashboard, Default Settings 266
Datum

dimensions 421
layer 152

Datum of Selected Element, probe specifier 125
Datum Offset Dimension 634
Datum point

construction lines 493
offsetting construction lines from 691
prims 545
stippling symbol

moving 581
symbols

moving 611
text elements 508

Datum Point Definition 125
Deactivate Scaled View functions 736
Deactivating a grid 210
Decortext, text display 270
Defaiult Settings

Arc Factor 278
Default

crosshatching settings 576
dimensioning standards 415
layer allocation 145
prims 546
probe specifier

changing 113
sheet scale 71
spacing

stippling 581
Default font 270
Default Settings 265

Element Options
Text 270

Element Options, Symbol 271
General Options 264

Message Area 265
Switches 264

General Settings, Dashboard 266
Radii and Arc Factor Options, Search Radii 277

Default settings
Search Radii 114
Search Radii/Arc Factor 114

Default settings dialog
Dimensions 272

Default Settings, Defaults dialog 264
Default style 167
Default Stylel 167
Defaults dialog

2D Products 281
3D Products 282
Design Objects 280
© CAD Schroer GmbH 813



MEDUSA4 Drafting

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
Parametric 280
Define Color, dialog 204
Define fixed value 399
Define Vertices with left Button 265
Define vertices with left mouse button 265
Defines a new multi-sheet working set 232
Defines a new multi-sheet working set containing the 

currently loaded sheets, tool 233
Deflection angles 693
Degree angular unit 72
Delete all construction lines tool 497
delete diagram symbol 802
Delete Point 377
Delete reference 721, 725
delete rows and columns from tables 561
delete selection from tables 555
Delete Shortcut 80
Delete, Clipborad 314
Deleting

area fills 584
construction lines 497

selected 497
crosshatching and stippling 584
grids 213
parts of dimensions 445
prims 548
Printers 300
whole dimensions 445
window views 101
WSD Files 235

deleting a layer name 161
Deleting an URL 514
Deleting group lines 334
Deselect All Option 759
Deselect Once, tool 765
Design Objects, Defaults dialog 280
diagram connector text 797
diagram datum prim 798
Diagram symbol

deleting 802
loading

named 801
temporary 800

named 796
selecting 802
temporary 796

Dialog
Auto Save 298
Crosshatch properties 578
Define Color 204
Fit Table Properties 627
HLR Type 589
JoinLine Properties 681
Layer Management 148
Layer Management, buttons 156
Measuring Properties 104
Merge User Styles 178
MovebyGrid 751
Number 520
Print Preview 250
Select Color 203
Selection by Area 93
Sheet Working Sets 231

Structure Tree Options 194
Surface Finish Symbol 455

dialog 52
buttons 52

Dialogs
Advanced Plotting Options 251
Angular Dimension Properties 442
Circle and Arc Dimension Properties 623
Closed Geometry Properties 347
Defaults

Dimension 415
Enter Coords 118
Grid Properties 200
Help 29
Icon Selection 782
Line Point Properties 358
Linear Dimension Properties

Style and Format tab 427
Text and Arrows tab 432

Load Symbol Temporary Properties 604
Measure 103
Plot 239
Plotter information 302
Plotter Properties 302
Point Functions 362
Prim Properties 550
Prims 546
Print 242
Profile Extrusion View Direction 705
Radial Dimension Properties 439
Sectioned Shaft Properties 701
Special Sheets 219
Style Selection 781
Symbol Manager 598
Table Creation 554, 557, 559
Temporary Stipple Properties 580
Text Properties 506, 512, 513
View Frames 730
Window Views 98
Working Set Properties 238

dialogs
save as 228
save or discard 258

Difference 590
Dimension

Gap 273
Prefix/Suffix 274
Standard 272

dimension line 444
Dimension offset from a datum tool 634
Dimension Session Defaults 415
dimension text 444
Dimensioning 413, 619
dimensioning

arrange coordinate dimensions text 636
dashboard 419
explode 637
gaps 638
linear

popup menu 422
Dimensions

adding segments 445
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angular
properties 442
text format 443

arcs 622
Arrows 272
arrows 435
arrows and text 432
chain 421
circle

diameter 437
circles and arcs 437
coordinate 421
creating angular 441
datum 421
deleting part 445
deleting whole 445
direction 433
dual 429
editing 444
gaps 435
Imperial units 433
in scale views 738
layer 433
limit and fit 430
linear 421
linear properties 427
Prefix and suffix 430
radius of a circle 437
radius with an off sheet center 437
selecting 92
spacing 434
standards 414

setting 415
text format 434
text position 432
tolerance format 429
tolerance style 428
tolerances 431
tools 420
type 434

dimensions
create notes 450

Dimensions, Defaults dialog 272
DIN dimensioning standard 414
Direction

of dimensions 433
of line 339

arrowhead point functions 361
Display

Clear 804
Grid lines 212

Display of Line Thickness 265
Display of texts, within symbols 581
display reference 724
Display rubber band 264
display scale views 735
Display tool group 804
Displaying

current grid 212
properties

using Dashboard 84
Distance 383
Distance between text characters, gap 508

Divide segment into specified number of divisions or at 
selected point 390

Divide segment into two 389
Dock the Structure Tree 184
DOT prim 545
Double segment length 389
Dragging

using the cursor 49
Draw Selection only 759
Drawing area

maximum 73
Drawing code

plotting 240
printing 243

Drawing Code, Default Settings 267
Drawing Elements

Construction Lines 269
Symbol 271
Text 270

drilling tables
appearance 669

DTM prim 545
Dual dimensions 429
DXF Files

save 229
DXF/DWG Interfaces, open dialog 304
Dyn. scaling, paste popup 317
Dynamic

alignment of symbols 609
construction lines 483

angle 484
crossed 488
offset 485
perpendicular 488
point recognition 483
tangential 487
use keyboard buttons 486

lines
displaying during edit 264

scaling
of symbols 610
turning off and on 738

Dynamic Construction Lines 270
examples 489

dynamic scaling, paste popup 317
Dynamically align geometry 748

E
EAR prim 545
Edge projection 707
Edges

creating
perpendicular to

viewing direction 707
Edit Description 303
Edit Line popup menu 377
edit title block text of a drawing 64
Editing 509

dimensions 444
lines

displaying dynamic line to cursor 264
overview 376
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Named Symbols 600
tables 561

Editing a QRCode Symbol, QRCOde Symbol, edit 644
Editing drilling data 666
element class 35
Element Classes 75
element classes 19, 170
Element Properties 19

changing - 171
Element Specific Dashboard 75
Elements 19

cloning properties
using Dashboard 311

Copy, Clipboard 314
creating

point at datum of 125
using dashboard 310

Cut 315
cutting

using Structure Tree 193
layer allocation

default 145
pasting

using Structure Tree 193
reparent 190
selecting

by clicking 129
using mouse 129

style
changing 170

using to align a grid 206
Elements with user attribute

selecting 764
E-Mail, Sheet as attachment 38
Enable

error bell 265
transportation lines 264

Enable Transportation lines option 693
Enclosed, Fully

select by area 94
Enclosed, Partially, Select by Area dialog 94
Ending line creation 341
Enter Coords Dialog 118
environment variable, M6ICONSIZE 776
Error bell

enable 265
error messages 37
error messages while creating item number balloons 538
ESC-Key 51
Example

Aligning Geometry along a Line 749
Drilling Table 1 663
Drilling Table 2 665
Fit Tables 629
Group Box and Freehand Group Lines 333
Moving Points 367
Offset Dimensioning 634
Rotation - Rotation Angle unknown 327
Scale View 739
Test Dimension 431

Example for transforming text elements 321
examples for boolean operations 591
Examples for Dynamic Construction Lines 489

Exit Groups 618
Exit Tool (popup line edit) 378
Exit Tools 58
Explode dimensions 637
export as DXF 229
Extend by factor 389
Extend line 389
Extend line to probed segment 389
Extend to Segment 384
Extruding profiles

specifying angle 706

F
Faces

creating 707
Favourites

Add Style to 176
Add style to 177
Remove style from 176
remove style from 177

Feature Control Frame 453
Feature Control Frame Datum 452
File

Default Settings 261
Options 216, 283
Options, Auto Sheet Save 298
Options, Change Directory 296
Options, Interfaces 304
Options, Licenses 297
Recent Sheets 226
Write Protection 223

File entry separator 556
File Formats, Import drawings 222
File Menu 216
file name of sheet 69
File Selectors 59
File tab, ribbon 215
File, Options 297
File, Tab 33
Filling areas with patterns or crosshatching 567
filling areas with symbols 574
Filling out input fields 51
Filter Selection, button in Power Selection Dialog 759
Find Text 518
Finishing line creation 341
Fit

specifying in dimensions 430
Fit a smooth curve through the current line 387
Fit table properties 627
Fit Tables, creating 627
fits.xml 629
fittab_import_fit2xml 630
Fixed, text 321
fixed, text 581
Flip 378
Font for text elements 507
Fonts, Size 776
Format of plotter 240
Format of printer 243
Frames

Tools to create construction lines 481, 482, 493
Free probe, Probe specifier 116
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Free style 168
freezing the active scale 736
Full grid 67
Functions

lines 359
of points

changing 360
Functions of mouse buttons 48

G
gap 508
Gap point function 360
Gap, Default settings 273
Gaps

dimensions 435
gaps in dimension leader/witness lines 638
Gaps Under Text in Crosshatching 587
General

Dashboard 266
Drawing Code 267

General Options 265
Defaults 264

General Popup Menu 44
General Properties

Style 166
Genral Options, Default Settings dialog 264
Geometry

closed 344
measure 2D properties 108
of line 338

Gradians 72
Graphics Area 44
Graphics area

popup menus 44
graphics area, graphics area, Popup menus 44
Grid

creating 208
Standard grid 209

Grid lines, Grids 198
Grid origin 200
Grid points, Grids 198
Grid probe specifier 116
Grid properties

Modifying 206
Grid Properties, dialog 200
Grid Steps Angle 398
Grid Steps Length 398
Grids 197

Activating and Deactivation, in Dashboard 210
Activating and Deactivation, via staus area 210
active and deactivate 210
aligning with elements 206
Cartesian grid 200
creating points on 116
Current grid 209
delete 213
displaying 212
Drawing lines 212
Grid Line Style 203
Grid lines 198
Grid points 198
Hide options 212

hiding lines 212
Introduction 198
maximum number of 208
Modifying grid properties 206
origin

align with element 206
setting by probing 206

Polar grid 201
reset origin 207
show and hide via popup menu in status area 212
Show options 212
showing lines 212

grids, origin 67
grids, parameters 67
group

create 615, 616
select at sheet level 92

Group Dashboard 188
Group Lines

how to create 332
Group lines

deleting 334
Group Selected 614
Groups

changing names 188
creating 188
in Structure Tree 179
Members 181
nesting 188
Properties 188
selecting 92

groups
nested 616

Groups, exit 618
Groups, Introduction 180
Groups, Ribbon, Home, Toolgroup 613
GroupsOowners 181

H
Half a symmetrical dimension tool 626
Halve segment length 389
Help buttons in dialogs 29
Help menu 27
Help Options 28
Hidden line style 701
Hidden lines

2D modeling 701
override when 2D modeling 701
show when 2D modeling 702

hidden lines
masking 588

hide construction lines 497
Hide or show the line segment 390
hide reference 725
Hide Symbol Browser after loading a symbol 271
Hiding

grid lines 212
Hierarchical Navigation, sheet structure 192
Hit Radius 277

Default settings 114
Hit radius 114

changing 114
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querying 114
HLR Type 589
Hole end view tool 709
Holes

creating
sectioned 713

Home, Tab 33
Horizontal dimensioning 422
Horizontal View menu option 707

I
Icon Chooser 79, 80
Icon Selector dialog 782
Icon, size 776
Imperial units

dimensions 433
Import drawings, File formats 222
In Graphics Probe Bar 46
In Graphics Tool Bar 47
Incremental angle 383
incremental offsets 691
input area 504
Input fields, filling out 51
Interfaces

CADConvert Mapping Tables, open dialog 304
DXF/DWG Interfaces, open dialog 304

Interfaces, Configuration 304
Interfaces, File, Options 304
Intersection 590
Intersection Probe, Probe specifier 116
Intersection Radius 277
Introduction

Grids 198
Introduction and more 792
Inv line function 359
ISO dimensioning standard 414
Item Number 536
Item Number Balloons 536

J
JIS dimensioning standard 414
JoinLine Properties, Dialog 681
Justification 505
justification

table 555
set to top left 558

justify text in tables 564

K
keyboard 51
Kreise

Werkzeuge für Hilfslinien 685

L
Last Probe, Probe specifier 123
launching URL 514
Layer

customize 159, 162
Show options 149

Layer Change 153
Layer Datum 152
Layer list 758
Layer Management 148
Layer Management Dialog

List Buttons 156
Layer Management, Dialog 148
Layer Properties 148
Layer Properties, Tab Layer Mangement Dialog 150
Layer Set Attributes 157
Layer Set Management 155
Layer Sets 150

Customize 162
Layers 143

allocation
default 145

delete name 161
dimensions 433
numbering

datum 152
overview 144
plotting 240
printing 243
rename 159
sets 144
stippling 581

Layers, sheet properties 74
leader line 450
leader line, witness line 444
Leaf Node, Structure Tree 186
Legible Text, text display 270
Legible, text 321
legible, text 581
Level 95
libraries of symbols 594
Licenses 297
Limit

specifying in dimensions 430
Lin line function 359
Line creation

ending 341
Line Dashboard 306
Line Dashboard, Overview 380
Line direction 339

order of points in line 338
reversing 381

Line functions
flipping an arc 378

Line Navigation 381
Line Point Properties (popup menu) 378
Line Point Properties dialog 358
line styles 353
line types 354
Linear Dimension Properties dialog

Style and Format tab 427
Text and Arrows tab 432

Linear dimensions 421
Linear units 71
Lines

construction 480
creating

construction 492
perpendicular segment 120
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creating points
at intersection 116
at middle of segment 122

crosshatching boundaries 569
current point 338
direction

effect on arrowhead point functions 361
editing

overview 376
editing tools 365
finishing 341
flipping the arc function 378
function 359
geometry 338
measure 107
measuring 103
measuring segments 104
properties

of points 358
selecting 92

for editing 376
temporary

defining areas to fill 569
deleting 569

lines
change properties 356
change properties with Dashboard 356
connect 680
construction

projected 695
hidden

masking 588
style variants 353
tidy 680
types 354

Lines, Tool Group Home 337
Load directories 40
Load named diagram symbol 801
Load reference tool 721
Load reference, tool 724
Load Symbol Temporary Properties, dialog 604
Load tables 560
Load temporary diagram symbol, tools 800
Load temporary symbol

popup menu 596
Loading

a WSD File 234
sheet in a WSD File 236
symbols

temporary 603
Lock, Symbol Dashboard 601
Locked properties 174
Log file

print jobs 301
login command 23
Logout, Cloud 40

M
M6ICONSIZE, environment variable 776
Magnify 317
Magnify, tools 331
Magnifying symbols 607

Main components, user interface 32
main features 18
Manage the properties associated with working sets 238
Map keys 291
Mapkey tab,Accelerator & Mapkey dialog 294
Mapkeys 294
Margins around sheets

printing 251
Masking a Selection 589
Masking Hidden Lines 588
Maximum

sheet size 73
Maximum chord angle 279
Maximum Radius 277
Measure dialog 103
Measuring

2D properties of geometry 108
angles 106
Distance Between the Current Point and the Last 

Point 106
Distance Between Two Points 105
line segments 104
lines 103, 107
precision 104

Measuring properties 104
Members of groups 181
Menu options

Axis of Rotation 708
Base Angle 348
Horizontal View 707
Oblique View 707
Reverse Offset 689
Vertical View 707
View Direction 705

Menus
popup 44

Merge User Styles 177
Merge User Styles, Style tree 177
Message Area 265
Message Lin 37
Message Line 28
Messages Types to Display 266
Mid Segment Probe, Probe specifier 122
Minimum chord angle 279
Minimum Text Legibility 270
Minute angular unit 72
Mirror Lock, Transformation 330
Mirror, how to 329
Mirroring symbols 607
Modification of sheet properties 69
Modify filter / Use for selection 760
Modify Properties 85
Modify the weight of the selected tangent arc 394
Modifying

lines 376
tools 781
working set sheet loading behavior 238

More button 771
Mouse

using to select elements 129
Mouse button

click, double click, hold down 49
Mouse Buttons
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Functions 48
Mouse buttons

dragging 49
LMB, RMB, MMB 48

Mouse wheel
change tab 49

Move
popup menu option 322

move
how to 323
toolset 323

Move Datum of symbol back to original 612
move elements 322
Move Point 377
Move the selected points, tool 367
MovebyGrid, dialog 751
Moves geometry multiple of a grid offset, tool 751
Moving

datum point
symbols 611

Multi-line text
creating 515

Multiple
crosshatching 585
elements

selecting 131, 765
multiple selection table 761
Multiple Selections of Text 510
Multi-segment Lines 20
My Favourites 176

N
named diagram symbol

load 801
Named point functions 363
Named symbols 596

Editing 600
named symbols 594
Names

changing
for groups 188

Navigation Line 381
Navigation, Structure Tree 192
Near point radius

probe specifiers 115, 277
Near Probe, Probe specifier 117
Nested Group 616
Nested groups 188
New Line 377
New Table 554
newlink deletescaleviews 735
Node

Group Node 186
Sheet Node 186
Summary Node 186

Nodes
Current node 185

Nodes inStructure Tree
Leaf Node 186

Nodes, Structure Tree 185
Note Dashboard 454
notes 450

Null line function 359
Null point function 360

O
Oblique construction lines 686
Oblique View menu option 707
Offset from Last Probe, Probe specifier 124
Offsets

construction lines 688
absolute offset values 691
multiple 691

positive and negative
construction lines 688

Opaque in-sheet buttons, Default Settings dialog, General, 
Switches 265

Opening
additional view windows 729

operations
boolean 590

Optimizing for printing 245
Options 283
Options, File tab 283
Origin

of grid, reset 207
origin

set - of grid 67
origin of grid 67
Orthogonal views

producing 700
Orthogonalize line within set tolerance 387
Orthogonalize whole line 387
Over-Dimensions 466
Overlapping centerlines 348
Overview

2D modelling 700
Construction lines

Tools 481, 482, 493
construction lines 480
crosshatching 568
CSV files 559
editing lines 376
of layers 144
selection methods 128
stippling 568
symbols 594
text properties 504
Text tools 500

overview of create line tools 674
Owners of groups 181

P
PAP prim 545
Parallel dimensioning 422
Parametric, Defaults Dialog 280
Parts List 565
Paste 316

recreate structure 316
Paste, Clipboard 314
Paste, Popup Menu 316
Pasting elements using Structure Tree 193
PDS group 725
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Perform boolean operations on geometry 590
Perform HLR operations on geometry 588
Permanent Sheet Scale 70
Permanent sheet units 71
Perpendicular

dynamic construction lines 488
Perpendicular dimensioning 422
Perpendicular Probe, Probe specifier 120
Plot dialog 239
Plot Queue 241
Plotter format 240
Plotter Information dialog 302
Plotter Properties dialog 302
Plotting

backdrop 241
current view 240
defined areas 240
defining appearance of arcs 240
drawing code 240
number of copies 240
rotating area to plot 245
sheets 239
specific layers 240
title information 240
to specific scale 240
Visibility Settings of Design Objects 241

Point functions 360
arrowhead 361
changing 361
gap 360
named point functions 363
Null 360
user-defined 364

Point functions dialog 362
point group 333
Point Recognition 483
Points

changing
appearance 360
coordinates 359

creating
at datum points 125
at line intersections 116
on arcs 122

on current grid 116
creating 116

properties of 358
sequence of 339

reversing 381
weight 358

points
move selected 367

Polar, Grid, polar 201
Popup Crosshatch Tool 572
Popup Menu

create tables 561
For Linear Dimensions 422
of the Create boxed Text Arrows Tool 516
While Typing into Table Cell 562

Popup menu
Paste 316

Popup Menu 1 for Editing Dimensions 446
Popup Menu 2 for Editing Dimensions 447

Popup Menu 3 for Editing Dimensions 447
Popup Menu for Handling Texts during Transformations 321
Popup Menu for Transform Groups 334
Popup Menu Load temporary symbol 596
Popup Menu Option Move 322
Popup Menu While Placing Prims 547
Popup Menus 44
Popup menus

Edit line 377
in Graphics area 44

Popup Stippling Tool 574
porthole

creating a new reference 722
reference tools 721

porthole element creation 718
porthole elements

tools 717
Power Selection Dialog 757
Power Selection Tool 757

Draw selection only 759
multiple selection table 761
save filter in custom selector button 762
selection modes 759

precision of measuring 104
Prefix for dimensions 430
Prefix/Suffix, Default settings 274
Preview, Print 249
Preview, Print dialog 245
Prim libraries

Prims dialog box 546
Prim Properties dialog 550
Prim types 545
Prims 543

adding to sheet
named prims 546
standard prims 545

choosing from a prim library 546
dashboard 546, 549
datum point 545
default 546
definition 544
deleting 548
how prims are displayed 544
selecting 92
storage 544
tools 545
transforming 548
updating on sheets 544

prims
change properties 551
popup menu 547

Prims dialog 546
Print

advanced options 250
Print Dialog

Show Preview 245
Print dialog 242
Print Preview 249
Print Preview Dialog 250
Printer format 243
Printer properties 302
Printers

adding 301
© CAD Schroer GmbH 821



MEDUSA4 Drafting

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
configuration file 303
deleting 300
log files 301

Printing
area options 246
automatically rotating plot area to fit page 244
autoscaling plot area to fit page 244
backdrop 244
boundary brackets 251
current view 243
defined areas 244
defining appearance of arcs 244
defining scrubbing area 252
defining text format 252
Directory 245
drawing code 243
Layer selection 247
Layer settings 247
Layers to print 247
nothing is printing 244
number of copies 243
optimization 245
optional user text 252

defining 252
select layers 247
sheared text 252
sheet margins 251
sheets 242
specific layers 243
text

defining proportional spacing 252
title information 243
to file 253
to specific scale 244

printing
edit description file 303

Probe Specifiers
In Graphics Probe Bar 46

Probe specifiers 111
Auto Probe 115
Center Probe 121
Datum of Selected Element 125
Free Probe 116
grid Probe 116
hit radius 114
intersection 116
Last Probe 123
Mid Segment Probe 122
Near Probe 117
Offset from Last Probe 124
Perpendicular Probe 120
probe radii 114
Segment Probe 119
selecting 113
setting the default 113
Tangent Probe 122

Processing Symbols, tool group 652
Profile extrusion tool 706
Profile Extrusion View Direction dialog 705
Profiles

restoring when 2D modeling 714
sweeping 704

Program, quitting 258

Project the construction lines from a section line 696
projected construction lines 695
Projecting Construction Lines Through a Profile 695
Projecting Construction Lines Through a Section 696
Projection construction lines from profiles 695
Projects a construction line from a rotated section line 698
Properties

2D Features 351
angular dimensions 442
balloon text 539
changing 170

crosshatching 579
stippling 579

changing element - 171
closed geometry 347
crosshatching 576
displaying

using Dashboard 84
Groups 188
linear dimensions 427
lines

changing 356
changing with the Dashboard 356

modify 85
modifying

using Dashboard 85
of a sheet, query and modify 69
printer 302
SMART Drafting 398
Style 167
symbols 604
text 504
text height 507
text rotation 507
unlocked 174
unused 173
views 730

properties
cloning 311

Properties changing, stippling 582
Properties Dialog

open Properties dialog 36
Properties for Masking hidden lines 588
Properties of points 358
Properties,Display in dashboard 84
Proportional spacing for printing text 252
Protractor 383
Pulldown Menu

Creation Tools 306
Pulldown menu

Creation tools 308

Q
QRCode Dialog 642
QRCode Symbol, create a 643
QRCode Symbols 642
qtplotpd f_color, predefined super printer 243
qtplotpdf_bw, predefined super printer 243
Query

Angle, Distance 385
line segment length 104

Querying
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2D properties of geometry 108
angles 106
hit radius 114
lines 107

Quick Selection Tools for Dimensions 631
quit 258
Quitting the program 258

R
Radial Dimension Properties dialog 439
Radians 72
Radii and Arc Factor

Arc Factor 278
Auto Probe Radii 277
Search Radii 277

Radii and Arc Factor Options, Default Settings 277
Rahmen

Werkzeuge für Hilfslinien 685
Raster

plotting 241
Raster Backtrop, Defaults dialog 281
raster image 230
RCS 660
RDS group 726
Recent Sheets 226
Record Trail File 787
Recreate structure 316
Redo 97, 378
Redo, Undo 96
Ref Load, tool 724
reference

create new 722
hide 725
load 724

Reference clump 725
Reference Coordinate System 660
Reference dimensions 466
Reference Group dialog 722
Reference System, Defaults dialog 281
reference tools 721
RefNew, tool 721, 722
Refresh button, Cloud 40
Relative offsets

construction lines 691
Reload WSD File 236
remove accelerator key 293, 294
Remove chamfer, tool 391
Remove fillet, tool 391
Remove Style from Favourites 177
Remove the curve fitted through the current line 387
Removing sheets from WSD files 235
renaming a layer 159
Reparent 190
Replace Text 519
Replace text properties 641
Replay Trail File 787, 789
Representation, grid 201
reset sheet scale 71
Resetting grid origin 207
Restore window view 100
Restoring profiles from 2D modeling 714
Reverse Offset menu option 689

Reverse Points in line 378
Reversing line direction 381
Ribbon 33

File tab 215
Home tab, Creation 305
Home tab, Creation Tool Group 306
Tabs 33
toggle between tabs 49

Rigid, text 321
rigid, text 581
Rotate 316
Rotate 90 316
Rotate profile to form a shaft 711
Rotate Profiles to Form Sectioned Holes 713
Rotate Profiles to Form Sectioned Shafts 712
Rotate profiles to form shafts tool 711
Rotate segment by -90 degrees 390
Rotate segment by fraction 390
Rotate segment by specified angle 390
Rotate segment, doubling angle 390
Rotate segment, halving angle 390
Rotate, how to 325
Rotating

area to plot 245
symbols 606
text elements 507

rows
add to tables 561

rubber band display 264

S
Save

sheets as image 230
Save As Dialog 228
save as DXF file 229
Save as image 230
Save Filter Dialog 762
Save filter in custom selector button 762
Save or Discard Dialog 258
Save sheet 227
Save Style Tree 176
save tables 560
Saves the current multi-sheet set 233, 234
Saving

changes to the work environment 783
symbols

temporary 602
window views 99

Scale symbols 610
Scale text height 271
Scale views 732

dimensioning 738
display 735
example 739
working with 736

Scale, sheet 70
Scales

defining for plotted area 240
defining for printed area 244
dynamic

symbols 610
turning off and on 738
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freezing 736
of symbols on sheets 610
sheet

default 71
temporary 70

using different 732
scaling

dynamic, paste popup 317
Scrubbing area

defining for plotter 252
Search Radii area, Defaults settings 114
Search Radii, Default Settings 277
Search, Cloud 40
Second angular unit 72
Sectioned Shaft Properties dialog 701
Seed line 576
Seed point

crosshatching 570
Seedpoint

stippling 570
Segment Probe, Probe specifier 119
Segment Radius 277
Select All Option 759
Select by Area

Add 94
Common 94
Enclosed, Fully 94
Remove 94
Select 94
Toggle 94

Select Color, dialog 203
select diagram symbol 802
Select Elements by Area Dialog 95
Select elements of any type 92
Select Once, tool 765
Select Symbol after Exit Tool 271
Selected elements

toggle 131, 765
Selecting

by clicking 129
crosshatch elements 92
crosshatching 92, 584
dimensions 92
elements by area 92
groups 92
lines 92

for editing 376
multiple elements 131, 765
overview of methods 128
prims 92
probe specifiers 113
sheet elements 92
sheet level group 92
stippling 92, 584
text 92
using

mouse 129
selecting

custom tool 762
elements with user attributes 764

Selecting crosshatch elements 92
Selection

filter 759

masking hidden lines 589
Power Selection Dialog 757
Power selection tool 757

selection
multiple criteria 761

Selection Criteria Options 758
Selection filter, save in button 758
Selection Methods 127

Selecting with mouse 129
Selection sets

adding elements to 764
elements common to several selections 764
removing elements from 764
toggle selected elements 131, 765

Selection tool, All 92
Selection Tools, Popup menu 754
Set Defaults 202, 209
Set Origin 67
Set table justification 555
Set table justification to top left 558
Sets of layers 144
Setting background color 782
setting dimension standard 415
Shaft end view tool 709
Shaft volume of revolution

axis of rotation 708
Shafts, solid

creating 711
sectioned 712

Shape, closed geometry 349
Shape, tools 675
Shapes

activate 350
Shapes, previously 2D-Features 349
Shapes, Tools 350
Shear of text 507
Shearing symbols 608
Shearing text

defining format when printing 252
Sheet

Creating a 218
Filename 69
plotting 240
printing 243
Scale 70
Size 73
Special Format 219
Standard Format 218
Units 71

sheet
saving 227

Sheet Dashboard 35
Sheet elements

selecting 92
Sheet header 63
Sheet Header Editor 64
Sheet Header Editor, dashboard 63
Sheet level group

selecting 92
sheet origin 200
Sheet Properties

Display and modification 69
Layers 74
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Sheet properties 69
angular units 72
linear units 71
maximum drawing area 73
sheet filename 69
temporary sheet scale 70

Sheet Scale
permanent 70
Temporary 70

Sheet scale 70
effect on symbols 610

Sheet Size 73
standard 218

Sheet Size, change 73
Sheet structure 179
Sheet type 220
Sheet Working Sets dialog 231
Sheets

add and remove to WSD file 235
annotating 220
border

create 73
loading behavior in working sets 238
loading into WSD files 236
maximum size 73
plotting 239
printing 242

boundary brackets 251
margins 251
optional text in title block 252

scale
default 71
temporary 70

units
permanent 71

Shift-Key 51
Shortcut, change icon of tool 79
Shortcut, delete tool from Shortcuts 80
Shortcuts 78
Shortcuts, SMART Drafting 402
Short-Info 645
Show options, grids 212
Show options, Layer 149
Show position of window views 101
Show Preview, Print dialog 245
Showing

grid lines 212
hidden lines when 2D modeling 702

Size of symbols 610
Size, of Fonts, setting 776
Size, of icons, setting 776
SMART Drafting 397

Arcs 406
calling up 398
Changing Line Direction 412
Construction Points 408
edit existing geometry 411
Mouse Pointer 399
Popup Menu 400
Properties 398
shortcuts 402
Snap Mode Information 404

SMART Edit 459

Arcs and circles 473
calling up 461
datum 470
edit Dimension Lines 468
edit dimension values 465
Non-orthogonal lines 472
Orthogonal lines 471
over-dimensions 466
selection 460

Smash Shape 350
Snap Mode Information 404
sort a column 562
Spacing

stippling symbols 581
Spacing between witness lines of dimensions 434
Special characters

entering into text strings 511
Special Sheets dialogs 219
Special styles 167
specific dashboard 35
Split Button 774
Split line at selected point 387
standard dimensions 414
Standard Grid 209
standard sheet size 218
Standard, Default settings 272
start command 23
Start-Batch-File 23
Status Area 37

Display Structure Tree 183
Status area

E-Mail 38
Step

stippling 581
Stipple Properties dialog 580
Stippling

changing symbol 580
default spacing 581
defining area to fill 569
deleting 584
fill with symbols 574
filling areas 567
layers 581
overview 568
properties, changing 582
seedpoint 570
selecting 92, 584
Step 581
symbol datum

moving 581
stippling

popup menu 574
Stippling tools 572
Storing prims 544
Structure Tree 43

Current node 185
cutting elements 193
displaying and hiding 183
dock/undock 184
Group Node 186
Leaf Node 186
Navigation 192
Nodes 185
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pasting elements 193
Sheet Node 186
Summary Node 186
Toolbar in 193

Structure Tree Options Dialog 194
Structure Tree, open, display 42
Style

Add to Favourites 176
changing element styles 170
Default 167
properties 167
Remove from Favourites 176

style
My Favourites 176
of lines 353

Style list in Power selection dialog 758
Style Selection dialog 781
Style Tree 43, 170
Style tree 42

Merge User Styles 177
Save Style Tree 176
Use Style 176

Style Tree Popup Menu 176
Style Tree, display 175
Style Variants 353
Styles 42, 165

Changing 170
default 167
definitions 173
free 168
special 167
unused properties 173
using 168

Styles, Introduction to 166
Subscript 505
Suffix for dimensions 430
Superscript 505
Surface Finish Symbol Dialog 455
Sweep profiles 706
Sweeping profiles 704
Switches, Default Settings dialog

Opaque in-sheet buttons 265
Symbol

Group Name, adding and changing 601
symbol

load temporary
popup menu 596

Symbol Dashboard 601
Symbol Dashboard, lock 601
Symbol Load/Unload 271
Symbol Manager 43, 598
Symbol Manager Dialog 598
Symbol properties

reversing 612
Symbol, Default Settings 271
Symbol, Default settings 271
Symbols 42, 593

changes
undoing 612

containing text
modifying 605

datum point
moving 611

Dynamic alignment 609
effect of sheet scale 610
in scale views 737
libraries 594
magnifying 607
mirroring 607
Move Datum back to original 612
named 594, 596
named editing 600
overview 594
rotating 606
scale of 610
scaling

dynamic 610
shearing 608
size 610
stippling

changing 580
spacing 581

temporary 594
loading 603
properties 604
saving 602

tools 595
transforming 605
unscaling 610
Untransform 612

symbols
fill areas with 574
welding symbol 653

Symbols+Catalog
Home tab, Tool group 593

Symmetrical dimension tool 625

T
Tab

File 33
Home 33

Tab Layer Management Dialog 148
Table Creation dialog 554, 557, 559
Tables 553

creating data files 559
Delete Selection 555
Justify Text 564

tables 553
Add and Delete Rows and Columns 561
create 557
create parts list 565
edit 561
load 560
popup menu 561
Save 560
sort a column 562

Tablet 779, 792
Tabs

toggle by using the mouse wheel 49
toggle in ribbon 49

Tabs, Ribbon 33
Tangent Probe, Probe specifier 122
Tangential dynamic construction lines 487
temporary crosshatching properties 579
temporary diagram symbol
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load 800
Temporary lines

deleting 569
using to define area to fill 569

Temporary Scale views 736
Temporary Sheet Scale 70
Temporary sheet scale 70
Temporary Stipple Properties dialog 580
Temporary symbols

loading 603
properties 604
saving 602

temporary symbols 594
Test dimension percentage 431
Text 509

aspect, height and width of characters 508
Box around Multi-line Text 515
create gaps under text in crosshatching 587
datum point 508
editing 509
entering special characters 511
Fixed 321
font 507
for dimensions 432
for printed title block 252
format

angular dimensions 443
defining for printed sheet 252

gap, distance between characters 508
height 507
Legibility, Default Settings 270
Legible 321
modifying symbols containing text 605
multi-line 515
position on dimensions 432
replace 519
Rigid 321
rotating 507
search, find 518
selecting 92
shear

defining for printing 252
shear value 507
Toolgroup, Home tab 499
width of text string 508
X and Y position 507

text
arrows at -box 516
creating 502
creation, popup menu 502
Dashboard 504
multiple selection 510
properties dialog 506, 512, 513
replace properties 641
tools 500, 640
tools, overview 500

Text Case, uppercase,lowercase 505
Text display

legible,fixed,rigid 581
Text Display, Default Settings 270
text format for dimensions 434
Text properties

overview 504

Text Properties dialog 506, 512, 513
Text, Default Settings 270
Text, Default settings 270
Text+Prims

Tool group, Home tab 543
thumbnails 59
Tidy lines, tool 680
Tidy the current line, tool 680
Title block

printing user text 252
title block text of a drawing, editing 64
Toggle button 764
toggle selection 131, 765
Tolerances

dimensions 428, 431
format for dimensions 429

Tool
array 746
Create a new reference 721
Creates a Named Group 614
Creates a Named Level 1 Group 614
Creates a Named Level 2 Group 614
Creates construction circle tangential to a line in three 

steps 495
Creates construction circle tangential to a line in two 

steps 494
Creates construction circle tangential to two lines 494
Creates construction lines tangential at two circles 496
Creates construction lines through tangent points of two 

circles 496
Defines a new multi-sheet working set containing the 

currently loaded sheet 233
Deselect Once 765
Group Selected 614
Moves geometry multiple of a grid offset 751
Ref Load 724
RefNew 722
Select Once 765
Smash Shape 350

tool
Compare selected reference 721, 725
Connect the current line with adjoining lines 680
Convert reference 721
Delete Short-Info 646
Load reference 721
Short-Info of sheet content 645
SMART Drafting 398
Tidy the current line 680
Update parts list 566
Writes data of Item Number Balloons to a table 565

Tool Group
Groups 613, 614
Lines, Ribbon, Home Tab 337

Tool group
Clipboard 313
Configure 790
Construction Lines, Ribbon, Home Tab, Tool group 479
Processing Symbols 652
Symbols+Catalog, Ribbon, Home Tab 593
Text, Ribbon, Home Tab 499
Text+Prims, Ribbon, Home tab 543
Text+Prims, tables 553

tool group
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Anzeige, Anzeige 804
Trail File 787

Tool Group Creation 305
Tool Group Creation, Pulldown-Menu 306
Tool Groups 33, 57
Tool Sets 57
Toolgroup

Areas, Ribbon, Home tab 567
Tools

2D modelling 700
Boundary Groups 332
connect lines 680
Construction lines 481, 482, 493, 684
Constuction lines, Rectangles 684
Create a new reference 722
Create Groups 614
Creation 306, 308
crosshatching 572
customizing 781
delete all construction lines 497
dimensioning 420
edge projection 707
Fillets/Chamfers 391
hole end view 709
In Graphics Probe Bar 46
line edit 365
mirror 329
modify 781
Modify Line 387
Modify Segment 389
move selected points 367
pre-defined tool buttons,Style 167
Probe Specifiers 46
profile extrusion 706
projected construction lines 695
rotate elements 325
rotate profiles to form shafts 711
shaft end view 709
Shape 675
Shapes 350
shear 744
standard prims 545
stippling 572
Structure Tree 193
symbols 595
tidy lines 680
Tool group Clipboard 314
Tool Group Groups 614
transformation 320

tools
creating closed geometry 344
text 500, 640

Tools for Creating Porthole Elements 717
Tools for References 721
Toolset

Move 323
Tooltips 28
Trail File

Close 788
record 787
Replay 789

Trail File, tool group 787
Transformation

array tool 746
boundary groups 334
magnify, tools 331
Mirror Lock option 330
mirror, how to 329
mirror, tools 329
move 322
move tools 323
move, how to 323
rotate, how to 325
rotation tools 325
shear, tools 744
-swerkzeuge 744
tools 320

Transforming
prims 548
symbols 605

Transportation lines
Enable 264

Transported construction lines 692
deflection angles 693

TRI prim 545
Types

dimensions 434
of sheet 220

U
Überblick

Hilfslinien
Werkzeuge 685

Undo 378
Undo, Redo 96
Undock the Structure Tree 184
Undoing changes to symbols 612
Union 590
Units 71

angular 72
linear 71
permanent 71

Units dimensioning 429
Units, sheet 71
Unlocked properties 174
Un-number, Re-number 520
Unscale button 610
Untransforming symbols 612
Update parts list, tool 566
Updating individual tables 667
URL

delete 514
launch 514
possible entries 513

Url
add to text 512

Use filter to control sheet selection 760
Use row height 556
Use Style, Style tree 176
User

background color 782
User attributes

Elements with user attributes 764
User Interface

main components 32
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Overview 32
User-adjustable parameters 669
User-defined point functions 364
using a dialog 52
Using styles 168
Utilities

Number 520

V
variants of styles 353
Vertical dimensioning 422
Vertical View menu item 707
View Direction dialog 705
View Direction menu item 705
View Frames dialog 730
View Properties 730
View windows

copy and paste between windows 731
viewing direction

using to create perpendicular edges 707
Views

current
plotting 240
printing 243

orthogonal
producing 700

saving window views 99
scale

using different scales 732
showing window view positions 101

W
Weight

control point defining shape of arc 358
of points 358

welding symbols 653
weldsym.xml 657
Werkzeuge

Hilfslinien 685
Transformation 744

wheel mouse 49

Width of text string 508
Window Views 98
Window views

confining construction lines 498
delete 101
restore 100
saving 99
show position 101

Window Views dialog 98
Windows

copy and paste between different view windows 731
displaying borders 730
opening new 729
view windows 729

With Shear, text display 270
witness line (also known as leader line) 444
Work Environment

save changes 783
Working set

active 236
Working Set Properties dialog 238
Working Sets 231
Working sets

modifying sheet loading behavior 238
Write Protection Display 223
Writes data of Item Number Balloons to a table, tool 565
WSD file 231
WSD files

add and remove sheets 235
close sheets 237
copying 234
creating 232
creating containing currently loaded sheets 233
deleting 235
loading 234
loading sheets 236
reload 236

Z
Zoom, using the mouse wheel 49
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